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„Bio-Rad“™ techninė pagalba
„Bio-Rad“ techninės pagalbos skyrius JAV dirba nuo pirmadienio iki penktadienio, 5:00–17:00, Ramiojo
vandenyno laiku.

Telefonas: 1-800-424-6723, 2 variantas

El. paštas: Support@bio-rad.com (tik JAV / Kanada)

Techninės pagalbos už JAV ir Kanados ribų kreipkitės į savo vietinį techninės pagalbos biurą arba spustelėkite
nuorodą svetainėje bio-rad.com.

Pranešimas
Jokios šio leidinio dalies negalima atkurti ar perduoti bet kokia forma ar bet kokiomis priemonėmis,
elektroniniu, mechaniniu, fotokopijavimo, įrašymo ar kitu būdu arba laikyti informacijos saugojimo ar paieškos
sistemoje be rašytinio „Bio-Rad Laboratories, Inc.“ leidimo.

„Bio-Rad“ pasilieka teisę bet kuriuo metu keisti savo produktus ir paslaugas. Ši instrukcija gali būti keičiama be
išankstinio įspėjimo. Nors „Bio-Rad“ pasirengusi užtikrinti tikslumą, ji neprisiima jokios atsakomybės už klaidas
ar netikslumus arba dėl bet kokios žalos, atsiradusios dėl šios informacijos taikymo ar naudojimo.

BIO-RAD yra „Bio-Rad Laboratories, Inc.“ prekės ženklas.

SYBR yra „Thermo Fisher Scientific Inc.“ prekės ženklas.

„EvaGreen“ yra „Biotium, Inc.“ prekių ženklas.

Visi čia naudojami prekių ženklai yra atitinkamų jų savininkų nuosavybė.

Autoriaus teisės © 2022, „Bio-Rad Laboratories, Inc.“ Visos teisės saugomos.

http://www.bio-rad.com/


Paskirtis

Paskirtis
„CFX Opus Dx“ realiojo laiko PGRTM su „CFX Maestro Dx“, „Security Edition“TM, skirta fluorescencija
pagrįstai PGR atlikti, siekiant aptikti ir kiekybiškai įvertinti nukleino rūgščių sekas. Sistema ir programinė
įranga skirtos naudoti kvalifikuotiems laborantams atliekant „in vitro“ diagnostiką. Sistema skirta naudoti
su trečiųjų šalių diagnostikos nukleino rūgščių testais, kurie buvo pagaminti ir paženklinti diagnostikos
tikslais.

Simbolių žodynas

Gamintojas Partijos numeris

Sunaudoti iki „In vitro“ diagnostikai

Temperatūros riba Katalogo numeris

Žr. naudojimo instrukcijas Tyrimų skaičius

Skirta naudoti su Serijos numeris

Naudoti tik pagal receptą Sudėtyje yra latekso
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CE žymėjimas - reglamentas
(ES) 2017/746 IVDR

Vertimai
Produkto dokumentai elektroninėse laikmenose gali būti pateikiami papildomomis kalbomis.
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Versijų istorija
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Atitiktis saugos ir teisės aktų reikalavimams
„CFX Opus 96 Dx“, „CFX Opus 384 Dx“ ir „CFX Opus Deepwell Dx“ realiojo laiko PGR sistemos (šiame
vadove vadinamos „CFX Opus Dx“) įkaista ir atvėsta. Siekiant užtikrinti saugų realiojo laiko PGR sistemos
veikimą, „Bio-Rad“ primygtinai rekomenduoja laikytis šiame skyriuje ir šiame vadove išvardytų saugos
specifikacijų.

Saugos įspėjamieji ženklai
Ant „CFX Opus Dx“ pritvirtinti įspėjamieji ženklai perspėja apie potencialius sužeidimo arba pakenkimo
šaltinius. 1 lent. paaiškinti visi saugos įspėjamieji ženklai.

Piktograma Reikšmė

Jei „CFX Opus Dx“ pradedama eksploatuoti neperskaičius šios instrukcijos, gali
kilti kūno sužalojimo pavojus. Jei prietaisas naudojamas šiame vadove arba
„Bio-Rad“ nenurodytu būdu, gali sutrikti arba išsijungti prietaiso apsauginės
funkcijos.

Nėra jokių biologinių pavojų ar radioaktyvių pavojų, susijusių su pačia „CFX
Opus Dx“. Šie pavojai gali kilti tik tada, kai medžiagų į sistemą patenka su
tiriamaisiais mėginiais. Jei dirbama su biologiškai pavojingais arba radioaktyviais
mėginiais, laikykitės rekomenduojamų atsargumo priemonių ir gairių, taikomų
jūsų laboratorijoje ir vietovėje. Šios gairės turėtų apimti jūsų naudojamų
pavojingų medžiagų valymo, stebėjimo ir šalinimo metodus.

Be to, kaip nurodyta anksčiau, yra maža sprogimo arba skysčių ar garų
išsiveržimo iš mėginių talpyklų rizika. Dirbant su pavojingomis medžiagomis,
rizika susižaloti dėl išsiveržusių medžiagų papildo rizika, kad pačios pavojingos
medžiagos gali pasklisti prietaise ir aplink jį. Tokiose situacijose naudotojai turėtų
imtis atitinkamų atsargumo priemonių.

1 lent. Bendrieji saugos įspėjimai
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Atitiktis saugos ir teisės aktų reikalavimams

Piktograma Reikšmė

„CFX Opus Dx“ veikia esant aukštai temperatūrai, galinčiai sukelti rimtų
nudegimų. Prieš atidarydami dangtį ir išimdami mėginius, visada palaukite, kol
mėginių blokas atvės iki kambario temperatūros. Net atvėsus mėginių blokui,
aplinkinės sritys ir šildytuvo plokštė dar kurį laiką gali išlikti karšti. Tais atvejais,
kai prietaisui atvėsti nepakanka laiko, rekomenduojama naudoti apsaugines
priemones, pavyzdžiui, karščiui atsparias pirštines ar orkaitės pirštines.

Už bet kurios sistemos, apimančios „CFX Opus Dx“ , saugą ir eksploatavimą
atsako tik sistemos montuotojas.

Veikiant įprastai „CFX Opus Dx“ gali pakankamai įkaisti, kad mėginiuose esantys
skysčiai užvirtų arba garuotų, didindami slėgį mėginių talpyklose. Yra tikimybė,
kad mėginių talpyklos gali sugesti; dėl to gali įvykti nutekėjimas, ištrykšti skystis,
jos gali sprogti plyšdamos ir gali išsiveržti garai ar skysčiai prietaise ir aplink jį.

Siekdami išvengti sužalojimų, naudotojai prietaisą visada turėtų eksploatuoti
uždarę dangtį arba dėvėdami apsauginius akinius, karščiui atsparias pirštines ir
kitas asmeninės apsaugos priemones. Atidarius prietaisą, kol mėginiai vis dar
karšti, pavyzdžiui, nutraukus vykdymą, talpyklos, kuriose susidaręs slėgis, gali
pratekėti, trykšti ar purkšti skystį. Prieš atidarydami dangtį, visada leiskite
mėginiams atvėsti.

Naudotojai niekada neturėtų vykdyti reakcijos su atviru, laisvu, pradurtu ar kitaip
pažeistu dangčiu ar sandarikliu, nes tai padidina pavojingo plyšimo ar sprogimo
tikimybę.

Naudotojai niekada neturėtų vykdyti reakcijos su lakiais reagentais, kurie gali
padidinti pavojingo plyšimo ar sprogimo tikimybę.

1 lent. Bendrieji saugos įspėjimai (tęsinys)
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Atitiktis saugos ir teisės aktų reikalavimams

Atitiktis saugos ir teisės aktų reikalavimams

Saugos atitiktis
„CFX Opus Dx“ buvo ir nustatyta, kad jie atitinka visus taikytinus šių saugos ir elektromagnetinio
suderinamumo standartų reikalavimus:

n IEC 61010-1:2010 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei įrangai.
1 dalis. Bendrieji reikalavimai

n IEC 61010-2-010:2019 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-010 dalis. Ypatingieji reikalavimai, keliami laboratorinei medžiagų kaitinimo įrangai

n IEC 61010-2-081:2019 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-081 dalis. Ypatingieji reikalavimai, keliami automatinei ir pusiau automatinei laboratorijų
įrangai, naudojamai analizės ir kitokiems tikslams

n IEC 61010-2-101:2018 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-101 dalis. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

n CAN/CSA-C22.2 NR. 61010-1-12:2018 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir
laboratorinei įrangai. 1 dalis. Bendrieji reikalavimai

n CAN/CSA-C22.2 NR. 61010-2-010:19 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir
laboratorinei įrangai. 2-010 dalis. Ypatingieji reikalavimai, keliami laboratorinei medžiagų kaitinimo
įrangai

n CAN/CSA-C22.2 NR. 61010-2-081:19 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir
laboratorinei įrangai. 2-081 dalis. Ypatingieji reikalavimai, keliami automatinei ir pusiau automatinei
laboratorijų įrangai, naudojamai analizės ir kitokiems tikslams

n CSA-C22.2 NR. 61010-2-101:19 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir
laboratorinei įrangai. 2-101 dalis. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos
įrangai

n EN 61010-1:2010 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei įrangai.
1 dalis. Bendrieji reikalavimai

n EN 61010-2-010:2014 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-010 dalis. Ypatingieji reikalavimai, keliami laboratorinei medžiagų kaitinimo įrangai
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n EN 61010-2-081:2015 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-081 dalis. Ypatingieji reikalavimai, keliami automatinei ir pusiau automatinei laboratorijų
įrangai, naudojamai analizės ir kitokiems tikslams

n EN 61010-2-101:2017 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-101 dalis. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

n UL 61010-1:2012 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei įrangai.
1 dalis. Bendrieji reikalavimai

n UL 61010-2-010:2019 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-010 dalis. Ypatingieji reikalavimai, keliami laboratorinei medžiagų kaitinimo įrangai

n UL 61010-2-081:2019 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-081 dalis. Ypatingieji reikalavimai, keliami automatinei ir pusiau automatinei laboratorijų
įrangai, naudojamai analizės ir kitokiems tikslams

n UL 61010-2-101:19 Saugos reikalavimai, keliami elektrinei matavimo, valdymo ir laboratorinei
įrangai. 2-101 dalis. Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

Elektromagnetinis suderinamumas (eMS)
„CFX Opus Dx“ buvo ir nustatyta, kad jie atitinka visus taikytinus šių elektromagnetinio suderinamumo
standartų reikalavimus:

n IEC 61326-1:2012 Elektrinė matavimo, valdymo ir laboratorinė įranga. EMS reikalavimai. 1 dalis. 1
dalis. Bendrieji reikalavimai. Išbandytas kaip A klasės prietaisas

n IEC 61326-2-6:2012 Elektrinė matavimo, valdymo ir laboratorinė įranga. EMS reikalavimai. 2-6 dalis.
Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

n EN 61326-1:2013 Elektrinė matavimo, valdymo ir laboratorinė įranga. EMS reikalavimai. 1 dalis.
Bendrieji reikalavimai. Išbandytas kaip A klasės prietaisas

n EN 61326-2:-6:2013 Elektrinė matavimo, valdymo ir laboratorinė įranga. EMS reikalavimai. 2-6 dalis.
Ypatingieji reikalavimai, keliami „in vitro“ diagnostikos medicinos įrangai

n FCC 15 dalies B poskyrio 15.107 ir 15.109 skirsniai. Išbandytas kaip A klasės skaitmeninis prietaisas

n CAN ICES-003v6: 2019 Trikdžius sukeliančios įrangos standartas, informacinių technologijų įranga
(įskaitant skaitmeninius aparatus). Ribos ir matavimo metodai. Išbandyta pagal A klasės ribas
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FCC įspėjimai ir pastabos
n Įspėjimas. Atlikus šio įrenginio pakeitimus ar modifikacijas, kurie nėra aiškiai patvirtinti „Bio-Rad“,

gali nustoti galioti naudotojui suteiktas leidimas eksploatuoti įrangą.

n Pastaba. Ši įranga buvo išbandyta ir buvo pripažinta, kad ji atitinka ribines vertes, taikomas A klasės
skaitmeniniam prietaisui pagal FCC taisyklių 15 dalį. Šios ribos skirtos tinkamai apsaugoti nuo
žalingųjų trukdžių, kai įranga naudojama komercinėje aplinkoje. Ši įranga generuoja, naudoja ir gali
spinduliuoti radijo dažnių energiją ir, jeigu ji nėra įrengta ir naudojama pagal naudojimo instrukciją,
gali žalingai trukdyti radijo ryšiams. Eksploatuojant šią įrangą gyvenamuosiuose rajonuose
veikiausiai atsiras žalingieji trukdžiai; tokiu atveju naudotojas turės pašalinti trukdžius savo sąskaita.

n Pastaba dėl atitikties FCC reikalavimams. Nors šis prietaisas buvo išbandytas ir buvo patvirtinta,
kad jis atitinka FCC taisyklių 15 dalies B poskyrio reikalavimus, taikomus A klasės skaitmeniniam
prietaisui, atkreipkite dėmesį į tai, kad šis reikalavimų laikymasis yra savanoriškas, nes prietaisas
priskiriamas „prietaisams, kuriems taikoma išimtis“, kaip apibrėžta FRK 47 antraštinės dalies 15.103
skirsnio c punkte, atsižvelgiant į nurodytas pagaminimo metu galiojusias FCC nuostatas.

n Pastaba dėl kabelių. Šio prietaiso EMS atitiktis buvo patikrinta naudojant specialiai sukurtus USB
kabelius, kurie tiekiami kartu su prietaisu. Šie kabeliai arba „Bio-Rad“ patvirtinti pakaitalai turi būti
naudojami kartu su šiuo prietaisu, kad būtų užtikrinta nuolatinė EMS spinduliuotės ribų atitiktis.
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Aplinkos reikalavimai
„CFX Opus Dx“ sukurta taip, kad ją būtų galima saugiai eksploatuoti esant nurodytoms aplinkos
sąlygoms.

Parametras Specifikacija

Aplinka Naudoti tik patalpoje

Naudojimo aukštis Iki 2 000 metrų virš jūros lygio

Patalpos aplinkos temperatūra 15–31 °C*

Transportavimo ir laikymo temperatūra Nuo –20 ° iki 60 °C**
Nuo –4 iki 140 °F

Santykinė drėgmė 20–80 % (nesikondensuojanti)***

Eksploatacinė galia 100–240 V kintamoji srovė ± 10 %, 50/60 Hz,
maks. 850 W

Maitinimo tinklo įtampos svyravimai ±10 %

Maksimalus energijos suvartojimas < 850 vatų

Saugikliai 10 A, 250 V, 5 x 20 mm, greitas smūgis (2 vnt.)

Viršįtampio kategorija II

Taršos laipsnis 2

*Dirbant su prietaisu už šio temperatūros intervalo ribų, gali būti pažeistos veikimo specifikacijos.
Saugia laikoma 5–40 °C kambario temperatūra.

**Laikykite ir gabenkite prietaisą transportavimo pakuotėje, kad jis atitiktų šias temperatūros sąlygas.

***Tokiomis sąlygomis prietaisą 4 °C temperatūroje reikėtų naudoti ne ilgiau kaip 18 valandų. Laikyti
4 °C temperatūroje galima iki 72 valandų, jei drėgmė yra mažesnė nei 60 % (be kondensato).

2 lent. „CFX Opus Dx“ realiojo laiko PGR aplinkos reikalavimai
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Pavojai

Pavojai
„CFX Opus Dx“ yra, sukurta taip, kad saugiai veiktų, kai naudojama gamintojo nurodytu būdu. Jei sistema
ar bet kuris su ja susijęs komponentas naudojami gamintojo nenurodytu būdu, gali netinkamai veikti
prietaiso apsaugos funkcijos. „Bio-Rad“ neatsako už jokius sužalojimus ar žalą, atsiradusią dėl šios
įrangos naudojimo nenurodytu būdu arba dėl prietaiso pakeitimų, kuriuos atliko ne „Bio-Rad“ arba
įgaliotasis atstovas. „CFX Opus Dx“ priežiūrą turi atlikti tik apmokytas „Bio-Rad“ personalas.

Biologiniai pavojai
„CFX Opus Dx“ yra laboratorijos produkta. Jeigu yra biologiškai pavojingų mėginių, laikykitės toliau
pateiktų rekomendacijų ir visų laboratorijoje ir vietovėje taikomų vietos rekomendacijų.

Pastaba. Jokios biologiškai pavojingos medžiagos nėra išleidžiamos įprasto šio prietaiso naudojimo
metu.

Bendrosios atsargumo priemonės

n Būtinai vilkėkite laboratorinį chalatą, mūvėkite laboratorines pirštines, naudokite apsauginius akinius
(uždarus arba su šoniniais skydeliais).

n Rankomis nelieskite burnos, nosies ir akių.

n Prieš dirbdami su galimai užkrečiamosiomis medžiagomis visiškai apsaugokite kūno vietas, kur
įsipjovėte arba nusibrozdinote.

n Baigę darbą su bet kokiomis galimai užkrečiamosiomis medžiagomis, prieš išeidami iš laboratorijos
kruopščiai nusiplaukite rankas vandeniu ir muilu.

n Prieš dirbdami prie laboratorinio stalo nusisekite laikrodį ir nusiimkite papuošalus.

n Visas galimai užkrečiamąsias medžiagas laikykite nedūžtančiose ir sandariose talpyklėse.

n Prieš išeidami iš laboratorijos, nusivilkite apsauginius drabužius.

n Pirštinėtomis rankomis nerašykite, neatsiliepkite į telefono skambučius, nejunginėkite šviesų ir
nelieskite jokių kitų daiktų, kuriuos galėtų paliesti kiti, pirštinių nemūvintys asmenys.

n Dažnai keiskite pirštines. Regimai užterštas pirštines tuojau pat nusimaukite.

n Medžiagas, kurių neįmanoma tinkamai nukenksminti, saugokite nuo galimai užkrečiamųjų medžiagų
poveikio.

n Baigę dirbti su biologiškai pavojingomis medžiagomis, tinkamu dezinfekantu (pavyzdžiui, 1:10
buitinių chlorkalkių tirpalu) nukenksminkite darbo vietą.
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Paviršiaus nukenksminimas

ĮSPĖJIMAS! Norėdami išvengti elektros smūgio, prieš atlikdami nukenksminimo
procedūras prietaisą visuomet išjunkite ir ištraukite kištuką iš elektros lizdo.

Šias sritis galima valyti bet kuriuo ligoninės laipsnio baktericidiniu, virucidiniu ar fungicidiniu dezinfekantu:

n Išorinis dangtis ir ašis

n Vidinis mėginių bloko paviršius ir mėginių bloko šulinėliai

n Valdymo skydas ir ekranas

Kaip paruošti ir naudoti dezinfekantą, žr. gaminio gamintojo pateiktose instrukcijose. Panaudoję
dezinfekantą mėginių bloką ir mėginių bloko šulinėlius visuomet skalaukite kelis kartus vandeniu. Po
skalavimo vandeniu mėginių bloką ir mėginių bloko šulinėlius visuomet kruopščiai išdžiovinkite.

Svarbu. Nenaudokite šveičiamųjų valiklių, korozinių ploviklių ar stiprių šarminių tirpalų. Šios
priemonės gali subraižyti paviršius ar pažeisti mėginių bloką, todėl gali sumažėti temperatūros
kontrolės tikslumas.

Biologiškai pavojingų medžiagų šalinimas

Visas toliau išvardytas galimai užterštas medžiagas šalinkite laikydamiesi taikomų vietinių laboratorijos,
regioninių ir nacionalinių taisyklių:

n klinikinius mėginius,

n reagentus,

n panaudotus reakcijos indus ar kitas sąnaudines priemones, kurios gali būti užterštos.

Cheminiai pavojai
„CFX Opus Dx“ nėra potencialiai pavojingų cheminių medžiagų.

Sprogimo arba užsiliepsnojimo pavojai
„CFX Opus Dx“ nekelia jokio neįprasto su užsiliepsnojimu ar sprogimu susijusio pavojaus, jei naudojama
laboratorijose tinkamu būdu pagal „Bio-Rad“ nurodymus.
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Transportavimas

Elektros pavojai
„CFX Opus Dx“ nekelia operatoriams jokio neįprasto su elektros srove susijusio pavojaus, jei yra tinkamai
įrengti bei eksploatuojami be fizinių modifikacijų ir yra prijungti prie reikiamos specifikacijos maitinimo
šaltinio.

Transportavimas
Prieš perkeliant arba siunčiant „CFX Opus Dx“, turi būti atliktos kenksmingumo pašalinimo procedūros.
Visada perkelkite ar transportuokite sistemą atskirose pakuotėse, naudodami „Bio-Rad“ pateiktas
pakavimo medžiagas, kurios apsaugos prietaisus nuo pažeidimų.

Norėdami gauti informacijos apie sistemos transportavimą ir paprašyti tinkamų pakavimo medžiagų,
kreipkitės į vietos „Bio-Rad“ biurą.

Baterija
„CFX Opus Dx“ naudojamas vienas arba 3 V ličio metalo maitinimo elementas, kad palaikytų laiko
nuostatas sutrikus kintamosios srovės maitinimui. Jei išjungus prietaisą, laiko nuostata neišlieka, gali būti,
kad senka maitinimo elementai.

ĮSPĖJIMAS! Nebandykite keisti baterijų. Jų naudotojas negali pakeisti. Kreipkitės
pagalbos į „Bio-Rad“ techninės priežiūros tarnybą.

Tik Kalifornijos valstijai, JAV

n Perchlorato medžiaga – ličio baterijose yra perchlorato medžiagos; gali būti taikoma speciali tvarka.
Žr. www.dtsc.ca.gov/hazardouswaste/perchlorate.

Šalinimas
„CFX Opus Dx“ yra elektrinių medžiagų; jos negali būti šalinamos kaip nerūšiuotos atliekos ir turi būti
surenkamos atskirai pagal Europos Sąjungos direktyvą 2012/19/ES dėl elektros ir elektroninės įrangos
atliekų (EEĮA direktyva). Prieš šalinimą susisiekite su vietos „Bio-Rad“ atstovu, kuris pateiks jūsų šaliai
skirtus nurodymus.

Garantija
„CFX Opus Dx“ bei su susijusiems priedams taikoma standartinė„Bio-Rad“ garantija. Dėl išsamesnės
informacijos apie garantiją susisiekite su vietos „Bio-Rad“ atstovybe.
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1 skyrius. Įvadas
„Bio-Rad“ efektyviosios PGR amplifikavimo sistemos paremtos naujausiais technologijų pasiekimais,
kurie leidžia užtikrinti didesnį tikslumą ir atkuriamumą taikant nukleino rūgščių amplifikavimą genominių
tyrimų reikmėms.

Programinės įrangos „Bio-Rad“ „CFX Maestro Dx“, „Security Edition“ suderinamas su šiais prietaisais ir
naudoja optimizuotus darbinius failus „Bio-Rad“ „PrimePCR“ (PGR pradmenys) pradmenų ir zondų
bandinių tyrimuose.

n „CFX Opus 96 Dx“ realiojo laiko PGR sistema (šiame vadove vadinama „CFX Opus 96 Dx“)

n „CFX Opus 384 Dx“ realiojo laiko PGR sistema (šiame vadove vadinama „CFX Opus 384 Dx“)

n CFX „Opus Deepwell Dx“ realiojo laiko PGR sistema (šiame vadove vadinama „CFX Opus Deepwell
Dx“)
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1 skyrius. Įvadas

Naudodami programinės įrangos „CFX Maestro Dx“, „Security Edition“ (šiame vadove vadinama
„CFX Maestro Dx SE“) galite interpretuoti sudėtingus duomenis ir vykdyti reikšmingus tyrimus genetinės
analizės reikmėms. Vos keliais pelės mygtukų paspaudimais galite pradėti tyrimus ir vykdyti savo genų
ekspresijos tyrimą, naudodamiesi tokiais įrankiais kaip t testai, vienfaktorinė ANOVA, „PrimePCR“ (PGR
pradmenys) kontrolinių medžiagų analizė ir etaloninio geno parinkiklio įrankis. Tada, naudodamiesi
„CFX Maestro Dx SE“ itin pritaikomomis duomenų vizualizavimo ir komentavimo priemonėmis, galite
paruošti publikavimo ir paskelbimo rezultatus.

Pastaba. Kai kurie „CFX Maestro“ ekranai gali būti rodomi kitaip nei šiame naudotojo vadove.
Programinėje įrangoje rodomi teisingi duomenys, o funkcijos yra tokios pačios.

Svarbu. Kibernetinis saugumas yra turto apsauga kibernetinėje erdvėje nuo kibernetinių atakų.
Kibernetinis saugumas yra„Bio-Rad“ gebėjimas apsaugoti savo žmones, informaciją, sistemas ir
reputaciją kibernetinėje erdvėje. Kibernetinė erdvė yra visuomet gyvuojantis, technologiškai
sujungtas pasaulis; ją sudaro žmonės, organizacijos, informacija ir technologijos.

Greita reakcija yra svarbi sprendžiant kibernetinio saugumo problemas! Jei įtariate, kad jūsų gali būtų
kibernetinio saugumo problema susijusi su jūsų prietaisu arba pažeistas jūsų svetainės kibernetinis
saugumas, nedelsdami kreipkitės techninės pagalbos į savo „Bio-Rad“ atstovą.
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Pagrindinės programinės įrangos „CFX Maestro Dx“, „Security Edition“ funkcijos

Pagrindinės programinės įrangos „CFX Maestro Dx“,
„Security Edition“ funkcijos

Naudodami „CFX Maestro Dx SE“ galite atlikti šiuos veiksmus:

n Analizuoti duomenis pasinaudodami stulpelinėmis diagramomis, grupinėmis diagramomis arba
taškinėmis diagramomis ir greitai interpretuoti bei suprasti savo rezultatus.

n Tinkinti savo duomenų pateikimą ir eksportuoti didelės raiškos diagramas publikacijoms ir
ataskaitoms kurti.

n Nustatyti RNR kokybę ir šalinti eksperimentų triktis su „PrimePCR“ (PGR pradmenys) analizės
valdikliais.

n Pasirinkti atitinkamą etaloninį geną ir analizuoti jo stabilumą etaloninio geno pasirinkimo įrankiu.

n Atlikti statistinę analizę, įskaitant vienfaktorinę ANOVA geno ekspresijos analizę.

Šiame naudotojo vadove paaiškintos šios funkcijos ir kaip jomis naudotis.

Sužinokite daugiau
Įdiegę „CFX Maestro Dx SE“ ir nustatę susijusį „Bio-Rad“PGR prietaisą, šį vadovą ir išsamias
„CFX Maestro Dx SE“ žinyno temas galite pasiekti meniu „Help“ (žinynas) bet kuriame rodinyje.

Patarimas. Spustelėkite „Bio-Rad“ logotipą, esantį bet kurio „CFX Maestro Dx SE“ lango
viršutiniame dešiniajame kampe, kad atidarytumėte „Bio-Rad“ svetainę. Šioje interneto svetainėje
pateikiama nuorodų į technines pastabas, vaizdo įrašus, instrukcijas, produkto informaciją ir techninę
pagalbą. Joje taip pat rasite daug techninių išteklių su informacija apie įvairius metodus ir programas,
susijusias su PGR, realiojo laiko PGR ir geno ekspresija.
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2 skyrius. Programinės įrangos „CFX Maestro Dx“,
„Security Edition“ diegimas

Šiame skyriuje paaiškinama, kaip įdiegti programinės įrangos „CFX Maestro Dx“, „Security Edition“.
Informacijos apie su „Bio-Rad“ suderinamo realiojo laiko PGR prietaiso nustatymą žr. atitinkamame
vadove.

„CFX Maestro Dx SE“ reikalinga PGR duomenų iš „CFX Opus 96 Dx“, „CFX Opus 384 Dx“ ir „CFX Opus
Deepwell Dx“ sistemų analizei realiuoju laiku. Šią programinę įrangą galite naudoti šioms sistemoms
kontroliuoti programinės įrangos valdomu režimu.

„CFX Opus Dx“ sistemos siunčiamos su USB kabeliu priedų maišelyje. Norėdami prijungti veikiantį
kompiuterį, kuriame veikia „CFX Maestro Dx SE“, prie „CFX Opus Dx“ sistemos, naudokite USB laidą.

Išimkite pakavimo medžiagas ir išsaugokite ateičiai. Jeigu trūksta dalies arba gavote sugadintą dalį,
kreipkitės į savo vietinį „Bio-Rad“ padalinį.
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Sistemos reikalavimai
3 lent. išvardyti minimalūs ir rekomenduojami sistemos reikalavimai, keliami kompiuteriui, kuriame veikia
„CFX Maestro Dx SE“.

Sistema Mažiausiai Rekomenduojama

Operacinė
sistema

„Microsoft Windows 10“ (tik 64
bitų), 1511 arba naujesnė
versija, su naujausiais saugos
naujinimais.

„Microsoft Windows 10“ (tik 64 bitų), 1511 arba
naujesnė versija, su naujausiais saugos
naujinimais.

Pastaba. „Windows 11“ taip pat palaiko programinę įrangą „CFX Maestro Dx“, „Security Edition“.

Svarbu. Kompiuteriuose, kuriuose veikia „CFX Maestro Dx SE“, saugusis paleidimas turi būti
išjungtas. Kompiuteriai, kuriuose veikia „CFX Maestro Dx SE“, turėtų būti sukonfigūruoti taip, kad jie
nebūtų automatiškai paleisti iš naujo po sistemos ar saugos naujinimo, jei paleistas vykdymas.
Kreipkitės pagalbos į sistemos administratorių.

Prievadai 2 USB 2.0 didelės spartos
prievadai

2 USB 2.0 didelės spartos prievadai

Standžiojo disko
talpa

128 GB 128 GB

Procesoriaus
greitis

2,4 GHz, dviejų branduolių 2,4 GHz, keturių branduolių

RAM 4 GB RAM 8 GB RAM

Ekrano skiriamoji
geba

1024 x 768 tikrų spalvų režimu 1280 x 1024 tikrų spalvų režimu

PDF skaitytuvas „Adobe PDF Reader“ arba „Windows PDF
Reader“ iš vienos iš palaikomų „Microsoft
Office“ paketo programų:

n 2016

n 2019

Lokalizavimas Palaikomos „Microsoft Windows“ 
64 bitų operacinės sistemos
anglų, kinų ir rusų kalbomis

Palaikomos „Microsoft Windows“ 64 bitų
operacinės sistemos anglų, kinų ir rusų
kalbomis

3 lent. Reikalavimai „CFX Maestro Dx SE“ kompiuteriui
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Sistemos reikalavimai

Pastaba. Jei planuojate paleisti „CFX Automation Control“ programinę įrangą tame pačiame
kompiuteryje, kuriame yra „CFX Maestro Dx SE“, nustatykite ekrano skiriamąją gebą iki 1280 x 1024
tikrų spalvų režimu.
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Programinės įrangos „CFX Maestro Dx SE“ diegimas
Svarbu. Prieš įdiegdami ar atnaujindami programinę įrangą, nuo „CFX Maestro Dx SE“ kompiuterio
turite atjungti visus prijungtus prietaisus. Diegiant programinę įrangą prietaiso išjungti nereikia.
Įsitikinkite, kad įrašėte visas analizes ir kad nevyksta jokie eksperimentai.

Pastaba. Prieš pradėdami diegimo procedūrą, patikrinkite, ar išjungta saugaus saugiojo paleidimo
funkcija. Įsitikinkite, kad kompiuteris sukonfigūruotas taip, kad nebūtų automatiškai paleidžiamas iš
naujo po sistemos ar saugos naujinimo, jei paleistas vykdymas. Kreipkitės pagalbos į sistemos
administratorių.

Norėdami įdiegti „CFX Maestro Dx SE“ programinę įrangą

1. Jei reikia, atjunkite nuo kompiuterio visus prijungtus prietaisus.

Raskite ir atjunkite nuo „CFX Maestro Dx SE“ kompiuterio prietaiso USB kabelį. Prie „CFX Opus Dx“
kabelio galas gali likti neatjungtas.

2. Prisijunkite prie „CFX Maestro Dx SE“ kompiuterio administratoriaus teisėmis.

3. Į kompiuterio USB prievadą įstatykite „CFX Maestro Dx SE“ programinės įrangos USB atmintinę.

4. Naršyklėje „Windows Explorer“ pasiekite ir atidarykite „CFX Maestro Dx SE“ programinės įrangos
USB diską.

USB atmintinėje yra laidos pastabų ir šie aplankai:

n CFX

n „Drivers“ (tvarkyklės)

n „Firmware“ (aparatinė programinė įranga)

n „Quick Start“ (greitoji paleistis)

Kartu su kitais failais CFX aplanke yra „CFX Maestro Dx SE“ programinės įrangos diegimo
programa (CFXMaestroDxSetup.exe).

5. Atidarykite CFX aplanką ir dukart spustelėkite CFXMaestroDxSetup.exe, kad paleistumėte diegimo
programą.

6. Vadovaukitės ekrane pateikiamais diegimo nurodymais.

Baigus darbą, „„Bio-Rad““ programinės įrangos „CFX Maestro Dx“, „Security Edition“ piktograma
atsiranda kompiuterio darbalaukyje.

Patarimas. „CFX Maestro“ diegimo programa automatiškai įdiegia programinės įrangos „CFX
Maestro Dx“, „Security Edition“ naudotojo vadovą. Norėdami rasti šiuos vadovus, eikite į meniu
„Help“ (pagalba) ir pasirinkite „Open User Guides“ (atidaryti naudotojo vadovus).
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7. Baigus diegti, galite saugiai išimti programinės įrangos USB atmintinę.
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Prijungtų prietaisų aptikimas
Diegiant „CFX Maestro Dx SE“ diegimo programa automatiškai įdiegia prietaisų tvarkykles „CFX Maestro
Dx SE“ kompiuteryje. „CFX Maestro Dx SE“ aptinka prijungtus prietaisus, kai paleidžiate programinę
įrangą.

Kaip aptinkami prijungti prietaisai

1. Jei to dar nepadarėte, prijunkite USB tipo B tipo kabelio kvadratinį (įstatomąjį) galą prie USB tipo B
prievado, esančio prietaiso pagrindo galinėje pusėje.

2. Kitą (jungties) galą prijunkite prie „CFX Maestro Dx SE“ kompiuterio USB prievado.

3. Jei prietaisas dar neveikia, paspauskite maitinimo jungiklį prietaise, kad jį įjungtumėte.

4. Paleiskite „CFX Maestro Dx SE“.

Programinė įranga automatiškai aptinka prijungtą prietaisą ir parodo jo pavadinimą srityje „Detected
Instruments“ (aptikti prietaisai) lange „Home“ (pagrindinis).

Pastaba. Jei prietaisas srityje „Detected Instruments“ (aptikti prietaisai) neparodomas, patikrinkite,
ar tinkamai prijungtas USB kabelis. Jei norite iš naujo įdiegti tvarkykles, „CFX Maestro Dx SE“
pagrindiniame lange pasirinkite „Tools > Reinstall Instrument Drivers“ (įrankiai > iš naujo įdiegti
prietaisų tvarkykles).
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Programinės įrangos failai

Programinės įrangos failai
4 lent. išvardyti „CFX Maestro Dx SE“ failų tipai.

Failo tipas Plėtinys Išsami informacija

Protokolas .prcl Yra protokolo sąrankos išsami informacija, skirta paleisti
PCR (PGR).

Plokštelė .pltd Yra plokštelės sąrankos išsami informacija, skirta paleisti
PCR (PGR).

Duomenys .pcrd Yra eksperimento paleidimo ir PCR (PGR) analizės
rezultatai.

„PrimePCR“ (PGR
pradmenys) paleidimas

.csv Yra protokolas ir plokštelių schema „PrimePCR“ (PGR
pradmenys) plokštelėms.

Geno tyrimas .mgxd Yra kelių PCR (PGR) paleidimų ir geno ekspresijos analizių
rezultatai.

Autonominis pradinių
duomenų failas

.zpcr Yra fluorescenciniai nuskaitymai iš autonominių operacijų,
kurie konvertuoti į duomenų failą.

LIMS .plrn Yra plokštelės sąrankos ir protokolo informacija, kurios
reikia norint atlikti su LIMS suderinamą vykdymą.

JSON .json Tik skaitomas failas, kurį sugeneruoja tik „CFX Opus Dx“ 
sistemos, šiame faile yra vykdymo failo duomenys, kurie
rodomi išsamios informacijos failų naršyklės srityje, kai
pasirenkamas vykdymo failas. Šis failas sukuriamas baigus
vykdymą. Jis eksportuojamas su .zpcr failu ir įrašomas
kartu su duomenų failais, kai „Save Location“ (įrašymo
vieta) yra USB diskas arba bendrasis tinklo aplankas.

4 lent. „CFX Maestro Dx SE“ failų tipai
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3 skyrius. Programinės įrangos „CFX Maestro Dx“,
„Security Edition“ naudotojo paskyrų valdymas

Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudotojai prisijungia naudodami savo
„Windows“ naudotojo vardą ir slaptažodį. Asmeniui, kuris įdiegė „CFX Maestro Dx SE“, automatiškai
priskiriamas administratoriaus vaidmuo ir jis gali kurti bei valdyti naudotojų paskyras ir vaidmenis. Visiems
kitiems naudotojams, norint prisijungti ir naudoti programinę įrangą, reikia priskirti naudotojo paskyrą.

Svarbu. Kiekvienas naudotojas privalo turėti „Windows“ paskyrą ir slaptažodį „CFX Maestro Dx SE“
kompiuteryje, kad galėtumėte priskirti naudotojo paskyrą ir vaidmenį. Naudotojai gali būti „Windows“ 
naudotojų grupės arba „Windows“ administratorių grupės nariai. „Windows“ naudotojų grupės nariai
gali pasiekti tik savo „CFX Maestro Dx SE“ failus ir aplankus. „Windows“ administratorių grupės nariai
gali pasiekti visų kompiuterio naudotojų failus ir aplankus.

Šiame skyriuje aiškinama, kaip sukurti „Microsoft Windows“ naudotojus, kad būtų galima įtraukti juos į
„CFX Maestro Dx SE“. Šiame skyriuje taip pat paaiškinta, kaip pridėti „CFX Maestro Dx SE“ naudotojų ir
tvarkyti naudotojų vaidmenis bei teises.
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Programinės įrangos „CFX Maestro Dx“, „Security Edition“
paleidimas

Pastaba. Kiekvienas naudotojas prisijungia naudodamas savo „Windows“ naudotojo vardą ir
slaptažodį.

Norėdami paleisti „CFX Maestro Dx SE“

1. „CFX Maestro Dx SE“ kompiuterio darbalaukyje dukart spustelėkite „CFX Maestro Dx SE“ nuorodos
piktogramą, kad paleistumėte programą.

2. Dialogo lange „Login“ (prisijungimas) įveskite „Windows“ slaptažodį ir spustelėkite OK (gerai).

„CFX Maestro Dx SE“ atsidaro pagrindinis langas. Pavadinimo juostoje rodomas prisijungusio
naudotojo „Windows“ naudotojo vardas, o meniu juostoje – mėlynas lipdukas, nurodantis, kad
programinė įranga atitinka 21 CFR 11 dalį, pavyzdžiui:
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Programinės įrangos „CFX Maestro Dx“, „Security Edition“ paleidimas
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„Microsoft Windows“ naudotojų įtraukimas į programinės
įrangos „CFX Maestro Dx“, „Security Edition“ kompiuterį

Visi naudotojai turi prisijungti prie „CFX Maestro Dx SE“ kompiuterio su savo „Windows“ naudotojo vardu
ir slaptažodžiu. Siekiant tiksliai stebėti auditą, „Windows“ naudotojų paskyrų negalima pridėti per dialogo
langą „Start > Settings > Accounts“ (pradžia > nuostatos > paskyros). „Windows“ naudotojų paskyras
reikia pridėti per kompiuterio valdymo pultą.

Svarbu. Pakeitimai, atlikti „Windows“ naudotojo ypatybėse (įskaitant naudotojo vardą ir pavardę)
sukūrus susietą „CFX Maestro Dx SE“ naudotoją, padaro „CFX Maestro Dx SE“ naudotoją
negaliojantį. Prieš įrašydami „Windows“ naudotoją ir kurdami susietą „CFX Maestro Dx SE“
naudotoją, įsitikinkite, kad informacija yra teisinga.

Patarimas. Prieš kurdami „Windows“ paskyras, peržiūrėkite „Microsoft Windows Administration“ 
dokumentaciją ir susisiekite su savo „Windows“ sistemos administratoriumi, kad gautumėte daugiau
informacijos.

Norėdami įtraukti „Windows“ naudotojų paskyras į „CFX Maestro Dx SE“ kompiuterį

1. Prisijunkite prie „CFX Maestro Dx SE“ kompiuterio kaip „Windows“ administratoriaus grupės narys.

2. Darbalaukyje dešiniuoju pelės mygtuku spustelėkite „My Computer“ (mano kompiuteris) ir pasirinkite
„Manage“ (tvarkyti), kad atidarytumėte kompiuterio valdymo pultą.

3. Kompiuterio valdymo pulte išplėskite „Local Users and Groups“ (vietiniai naudotojai ir grupės).

4. Dešiniuoju pelės mygtuku spustelėkite aplanką „Users“ (naudotojai) ir pasirinkite „New User“ (naujas
naudotojas), kad atidarytumėte dialogo langą „New User“ (naujas naudotojas).

42 | Programinė įranga „CFX Maestro Dx SE“
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5. Dialogo lange „New User“ (naujas naudotojas) užpildykite šiuos laukus:

n „User name“ (naudotojo vardas)

n „Full name“ (vardas ir pavardė)

n „Password“ (slaptažodis)

n „Confirm password“ (patvirtinti slaptažodį)

6. Spustelėkite „Create“ (kurti).
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Programinės įrangos „CFX Maestro Dx“, „Security Edition“
naudotojų pridėjimas ir šalinimas

Patarimas. Tik naudotojai, kuriems priskirtas „CFX Maestro Dx SE“ administratoriaus vaidmuo, gali
sukurti ir pašalinti „CFX Maestro Dx SE“ naudotojo paskyras. Asmeniui, kuris įdiegė „CFX Maestro
Dx SE“, automatiškai priskiriamas administratoriaus vaidmuo. Šis asmuo gali priskirti
administratoriaus vaidmenį kitiems naudotojams.

Pastaba. „CFX Maestro Dx SE“ bent vienam naudotojui turi būti priskirtas administratoriaus
vaidmuo.

Kaip pridėti naudotojo paskyras „CFX Maestro Dx SE“

1. Patikrinkite, ar kiekvienas numatytas naudotojas yra „Windows“ naudotojų grupės arba „Windows“ 
administratorių grupės narys ir turi „Windows“ slaptažodį „CFX Maestro Dx SE“ kompiuteryje.

2. Paleiskite „CFX Maestro Dx SE“ ir prisijunkite kaip administratorius.

3. Lange „Home“ (pagrindinis) pasirinkite „User > User Administration“ (naudotojas > naudotojų
administravimas).

Pasirodo dialogo langas „User Administration“ (naudotojų administravimas).
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Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudotojo vaidmenų valdymas

4. Skiltyje „Manage Users“ (tvarkyti naudotojus) pateikite šią informaciją kiekvienam naudotojui:

n User name (naudotojo vardas) – „CFX Maestro Dx SE“ tai turi būti naudotojo prisijungimo prie
„Windows“ naudotojo vardas.

n Full name (vardas ir pavardė) – naudotojo vardas ir pavardė.

Šis vardas rodomas audito sekos lauke „Full Name“ (vardas ir pavardė). Šis vardas turi sutapti
su lauke „Full Name“ (vardas ir pavardė) įvestu vardu, kuriant „Windows“ naudotoją.

n Role (vaidmuo) – naudotojui priskiriamas vaidmuo.

Pastaba. Išskleidžiamajame sąraše galite pasirinkti tik vieną vaidmenį. Daugiau
informacijos žr. Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudotojo
vaidmenų valdymas.

n Domain (domenas) – „Windows“ domenas, iš kurio naudotojas pasiekia programinę įrangą.

Daugiau informacijos žr. „Windows“ sistemos administratorių.

5. Spustelėkite OK (gerai), tada spustelėkite „Yes“ (taip), kad įrašytumėte pakeitimus ir uždarytumėte
dialogo langą „User Administration“ (naudotojo administravimas).

Norėdami pašalinti „CFX Maestro Dx SE“ naudotojo paskyrą

1. Paleiskite „CFX Maestro Dx SE“ ir prisijunkite kaip administratorius.

2. Pagrindiniame lange pasirinkite „User > User Administration“ (naudotojas > naudotojo
administravimas), kad atidarytumėte dialogo langą „User Administration“ (naudotojo
administravimas).

3. Srityje „Manage Users“ (valdyti naudotojus) pasirinkite „Remove“ (šalinti) prie kiekvieno naudotojo,
kurį norite pašalinti.

4. Spustelėkite OK (gerai), tada spustelėkite „Yes“ (taip), kad įrašytumėte pakeitimus ir uždarytumėte
dialogo langą „User Administration“ (naudotojo administravimas).

Programinės įrangos „CFX Maestro Dx“, „Security Edition“
naudotojo vaidmenų valdymas

Svarbu. „CFX Maestro Dx SE“ reikalauja, kad bent vienam naudotojui būtų priskirtas
administratoriaus vaidmuo. Šį vaidmenį galite priskirti daugiau nei vienam naudotojui.

„CFX Maestro Dx SE“ yra keturi naudotojo vaidmenys. Norint pasiekti programinę įrangą, kiekvienam
naudotojui turi būti priskirtas vaidmuo. Nors naudotojams gali būti priskirtas tik vienas vaidmuo, bet kada
galite pakeisti naudotojo vaidmenį.
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Išskyrus administratoriaus vaidmenį, galite pakeisti kiekvienam vaidmeniui priskirtas teises. Visi
vaidmeniui priskirti naudotojai paveldi tik to vaidmens teises.

Pagal numatytąsias nuostatas kiekvieno vaidmens teisės yra šios:

n Administratorius – šis vaidmuo turi visas teises, jų negalite keisti.

n Pagrindinis – šis vaidmuo turi visas teises, išskyrus el. pašto nustatymo.

n Operatorius – šis vaidmuo turi visas teises, išskyrus ciklų praleidimo ir el. pašto nustatymo.

n Svečias – šis vaidmuo gali tik skaityti failus.

Skirdami vaidmenis „CFX Maestro Dx SE“, atidžiai nustatykite reikalavimus kiekvienam naudotojui.
Pavyzdžiui, neturėdami teisės įrašyti naudotojai, kuriems priskirtas vaidmuo „Svečias“, negalės pasirašyti
failo. Neturėdami teisės sukurti el. pašto paskyros, nė vienas iš vaidmenų negaus el. laiško, kai bus baigta
vykdyti.

Norėdami pakeisti vaidmens teises

1. Paleiskite „CFX Maestro Dx SE“ ir prisijunkite kaip administratorius.

2. Pagrindiniame lange pasirinkite „User > User Administration“ (naudotojas > naudotojo
administravimas), kad atidarytumėte dialogo langą „User Administration“ (naudotojo
administravimas).

3. Skyriuje „Manage Rights“ (tvarkyti teises) prie kiekvieno vaidmens atitinkamai išvalykite arba
pažymėkite konkrečių teisių žymimąjį laukelį.

4. Spustelėkite OK (gerai), tada spustelėkite „Yes“ (taip), kad įrašytumėte pakeitimus ir uždarytumėte
dialogo langą „User Administration“ (naudotojo administravimas).

Savo vaidmens ir leidimų peržiūra
Patarimas. Naudotojai, kuriems priskirti „Principal“ (pagrindinis), „Operator“ (operatorius) arba
„Guest“ (svečias) naudotojo vaidmenys, gali peržiūrėti tik savo naudotojo nuostatas, teises ir
vaidmenis. Naudotojai, kuriems priskirtas administratoriaus vaidmuo, gali peržiūrėti visų naudotojų
leidimus ir vaidmenis.

Norėdami peržiūrėti esamo naudotojo vaidmenį ir leidimus

u Lange „Home“ (pagrindinis) pasirinkite „User > User Administration“ (naudotojas > naudotojų
administravimas).

Kreipkitės į savo „CFX Maestro Dx SE“ administratorių ir pakeiskite naudotojo nuostatas, teises ir
vaidmenis, išvardytus lange „User Administration“ (naudotojų administravimas).
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4 skyrius. Programinės įrangos „CFX Maestro Dx“,
„Security Edition“ naudojimas

Svarbu. Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudoja „Microsoft Windows“ 
naudotojo autentifikavimą prieigai prie saugių CFX duomenų failų patikrinti. Susisiekite su „Windows“ 
administratoriumi, kad sukurtumėte aplinką, atitinkančią 21 CFR 11 dalies reikalavimus.

Naudodami „CFX Maestro Dx SE“ naudotojai gali

n Pasirašyti duomenų ir genų tyrimo failus.

n Apsaugoti slaptažodžiu duomenų failus.

n Peržiūrėti ir išspausdinti audito sekas.

Šiame skyriuje išsamiai paaiškintos šios funkcijos.

Saugūs failai
Pagal numatytąsias nuostatas „CFX Maestro Dx SE“ įrašo saugius failus prisijungusio naudotojo
asmeniniame aplanke, esančiame

C:\Users\<username>\Documents\Bio-Rad\CFX_MDX\My qPCR

Šiame aplanke galite išsaugoti ir redaguoti .pcrd failus. Šiame aplanke yra nuorodų į kitus aplankus (pvz.,
mėginių failų aplanką), kuriuose yra tik skaityti skirtų failų. Tačiau administratorius gali ištrinti to aplanko
turinį.

Patarimas. Arba jūsų „Windows“ sistemos administratorius gali sukurti bendrą aplanką ir jūsų
„CFX Maestro Dx SE“ administratorius gali užprogramuoti programinę įrangą įrašyti visus failus tame
aplanke.

„CFX Maestro Dx SE“ plokštelės, protokolo, duomenų ir genų tyrimo failai įrašymo metu pažymimi kaip
saugūs. Šiuos failus galite sukurti naudodami „CFX Maestro“ programinę įrangą arba „CFX Maestro Dx
SE“. Po to, kai jie bus įrašyti „CFX Maestro Dx SE“, šiuos failus galite atidaryti tik „CFX Maestro Dx SE“.

„CFX Maestro Dx SE“ sukuria visų saugių duomenų ir genų tyrimo failų (atitinkamai .pcrd ir .mgxd failų)
audito seką. Programinė įranga įrašo visą audituojamą veiklą į failo audito seką. Daugiau informacijos žr.
Audito sekos, p. 309
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Saugių failų pasirašymas

Įrašę failą „CFX Maestro Dx SE“, naudotojai gali pridėti elektroninį parašą. Norint pasirašyti failą,
naudotojo vaidmuo privalo turėti failo įrašymo teisę. Pavyzdžiui, pagal numatytąsias nuostatas svečio
vaidmeniui nesuteikiama failo įrašymo teisė, todėl naudotojai, kuriems priskirtas šis vaidmuo, negali
pasirašyti failo.

„CFX Maestro Dx SE“ pasirašyti failai nenustatyti tik skaityti. Juos galima peržiūrėti, modifikuoti ir
pasirašyti kelis kartus. Visi pakeitimai ir parašai stebimi failo audito sekoje. Galite pasirašyti šių tipų failus:

n Duomenų failai (.pcrd)

n Genų tyrimo failai (.mgxd)

Pastaba. Failai turi būti įrašyti, kad juos būtų galima pasirašyti. Jei neseniai „CFX Maestro Dx SE“
atlikote paleidimą, pirmiausia įrašykite gautą duomenų failą.

Norėdami pasirašyti failą

1. Prisijunkite prie „CFX Maestro Dx SE“ naudodami „Windows“ prisijungimo kredencialus.

2. Norėdami pasirašyti, atidarykite saugų duomenų failą arba genų tyrimo failą.

3. Pasirinkite „File > Sign“ (failas > pasirašyti). Pasirodys dialogo langas „Electronic Signature“ 
(elektroninis parašas).
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4. Įveskite „Windows“ naudotojo vardą ir slaptažodį bei failo pasirašymo priežastį.

Naudotojo vardas ir pasirašymo priežastis yra įtraukiami į audito seką (daugiau informacijos žr.
Audito sekos, p. 309).

5. Spustelėkite OK (gerai), kad pateiktumėte parašą ir uždarytumėte dialogo langą.

Saugių failų modifikavimas

„CFX Maestro Dx SE“ naudotojai gali modifikuoti saugius failus, įskaitant pasirašytus ir nepasirašytus
duomenų ir genų tyrimo failus. Programinė įranga ragina jus nurodyti keitimo priežastį, kai įrašote
modifikuotą saugių duomenų ar genų tyrimo failą. Pakeitimai stebimi failo audito sekoje.

Patarimas. Kadangi programinė įranga nesukuria plokštelių ar protokolų failų audito sekų, įrašant šių
failų pakeitimus nesate raginami nurodyti priežastį.

Norėdami įrašyti modifikuotą duomenų ar genų tyrimo failą

1. Prisijunkite prie „CFX Maestro Dx SE“ naudodami „Windows“ prisijungimo kredencialus.

2. Atidarykite ir modifikuokite saugų duomenų failą arba genų tyrimo failą.

Patarimas. Jei norite peržiūrėti audituojamų veiklų sąrašą, žr. Audituojami įvykiai, p. 311

3. Pasirinkite „File > Save“ (failas > įrašyti). Pasirodys dialogo langas„Audit Trail Change Reason“ 
(audito sekos keitimo priežastis).
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Šiame dialogo lange pateikiama ši informacija, kuri užfiksuota kiekvieno modifikavimo įvykio failo
audito sekos antraštėje:

n Date (data) – keitimo data.

n User (naudotojas) – prisijungusio naudotojo „Windows“ domenas ir naudotojo vardas.

n Comment (komentaras) – paskutinis įrašytas komentaras.

n Signature (parašas) – paskutinio failą pasirašiusio asmens elektroninis parašas.

n Signature reason (parašo priežastis) – parašo priežastis.

n Application (programa) „CFX Maestro Dx SE“ (rodoma kaip „BioRadCFXManager.exe“ 
(teisinga).

n Application version (programos versija) – dabartinė„CFX Maestro Dx SE“ versija.

n Full user (naudotojo vardas ir pavardė) – prisijungusio naudotojo vardas ir pavardė.

Pastaba. šis vardas rodomas audito sekoje.

n Machine (įrenginys) – kompiuteris, kuriame įdiegta.
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Pakeitimų lentelėje pateikiami audituojami pakeitimai, įvykę modifikuojant. Taip pat gali būti pateiktas
trumpas pakeitimo priežasties aprašas.

Patarimas. Stulpelyje „Reason for Change“ (pakeitimo priežastis) galite pridėti ar redaguoti
aprašus.

4. Peržiūrėkite pakeitimų sąrašą. Jei reikia, pateikite išsamias priežastis.

5. Atlikite vieną iš toliau nurodytų veiksmų:

n Spustelėkite „Save Changes“ (įrašyti pakeitimus), kad įrašytumėte failo pakeitimus, taip pat
visus pakeitimus, kuriuos atlikote lentelėje, ir uždarytumėte dialogo langą.

Failo pakeitimai ir keitimų priežastys pateikiamos failo audito sekoje.

n Spustelėkite „Cancel Changes“ (atšaukti pakeitimus), jei norite grąžinti failo ankstesnę būseną ir
uždaryti dialogo langą.

Pakeitimai faile neįrašomi ir audito seka neatnaujinama.
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Failų apsaugojimas slaptažodžiu

Kaip papildomą saugumo lygį, „CFX Maestro Dx SE“ leidžia naudotojams nustatyti slaptažodžius visuose
saugiuose failuose. Nustatydami slaptažodžius saugiame faile, atsižvelkite į šias sąlygas:

Sąlyga Veiksmas

Slaptažodžio nereikia. Visi naudotojai gali atidaryti, modifikuoti ir įrašyti saugų
failą, atsižvelgdami į turimus leidimus.

Failui reikia įrašymo
slaptažodžio.

Visi naudotojai gali atidaryti saugų failą, o naudotojai,
kurie žino įrašymo slaptažodį, gali pakeisti ir įrašyti
saugų failą.

Failui reikia atidarymo
slaptažodžio.

Tik tie naudotojai, kurie žino atidarymo slaptažodį, gali
atidaryti, modifikuoti ir įrašyti saugų failą.

Failui reikalingi tiek atidarymo,
tiek įrašymo slaptažodžiai.

Kai kurie naudotojai gali atidaryti saugų failą, o šių
naudotojų pogrupis gali modifikuoti ir įrašyti failą.

Atsižvelgiant į naudotojo vaidmenį, bet kuris naudotojas gali „Save As“ (įrašyti kaip), kad sukurtų naują
saugų failą kitu vardu arba įrašytų failą tuo pačiu vardu kitoje vietoje, jei yra teisinga viena iš šių sąlygų:

n Saugus failas neapsaugotas slaptažodžiu.

n Naudotojas turi slaptažodį failui atidaryti.

Patarimas. Naujas failas įrašomas neapsaugotas slaptažodžiu. Pradiniame faile slaptažodžiai
išlieka.

Atsižvelgiant į vaidmenį, naudotojas gali modifikuoti ir įrašyti pradinį failą, jei įvykdoma viena iš šių sąlygų:

n Failas neapsaugotas slaptažodžiu.

n Naudotojas turi failo atidarymo ir įrašymo slaptažodžius.

Pastaba. Naudotojo vaidmuo turi apimti failų įrašymo teisę, kad būtų galima nustatyti slaptažodžius.
Pavyzdžiui, naudotojai, kurių vaidmuo „Guest“ (svečias), negali įrašyti failų, todėl negali nustatyti
slaptažodžių faile.

Svarbu. Tik „CFX Maestro Dx SE“ administratoriai gali iš naujo nustatyti arba pašalinti slaptažodžius.
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Norėdami apsaugoti failą slaptažodžiu

1. Prisijunkite prie „CFX Maestro Dx SE“ naudodami „Windows“ kredencialus.

2. Atidarykite saugų failą.

3. Pasirinkite „File > File Passwords“ (failas > failų slaptažodžiai). Pasirodys dialogo langas „File
Passwords“ (failo slaptažodžiai).

4. Laukuose „Save Password“ (įrašymo slaptažodis) ir „Open Password“ (atidarymo slaptažodis) ir
įveskite slaptažodžius.

Patarimas. Pagal numatytąsias nuostatas įvedami slaptažodžiai rodomi kaip žvaigždutės
simboliai. Pasirinkite „Show Password“ (rodyti slaptažodį), kad slaptažodis būtų rodomas jį
įvedant.

Svarbu. Slaptažodžiuose skiriamos didžiosios ir mažosios raidės. „CFX Maestro Dx SE“
nenustato slaptažodžių apribojimų. Norėdami sužinoti apie geriausią reikalavimų
slaptažodžiams jūsų vietoje praktiką, kreipkitės į sistemos administratorių.

5. Norėdami nustatyti slaptažodžius ir uždaryti dialogo langą, spustelėkite „Set Passwords“ (nustatyti
slaptažodžius).

6. Pasirinkite „File > Save“ (failas > įrašyti), kad įrašytumėte failo pakeitimus.
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Norėdami pašalinti slaptažodžius

Svarbu. Norėdami pašalinti slaptažodžius, turite būti „CFX Maestro Dx SE“ administratorius.

1. Dialogo lange „Password Required“ (būtinas slaptažodis) spustelėkite „Remove Passwords“ 
(pašalinti slaptažodžius).

Parodomas „CFX Maestro Dx SE“ prisijungimo dialogo langas.

2. Pateikite „Windows“ naudotojo vardą ir slaptažodį „CFX Maestro Dx SE“ administratoriui, tada
spustelėkite OK (gerai).

Pasirodo pradinis duomenų failas.

Svarbu. Norėdami pašalinti slaptažodžius, turite įrašyti failą.

3. Pasirinkite „File > Save“ (failas > įrašyti), kad įrašytumėte failo pakeitimus.
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Norėdami pakeisti slaptažodžius

Svarbu. Tik „CFX Maestro Dx SE“ administratoriai gali pakeisti slaptažodžius.

1. Atidarykite saugų failą.

2. Pasirinkite „File > File Passwords“ (failas > failų slaptažodžiai). Pasirodys dialogo langas „File
Passwords“ (failo slaptažodžiai).

Patarimas. Funkcijos „Save Password“ (įrašymo slaptažodis), „Open Password“ (atidarymo
slaptažodis) ir „Show Password“ (rodyti slaptažodį) yra išjungtos.

3. Spustelėkite „Reset Passwords“ (nustatyti slaptažodžius iš naujo).

Parodomas „CFX Maestro Dx SE“ prisijungimo dialogo langas.
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4. Pateikite „Windows“ naudotojo vardą ir slaptažodį „CFX Maestro Dx SE“ administratoriui, tada
spustelėkite OK (gerai).

Pasirodys dialogo langas „File Passwords“ (failo slaptažodžiai).

5. Atlikite vieną iš toliau nurodytų veiksmų:

n Norėdami atkurti slaptažodžio apsaugą, atitinkamame slaptažodžio laukelyje įveskite naują
slaptažodį.

n Norėdami pašalinti slaptažodžio apsaugą, išvalykite slaptažodžio langelius.

6. Norėdami įrašyti slaptažodį ir uždaryti dialogo langą, spustelėkite „Set Passwords“ (nustatyti
slaptažodžius).
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5 skyrius. Darbo erdvė
Programinės įrangos „CFX Maestro Dx“, „Security Edition“ suteikia sąsają plokštelėms nuskaityti, PGR
protokolams rengti, jiems vykdyti „CFX Opus Dx“ „Deepwell Dx“ prietaisais ir PGR analizių duomenims
vertinti.

„CFX Maestro Dx SE“ yra penkios pagrindinės darbo erdvės:

n Langas „Home“ (pagrindinis)

n Sąrankos vedlys

n Langas „Protocol Editor“ (protokolų redaktorius)

n Langas „Plate Editor“ (plokštelės redaktorius)

n Langas „Data Analysis“ (duomenų analizė)

Šiame skyriuje parodyta ir trumpai aprašyta kiekviena darbo erdvė.
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Pagrindinis langas
„CFX Maestro Dx SE“ atidaro langą „Home“ (pagrindinis) ir parodo „Startup Wizard“ (paleisties vedlys),
kuriame galite nustatyti eksperimentą, atlikti arba pakartoti paleidimą ar išanalizuoti esamą paleidimą.
Lange „Home“ (pagrindinis) taip pat galite peržiūrėti programos ir prietaisų žurnalą, sukurti ir valdyti
naudotojus bei pasiekti daug naudingų įrankių. Daugiau informacijos žr. 6 skyrius, Pagrindinis langas.
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Sąrankos vedlys

Sąrankos vedlys
Lange „Startup Wizard“ (sąrankos vedlys) galite greitai parengti ir paleisti naudotojo nustatytus
eksperimentus arba pasirinkti ir paleisti „PrimePCR“ (PGR pradmenys) eksperimentą. Šiame vedlyje taip
pat galite pakartoti paleidimą arba analizuoti paleidimo duomenis.
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Protokolų redaktoriaus langas
Lange „Protocol Editor“ (protokolų redaktorius) galite kurti, atidaryti, peržiūrėti ir redaguoti protokolą. Taip
pat galite keisti atvirojo protokolo dangtelio temperatūrą. Lango „Protocol Editor“ (protokolų redaktorius)
funkcijos išsamiai aprašytos 7 skyrius, Protokolų kūrimas.
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Plokštelės redaktoriaus langas

Plokštelės redaktoriaus langas
Lange „Plate Editor“ (plokštelės redaktorius) galite kurti, atidaryti, peržiūrėti ir redaguoti plokštelę. Lango
„Plate Editor“ (plokštelės redaktorius) funkcijos išsamiai aprašytos 8 skyrius, Plokštelių paruošimas.
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Duomenų analizės langas
Lange „Data Analysis“ (duomenų analizė) galite peržiūrėti ir palyginti paleidimų duomenis, atlikti statistinę
analizę, eksportuoti duomenis ir kurti publikuoti parengtas ataskaitas. Funkcija „Data Analysis“ (duomenų
analizė) išsamiai aprašyta 10 skyrius, Duomenų analizės apžvalga ir 11 skyrius, Išsami duomenų
analizės informacija.
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6 skyrius. Pagrindinis langas
Programinės įrangos „CFX Maestro Dx“, „Security Edition“ suteikia sąsają PGR protokolams kurti, vykdyti
juos naudojant „CFX Dx“ sistemas ir analizuoti PGR eigos duomenis.

Šiame skyriuje supažindinama su „CFX Maestro Dx SE“ ir paaiškinamos funkcijos, kurias galima pasiekti
iš lango „Home“ (pagrindinis).
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Langas „Home“ (pagrindinis)
„CFX Maestro Dx SE“ atidaro langą „Home“ (pagrindinis) ir parodo „Startup Wizard“ (paleisties vedlys),
kuriame galite nustatyti paleidimą, atlikti arba pakartoti paleidimą ar išanalizuoti esamą paleidimą. Lange
„Home“ (pagrindinis) taip pat galite peržiūrėti programos ir prietaisų žurnalą, sukurti ir valdyti naudotojus
bei pasiekti daug naudingų įrankių.

1. Programinės įrangos antraštės juostoje rodomas programinės įrangos pavadinimas ir
prisijungęs naudotojas.

2. Meniu juosta suteikia greitą prieigą prie „File“ (failas), „View“ (rodinys), „Users“ (naudotojai),
„Run“ (paleidimas), „Tools“ (įrankiai), „Window“ (langas) ir „Help“ (žinynas) meniu komandų.

3. Įrankių juostos komandos suteikia sparčią prieigą prie meniu parinkčių.

4. Kairėje srityje rodomi prietaisai, prijungti prie „CFX Maestro Dx SE“ kompiuterio ir pateikti
mygtukai, kuriais galite valdyti dangtelį ir peržiūrėti prietaisų būsenas.

LEGENDA
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Langas „Home“ (pagrindinis)

5. Pagrindinėje srityje rodomas darbinis langas. Numatytasis darbinis langas ekrane „Home“ 
(pagrindinis) yra „Startup Wizard“ (paleisties vedlys).

6. Būsenos juostoje rodomi prijungtų prietaisų pavadinimai ir prisijungęs naudotojas.

Meniu „File“ (failas) komandos
„New“ (naujas) – atidaromas dialogo langas, kuriame galite: pasirinkti sukurti naują protokolą, plokštelę ar
geno tyrimą.

„Open“ (atidaryti) – atidaromas dialogo langas, kuriame galite pasirinkti naršyti ir atidaryti esamą
protokolą, plokštelę, duomenų failą, geno tyrimą, LIMS failą, paleidžiamus iš individualaus prietaiso
(individualus paleidimas), arba „PrimePCR“ (PGR pradmenys) paleidimo failą.

„Recent Data Files“ (naujausi duomenų failai) – rodomas šiuo metu atidarytų PGR failų sąrašas.

„Repeat a Run“ (pakartoti paleidimą) – įrašytų PGR failų vietoje atidaromas „Windows Explorer“, kur
galite rasti kartojamą paleidimą.

„Exit“ (išeiti) – uždaroma „CFX Maestro Dx SE“.

Meniu „View“ (rodymas) komandos
„Application Log“ (programos žurnalas) – rodomi programinės įrangos naudojimo duomenys nuo
įdiegimo iki einamosios dienos.

„Run Reports“ (paleidimo ataskaitos) – rodomas paleidimo ataskaitų sąrašas.

„Startup Wizard“ (paleisties vedlys) – pagrindinėje srityje rodomas „Startup Wizard“ (paleisties
vedlys).

„Run Setup“ (paleidimo sąranka) – pagrindinėje srityje rodomas langas „Run Setup“ (paleidimo
sąranka).

„Instrument Summary“ (prietaiso santrauka) – pagrindinėje srityje rodomas langas „Instrument
Summary“ (prietaiso santrauka).

„Detected Instruments“ (aptikti prietaisai) – perjungiamas prijungtų prietaisų rodymas ir nerodymas
kairiojoje srityje. Pagal numatytąsias nuostatas programinė įranga rodo prijungtus prietaisus kairiojoje
srityje.

„Toolbar“ (įrankių juosta) – perjungiamas įrankių juostos rodymas ir nerodymas ekrano viršuje. Pagal
numatytąsias nuostatas programinė įranga rodo įrankių juostą.

„Status Bar“ (būsenos juosta) – perjungiamas būsenos juostos rodymas ir nerodymas ekrano viršuje.
Pagal numatytąsias nuostatas programinė įranga rodo būsenos juostą.
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„Show“ (rodyti) – atidaromas dialogo langas, iš kurio galite:

n peržiūrėti arba blokuoti žurnalą „Status“ (būsena);

n atidaryti ir peržiūrėti „CFX Maestro Dx SE“ duomenų aplanką;

n atidaryti ir peržiūrėti naudotojo duomenų aplanką;

n atidaryti ir peržiūrėti LIMS failų aplanką;

n atidaryti ir peržiūrėti „PrimePCR“ (PGR pradmenys) aplanką;

n peržiūrėti paleidimų istoriją;

n Peržiūrėti visų prijungtų prietaisų ypatybes.

Meniu „User“ (naudotojas) komandos
„Select User“ (pasirinkti naudotoją) – atidaromas ekranas „Login“ (prisijungimas), kuriame iš
išplečiamojo sąrašo „User Name“ (naudotojo vardas) galite pasirinkti naudotoją ir prisijungti prie
programos.

„Change Password“ (keisti slaptažodį)– atidaromas dialogo langas „Change Password“ (keisti
slaptažodį), kuriame naudotojai gali keisti savo slaptažodį.

Pastaba. Ši parinktis „CFX Maestro Dx SE“ išjungta. Naudotojai, norėdami pakeisti savo
„CFX Maestro Dx SE“ slaptažodį, turi pakeisti savo „Windows“ slaptažodį.

„User Preferences“ (naudotojo nuostatos) – atidaromas dialogo langas „User Preferences“ 
(naudotojo nuostatos), kuriame naudotojai gali keisti tokias numatytąsias nuostatas:

n Pranešimo el. paštu siuntimas ir gavimas pasibaigus analizės ciklui

n Duomenų failo įrašymas

n Protokolų kūrimas lange „Protocol Editor“ (protokolų redaktorius) arba naudojantis „Protocol
AutoWriter“ (protokolų automatinio kūrimo priemonė)

n Plokštelių kūrimas

n Duomenų analizavimas

n Geno ekspresijos analizės vykdymas

n Duomenų kokybės nustatymas

n CFX prietaisų duomenų eksportavimas

„User Administrationׅ‏“ (naudotojų administravimas) – atidaromas dialogo langas „User
Administration“ (naudotojų administravimas), kuriame administratoriai gali kurti naudotojus, keisti
vaidmens teises ir priskirti naudotojams vaidmenis.
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„Bio-Rad“ Service Login“ („Bio-Rad“ techninės priežiūros personalo prisijungimas) – skirta tik
„Bio-Rad“ techninės priežiūros personalui. Nesirinkite šios komandos.

Meniu „Run“ (paleidimas) komandos
„User-defined Run“ (naudotojo nustatytas paleidimas) – atidaromas langas „Run Setup“ (paleidimo
sąranka), kuriame galite nustatyti naudotojo nustatytą protokolą ir plokštelę ir tada pasirinktame prietaise
paleisti PGR eksperimentą.

„PrimePCR Run“ (PGR pradmenų paleidimas) – atidaroma kortelė „Start Run“ (paleidimo pradžia),
esančią lange „Run Setup“ (paleidimo sąranka), su numatytaisiais įkeltais „PrimePCR“ (PGR pradmenys)
protokolu ir plokštelės schema, remiantis pasirinktu prietaisu.

„End-Point Only Run“ (tik galinio taško paleidimas) – atidaroma kortelė „Start Run“ (paleidimo
pradžia), esančią lange „Run Setup“ (paleidimo sąranka), su numatytuoju pabaigos taško protokolu ir
plokštelės schema, remiantis pasirinktu prietaisu.

„Qualification Run“ (kvalifikacinis paleidimas) – atidaroma kortelė „Start Run“ (paleidimo pradžia),
esančią lange „Run Setup“ (paleidimo sąranka), su numatytuoju „Bio-Rad“ kvalifikaciniu protokolu ir
plokštelės schema, įkelta pasirinktam prietaisui.

Meniu „Tools“ (įrankiai) komandos
„Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas) – atidaro „Master Mix Calculator“ 
(pagrindinio mišinio skaičiuotuvas), kuriame galite sukurti reakcijos mišinį ir atspausdinti skaičiavimus.

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) – atidaro dialogo langą „Protocol
AutoWriter“ (protokolų automatinio kūrimo priemonė), kur galite lengvai sukurti naują protokolą.

„Ta Calculator“ (Ta skaičiuotuvas) – atidaro „Ta Calculator“ (Ta skaičiuotuvas), kur galite lengvai
apskaičiuoti pradmenų atkaitinimo temperatūrą.

„Dye Calibration Wizard“ (dažų kalibravimo vedlys) – atidaro „Dye Calibration“ (dažų kalibravimas)
vedlį, kuriuo galite sukalibruoti prietaisą naujam fluoroforui.

„Reinstall Instrument Drivers“ (iš naujo įdiegti prietaiso tvarkykles) – iš naujo įdiegia tvarkykles,
kurios valdo ryšį su „Bio-Rad“ realiojo laiko PGR sistemomis.

„Zip Data and Log Files“ (suarchyvuoti duomenys ir žurnalo failai) – atidaro dialogo langą, kuriame
galite pasirinkti failus, suglaudinti ir įrašyti suglaudintą failą saugoti ar išsiųsti el. paštu.

„Batch Analysis“ (paketo analizė) – atidaro dialogo langą „Batch Analysis“ (paketo analizė), kuriame
galite nustatyti parametrus kelių duomenų failų analizei vienu metu.

„Options“ (parinktys) – atidaromas dialogo langas, kuriame galite

n Konfigūruoti savo el. pašto serverio nuostatas;
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n Konfigūruoti eksporto LIMS, „Seegene“ ir kitų duomenų failų nuostatas.

Patarimas. Taip pat galite pasirinkti parinktį automatiškai paleisti „Seegene Viewer“ 
eksportuojant, jei nuspręsite eksportuoti duomenis „Seegene“ formatu.

n Pakeiskite naudotojo sąsajos kalbą (anglų, kinų, rusų)

Svarbu. Norėdami, kad būtų rodoma pasirinkta kalba, turite paleisti iš naujo „CFX Maestro
Dx SE“.

Svarbu. Jūsų operacinės sistemos kalba turi atitikti kalbą, kurią norite rodyti „CFX Maestro
Dx SE“ sąsajoje.

Meniu „Help“ (žinynas) komandos
Patarimas. Meniu „Help“ (žinynas) yra visų „CFX Maestro Dx SE“ langų meniu juostose.

„Contents“ (turinys) – rodoma kortelė „Contents“ (turinys) „CFX Maestro Dx SE“ sistemoje „Help“ 
(žinynas).

„Index“ (rodyklė) – rodoma kortelė „Index“ (turinys) „CFX Maestro Dx SE“ sistemoje „Help“ (žinynas).

„Search“ (paieška) – rodoma kortelė „Search“ (paieška) „CFX Maestro Dx SE“ sistemoje „Help“ 
(žinynas).

„Open User Guide“ (atidaryti naudotojo vadovą) – atidaro šio vadovo PDF.

„Additional Documentation“ (papildoma dokumentacija) – suteikia prieigą prie „CFX Opus Dx“ 
realiojo laiko PGR sistemų naudojimo vadovo.

„Release Notes“ (laidos pastabos) – atidaromas dokumentas „Release Notes“ (laidos pastabos),
skirtas įdiegtai „CFX Maestro Dx SE“ versijai.

„Video Resources“ (vaizdo įrašų ištekliai) – atidaroma žiniatinklio svetainė, kurioje pateikiami
„Bio-Rad“ vaizdo įrašų ištekliai, pvz., mokomieji vaizdo įrašai.

„qPCR Applications and Technologies Web Site“ (svetainė „qPGR programos ir technologijos“)
– atidaroma „Bio-Rad“ qPGR programų ir technologijų žiniatinklio svetainė, kurioje galite daugiau sužinoti
apie realiojo laiko PGR (qPGR).

„PCR Reagents Web Site“ (PGR reagentų svetainė) – atidaroma „Bio-Rad“ PGR ir qPGR reagentų
svetainė, kurioje galite užsisakyti PGR reagentų, supermišinių, dažų ir rinkinių.

„PCR Plastic Consumables Web Site“ (PGR plastikinių reikmenų svetainė) – atidaroma „Bio-Rad“ 
PGR plastikinių medžiagų ir reikmenų svetainė, kurioje galite užsisakyti PGR plokštelių, plokštelių
tarpiklių, mėgintuvėlių ir dangtelių bei kitų plastikinių priedų.
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„Software Web Site“ (programinės įrangos svetainė) – atidaroma „Bio-Rad“ PGR analizės
programinės įrangos svetainė, kurioje galite užsisakyti atnaujintas „Bio-Rad“ „CFX Maestro Dx SE“
versijas.

„About“ (apie) – rodoma informacija apie „CFX Maestro Dx SE“ autoriaus teises ir versiją.

Įrankių juostos komandos

– atidaromas „Windows Explorer“, kuriame galite naršyti ir atidaryti duomenų failą arba geno tyrimo
failą.

– atidaro „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).

– atidaro langą „Run Setup“ (paleidimo sąranka).

– atidaro langą „Run Setup“ (paleidimo sąranka) su numatytuoju „PrimePCR“ (PGR pradmenys)
protokolu ir plokštelės schema, įkelta pagal pasirinktą prietaisą.

– atidaro „Startup Wizard“ (paleisties vedlys).

Naudotojo vadovas | 69



6 skyrius. Pagrindinis langas

Sąrankos vedlys
Kai paleidžiama „CFX Maestro Dx SE“, darbinėje srityje rodomas „Startup Wizard“ (paleisties vedlys). Per
„Startup Wizard“ (paleisties vedlys) galima atlikti šiuos veiksmus:

n Iš aptiktų prietaisų pasirinkti prietaisą ir nustatyti naudotojo apibrėžtą arba „PrimePCR“ (PGR
pradmenys) paleidimą

n Atidaryti ir pakartoti paleidimą

n Atidaryti paleidimo ar geno tyrimo failo rezultatams iš kelių geno ekspresijos paleidimų

Šios užduotys yra išsamiai paaiškintos tolesniuose skyriuose.

Būsenos juosta
Pagrindinio programinės įrangos lango apačioje esančios būsenos juostos kairėje pusėje rodoma esama
aptiktų prietaisų būsena. Kairėje būsenos juostos pusėje rodomas esamo naudotojo vardas ir data bei
laikas.
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Aptiktų prietaisų sritis
Srityje „Detected Instruments“ (aptikti prietaisai) rodomas kiekvienas prie „CFX Maestro Dx SE“ kompiuterio
prijungtas prietaisas. Pagal numatytąsias nuostatas, kiekvienas prietaisas rodomas kaip piktograma, kurios
pavadinimas – prietaiso serijos numeris.

Šioje srityje galite

n Peržiūrėti pasirinkto prietaiso savybes ir sukalibruotus dažus

Daugiau informacijos apie prietaiso savybes žr. Prietaiso savybių peržiūra, p. 74

n Peržiūrėti prijungto prietaiso būseną

n Atidaryti pasirinkto prietaiso motorizuotą dangtelį

n Uždaryti pasirinkto prietaiso motorizuotą dangtelį

n Peržiūrėti visų prijungtų prietaisų būseną

Kaip peržiūrėti prijungto prietaiso būseną

u Srityje „Detected Instruments“ (aptikti prietaisai) pasirinkite norimą prietaisą ir atlikite vieną iš šių
veiksmų:

n Spustelėkite „View Status“ (rodyti būseną) dalyje „Selected Instrument“ (pasirinktas prietaisas).

n Paspauskite dešinįjį pelės mygtuką ir atsidariusiame meniu pasirinkite „View Status“ (rodyti
būseną).

Pasirodo dialogo langas „Run Details“ (paleidimo išsami informacija), kuriame yra kortelė „Run
Status“ (paleidimo būsena). Pasirinkto prietaiso būsena rodoma po paleisties būsenos sritimi,
pavyzdžiui:

Naudotojo vadovas | 71



6 skyrius. Pagrindinis langas

Kaip atidaryti arba uždaryti prietaiso dangtelį

u Srityje „Detected Instruments“ (aptikti prietaisai) pasirinkite norimą prietaisą ir atlikite šiuos veiksmus:

n Spustelėkite „Open Lid“ (atidaryti dangtelį) arba „Close Lid“ (uždaryti dangtelį) dalyje „Selected
Instrument“ (pasirinktas prietaisas).

n Paspauskite dešinįjį pelės mygtuką ir atsidariusiame meniu pasirinkite atitinkamą veiksmą.

n Atidarykite dialogo langą „Run Details“ (paleidimo išsami informacija), pasirinkite kortelę „Run
Status“ (paleidimo būsena) ir spustelėkite „Open Lid“ (atidaryti dangtelį) arba „Close Lid“ 
(uždaryti dangtelį).

Kaip peržiūrėti visų aptiktų prietaisų būseną

u Atlikite vieną iš toliau nurodytų veiksmų:

n Srities „Detected Instruments“ (aptikti prietaisai) dalyje „All Instruments“ (visi prietaisai)
spustelėkite „View Summary“ (rodyti santrauką).

n Meniu juostoje pasirinkite „View > Instrument Summary“ (rodinys > prietaiso santrauka).

Pasirodo dialogo langas „Instrument Summary“ (prietaiso santrauka).

Patarimas. Jei sistema aptinka tik vieną prijungtą prietaisą, dalis „All Instruments“ (visi
prietaisai) srityje „Detected Instruments“ (aptikti prietaisai) nėra rodoma. Norėdami peržiūrėti
atskiro dokumento prietaiso santrauką, pasirinkite „View > Instrument Summary“ (rodinys >
prietaiso santrauka).

72 | Programinė įranga „CFX Maestro Dx SE“



Langas „Home“ (pagrindinis)

Įrankių juostos „Instrument Summary“ (prietaiso santrauka) valdikliai

5 lent. pateikiami įrankių juostoje „Instrument Summary“ (prietaiso santrauka) esantys valdikliai ir
funkcijos.

Mygtukas Mygtuko pavadinimas Funkcija

Sukurti naują paleidimą Sukuria naują paleidimą pasirinktame
bloke atidarius langą „Run Setup“ 
(paleidimo sąranka).

Stabdyti Sustabdo esamą paleidimą pasirinktuose
blokuose.

Pristabdyti Laikinai pristabdo esamą paleidimą
pasirinktuose blokuose.

Tęsti Tęsia paleidimą pasirinktuose blokuose.

Mirksėti bloko indikatoriumi Blyksteli indikatoriaus šviesos diodu,
esančiu ant pasirinktų blokų dangtelio.

Atidaryti dangtelį Atidaro pasirinkto bloko motorizuotą
dangtelį.

Uždaryti dangtelį Uždaro pasirinkto bloko motorizuotą
dangtelį.

Paslėpti pasirinktus blokus Paslepia pasirinktus blokus sąraše
„Instrument Summary“ (prietaiso
santrauka)

Rodyti visus blokus Rodo pasirinktus blokus sąraše
„Instrument Summary“ (prietaiso
santrauka)

Rodyti Leidžia pasirinkti, kuriuos blokus rodyti
sąraše. Pasirinkite vieną iš parinkčių, kad
būtų rodomi visi aptikti blokai, visi
neveikiantys blokai, visi blokai, veikiantys
su dabartiniu naudotoju, arba visi
veikiantys blokai

5 lent. Įrankių juostos „Instrument Summary“ (prietaiso santrauka) valdikliai
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Prietaiso savybių peržiūra
Srityje „Detected Instruments“ (aptikti prietaisai) galite peržiūrėti išsamią informaciją apie pasirinktą
prietaisą, įskaitant jo savybes, transportavimo varžto būseną (tik „CFX Connect“ ir „CFX Touch“ prietaisai)
ir jo kalibruotų dažų (fluoroforų) sąrašą.

Kaip peržiūrėti prietaiso savybes

u Srityje „Detected Instruments“ (aptikti prietaisai) galite dešiniuoju pelės mygtuku spustelėti tikslinį
prietaisą ir rodomame meniu pasirinkti kortelę „Properties“ (savybės).

Kortelė „Properties“ (savybės)

Kortelėje „Properties“ (savybės) pateikiama techninė informacija apie pasirinktą prietaisą, įskaitant
modelį, jo komponentų serijos numerius ir programinės įrangos versiją. Numatytasis prietaiso
pavadinimas (serijos numeris) rodomas daugelyje vietų, įskaitant sritį „Detected Instruments“ (aptikti
prietaisai) ir dialogo lango „Instrument Properties“ (prietaiso savybės) antraštės juostą. Jūs galite
pervadinti prietaisą, kad būtų lengviau jį identifikuoti.

Pastaba. Naudodami „CFX Maestro“ negalite pakeisti „CFX Opus“ prietaiso pavadinimo.

Kortelė „Calibrated Dyes“ (kalibruoti dažai)

Kortelėje „Calibrated Dyes“ (kalibruoti dažai) rodomi kalibruoti pasirinkto prietaiso fluoroforai ir plokštelės.

Norėdami peržiūrėti išsamią informaciją apie kalibravimą, stulpelyje „Detail“ (išsami informacija)
spustelėkite mygtuką „Info“ (informacija).
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Prieš pradedant
Šiame skyriuje paaiškinamos užduotys, kurias gali tekti atlikti prieš naudojant „CFX Maestro Dx SE“. Tai
apima

n Reakcijos pagrindinio mišinio sukūrimą

n Naujų dažų kalibravimą

Reakcijos pagrindinio mišinio sukūrimas
Naudodamiesi „CFX Maestro Dx SE“ „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas) galite
lengvai apskaičiuoti reikiamą kiekvieno pagrindinio mišinio komponento tūrį. Galite atspausdinti
pagrindinio mišinio skaičiavimų lentelę savo numatytuoju spausdintuvu ir įrašyti kiekvieno taikinio
skaičiavimus ateičiai.

Reakcijos pagrindinio mišinio sukūrimas naudojant „Master Mix Calculator“ (pagrindinio
mišinio skaičiuotuvas)

1. Norėdami atidaryti „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas), atlikite vieną iš šių
veiksmų:

n Pasirinkite „Tools > Master Mix Calculator“ (įrankiai > pagrindinio mišinio skaičiuotuvas).

n Įrankių juostoje spustelėkite „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).

Parodomas „Master Mix Calculator“ (pagrindinio mišinio skaičiuotuvas).
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2. Skyriuje „Reaction“ (reakcija) pasirinkite aptikimo metodą:

n SYBR® „Green“ / „EvaGreen®“

n „Probes“ (zondai)

3. Norėdami sukurti naują taikinį, taikinio skyriuje spustelėkite„Create New“ (sukurti naują). Taikinio
išplečiamajame sąraše parodomas naujo taikinio pavadinimas.

4. (Neprivaloma) Norėdami pakeisti numatytąjį taikinio pavadinimą:

a. Išplečiamajame taikinių sąraše paryškinkite taikinio pavadinimą.

b. Langelyje „Target“ (taikinys) įrašykite naują taikinio pavadinimą.

c. Paspauskite klavišą „Enter“ (įvesti).

5. Koreguokite tiesioginių ir atvirkštinių pradmenų ir visų zondų pradžios ir pabaigos koncentracijas.

6. Skyriuje „Master Mix Setup“ (pagrindinio mišinio sąranka) pakoreguokite vertes:

n Paleidžiamų reakcijų skaičių
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n Reakcijos tūrį šulinėliui

n Šablono tūrį šulinėliui

n Supermišinio koncentraciją šulinėliui

n Perteklinės reakcijos tūrį šulinėliui

7. (Neprivaloma) Atlikite 2.–6. veiksmus su tiek taikinių, kiek reikia.

8. Skyriuje „Choose Target to Calculate“ (pasirinkite skaičiuotiną taikinį) pasirinkite skaičiuotiną taikinį.

Patarimas. Vienu metu galite apskaičiuoti tik vieną, kelis arba visus taikinius.

Kiekvieno pasirinkto taikinio reikiamų komponentų apskaičiuoti tūriai rodomi pagrindinio mišinio
lentelėje.

9. Spustelėkite „Set as Default“ (nustatyti kaip numatytąjį) ir skyriuose „Target“ (taikinys) ir „Master Mix
Setup“ (pagrindinio mišinio sąranka) nustatykite įvedamus kiekius kaip naujus numatytuosius.

10. Spustelėkite OK (gerai) ir įrašykite dialogo lango „Master Mix Calculator“ (pagrindinio mišinio
skaičiuotuvas) turinį.

Pagrindinio mišinio skaičiavimų lentelės spausdinimas

u Norėdami atspausdinti pagrindinio mišinio skaičiavimų lentelę, spustelėkite „Print“ (spausdinti).

Skaičiavimų lentelė atspausdinama jūsų numatytajame spausdintuve.

Pagrindinio mišinio skaičiavimų lentelės įrašymas PDF formatu

u Savo numatytąjį spausdintuvą pakeiskite į PDF tvarkyklę ir „Master Mix Calculator“ (pagrindinio
mišinio skaičiuotuvas) spustelėkite „Print“ (spausdinti).

Taikinių naikinimas

u Išplečiamajame taikinių sąraše pasirinkite taikinį ir spustelėkite „Remove“ (pašalinti).

Svarbu. Taikinį šalinant iš taikinių sąrašo, jis taip pat pašalinamas iš visų pagrindinių mišinių
skaičiavimų, kuriuose buvo naudojamas. Būkite atsargūs, kai šalinate taikinį.

Naujų dažų kalibravimas
„CFX Opus 96 Dx“ ir „CFX Opus Deepwell Dx“ sistemos gamykloje sukalibruotos dažniausiai
naudojamiems fluoroforams baltų ir skaidrių šulinėlių plokštelėse. „CFX Opus 384 Dx sistemos yra
gamykloje sukalibruotos tik dažniausiai naudojamiems fluoroforams baltų šulinėlių plokštelėse. 6 lent.
išvardyti fluoroforai ir kanalai, kuriems sukalibruotas kiekvienas prietaisas.
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Pastaba. „CFX Opus 96 Dx“, „CFX Opus 384 Dx“ ir „CFX Opus Deepwell Dx“ sistemos taip pat
apima kanalą, skirtą FRET chemijai. Šio kanalo nereikia kalibruoti konkrečiam dažui.

Svarbu. Jei atliksite naudotojo nustatytą dažo, kuris buvo kalibruotas gamykloje, kalibravimą,
prietaisas vietoj gamyklinio kalibravimo naudos naudotojo nustatytą kalibravimą.

Fluoroforai Kanalas Sužadinimas, nm Aptikimas, nm Prietaisas

FAM, „SYBR®
Green I“

1 450–490 515–530 „CFX Opus 96
Dx“, „CFX Opus
384 Dx“ ir „CFX
Opus Deepwell
Dx“ sistemos

VIC, HEX, „CAL
Fluor Gold 540“,
„Cal Fluor
Orange 560“

2 515–535 560–580 „CFX Opus 96
Dx“, „CFX Opus
384 Dx“ ir „CFX
Opus Deepwell
Dx“ sistemos

ROX, „Texas
Red“, „CAL Fluor
Red 610“, TEX
615

3 560–590 610–650 „CFX Opus 96
Dx“, „CFX Opus
384 Dx“ ir „CFX
Opus Deepwell
Dx“ sistemos

„Cy5“, „Quasar
670“

4 620–650 675–690 „CFX Opus 96
Dx“, „CFX Opus
384 Dx“ ir „CFX
Opus Deepwell
Dx“ sistemos

„Quasar 705“,
„Cy5.5“

5 672–684 705–730 Tik „CFX Opus
96 Dx“ sistemos

FRET chemija (nekalibruota gamykloje)

Ne gamykloje
kalibruota spalva

FRET 450–490 560–580 „CFX Opus 96
Dx“, „CFX Opus
384 Dx“ ir „CFX
Opus Deepwell
Dx“ sistemos

6 lent. Gamykloje kalibruoti fluoroforai, kanalai ir prietaisai
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Naujų dažų kalibravimas CFX sistemoms

1. Lango „Home“ (pagrindinis) srityje „Detected Instruments“ (aptikti prietaisai) pasirinkite tikslinį
prietaisą.

2. Pasirinkite „Tools > Calibration Wizard“ (įrankiai > kalibravimo vedlys) ir atidarykite vedlį „Dye
Calibration“ (dažų kalibravimas).

Fluoroforas, jau kalibruotas tiksliniam prietaisui, rodomas lentelėje „Calibrated Fluorophores“ 
(kalibruoti fluoroforai).

3. Skyriuje „Calibrate New or Existing Fluorophores“ (kalibruoti naujus ir esamus fluoroforus) iš
išplečiamojo sąrašo pasirinkite kalibruojamą fluoroforą.

Jeigu fluoroforo pavadinimas į sąrašą neįtrauktas, jo pavadinimą įrašykite į tekstinį langelį ir įtraukite jį
į sąrašą.

Svarbu. Būkite atsargūs, pavadindami individualiai kalibruotus fluoroforus. Jei sukursite
pasirinktinį fluoroforo dažų kalibravimą tuo pačiu pavadinimu, kaip ir gamykloje kalibruoto
fluoroforo, prietaisas paleidžiant naudos tinkintą fluoroforą (ne gamykloje kalibruotą fluoroforą).

4. Pasirinkite fluoroforo plokštelės tipą.

Jeigu fluoroforo tipas į sąrašą neįtrauktas, pavadinimą įrašykite į tekstinį langelį ir įtraukite jį į sąrašą.

5. Pasirinkite fluoroforo kanalą.
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6. Pasirinkite fluoroforo plokštelės stulpelį.

7. (Neprivaloma) Įrašykite su fluoroforu siejamą spalvą.

8. Spustelėkite „Add to Plate“ (pridėti plokštelėje) ir pridėkite fluoroforą.

9. (Neprivaloma) Pakartokite 3–8 veiksmus ir pridėkite kiekvieną fluoroforą, kurį planuojate kalibruoti
plokštelei.

10. Kai pridedate fluoroforus, spustelėkite „View Plate“ (peržiūrėti prokštelę) ir atidarykite langą „Pure
Dye Plate Display“ (grynų dažų plokštelės rodmuo).

Šiuo langu naudokitės kaip rekomendacija dažams įdėti į plokštelę.

11. Paruoškite 96 arba 384 šulinėlių plokštelę dažams kalibruoti:

a. Pagal „Pure Dye Plate Display“ (grynų dažų plokštelės rodmuo) rodomą schemą į kiekvieną
šulinėlį pipetuokite dažų tirpalą.

b. Kiekvienam fluoroforui keturis šulinėlius pripildykite 50 µl (96 šulinėlių arba gilių šulinėlių
plokštelė) arba 30 µl (384 šulinėlių plokštelė) 300 nM dažų tirpalo. Atkreipkite dėmesį, kad
mažiausiai pusėje plokštelių yra tuščių šulinėlių.

c. Plokštelę užsandarinkite sandarinimo metodu, kurį naudosite savo eksperimente.

12. Kalibravimo plokštelę padėkite į bloką ir uždarykite dangtelį.

13. Vedlyje „Dye Calibration“ (dažų kalibravimas) spustelėkite „Calibrate“ (kalibruoti), tada spustelėję OK
(gerai) patvirtinkite, kad plokštelė yra bloke.

14. Kai programinės įrangos „CFX Maestro Dx“, „Security Edition“ baigia kalibravimą, parodomas
dialogo langas. Spustelėkite „Yes“ (taip), kad baigtumėte kalibravimą ir atidarytumėte „Dye
Calibration Viewer“ (dažų kalibravimo žiūryklė).

15. Spustelėkite OK (gerai) ir uždarykite langą.

Naudotojo nuostatų nustatymas
Patarimas. Šių užduočių neprivaloma atlikti, norint naudoti „CFX Maestro Dx SE“. Galite saugiai
praleisti šią dalį arba atlikti šias užduotis bet kurį kitą kartą.

„CFX Maestro Dx SE“ kiekvienas naudotojas gali pritaikyti savo darbo aplinką. Pavyzdžiui, meniu „Users
> User Preferences“ (naudotojai > naudotojo nuostatos) galima atlikti šiuos veiksmus:

n Nustatyti, kad būtų siunčiamas pranešimas el. paštu apie baigtą paleidimą

Pastaba. Ši funkcija galima tik tiems naudotojams, kurių vaidmeniui suteikta ši teisė. Daugiau
informacijos rasite skyriuje Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudotojo
vaidmenų valdymas, p. 45.
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n Keisti šias numatytąsias nuostatas:

o Vietą, kurioje įrašomi failai

o Paleidimo sąrankos failus

o Failo pavadinimo prefiksą

n Nustatyti numatytuosius parametrus, kurie bus naudojami kuriant naują protokolą ir plokštelę

n Nustatyti numatytuosius duomenų analizės ir geno ekspresijos parametrus

n Tinkinti numatytuosius kokybės kontrolės parametrus

n Duomenų eksporto parametrų tinkinimas

Meniu „Tools“ (įrankiai) galima atlikti šiuos veiksmus:

n Sukurti pagrindinį mišinį

n Sukalibruoti dažus konkrečiam prietaisui

Pastaba. Pagrindinis mišinys ir dažų kalibravimas prieinami visiems, kurie prisijungia prie
programinės įrangos.

Šioje dalyje paaiškinta, kaip atlikti šias užduotis.

El. pašto pranešimų nustatymas

„CFX Maestro Dx SE“ galite prijungti prie siunčiamo el. pašto serverio ir, baigę paleidimą, sąraše
esantiems naudotojams išsiųsti pranešimus el. paštu. Taip pat galite pasirinkti prisegti duomenų failą ir
analizės ataskaitą sąraše esantiems naudotojams. Norėdami užmegzti ryšį tarp „CFX Maestro Dx SE“ ir
jūsų SMPT serverio, žr. „Security Edition“ prijungimas prie SMTP serverio, p. 83

Pastaba. Naudotojo galimybė pereiti prie el. pašto nuostatų funkcijų priklauso nuo naudotojo
vaidmens ir administratoriaus suteiktų leidimų. Išsamios informacijos apie naudotojų ir jų vaidmenų
valdymą rasite skyriuje Programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudotojo
vaidmenų valdymas, p. 45.

Kaip nustatyti el. pašto pranešimus

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (naudotojo nuostatos), kuriame rodoma kortelė
„Email“ (el. paštas).

Naudotojo vadovas | 81



6 skyrius. Pagrindinis langas

Pastaba. Jus informuos, jeigu sistema nustatys, kad nenustatėte galiojančio SMTP serverio,
skirto „CFX Maestro Dx SE“. Spustelėkite „Configure Outgoing Email“ (konfigūruoti siunčiamą el.
paštą), atidarykite dialogo langą „Options“ (parinktys) ir sukonfigūruokite el. pašto SMTP serverį.
Daugiau informacijos žr. „Security Edition“ prijungimas prie SMTP serverio, p. 83

2. Tekstiniame langelyje „To“ (į) įrašykite kiekvieno asmens, kurį planuojate informuoti apie paleidimo
baigimą, el. pašto adresą. Visi gavėjai gaus el. laišką, kai bus baigtas paleidimas.

Pastaba. Kiekvieną el. pašto adresą turite įvesti atskiroje eilutėje. Paspauskite „Enter“ (įvesti)
arba „Return“ (grįžti) po kiekvieno adreso.

3. (Neprivaloma) Tekstiniame langelyje „cc“ įrašykite kiekvieno gavėjo, kuriam planuojate išsiųsti
kiekvieno pranešimo kopiją, el. pašto adresą.

4. (Neprivaloma) Pagal numatytuosius parametrus visi gavėjai gauna duomenų failo kopiją kaip priedą.
Panaikinkite žymės langelio žymėjimą, jeigu nenorite prisegti duomenų failo kopijos.

5. (Neprivaloma) Pasirinkite „Attach Analysis Report“ (prisegti analizės ataskaitą) ir prie el. laiško
prisekite analizės ataskaitos PDF failą.

6. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą „User Preferences“ 
(naudotojo nuostatos).

Pastaba. Priklausomai nuo paslaugų teikėjo, galbūt galėsite sukonfigūruoti sistemą taip, kad ji siųstų
pranešimą el. paštu į jūsų mobilųjį telefoną. Prireikus konkrečios informacijos apie mobiliojo telefono
el. pašto adresą, kreipkitės į mobiliojo ryšio paslaugų teikėją. Įveskite telefono el. pašto adresą (pvz.,
5552221234@your_service_provider_EmailDomain.net) į „User Preferences“ (naudotojo nuostatų)
ekrano teksto laukelį.

Kaip redaguoti gavėjo el. pašto adresą

u Jeigu reikia, pakeiskite el. pašto adresą ir spustelėkite OK (gerai).
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Kaip pašalinti gavėjo el. pašto adresą

1. Pasirinkite gavėjo el. pašto adresą ir paspauskite klavišą „Delete“ (šalinti).

2. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.

„Security Edition“ prijungimas prie SMTP serverio

Svarbu. Kai kurie komercinių žiniatinklio pašto paslaugų teikėjai padidino el. pašto saugumą. Jeigu
naudojate šias paskyras, jų paskyros nuostatose turite įjungti parinktį „Allow less secure apps“
(leisti mažiau saugias programas), kad „CFX Maestro Dx SE“ galėtų siųsti el. laiškus. Daugiau žr.
savo interneto paslaugų teikėjo saugos informacijoje.

Jei naudojate „Google Gmail“ arba „Microsoft Office 365“ SMTP serverį el. laiškams siųsti, reikia įgalinti 2
veiksnių patvirtinimą ir generuoti „App Password“ jūsų „Gmail“ arba „Office365“ paskyros nustatymuose.
Norėdami autentifikuoti „Maestro“ el. pašto dialogo lange, nukopijuokite ir įklijuokite „App Password“ lauke
„Password“ (slaptažodis), o ne įprastą el. pašto slaptažodį.

Turite nustatyti ryšį su „CFX Maestro Dx SE“ ir savo el. pašto serveriu prieš programinei įrangai
išsiunčiant pranešimus el. paštu.

„CFX Maestro Dx SE“ prijungimas prie el. pašto serverio

1. Atlikite vieną iš toliau nurodytų veiksmų:

n Pasirinkite „User > User Preferences“ (naudotojas > naudotojo nuostatos) ir spustelėkite
„Configure Outgoing Email“ (konfigūruoti siunčiamus el. laiškus) kortelėje „Email“ (el. paštas).

n Pasirinkite „Tools > Options“ (įrankiai > parinktys).

Atidaromas dialogo langas „Options“ (parinktys), kuriame rodoma kortelė „Email“ (el. paštas).
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2. Pateikite šią savo kompanijos informaciją:

n „SMTP Server Name“ (SMTP serverio pavadinimas) – išsiunčiamų el. laiškų serverio jūsų
kompanijoje pavadinimas.

n „Port“ (prievadas) – jūsų SMTP serverio prievado numeris. Paprastai tai yra 25.

n „Use SSL“ (naudoti SSL) – saugiųjų jungčių lygmens (SSL) parinktis. Kai kuriems SMTP
serveriams reikia šios nuostatos. Jeigu jūsų kompanijai to nereikia, panaikinkite šio žymės
langelio žymėjimą.

n „Use Default “From” Address“ (naudoti numatytąjį išsiuntimo „iš“ adresą) – jūsų
kompanijos el. pašto serverio pavadinimas. Kai kuriems SMTP serveriams reikia, kad visi išsiųsti
el. laiškai turėtų adresą „iš“, tai yra iš tam tikro domeno, pavyzdžiui, vardas@jūsųįmonė.com.
Jeigu tai galioja, panaikinkite šio žymės langelio žymėjimą ir pateikite galiojantį el. pašto adresą.

n „Authentication Required“ (būtina autentifikuoti) – jeigu jūsų vietoje reikia autentifikuoti
paskyrą, patikrinkite, ar pažymėtas žymės langelis.

n „User Name“ (naudotojo vardas) – autentifikuotos paskyros pavadinimas. To reikalaujama tik
tada, jeigu pasirinkta „Authentication Required“ (būtina autentifikuoti).
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n „Password“ (slaptažodis) – autentifikuotos paskyros slaptažodis. To reikalaujama tik tada,
jeigu pasirinkta „Authentication Required“ (būtina autentifikuoti).

Svarbu. Jei naudojate „Google Gmail“ arba „Microsoft Office 365“ SMTP serverį el. laiškams
siųsti, reikia įgalinti 2 veiksnių patvirtinimą ir tada generuoti „App Password“ jūsų „Gmail“ arba
„Office365“ paskyros nustatymuose. Norėdami autentifikuoti „Maestro“ el. pašto dialogo lange,
nukopijuokite ir įklijuokite „App Password“ „CFX Maestro Dx SE“ lauke „Password“ (slaptažodis),
o ne įprastą el. pašto slaptažodį.

Norėdami patikrinti, ar teisingos SMTP serverio nuostatos, į tekstinį langelį „Test Email Address“ 
(patikrinti el. pašto adresą) įveskite galiojantį el. pašto adresą ir pasirinkite „Test Email“ (patikrinti el.
paštą).

Pastaba. Kai kurie SMTP serveriai neleidžia siųsti priedų, o kiti leidžia siųsti tik tam tikro
didžiausio dydžio priedus. Jeigu planuojate el. paštu siųsti duomenų failus ir (arba) ataskaitas
naudodami „CFX Maestro Dx SE“, pasirinkite „Test Attachment“ (patikrinti priedą) ir nustatykite 5
megabaitų (MB) ar didesnį „Attachment Size in MB“ (priedo dydis megabaitais).

3. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Numatytųjų failų nuostatų keitimas

Dialogo lango „User Preference“ (naudotojo nuostatos) kortelėje „File“ (failas) galite pakeisti šias
nuostatas:

n Numatytąją vietą „CFX Maestro Dx SE“ failams įrašyti

n Numatytuosius failus paleidimo sąrankai

n Numatytuosius failo pavadinimo parametrus

Kaip pakeisti numatytųjų failų nuostatas

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Files“ (failai).
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3. Pereikite į skyrių „Default Folder for File Creation“ (numatytasis aplankas failui sukurti) ir pasirinkite
numatytąjį aplanką, kuriame norite įrašyti naujus failus. Kiekvienam failų tipui galite pasirinkti
skirtingą vietą:

n Protokolas

n Plokštelė

n Duomenų failas

n Geno tyrimas

4. Eikite į skyrių „File Selection for Run Setup“ (failo pasirinkimas paleidimo sąrankai) ir pasirinkite
tikslinio protokolo ir plokštelės failus, kurie bus rodomi atidarius langą „Experiment Setup“ 
(eksperimento sąranka).

5. Skyriuje „Data File“ (duomenų failas) nustatykite duomenų failų prievardį ir (arba) povardį. Bet kuriai
daliai išplečiamajame sąraše pasirinkite naują vertę. Prievardžio ir povardžio tekstiniuose
langeliuose taip pat galite pateikti tinkintą prievardį ir povardį.

„CFX Maestro Dx SE“ po pasirinkimo langeliais rodo failo pavadinimo peržiūrą.

6. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.
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Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.

Numatytųjų protokolo parametrų nustatymas

Numatytųjų protokolų parametrų nustatymas „Protocol Editor“ (protokolų redaktoriuje) ir
„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonėje)

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Protocol“ (protokolas).

3. Skyriuje „Protocol Editor“ (protokolų redaktorius) nurodykite šių nuostatų reikšmes, kurios rodomos
„Protocol Editor“ (protokolų redaktorius):

n „Sample volume“ (mėginio tūris) – kiekvieno mėginio šulinėlyje tūris (µl).

n „Lid Shutoff temperature“ (dangtelio išjungimo temperatūra) – temperatūra ºC, kuriai esant
paleidžiant dangtelio kaitinimas išjungiamas.

4. Skyriuje „Protocol AutoWriter“ (protokolo automatinio kūrimo priemonė) nurodykite šių nuostatų
reikšmes, kurios rodomos „Protocol AutoWriter“ (protokolo automatinio kūrimo priemonėje):

n „Annealing temperature“ (atkaitinimo temperatūra) – temperatūra º C eksperimentams,
kuriuose naudojama „iProof“ DNR polimerazė, „iTaq“ DNR polimerazė ar kitos polimerazės.

n „Amplicon length“ (amplikono ilgis) – amplikono ilgis bp.

5. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.
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Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.

Numatytųjų plokštelės parametrų nustatymas

Kortelėje „Plate“ (plokštelė) padaryti pakeitimai galioja visiems programinės įrangos naudotojams. Per
plokštelės sąranką atlikti pakeitimai pritaikomi naudotojams tada, kai juos įrašote ir uždarote.

Dialogo lange „User Preferences“ (naudotojo nuostatos) galima atlikti šiuos veiksmus:

n Nustatyti numatytuosius plokštelės parametrus

n Pridėti naujus taikinio, mėginio ir biologinės grupės pavadinimus į atitinkamas bibliotekas.

n Panaikinti taikinio, mėginio ir biologinės grupės pavadinimus atitinkamose bibliotekose.

Kaip nustatyti numatytuosius plokštelės parametrus

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Plate“ (plokštelė).
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3. Nurodykite šių naujo plokštelės failo nuostatų reikšmes. Šios reikšmės pateikiamos lange „Plate
Editor“ (plokštelės redaktorius):

n „Plate type“ (plokštelės tipas)

n „Plate size“ (plokštelės dydis)

n „Units“ (vienetai) – pradinio šablono koncentracija šulinėliuose, kuriuose yra standartų.

„CFX Maestro Dx SE“ šie vienetai naudojami standartinei kreivei sukurti kortelėje „Data Analysis
Quantification“ (duomenų analizės kiekybinis įvertinimas).

n „Scientific notation“ (standartinė skaičiaus išraiška) – pasirinkus šią parinktį „CFX Maestro
Dx SE“ standartinėje skaičiaus išraiškoje rodomi koncentracijos vienetai.

n „Scan mode“ (nuskaitymo režimas) – kanalų, kuriuos norite nuskaityti per paleidimą, skaičius
ar tipas.

n „Fluorophores“ (fluoroforai) – numatytieji fluoroforai, pateikiami „Plate Editor“ (plokštelės
redaktorius) šulinėlių apkrovimo valdikliuose.

n „Libraries“ (bibliotekos) – taikinio, mėginio ir biologinės grupės pavadinimai, kuriuos paprastai
naudojate eksperimentuose:

o „Target names“ (taikinių pavadinimai) – taikinio genų ir sekų pavadinimai.

o „Sample names“ (mėginių pavadinimai) – eksperimentinių mėginių pavadinimai arba
identifikavimo charakteristika (pavyzdžiui, „Mouse1“ (1 pelė), „Mouse2“ (2 pelė), „Mouse3“ 
(3 pelė)).

o „Biological group names“ (biologinių grupių pavadinimai) – panašių mėginių grupių su
ta pačia apdorojimo būsena ar sąlygomis pavadinimai (pavyzdžiui, 0Hr (0 val.), 1Hr (1 val.),
2Hr (2 val.)).

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Norėdami pridėti naują taikinio, mėginio ar biologinės grupės pavadinimą

u Atitinkamame bibliotekos laukelyje įrašykite taikinio, mėginio ar biologinės grupės pavadinimą ir
spustelėkite OK (gerai).

Norėdami panaikinti taikinio, mėginio ar biologinės grupės pavadinimą

u Atitinkamame bibliotekos laukelyje pasirinkite pavadinimą ir spauskite mygtuką „Delete“ (šalinti) ir
OK (gerai).

Svarbu. Pavadinimai, kuriuos pašalinate iš bibliotekos, pašalinami iš programinės įrangos ir
naudotojas daugiau negali jų naudoti. Norėdami atkurti numatytuosius „CFX Maestro Dx SE“
pavadinimus, spauskite „Restore Defaults“ (atkurti numatytuosius parametrus). Dialogo lange „User
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Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ (atkurti numatytuosius
parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės gamyklinės reikšmės
Būkite atsargūs, kai šalinate numatytuosius „CFX Maestro Dx SE“ pavadinimus ir spaudžiate šį
mygtuką.
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Numatytųjų duomenų analizės parametrų nustatymas

Kaip nustatyti numatytuosius duomenų analizės parametrus

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Data Analysis“ 
(duomenų analizė).

3. Dalyje „Analysis Mode“ (analizės režimas) pasirinkite režimą, kuriame analizuoti duomenis
(„Fluorophore“ (fluoroforas) arba „Target“ (taikinys)).

4. Dalyje „PCR Quantitation“ (PGR kiekybinis įvertinimas) nustatykite šių parinkčių numatytuosius
parametrus:

n „Baseline Setting“ (pagrindinė nuostata) – pagrindinis analizės režimo metodas.

n „Cq Determination Mode“ (Cq nustatymo režimas) – režimas, kuriame Cq reikšmės
apskaičiuojamos kiekvienam fluorescencijos pėdsakui (regresijos arba atskiros ribinės
reikšmės).
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n „Threshold Calc. Mode“ (ribinės reikšmės skaičiavimo režimas) – galutinio taško taikinio
kiekis.

Numatytoji nuostata – „Auto“ (automatinė). Tai reiškia, kad programinė įranga automatiškai
apskaičiuoja galutinio taško taikinį. Norėdami nustatyti konkrečią ribinę reikšmę, išvalykite
žymės langelį „Auto“ (automatinė) ir įveskite galutinio taško kiekį, apskaičiuotą santykiniais
fluorescencijos vienetais (arba RFU). Didžiausia reikšmė – 65 000,00 RFU. Duomenų failuose,
skirtuose vėlesniems paleidimams, bus naudojama ši ribinės reikšmės nuostata.

n „Baseline Calc. Mode (pagrindinės reikšmės skaičiavimo režimas) – visų pėdsakų
pagrindinė reikšmė.

Numatytoji nuostata – „Auto“ (automatinė). Tai reiškia, kad programinė įranga automatiškai
apskaičiuoja visų pėdsakų pagrindinę reikšmę. Norėdami nustatyti konkrečią pagrindinę
reikšmę, išvalykite žymės langelį „Auto“ (automatinė) ir įveskite mažiausią ir didžiausią ciklo
intervalo reikšmes (nuo 1 iki 9999). Duomenų failuose, skirtuose vėlesniems paleidimams, bus
naudojamas šis ciklo intervalas.

n „Log View“ (žurnalo rodinys) – nustato, kaip programinėje įrangoje atvaizduojami
amplifikavimo duomenys:

o „On“ (įjungta) – amplifikavimo duomenys rodomi pusiau logaritminiame grafike.

o „Off“ (išjungta) – (numatytieji) amplifikavimo duomenys rodomi linijiniame grafike.

5. Dalyje „End Point“ (galutinis taškas) pasirinkite galutinių ciklų skaičių, kuris bus naudojamas atliekant
galutinio taško skaičiavimus:

n PCR (PGR) – galutinių ciklų skaičius, kuris bus naudojamas kiekybinio įvertinimo duomenims
(numatytasis – 5).

n „End Point Only run“ (paleidimas tik galutiniame taške) – galutinių ciklų skaičius, kuris bus
naudojamas galutinio taško duomenims (numatytasis – 2).

6. Dalyje „Melt Curve“ (lydymosi kreivė) pasirinkite, kokio tipo didžiausią temperatūrą norite aptikti
(teigiamą arba neigiamą).

7. Dalyje „Well Selector“ (šulinėlių parinkiklis) pasirinkite, kaip rodyti šulinėlių etiketes (pagal mėginio
rūšį, taikinio pavadinimą arba mėginio pavadinimą).

8. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.
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Numatytųjų geno ekspresijos duomenų failo parametrų nustatymas

Kaip nustatyti numatytuosius naujo geno ekspresijos duomenų failo parametrus

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Gene Expression“ (geno
ekspresija).

3. Nurodykite šių nuostatų reikšmes:

n „Relative to“ (lyginant su) – grafike parodomi geno ekspresijos duomenys, lyginant su
kontroliniu mėginiu (prasidedančiu nuo 1) arba nuliu:

o „Zero“ (nulis) – programinė įranga ignoruoja kontrolinį mėginį. Ši nuostata yra numatytoji,
kai lange „Experiment Settings“ (eksperimento nuostatos) nėra priskirto kontrolinio mėginio.

o „Control“ (kontrolė) – programinė įranga apskaičiuoja duomenis, lygindama su kontroliniu
mėginiu, priskirtu lange „Experiment Setup“ (eksperimento sąranka).

n „X-axis“ (x ašis) – mėginys arba taikinys grafiškai atvaizduojamas x ašyje.

n „Y-axis“ (y ašis) – linijinė, log2 arba log10 skalė grafiškai atvaizduojama y ašyje.

n „Scaling“ (mastelio keitimas) – grafiko mastelio keitimo parinktis (numatytoji parinktis –
neapdorota):

o „Highest“ (didžiausias) – programinė įranga pakeičia grafiko dydį į didžiausią duomenų
tašką.

o „Lowest“ (mažiausias) – programinė įranga pakeičia grafiko dydį į mažiausią duomenų
tašką.

o „Unscaled“ (neapdorotas) – programinė įranga pateikia neapdorotus duomenis grafike.

n „Mode“ (režimas) – analizės režimas: santykinis kiekis (∆Cq) arba normalizuota ekspresija
(∆∆Cq).

n „Error Bar“ (paklaidos juosta) – duomenų kintamumas, pateikiamas kaip standartinis
nuokrypis („Std. Dev.“) arba vidurkio standartinė paklaida („Std. Error Mean“).

n „Error Bar Multiplier“ (paklaidos juostos daugiklis) – standartinio nuokrypio daugiklis,
naudojamas grafiškai atvaizduoti paklaidų juostoms (numatytasis – 1).

Daugiklį galite padidinti iki 2 arba 3.

n „Sample Types to Exclude“ (neįtrauktini mėginių tipai) – mėginių tipai, kurių nenorite
įtraukti į analizę.
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Galite pasirinkti vieną ar kelis mėginius, kurių nenorite įtraukti į analizę. Jei nenorite įtraukti nė
vieno mėginio tipo, išvalykite pasirinktų tipų žymės langelius.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.

Kokybės kontrolės taisyklių tinkinimas

„CFX Maestro Dx SE“ galite nustatyti kokybės kontrolės taisykles, kurios galiotų duomenims lange „Data
Analysis“ (duomenų analizė). Programinė įranga patvirtina duomenis pagal jūsų nustatytas taisykles.

Pastaba. Pagal numatytąsias nuostatas visos kokybės kontrolės taisyklės yra įjungtos.

Patarimas. Galite lengvai pašalinti šulinėlius, kurie neatitinka KK parametro, iš analizės lango „Data
Analysis“ (duomenų analizė) KK modulyje.

Kaip tinkinti kokybės kontrolės taisykles

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę QC (KK).
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Kur:

n NTC – kontrolė be šablono

n NRT – kontrolė be atvirkštinės transkriptazės

n „Efficiency“ (veiksmingumas) – reakcijos veiksmingumas

n „Std Curve R^2“ (standartinės kreivės R^2) – R kvadratinė vertė standartinei kreivei

n „Replicate group Cq Std Dev“ (kopijų grupės apskaičiuotas standartinis nuokrypis) –
standartinis nuokrypis, apskaičiuotas kiekvienai kopijų grupei

3. Kiekvienai QC (KK) taisyklei atlikite vieną iš šių veiksmų:

n Norėdami naudoti numatytąją vertę, nieko nedarykite.

n Norėdami pakeisti jos vertę, spustelėkite tekstinį langelį „Value“ (vertė), įrašykite naują vertę ir
paspauskite klavišą „Enter“ (įvesti).

n Norėdami išjungti taisyklę, panaikinkite žymės langelio „Use“ (taikyti) žymėjimą.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.

Duomenų eksporto parametrų tinkinimas

„CFX Maestro Dx SE“ duomenis galite eksportuoti šiais formatais:

n Tekstinis (.txt)

n CSV (.csv)

n „Excel“ (.xls, .xlsx)

n XML (.xml)

n HTML (.html)

Svarbu. Jūsų kompiuteryje turi būti įdiegta „Microsoft Excel“ programa, kad galėtumėte eksportuoti
duomenis į „Microsoft Excel“ skaičiuoklę.

Galite nurodyti, kokio tipo duomenis eksportuoti, ir tinkinti eksportuojamų duomenų išvestį.
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Kaip tinkinti duomenų eksporto parametrus

1. Pasirinkite „User“ > „User Preferences“ (naudotojai > naudotojo nuostatos) ir atidarykite dialogo
langą „User Preferences“ (naudotojo nuostatos).

2. Dialogo lange „User Preferences“ (naudotojo nuostatos) pasirinkite kortelę „Custom Export“ 
(pasirinktinis eksportas).

3. Išplečiamajame sąraše „Export Format“ (eksporto formatas) pasirinkite, kokiu formatu eksportuoti
duomenis.

4. Dalyje „Data to Export“ (eksportuojami duomenys) pasirinkite arba išvalykite eksportuojamų
duomenų tipo žymės langelius. Pasirinkti elementai pasirodo sąrašo lauke „Exported Columns“ 
(eksportuoti stulpeliai).

Pastaba. Pagal numatytąsias nuostatas paleisties informacija įtraukta į antraštę. Jei nenorite
įtraukti paleisties informacijos, išvalykite šį žymės langelį.

5. Galite keisti pasirinktų elementų išvesties rodymo tvarką.

Sąrašo lauke „Exported Columns“ (eksportuoti stulpeliai) pažymėkite elementą ir spausdami sąrašo
kairėje esančias rodykles perkelkite jį aukštyn arba žemyn.

6. Pasirinktinai galite keisti pasirinktų elementų išvesties stulpelių pavadinimus:
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a. Spustelėkite „Customize Column Names“ (tinkinti stulpelių pavadinimus).

Pasirodo dialogo langas „Column Name Customizer“ (stulpelių pavadinimų pasirinkimo
priemonė).

b. Kiekvieno numatytojo stulpelio pavadinimo, kurį norite pakeisti, naują pavadinimą įveskite
laukelyje „Custom Name“ (pasirinktinis pavadinimas).

c. Atlikite vieną iš toliau nurodytų veiksmų:

n Spustelėkite OK (gerai), įrašykite keitimus ir grįžkite į kortelę „Custom Export“ (pasirinktinis
eksportas). Naujasis pavadinimas pasirodo skliausteliuose, šalia numatytojo stulpelio
pavadinimo sąrašo lauke „Exported Columns“ (eksportuoti stulpeliai).

n Spustelėkite „Cancel“ (atšaukti), išvalykite pakeitimus ir grįžkite į kortelę „Custom Export“ 
(pasirinktinis eksportas).

7. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą.

Svarbu. Dialogo lange „User Preferences“ (naudotojo nuostatos) spustelėjus „Restore Defaults“ 
(atkurti numatytuosius parametrus) visose kortelėse iš naujo nustatomos visų nuostatų pradinės
gamyklinės reikšmės Būkite atsargūs, kai spaudžiate šį mygtuką.
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Protokolas yra veiksmų, kurie atliekami nurodyta seka, rinkinys. Programinės įrangos „CFX Maestro Dx“,
„Security Edition“ visi veiksmai yra susieti su prietaiso parinktimis. Pavyzdžiui, veiksmu prietaisui
nurodoma kontroliuoti bloko ir dangtelio temperatūrą, taikyti temperatūros skirtumą bloke, nuskaityti
plokštelę arba atlikti lydymosi kreivės analizę. Kiekviena parinktis nurodoma skirtingoms plokštelėms ir
paleidimų tipams.

„CFX Maestro Dx SE“ pateikia dvi protokolų kūrimo galimybes: „Protocol Editor“ (protokolų redaktorius) ir
„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė).

„Protocol Editor“ (protokolų redaktorius) funkcijos

n Standartiniai protokolo valdikliai sparčiam protokolų kūrimui

n Galimybė greitai apskaičiuoti gradientą pasirinktam eilučių skaičiui

n Galimybė greitai apskaičiuoti gradientą pasirinkto tipo plokštelei

n Galimybė redaguoti protokolo veiksmus

n Galimybė įrašyti protokolą, kad būtų galima naudoti pakartotinai

n Galimybė atspausdinti protokolą numatytuoju spausdintuvu

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) automatiškai sukuria tinkintą PGR
protokolą su karšta pradžia, pradine denatūracija, atkaitinimu ir pratęsimo veiksmais taikydama jūsų
pateiktus parametrus. Tada jūs galite peržiūrėti siūlomo protokolo grafinį pavaizdavimą ir redaguoti,
paleisti ar įrašyti protokolą.
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Protokolo veiksmų parametrai ir diapazonai
Norėdami modifikuoti numatytąsias protokolo veiksmų nuostatas, naudokite 7 lent. pateiktą informaciją.

Temperatūros veiksmai

Tikslinė temperatūra yra vertė nuo 4,0 iki 100,0 °C, nustatyta laipsnio dešimtosiomis dalimis. Sistema
pasiekia šią temperatūrą ir išlaiko ją nustatytą laiką (užlaikymo laikas).

Gradiento veiksmai

Gradiento diapazonas yra gradiento veiksmo skirtumas tarp apatinės ir viršutinės temperatūrų.
Didžiausias leistinas diapazonas yra 24 °C. Apatinė temperatūra yra vertė nuo 30,0 iki 99,0 ° C, nustatyta
laipsnio dešimtosiomis dalimis. Didžiausia viršutinė temperatūra yra 100 °C. Termocikleris kelia
temperatūrą iki tikslinės temperatūros gradiento visame bloke ir palaiko tą temperatūrą nustatytą
palaikymo laiką.

Svarbu. Prietaisas apskaičiuoja gradiento vertę. Kai įvedate reikšmę gradiento skaičiuoklės
viršutiniame ir apatiniame laukuose, programinė įranga automatiškai apskaičiuoja ir priskiria
temperatūrą likusiuose laukuose. Įvedus temperatūrą bet kuriame lauke tarp viršutinio ir apatinio
laukų, prietaisas automatiškai apskaičiuos likusius laukus. Negalite rankiniu būdu įvesti temperatūros
vertės kiekviename lauke.

Parametras Intervalas Aprašymas

„Ramp rate“ 
(kitimo greitis)

n „CFX Opus 96“ Dx“ sistemos:
0,1–5 °C per sek.

n „CFX Opus 384 Dx“ sistemos:
0,1–2,5 °C per sek.

n „CFX Opus Deepwell Dx“
sistemos:
0,1–2,5 °C per sek.

Nurodo termocikleriui pasiekti tame
veiksme tikslinę temperatūrą nurodytu
greičiu.

Pasiekiama tik temperatūros veiksmuose.

„Increment“ 
(prieaugis)

Skaičius nuo –10,0 iki 10,0 °C per
ciklą dešimtosiomis laipsnio dalimis

Nurodo termocikleriui keisti tikslinę veiksmo
temperatūrą kiekviename cikle, kai
teigiamas skaičius didina temperatūrą, o
neigiamas skaičius mažina temperatūrą.

Pasiekiama tik temperatūros veiksmuose.

7 lent. Protokolo veiksmų parametrai ir diapazonai
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Parametras Intervalas Aprašymas

„Extend“ 
(pratęsimas)

Laikas nuo –60 iki 60 sek. per ciklą Nurodo termocikleriui pratęsti užlaikymo
laiką kiekviename cikle. Teigiamas skaičius
ilgina užlaikymo laiką, neigiamas –
trumpina.

Galima tiek temperatūros, tiek gradiento
veiksmuose.

„Beep“ 
(pyptelėjimas)

(nėra parametrų) Nurodo termocikleriui pyptelėti, kad
signalizuotų, jog termocikleris pasiekė
tikslinę to veiksmo temperatūrą.

Pasiekiama tik temperatūros veiksmuose.

„Plate read“ 
(plokštelės
skaitymas)

(nėra parametrų) Nurodo termocikleriui pridėti prie pasirinkto
veiksmo plokštelės nuskaitymą.

Galima tiek temperatūros, tiek gradiento
veiksmuose.

7 lent. Protokolo veiksmų parametrai ir diapazonai (tęsinys)
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Protokolų redaktoriaus langas
Lange „Protocol Editor“ (protokolų redaktorius) galite kurti, atidaryti, peržiūrėti ir redaguoti protokolą.
Pagal numatytąsias nuostatas „Protocol Editor“ (protokolų redaktorius) rodomas bendras realiojo laiko 2
veiksmų protokolas 96 šulinėlių plokštelei.

1. Meniu juosta suteikia sparčią prieigą prie meniu „File“ (failas), „Settings“ (nuostatos) ir „Tools“ 
(įrankiai) komandų.

2. Įrankių juosta suteikia sparčią prieigą prie protokolo įrašymo ir spausdinimo, naujo veiksmo
įterpimo vietos nustatymo, mėginio tūrio nustatymo ir protokolo numatomo veikimo laiko
rodymo parinkčių.

3. Pagrindinėje srityje rodomas protokolo grafinis vaizdas.

4. Toliau esančioje srityje rodoma protokolo schema.

5. Kairėje srityje rodomi protokolo valdymo elementai, kuriuos galite pridėti pritaikydami protokolą.

LEGENDA

Meniu „File“ (failas) komandos
„Save“ (įrašyti) – įrašomas esamas protokolas.
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„Save As“ (įrašyti kaip) – esamas protokolas įrašomas nauju pavadinimu arba naujoje vietoje.

„File Passwords“ (failų slaptažodžiai) – naudotojai gali nustatyti failų įrašymo ir atidarymo
slaptažodžius.

Patarimas. Daugiau informacijos, žr. Failų apsaugojimas slaptažodžiu, p. 52

„Close“ (uždaryti) – uždaromas „Protocol Editor“ (protokolų redaktorius).

Meniu „Settings“ (nuostatos) komanda
„Lid Settings“ (dangtelio nuostatos) – atidaromas dialogo langas „Lid Setting“ (dangtelio nuostata),
kuriame galite pakeisti arba nustatyti dangtelio temperatūrą.

Meniu „Tools“ (įrankiai) komandos
„Gradient Calculator“ (gradiento skaičiuotuvas) – atveriamas dialogo langas, kuriame galite pasirinkti
gradiento veiksmo bloko tipą. Numatytoji nuostata yra 96 šulinėliai.

„Run time Calculator“ (paleidimo trukmės skaičiuotuvas) – atidaro dialogo langą, kuriame galite
pasirinkti plokštelės tipą ir nuskaitymo režimą, kad būtų galima apskaičiuoti paleidimo trukmę lange „Run
Setup“ (paleidimo sąranka). Numatyti 96 šulinėliai visuose kanaluose.

Įrankių juostos komandos

– įrašo esamą protokolo failą.

– atspausdina pasirinktą langą.

– naudokite šią komandą pasirinkti, kur įterpti veiksmus, palyginti su esamu
pasirinktu veiksmu.

– naudokite šią komandą ir įveskite mėginio tūrį µl. Mėginio tūris skiriasi
priklausomai nuo bloko tipo:

n 96 šulinėlių bloko intervalas yra 0–50 µl.

n 384 šulinėlių bloko intervalas yra 0–30 µl.

n 96 gilių šulinėlių bloko intervalas yra 0–125 µl.
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– rodo apskaičiuotą paleidimo trukmę, remiantis protokolo veiksmais, kitimo
greičiu ir pasirinkto bloko tipu.

– rodo žinyno informacija apie protokolus.

Protokolų redagavimo valdikliai
Lango „Protocol Editor“ (protokolų redaktorius) kairę sritį sudaro valdikliai, kuriais galite sukurti
protokolus.

Kiekvieną valdiklį sudaro keli parametrai, reiškiantys veiksmą protokole. Kiekvieną parametrą galite keisti
ir pridėti arba pašalinti, kad tinkintumėte savo protokolą. Šiame skyriuje apibūdintos kiekvieno valdiklio
parinktys.

n „Insert Step“ (įterpti veiksmą) – įterpia veiksmą prieš pasirinktą
veiksmą arba po jo. Galite redaguoti temperatūros arba užlaikymo
trukmės vertes arba protokolo grafiniame rodinyje, arba protokolo
schemoje.

n „Insert Gradient“ (įterpti gradientą) – įterpiamas gradiento veiksmas,
remiantis gradiento skaičiuotuve pasirinkto šulinėlių bloko tipu. Gradiento
intervalą galite redaguoti srityje „Gradient“ (gradientas), kuris
parodomas, kai įterpiamas gradiento veiksmas.

n „Insert GOTO“ (įterpti GOTO) – įterpiamas ciklinis (kilpos) veiksmas,
kuris programinei įrangai nurodo pakartoti veiksmus sekoje nurodytą
ciklų skaičių. Kartojimas pradedamas, kai baigiamas pirmasis ciklas.

Pavyzdžiui, jūs galite programinei įrangai nurodyti 2–4 veiksmus pakartoti 39 kartus. Po paskutinio
pakartojimo programinė įranga 2–4 veiksmus bus atlikusi 40 kartų. Galite koreguoti sugrįžimo į
(GOTO) veiksmą ir ciklų skaičių arba grafiniame rodinyje, arba protokolo schemoje.

n „Insert Melt Curve“ (įterpti lydymosi kreivę) – įterpiamas lydymosi kreivės nuskaitymo veiksmas.

n „Insert Plate Read to Step“ (įterpti plokštelės nuskaitymą į veiksmą) – į pasirinktą veiksmą
įtraukiama plokštelės nuskaitymo komanda. Plokštelės nuskaitymo funkcija ciklo pabaigoje
išmatuoja fluorescencijos kiekį. Plokštelės nuskaitymo veiksmas paprastai yra paskutinis veiksmas
GOTO cikle.

Patarimas. Kai prie veiksmo pridedate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).
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n „Remove Plate Read“ (pašalinti plokštelės nuskaitymą) – iš pasirinkto veiksmo pašalinama
plokštelės nuskaitymo komanda.

Patarimas. Kai iš veiksmo pašalinate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Add Plate Read to Step“ (į veiksmą įtraukti plokštelės nuskaitymą).

n „Step Options“ (veiksmų parinktys) – atidaromas dialogo langas „Step Options“ (veiksmų
parinktys) ir rodomos pasirinkto veiksmo galimos parinktys. Išsamią informaciją apie veiksmų
parinktis žr. Veiksmų parinktys, p. 106.

Patarimas. „Step Options“ (veiksmų parinktys) galite pasiekti grafiniame rodinyje veiksmą
spustelėję dešiniuoju pelės mygtuku.

n „Delete Step“ (pašalinti veiksmą) – iš protokolo pašalina pasirinktą veiksmą.

Naudotojo vadovas | 105



7 skyrius. Protokolų kūrimas

Veiksmų parinktys

Atidarykite dialogo langą „Step Options“ (veiksmų parinktys) ir peržiūrėkite parinktis, kurias galite pridėti,
pakeisti ar pašalinti iš veiksmo.

n „Plate Read“ (plokštelės nuskaitymas) – pasirinkus į veiksmą įtraukiamas plokštelės
nuskaitymas.

n „Temperature“ (temperatūra) – nustatoma pasirinkto veiksmo tikslinė temperatūra.

n „Gradient“ (gradientas) – veiksmui nustatomas gradiento intervalas; intervalas yra 1–24 °C.

Pastaba. Gradientas paleidžiamas mažiausia temperatūra bloko priekyje (šiame paveikslėlyje –
H eilė) ir didžiausia temperatūra bloko gale (šiame paveikslėlyje – A eilė).

n „Increment“ (kitimas) – pasirinkto veiksmo temperatūros didinimo (ar mažinimo) dydis; šio dydžio
vertė pridedama prie tikslinės temperatūros kiekviename cikle. Diapazonas – ±0,1–10 °C.

Pastaba. Norėdami sumažinti temperatūrą, prieš skaitinę vertę parašykite minuso ženklą
(pavyzdžiui, –5 °C).

n „Ramp Rate“ (kitimo greitis) – pasirinkto veiksmo kitimo greitis; intervalas priklauso nuo bloko
dydžio.

n „Time“ (laikas) – pasirinkto veiksmo užlaikymo laikas.
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n „Extend“ (pratęsimas) – laikas (sek.), kuriuo pratęsimas ar sutrumpinamas pasirinktas veiksmas; ši
parinktis pridedama prie užlaikymo laiko kiekviename cikle; intervalas yra ±1–60 sek.

n „Beep“ (pyptelėjimas) – jei pasirenkama, žingsnio metu pypteli.

Patarimas. Įvedus skaičių, kuris nepatenka į parinkties intervalą, programinė įranga jį pakeičia
artimiausia įvestimi intervale.
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Protokolo kūrimas protokolų redaktoriuje
Lange „Protocol Editor“ (protokolų redaktorius) galite kurti pasirinktinius protokolų failus. Taip pat galite
redaguoti ir įrašyti anksčiau įrašytus protokolo failus arba pavyzdinius protokolų failus, pridėtus prie
„CFX Maestro Dx SE“.

Kaip sukurti naują protokolo failą:

n Lange „Protocol Editor“ (protokolų redaktorius) atidarykite protokolo failą.

Patarimas. Lange „Protocol Editor“ (protokolų redaktorius) galite atidaryti naują arba esamą
protokolą.

n Sukurkite naują protokolą.

n Pridėkite prie protokolo veiksmus iš protokolų valdymo srities.

n Redaguokite veiksmų ypatybes.

n Įrašykite protokolą.

Patarimas. Apie tai, kaip sukurti naują protokolą iš anksčiau įrašytų arba pavyzdinių protokolų failų,
žr. Esamo protokolo atidarymas protokolų redaktoriumi, p. 110.

Naujo protokolo failo atidarymas protokolų redaktoriumi
„CFX Maestro Dx SE“ turi kelias galimybes naujo protokolo failui atidaryti:

n Meniu „File“ (failas) pagrindiniame lange

n Pradiniame lange esančiame dialogo lange „Run Setup“ (vykdymo sąranka)

n Pradiniame lange esančiame dialogo lange „Startup Wizard“ (paleisties vedlys)

Kaip atidaryti naujo protokolo failą meniu „File“ (failas)

u Lange „Home“ (pagrindinis) pasirinkite „File > New > Protocol“ (failas > naujas > protokolas).

Atidaromas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas numatytasis protokolo
failas.

Patarimas. Daugiau informacijos apie numatytojo protokolo nustatymą žr. Numatytųjų failų
nuostatų keitimas, p. 85.

Kaip atidaryti naują protokolą dialogo lange „Run Setup“ (paleidimo sąranka)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atidarykite dialogo langą „Run Setup“ 
(paleidimo sąranka):

n Pasirinkite „Run > User-defined Run“ (paleidimas > naudotojo nustatytas paleidimas).
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n Įrankių juostoje spustelėkite „User-defined Run Setup“ (naudotojo nustatyto paleidimo sąranka).

Dialogo langas „Run Setup“ (paleidimo sąranka) atidaro kortelę „Protocol“ (protokolas) ir rodo jūsų
numatytąjį protokolo failą.

2. Spustelėkite „Create New“ (kurti naują).

Atidaromas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas realiojo laiko
protokolas.

Kaip atidaryti naujo protokolo failą per „Startup Wizard“ (paleisties vedlį)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atidarykite „Startup Wizard“ (paleisties
vedlys), jeigu jis dar nerodomas:

n Pasirinkite „View > Startup Wizard“ (peržiūrėti > paleisties vedlys).

n Įrankių juostoje spustelėkite „Startup Wizard“ (paleisties vedlys).

2. Jeigu reikia, išplečiamajame sąraše pasirinkite prietaiso tipą.

3. Spustelėkite „User-defined“ (naudotojo nustatytas) kaip paleidimo tipą.

Dialogo langas „Run Setup“ (paleidimo sąranka) atidaro kortelę „Protocol“ (protokolas) ir rodo
numatytąjį protokolo failą.

4. Spustelėkite „Create New“ (kurti naują).

Atidaromas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas realiojo laiko
protokolas.

Kaip atidaryti naują protokolą iš meniu „Run“ (paleisti)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atidarykite dialogo langą „Run Setup“ 
(paleidimo sąranka):

n Pasirinkite „Run > User-defined Run“ (paleidimas > naudotojo nustatytas paleidimas).

n Įrankių juostoje spustelėkite „User-defined Run Setup“ (naudotojo nustatyto paleidimo sąranka).

Dialogo langas „Run Setup“ (paleidimo sąranka) atidaro kortelę „Protocol“ (protokolas) ir rodo jūsų
numatytąjį protokolo failą.

2. Spustelėkite „Create New“ (kurti naują).

Atidaromas langas „Protocol Editor“ (protokolų redaktorius), kuriame rodomas realiojo laiko
protokolas.
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Esamo protokolo atidarymas protokolų redaktoriumi
„CFX Maestro Dx SE“ pateikia mėginių protokolų failus, kuriuos galite redaguoti ir įrašyti kaip tinkintus
naujus protokolus. Taip pat galite sukurti naujus protokolus pagal esamą tinkintą protokolą.

Kaip atidaryti mėginio protokolo failą

1. Lange „Home“ (pagrindinis) pasirinkite „File > Open > Protocol“ (failas > atidaryti > protokolas).

Pagal numatytuosius parametrus „Windows Explorer“ atidaromas „CFX Maestro Dx SE“ mėginių
failų aplanko vietoje.

2. Atidarykite mėginių failų aplanką. Galite matyti šiuos aplankus:

n „ConventionalProtocols“ (įprasti protokolai) – protokolų pavyzdžių failai tradicinei PGR
analizei.

n „DataFiles“ (duomenų failai) – duomenų pavyzdžių failai, kuriuos galite naudoti „CFX Maestro
Dx SE“ funkcijoms tyrinėti.

n „MeltCalibration“ (lydymosi kalibravimas) – protokolų pavyzdžių failai, skirti naudoti su
„Bio-Rad“ rezultatų lydymosi analizės programine įranga.

n „Plates“ (plokštelės) – plokštelės pavyzdžių failai.

n „RealTimeProtocols“ (realiojo laiko protokolai) – protokolų pavyzdžių failai PGR analizei
realiuoju laiku.

3. Atidarykite protokolų aplanką planuojamam atlikti paleidimo tipui („ConventionalProtocols“ (įprasti
protokolai) arba „RealTimeProtocols“ (realiojo laiko protokolai)).

4. Pasirinkite reikiamą protokolą ir spustelėkite „Open“ (atidaryti).

Lange „Protocol Editor“ (protokolų redaktorius) atidaromas mėginių protokolas.

5. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite protokolą nauju pavadinimu ar naujame
aplanke.

Kaip atidaryti esamą protokolą

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų:

n Pasirinkite „File > Open > Protocol“ (failas > atidaryti > protokolas), suraskite tikslinį protokolą, jį
pasirinkite ir spustelėkite „Open“ (atidaryti).

n Atidarykite „Startup Wizard“ (paleisties vedlys) ir atlikite vieną iš šių veiksmų:

o Norėdami redaguoti rodomą protokolą, spustelėkite „Edit Selected“ (redaguoti pasirinktą).
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o Norėdami redaguoti kitą esamą protokolą, spustelėkite „Select Existing“ (pasirinkti esamą)
ir raskite tikslinį failą.

Lange „Protocol Editor“ (protokolų redaktorius) atidaromas protokolas.

2. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite protokolą nauju pavadinimu ar naujame
aplanke.

Naujo protokolo nustatymas
Patarimas. Jei jūsų protokolo faile yra reikalingi parametrai (pvz., jei redaguojate esamą plokštelės
failą), galite šį skyrių praleisti. Tęskite, kaip nurodyta skirsnyje Protokolo veiksmų pridėjimas , p. 113.

Naujiems protokolo failams reikalingi šie parametrai:

n Bloko tipas

n Pasirinkto bloko tipo nuskaitymo režimas

n „Lid temperature“ (dangčio temperatūra)

n Mėginio tūris
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Bloko tipo nustatymas

„CFX Maestro Dx SE“ automatiškai apskaičiuoja gradiento veiksmų temperatūros kitimus, remiantis bloko
tipu.

Pastaba. Plokštelės tipas, nustatytas „Protocol Editor“ (protokolų redaktoriuje), turi būti toks pat, kaip
ir plokštelė reakcijos modulyje.

Kaip nustatyti bloko tipą

u Lange „Protocol Editor“ (protokolų redaktorius) pasirinkite „Tools > Gradient Calculator“ (įrankiai >
gradiento skaičiuotuvas) ir rodomame išplečiamajame sąraše pasirinkite atitinkamo tipo plokštelę.

Nuskaitymo režimo pasirinkimas pasirinkto tipo blokui

Norėdami nustatyti protokolo paleidimo laiką, pasirinkite tikslo bloko tipą ir nuskaitymo režimą.

Kaip pasirinkti bloko tipą ir nuskaitymo režimą

u Lange „Protocol Editor“ (protokolų redaktorius) pasirinkite „Tools > Run time Calculator“ (įrankiai >
paleidimo laiko skaičiuotuvas) ir rodomame išplečiamajame sąraše pasirinkite atitinkamo tipo
plokštelę.

Dangtelio temperatūros koregavimas

„CFX Maestro Dx SE“ nustato numatytąją dangtelio temperatūrą:

n 96 šulinėlių ir gilių šulinėlių prietaisai – 105,0 °C

n 384 šulinėlių prietaisai – 95,0 °C

Galite pakeisti numatytąsias nuostatas arba dangtelio kaitintuvą išjungti, kai reikia, pagal protokolo
reikalavimus.

Kaip koreguoti dangtelio temperatūrą

1. Lange „Plate Editor“ (plokštelės redaktorius) pasirinkite „Settings > Lid Settings“ (nuostatos >
dangtelio nuostatos).

Parodomas dialogo langas „Lid Settings“ (dangtelio nuostatos).

2. Atlikite vieną iš toliau nurodytų veiksmų:

n Pasirinkite „User Defined“ (naudotojo nustatyta) ir teksto langelyje įrašykite temperatūros vertę.

n Pasirinkite „Turn Off Lid Heater“ (išjungti dangtelio kaitintuvą).

3. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei uždarykite dialogo langą
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Mėginio tūrio nustatymas

Pagal numatytąsias nuostatas „CFX Maestro Dx SE“ kiekvienam šulinėliui nustato 25 µl mėginio tūrį.
Mėginio tūris skiriasi, priklausomai nuo bloko tipo, pavyzdžiui:

n 0–50 µl 96 šulinėlių bloko atveju

n 0–30 µl 384 šulinėlių bloko atveju

Prietaisas naudoja vieną iš dviejų temperatūros reguliavimo režimų, kad nustatytų, kada mėginys
pasiekia tikslinę temperatūrą protokole:

n „Calculated mode“ (apskaičiuotas režimas) – kai mėginio tūris yra nustatomas pagal blokui
tinkamą ne nulio tūrį, prietaisas apskaičiuoja mėginio temperatūrą pagal mėginio tūrį. Tai standartinis
režimas.

n „Block mode“ (bloko režimas) – kai nustatytas mėginio tūris yra nulis (0) µl, prietaisas užfiksuoja
tokią pačią mėginio temperatūrą, kaip išmatuota bloko temperatūra.

Mėginio tūrio konkrečiam blokui nustatymas

u Lange „Plate Editor“ (plokštelės redaktorius) įveskite reikiamą reikšmę įrankių juostoje esančiame
tekstiniame langelyje „Sample Volume“ (mėginio tūris).

Patarimas. Numatytąjį mėginio tūrį galite pakeisti dialogo lange „User Preferences“ (naudotojo
nuostatos). Daugiau informacijos žr. skirsnyje Numatytųjų failų nuostatų keitimas, p. 85.

Protokolo veiksmų pridėjimas
Kaip pridėti protokolo veiksmą

1. Atidarykite protokolą lange „Protocol Editor“ (protokolų redaktorius).

2. Nustatykite, kur įterpti naują veiksmą. Įrankių juostoje esančiame išplečiamajame sąraše „Step“ 
(veiksmas) pasirinkite „Before“ (prieš) arba „After“ (po).

3. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti naują veiksmą.

4. Kairiojoje srityje pasirinkite „Insert Step“ (įterpti veiksmą).

5. Norėdami pakeisti temperatūrą ar užlaikymo trukmę, spustelėkite numatytąją reikšmę diagramoje
arba protokolo kontūre ir įveskite naują reikšmę.

6. (Neprivaloma) Kairiojoje srityje spustelėkite „Step Options“ (veiksmų parinktys), kad atidarytumėte
dialogo langą „Step Options“ (veiksmų parinktys) ir pakeistumėte pasirinkto veiksmo parinktis.

Patarimas. Dialogo langą „Step Options“ (veiksmų parinktys) galite rasti dešiniuoju pelės
mygtuku paspaudę diagramos arba protokolo kontūro sritį ir atidarę meniu.

7. Spustelėkite OK (gerai) ir „Yes“ (taip), kad įrašytumėte protokolo pakeitimus.
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Parodomas dialogo langas „Save As“ (įrašyti kaip).

8. Lange „Save As“ (įrašyti kaip) įveskite naujo protokolo failo pavadinimą ir spustelėkite „Save“ 
(įrašyti).

Gradiento veiksmo įterpimas
Kaip įterpti gradiento veiksmą

1. Patikrinkite, ar gradiento plokštelės dydis yra toks pat, kaip ir prietaiso bloko tipo, 96 arba 384
šulinėlių, arba gilių šulinėlių.

2. Jeigu to dar neatlikote, pasirinkite plokštelės dydį gradientui:

Pasirinkite „Tools > Gradient Calculator“ (įrankiai > gradiento skaičiuotuvas) ir išplečiamajame
sąraše pasirinkite šulinėlių tipą.

3. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite arba
„Before“ (prieš), arba „After“ (po).

4. Diagramoje arba paryškintoje srityje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti
gradiento veiksmą.

5. Kairiojoje srityje spustelėkite „Insert Gradient“ (įterpti gradientą). Naujas gradiento veiksmas
paryškinamas diagramoje ir apibrėžtoje srityje, pavyzdžiui:
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Kiekvienos eilutės temperatūra gradiente parodoma lentelėje „Gradient“ (gradientas), esančioje
dešiniojoje srityje.

6. Norėdami koreguoti gradiento temperatūros intervalą, atlikite šiuos veiksmus:

n Spustelėkite numatytąją temperatūrą diagramoje ar apibrėžtoje srityje ir įveskite naują
temperatūrą.

n Spustelėkite „Step Options“ (veiksmų parinktys) ir lange „Step Options“ (veiksmų parinktys)
įveskite gradiento intervalą.

n Pakeiskite lentelėje „Gradient“ (gradientas) esančią vertę „Range“ (intervalas).

7. Norėdami koreguoti užlaikymo laiką, grafike ar tekstiniame vaizde spustelėkite numatytąjį laiką ir
įveskite naują laiką.

8. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).

Veiksmo GOTO įterpimas
Pastaba. Veiksmo GOTO negalite įterpti į GOTO rinkinį; negalite sukurti rinkinio GOTO
pasikartojančių veiksmų.

Kaip įterpti veiksmą GOTO

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite „Before“ 
(prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti GOTO veiksmą.

3. Kairiojoje srityje spustelėkite „Insert GOTO“ (įterpti GOTO).

4. Norėdami koreguoti GOTO veiksmo numerį ar GOTO pasikartojimų numerį, diagramoje pasirinkite
numatytąjį numerį arba pažymėkite sritį ir įveskite naują vertę.

5. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).

Lydymosi kreivės veiksmo įterpimas
Patarimas. Lydymosi kreivės veiksmo negalite įterpti į GOTO ciklą.

Pastaba. Lydymosi kreivės veiksmas apima 30 sek. užlaikymą veiksmo, kuris neparodytas
protokole, pradžioje.
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Kaip įterpti lydymosi kreivės veiksmą

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite „Before“ 
(prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti lydymosi kreivės veiksmą.

3. Kairiojoje srityje spustelėkite „Insert Melt Curve“ (įterpti lydymosi kreivę). Naujas lydymosi kreivės
veiksmas paryškinamas diagramoje ir apibrėžtoje srityje, pavyzdžiui:

4. Norėdami koreguoti lydymosi temperatūros intervalą arba padidinimo laiką, diagramoje pasirinkite
numatytąjį numerį arba apibraukite sritį ir įveskite naują vertę.

5. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).
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Plokštelės nuskaitymo veiksmo pridėjimas arba pašalinimas
Patarimas. Kai prie veiksmo pridedate plokštelės nuskaitymo komandą, pasirinkus veiksmą
mygtukas pasikeičia į „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).

Plokštelės nuskaitymo pridėjimas prie veiksmo

1. Įrankių juostoje esančiame išplečiamajame sąraše „Insert Step“ (įterpti veiksmą) pasirinkite „Before“ 
(prieš) arba „After“ (po).

2. Diagramoje pasirinkite veiksmą, prieš kurį arba po kurio planuojate įterpti plokštelės nuskaitymo
veiksmą.

3. Norėdami prie pasirinkto veiksmo pridėti plokštelės nuskaitymą, kairėje srityje spustelėkite „Add
Plate Read to Step“ (plokštelės nuskaitymą pridėti prie veiksmo).

4. Kad įrašytumėte pakeitimus, spustelėkite mygtuką OK (gerai), o tada „Yes“ (taip).

Plokštelės nuskaitymo pašalinimas iš veiksmo

u Diagramoje pasirinkite veiksmą, į kurį įtrauktas plokštelės nuskaitymas, ir kairiojoje srityje
spustelėkite „Remove Plate Read“ (pašalinti plokštelės nuskaitymą).

Veiksmų parinkčių keitimas
Pasirinkto veiksmo parinkčių keitimas

1. Diagramoje ar kontūro srityje pasirinkite tikslinį veiksmą.

2. Kairiojoje srityje spustelėkite „Step Options“ (veiksmų parinktys) ir atidarykite dialogo langą „Step
Options“ (veiksmų parinktys).

Taip pat galite dešiniuoju pelės mygtuku bet kurioje srityje spustelėti tikslinį veiksmą ir rodomame
meniu pasirinkti „Step Options“ (veiksmų parinktys).

3. Norėdami pridėti, keisti ar pašalinti parinktis, atlikite šiuos veiksmus:

n Atitinkamame tekstiniame langelyje įrašykite vertę.

n Konkrečiame tekstiniame langelyje koreguokite vertę.

n Pasirinkite arba išvalykite žymės langelį.

4. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei uždarykite dialogo langą „Step Options“ (veiksmų
parinktys).

5. Spustelėkite OK (gerai), paskui „Yes“ (taip) ir įrašykite protokolą.
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Veiksmo šalinimas
Svarbu. Šios funkcijos anuliuoti negalite. Būkite atsargūs, kai šalinate veiksmus.

Veiksmo protokole šalinimas

1. Diagramoje ar kontūro srityje pasirinkite veiksmą.

2. Kairiame skydelyje spustelėkite „Delete Step“ (šalinti veiksmą) ir pašalinkite pasirinktą veiksmą.

3. Spustelėkite OK (gerai), paskui „Yes“ (taip) ir įrašykite protokolą.

Protokolo kopijavimas, eksportavimas arba spausdinimas
Protokolo kopijavimas

u Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Copy Protocol“ (kopijuoti
protokolą).

Galite įklijuoti schemą į .txt, .xls, .doc arba .ppt failą.

Protokolo eksportavimas

1. Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Export Protocol“ (eksportuoti
protokolą).

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. (Neprivaloma) Per naršyklę „Windows Explorer“ pasiekite aplanką, kuriame norite įrašyti protokolo
failą.

3. Lauke „File Name“ (failo pavadinimas) įrašykite eksportuoto protokolo failo pavadinimą.

4. Spustelėkite „Save“ (įrašyti).

Protokolo spausdinimas

u Pelės dešiniuoju mygtuku spustelėkite protokolo schemą ir pasirinkite „Print“ (spausdinti).

Galite atspausdinti protokolo schemą jūsų numatytuoju spausdintuvu.
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Protokolų kūrimas su protokolų automatinio kūrimo priemone
Svarbu. „Bio-Rad“ negarantuoja, kad paleidžiant su „Protocol AutoWriter“ (protokolų automatinio
kūrimo priemonė) sukurtą protokolą bus gaunamas PGR produktas.

„CFX Maestro Dx SE“ „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) automatiškai
sukuria ciklinius protokolus pagal šiuos įvesties parametrus:

n „Amplicon length“ (amplikono ilgis) – PGR produkto tikėtinas ilgis.

n „Annealing temperature“ (atkaitinimo temperatūra) – reakcija Ta naudojamiems pradmenims.

Jeigu Ta yra nežinoma, galite naudoti „Ta Calculator“ (Ta skaičiuotuvą) ir automatiškai apskaičiuoti
pagal jūsų pradmens sekas.

Pastaba. Ta yra koreguota iš pradmens lydymosi temperatūros (Tm) informacijos, kuri pagrįsta
pažymėtu fermentu ir protokolo greičiu.

n „Enzyme type“ (fermento tipas) – DNA (DNR) polimerazės fermentas („iTaq, iProof DNA“ („iTaq“,
„iProof DNR“) polimerazė arba „Other“ (kt.))

Jeigu jūs naudojate kitą fermentą, ne „iTaq“ ar „iProof DNA“ („iProof DNR“) polimerazę, galite įvesti
papildomą informaciją, įskaitant gradiento intervalą, karšto paleidimo aktyvinimo laiką (sek.) ir
galutinį pratęsimo laiką (sek.).

n „Run speed“ (paleidimo greitis) – reakcijos greitis (standartinis, greitas arba itin greitas)

„Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė) optimizuoja protokolą, priklausomai
nuo pasirinktos greičio nuostatos. Bendras paleidimo laikas nustatomas pagal veiksmų ir ciklų
skaičių, inkubavimo laiką kiekvienu etapu ir laiką, kiek užtruko pasiekti vienodą tikslinę temperatūrą.

Pagal jūsų įvestus parametrą ir standartines PGR rekomendacijas „Protocol AutoWriter“ (protokolų
automatinio kūrimo priemonė) automatiškai sukuria tinkintą PGR protokolą su karšta pradžia, pradine
denatūracija, atkaitinimu ir pratęsimo veiksmais. Tada jūs galite peržiūrėti siūlomo protokolo grafinį
pavaizdavimą ir redaguoti, paleisti ar įrašyti protokolą.
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Naujo protokolo sukūrimas naudojant „CFX Maestro Dx SE“ „Protocol AutoWriter“ 
(protokolų automatinio kūrimo priemonė)

1. Lange „Home“ (pagrindinis) pasirinkite „Tools > Protocol AutoWriter“ (įrankiai > protokolų automatinio
kūrimo priemonė).

Parodomas dialogo langas „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė).

2. Skyriuje „Enter Target Values/Enzyme“ (įvesti tikslines vertes / fermentą) atlikite šiuos veiksmus:

n Įveskite pradmens atkaitinimo temperatūrą (Ta), jeigu žinoma.

Patarimas. Daugiau informacijos žr. Ta skaičiuotuvo naudojimas, p. 121.

Pastaba. Informacijos apie skaičiavimus, atliekamus „Ta Calculator“ (Ta skaičiuotuvu), žr.
Breslauer et al., 1986.

n Įveskite amplikono ilgį bazių porose (bp).

n Iš parinkčių („iTaq DNA“ („iTaq DNR“) polimerazė, „iProof DNA“ („iProof DNR“) polimerazė ar
„Other“ (kt.)) sąrašo pasirinkite fermento tipą.

Patarimas. Jeigu pasirenkate fermento tipą „Other“ (kt.), parametras skyriuje „Additional
Parameters (Optional)“ (papildomi parametrai (neprivaloma) tampa aktyvus.
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3. Jeigu pasirinkote fermento tipą „Other“ (kt.), galite pridėti bet kurį iš pateikiamų arba visus protokolo
parametrus:

n Gradiento intervalas

n Karštos pradžios aktyvinimo temperatūra

n Galutinis pratęsimo laikas

4. Skyriuje „Type“ (tipas) slinkite slankiąją juostą ir pasirinkite protokolo greitį („Standard“ (standartinis),
„Fast“ (greitas) arba „Ultrafast“ (itin greitas)). „CFX Maestro Dx SE“ koreguoja bendrą paleidimo
laiką.

5. Pasirinkite atliekamos PGR tipą („Real-time PCR“ (realiojo laiko PGR) yra numatytasis).

Su realiojo laiko PGR „CFX Maestro Dx SE“ prideda plokštelės nuskaitymo veiksmą fluorescencijos
duomenims surinkti.

6. Skyriuje „Preview“ (peržiūra) peržiūrėkite protokolą. Jeigu reikia, galite atlikti pakeitimus.

7. Atlikite vieną iš toliau nurodytų veiksmų:

n Spustelėkite OK (gerai) ir įrašykite naują protokolą. Jį įrašius, protokolas atidaromas lange
„Startup Wizard“ (paleisties vedlys). Spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir keiskite
protokolą. Pavyzdžiui, jums gali reikėti pakeisti dangtelio temperatūrą ir mėginio tūrį.

n Spustelėkite „Cancel“ (atšaukti) ir uždarykite langą neįrašę protokolo.

Ta skaičiuotuvo naudojimas
Kai nežinoma pradmens atkaitinimo temperatūra, galite pasinaudoti „Ta Calculator“ (Ta skaičiuotuvas) ir
apskaičiuoti vertę. Vertę galite naudoti priemonėje „Protocol AutoWriter“ (protokolo automatinio kūrimo
priemonė) arba „Protocol Editor“ (protokolų redaktorius) ir sukurti savo protokolą.

Apie Ta skaičiuotuvą
„Ta Calculator“ (Ta skaičiuotuvas) skaičiuoja kiekvieno pradmens Tm vertę, taip pat Ta vertę standartinio
greičio protokolui.

Ta protokolas grindžiamas vidutinėmis pradmens Tm vertėmis taikant šias galiojančias taisykles:

n Jeigu skirtumas tarp pradmens Tm verčių yra >4 °C, Ta = (mažesnė iš dviejų pradmenų Tm verčių +
2) – 4 °C

n Jeigu skirtumas tarp Tm verčių yra ≤4 °C, Ta = (pradmens Tm verčių vidurkis) – 4 °C
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Bazių porų skaičiavimo metodas

Kiekvienam pradmeniui „Ta Calculator“ (Ta skaičiuotuvas) taiko bazių porų skaičiavimo metodą sekoms
su 14 ar mažiau bazių porų (bp).

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

kur atitinkamai w, x, y ir z yra bazių A, T, G ir C skaičius sekoje.

Artimiausių kaimynų metodas

Sekoms su daugiau nei 14 bp naudojamas artimiausių kaimynų metodas. Artimiausių kaimynų metode
lydymosi temperatūros skaičiavimai grindžiami termodinaminiu ryšiu tarp entropijos (oligonukleotido
sekos ar matmenų atsitiktinumo), entalpijos (oligonukleotido išskiriamos arba absorbuotos šilumos),
laisvosios energijos ir temperatūros.

∆H = ∆G + T* ∆S

kur:

n ∆H = entalpijos reikšmė, cal/mol*K

n T = temperatūra pagal Kelvino skalę

n ∆S = entropijos reikšmė, cal/mol*K

n ∆G = Gibso laisvoji energija, cal/mol*K

Entropijos ir entalpijos pokyčiai yra tiesiogiai apskaičiuojami sumuojant nukleotidų porų reikšmes,
pateiktas 8 lent. (Breslauer et al., 1986).

Laisvosios energijos ir reaktantų bei produktų koncentracijos pusiausvyrai reikalingas santykis
apskaičiuojamas pagal:

∆G = R*T*ln ((DNR * pradmuo)/(DNR + pradmuo))

kur R yra dujų konstanta (1,986 cal/mol*K).

Pakeitus G dviejose lygtyse ir apskaičiavus T gaunama

T = ∆H/(∆S + R*Ln((DNR * pradmuo)/(DNR + pradmuo)))

darant prielaidą, kad DNR ir DNR pradmenų komplekso koncentracija yra vienoda.

Empiriškai nustatyta, kad perėjimo nuo vienos grandinės DNR prie B formos DNR metu atsiranda 5 kcal
(3,4 kcal) (Sugimoto et al., 1996) laisvosios energijos pokytis. Tai tikriausiai spiralės inicijavimo energija.
Galiausiai, pridėjus druskos paklaidą, gaunama lygtis, kurią naudoja Ta skaičiuotuvas:

T = (∆H – 5(KCal/K*mol))/(∆S + (R * ln(1/(pradmuo)))) + 16,6 log10 (druskos molinė koncentracija)
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Nereikia taikyti jokios paklaidos druskos koncentracijos konstantai, nes įvairūs parametrai buvo nustatyti
esant 1 M NaCl, o log10 iš 1 lygus nuliui.

Termodinaminiais skaičiavimais daroma prielaida, kad atkaitinimas vyksta esant pH 7,0. Tm skaičiavimo
metu daroma prielaida, kad sekos nėra simetriškos ir turi bent vieną G ar C.

Tam, kad būtų gautos pagrįstos Tm reikšmės, oligonukleotido seka turi būti mažiausiai 14 bazių ilgio.
Mažiau nei 14 bazių atveju naudojamas bazių porų skaičiavimo metodas (žr. toliau pateiktą 8 lent.).

Sąveika ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

8 lent. Breslauer sąveikos konstantos
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Ta skaičiuotuvo naudojimas

Kaip naudoti „Ta Calculator“ (Ta skaičiuotuvą)

1. Tam, kad atidarytumėte langą „Ta Calculator“ (Ta skaičiuotuvas), atlikite vieną iš toliau nurodytų
veiksmų:

n Jei šiuo metu esate atidarę „Protocol AutoWriter“ (protokolų automatinio kūrimo priemonė),
spustelėkite „Ta Calculator“ (Ta skaičiuotuvas).

n Lange „Home“ (pagrindinis) pasirinkite „Tools > Ta Calculator“ (įrankiai > Ta skaičiuotuvas).

Atidaromas dialogo langas „Ta Calculator“ (Ta skaičiuotuvas).

2. Tekstiniame langelyje „Forward Primer“ (tiesioginis pradmuo) įrašykite arba įklijuokite tiesioginio
pradmens seką.

Patarimas. Seką įvesti taip pat galite mygtukais A, T, G, C dialogo lango kairėje pusėje.

3. Tekstiniame langelyje „Reverse Primer“ (atvirkštinis pradmuo) įrašykite arba įklijuokite atvirkštinio
pradmens seką.

4. Spustelėkite mygtuką „Calculate“ (skaičiuoti).
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„Ta Calculator“ (Ta skaičiuotuvas) skaičiuoja ir parodo kiekvieno pradmens Tm reikšmę bei vidutines
Tm ir Ta reikšmes, pavyzdžiui:

Jei pradmens Tm reikšmės skiriasi daugiau nei 4 °C, „Protocol AutoWriter“ (protokolų automatinio
kūrimo priemonė) remiasi žemesne pradmens Tm reikšme + 2 °C kaip pagrindu apskaičiuodama Ta
reikšmę, kurią galite toliau koreguoti, keisdami fermentą ir reakcijos greitį.

„Ta Calculator“ (Ta skaičiuotuvas) su „iTaq DNR“ polimeraze generuoja atkaitinimo temperatūrą
standartiniam greičiui. Naudojant kitą fermentą, greičio nuostatos automatiškai koreguoja Ta.

5. Atlikite vieną iš toliau nurodytų veiksmų:

n Jei atidarėte langą „Ta Calculator“ (Ta skaičiuotuvas) iš „Protocol AutoWriter“ (protokolų
automatinio kūrimo priemonė), spustelėkite OK (gerai). Tada grįšite į „Protocol AutoWriter“ 
(protokolų automatinio kūrimo priemonė). Atkaitinimo temperatūra keičiama automatiškai.

n Jei atidarėte langą „Ta Calculator“ (Ta skaičiuotuvas) iš meniu „Tools“ (įrankiai), įrašykite
skaičiavimus ir spustelėkite „Cancel“ (atšaukti), kad uždarytumėte skaičiuotuvą.
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8 skyrius. Plokštelių paruošimas
Plokštelės faile yra informacijos apie paleidimo parametrus, pvz., nuskaitymo režimą, fluoroforus ir
šulinėlių turinį. Po paleidimo programinės įrangos „CFX Maestro Dx“, „Security Edition“ susieja šulinėlio
turinį su fluorescencijos duomenimis, gautais vykdymo metu, ir lange „Data Analysis“ (duomenų analizė)
atliekama atitinkama analizė. Pavyzdžiui, šulinėliai, į kuriuos įdėtas standartinio tipo mėginys, naudojami
standartinei kreivei sukurti.

„CFX Maestro Dx SE“ numato dvi plokštelių kūrimo galimybes: „Plate Editor“ (plokštelės redaktorius)
realiojo laiko PGR paleidimams ir „Setup Wizard“ (sąrankos vedlys) normalizuotos geno ekspresijos
analizei.

„Plate Editor“ (plokštelės redaktorius) apima šias funkcijas:

n Standartinių fluoroforų ir mėginių tipų priskyrimas plokštelių šulinėliams

n Galimybė nustatyti etaloninį taikinį ir kontrolinį mėginį geno ekspresijos analizei

n Galimybė redaguoti plokštelių sąranką prieš paleidimą, jo metu arba po jo

n Galimybė įrašyti failus, kad būtų galima naudoti pakartotinai

n Galimybė atspausdinti plokštelės failą numatytuoju spausdintuvu

„Setup Wizard“ (sąrankos vedlys) padės jums sukurti plokštelės schemą normalizuotai geno ekspresijos
analizei. Parinktį „Setup Wizard“ (sąrankos vedlys) galite naudoti prieš paleidimą, jo metu arba po jo.
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Plokštelės redaktoriaus langas
Naudodami „Plate Editor“ (plokštelės redaktorius) sukurkite tinkintas plokšteles ar keiskite esamas
plokšteles.

1. Meniu juosta suteikia sparčią prieigą prie meniu „File“ (failas) ir „Settings“ (nuostatos) komandų
bei plokštelės redagavimo įrankių parinkčių.

2. Įrankių juosta leidžia greitai pasiekti svarbias plokštelės įdėjimo funkcijas.

3. Pagrindinėje srityje rodoma plokštelės schema ir plokštelės parinktys, kurias joms taikysite.

4. Dešiniojoje srityje rodomos parinktys, kurias naudojate savo plokštelei tinkinti.

5. Apatinėje srityje rodomas plokštelės tipas ir suteikiama greita prieiga prie peržiūros parinkčių.

LEGENDA

Meniu „File“ (failas) komandos
„Save“ (įrašyti) – plokštelės duomenų failas įrašomas dialogo lango „User Preferences“ (naudotojo
nuostatos) kortelėje „File“ (failas) nurodytoje vietoje. Daugiau informacijos žr. Numatytųjų failų nuostatų
keitimas, p. 85. Šis meniu elementas prieinamas tik kuriant naują plokštelės failą.

„Save As“ (įrašyti kaip) – atvertos plokštelės duomenų failas įrašomas nauju, jūsų nurodytu
pavadinimu. Šis meniu elementas prieinamas tik kuriant naują plokštelės failą.
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„File Passwords“ (failų slaptažodžiai) – naudotojai gali nustatyti failų įrašymo ir atidarymo
slaptažodžius.

„Extract Plate“ (išskleisti plokštelę) – atidaromas dialogo langas, kuriame galite išskleisti (įrašyti)
plokštelės failą (.pltd). Šis meniu elementas prieinamas tik peržiūrint arba redaguojant esamą plokštelės
failą.

„Print“ (spausdinti) – atspausdina atidarytos plokštelės duomenų failą.

„Close“ (uždaryti) – uždaro langą „Plate Editor“ (plokštelės redaktorius).

Meniu „Edit“ (redagavimas) komandos
„Undo“ (anuliuoti) – grąžina plokštelės failo pakeitimus prieš įrašant plokštelės failą.

„Redo“ (atšaukti) – panaikina naujausius anuliavimo veiksmus, nebent plokštelės failas buvo įrašytas.

Meniu „Settings“ (nuostatos) komandos
„Plate Size“ (plokštelės dydis) – atidaro dialogo langą, kuriame galite pasirinkti paleidimo plokštelės
dydį.

Pastaba. Plokštelės dydis turi būti toks pat, kaip bloko dydis prietaise, kuriame atliekamas
paleidimas.

Pasirinkite 96 šulinėlius, jei naudojate:

n „CFX Opus 96 Dx“

n „CFX Opus Deepwell Dx“

Pasirinkite 384 šulinėlius, jei naudojate:

n „CFX Opus 384Dx“

„Plate Type“ (plokštelės tipas) – leidžia jums pasirinkti šulinėlių tipą plokštelėje, kurioje laikomi jūsų
mėginiai, arba „BR White“ (BR balta), arba „BR Clear“ (BR skaidri). Kad gautumėte tikslią duomenų
analizę, pasirinktas plokštelės tipas turi būti toks pat, kaip paleidimo metu naudojamos plokštelės tipas.

Pastaba. Turite kalibruoti naujos plokštelės tipus. Daugiau informacijos žr. Naujų dažų
kalibravimas, p. 77.

„Number Convention“ (sutartinis skaičių žymėjimas) – leidžia jums pasirinkti ar panaikinti parinkties
žymėjimą, kad standartinėje skaičiaus išraiškoje būtų rodomi matavimo vienetai. Pagal numatytąsias
nuostatas standartinėje skaičiaus išraiškoje rodomi matavimo vienetai.

„Units“ (matavimo vienetai) – leidžia pasirinkti matavimo vienetus, kurie bus rodomi skaičiuoklėse, kai
atliekamas nežinomų mėginių kiekybinis vertinimas, palyginus su standartine kreive.
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Meniu „Editing Tools“ (redagavimo įrankiai) komandos
„Setup Wizard“ (sąrankos vedlys) – atidaroma parinktis „Setup Wizard“ (sąrankos vedlys), kuria galite
nustatyti dabartinės plokštelės schemos ir analizės parametrus. Parinktį „Setup Wizard“ (sąrankos
vedlys) galite naudoti prieš paleidimą, jo metu arba po jo.

„Spreadsheet View/Importer“ (skaičiuoklės peržiūra / importavimo įrankis) – atidaromas dialogo
langas „View“ (peržiūrėti), kuriame plokštelės schema rodoma kaip šablonas skaičiuoklės formatu. Galite
naudoti šį dialogo langą, jei norite eksportuoti arba importuoti plokštelės šablono duomenis .csv formatu.

„Flip Plate“ (plokštelės apvertimas) – plokštelės turinys apverčiamas 180 o kampu.

Įrankių juostos komandos

Grąžina plokštelės pakeitimą. „CFX Maestro Dx SE“ palaiko iki dešimties
anuliavimo veiksmų

Atšaukia naujausią anuliavimo veiksmą. „CFX Maestro Dx SE“ palaiko iki
dešimties atšaukimo veiksmų.

Įrašomas esamas plokštelės failas.

Rodomas išplečiamasis sąrašas, kuriame galite padidinti arba sumažinti
plokštelės vaizdą.

Rodomas išplečiamasis sąrašas, kuriame galite pasirinkti skenavimo
režimą, kuriuo prietaisui nurodoma, kuriuose kanaluose rinkti
fluorescencijos duomenis paleidimo metu.

Atidaro „Well Groups Manager“ (šulinėlių grupių tvarkyklė), kur galima
sukurti naudojamos plokštelės šulinėlių grupes.

Rodomas dialogo langas, kuriame galite pasirinkti amplifikavimo pėdsakų
spalvas ir simbolius.

Atidaro dialogo langą „View“ (peržiūrėti), kuriame plokštelės schema
rodoma kaip šablonas skaičiuoklės formatu. Galite naudoti šį dialogo
langą, jei norite eksportuoti arba importuoti plokštelės šablono duomenis
.csv formatu.

Atidaro „Setup Wizard“ (sąrankos vedlys), kuriame galite nustatyti
dabartinės plokštelės schemos ir analizės parametrus. Parinktį „Setup
Wizard“ (sąrankos vedlys) galite naudoti prieš paleidimą, jo metu arba po
jo.
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Dialogo lange „User Preferences“ (naudotojo nuostatos) atidaroma
kortelė „Plate“ (plokštelė), kuriame galite nustatyti plokštelės schemos
parametrus ir sukurti arba pašalinti taikinio, mėginio ir biologinės grupės
pavadinimus. Jūsų kortelėje „Plate“ (plokštelė) atliktus pakeitimus galite
rasti kitą kartą atidarę „Plate Editor“ (plokštelės redaktorius).

Rodomi būtini veiksmai plokštelei nustatyti ir šulinėliams įkelti.
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Plokštelės failo sukūrimas plokštelės redaktoriumi
Naudodami „Protocol Editor“ (plokštelės redaktorius) galite kurti pasirinktinius plokštelių failus. Taip pat
galite redaguoti ir įrašyti anksčiau įrašytus plokštelių failus arba pavyzdinius plokštelių failus, pridėtus prie
„CFX Opus Dx“ sistemos.

Norėdami sukurti naują plokštelės failą, atlikite šiuos veiksmus:

n Atidarykite plokštelės failą per „Plate Editor“ (plokštelės redaktorius).

n Pasirinkite plokštelės tipą.

Pastaba. Plokštelės faile nurodytas plokštelės tipas turi būti toks pats kaip reakcijos modulyje.

n Pasirinkite, kokį nuskaitymo režimą naudoti protokole.

n Pasirinkite, kokius fluoroforus naudoti plokštelėje.

n Pasirinkite mėginio tipą, taikinius ir mėginius.

n Jei reikia, pasirinkite technines kopijas.

n Įrašykite plokštelės išdėstymą.

Patarimas. Norėdami sukurti naują plokštelę iš anksčiau įrašytų arba pavyzdinių plokštelių failų, žr.
Esamo plokštelės failo atidarymas plokštelės redaktoriumi, p. 134.

Naujos plokštelės failo atidarymas plokštelės redaktoriumi
„CFX Maestro Dx SE“ turi kelias galimybes naujos plokštelės failui atidaryti:

n Lange „Home“ (pagrindinis)

n Dialogo lange „Startup Wizard“ (paleisties vedlys)

n Dialogo lange „Run Setup“ (paleidimo sąranka)

Naujos plokštelės failo atidarymas lange „Home“ (pagrindinis)

u Pasirinkite „File > New > Plate“ (failas > naujas > plokštelė).

Atidaromas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodomas numatytasis plokštelės
failas pasirinktam prietaisui.

Patarimas. Daugiau informacijos apie numatytojo plokštelės failo nustatymą žr. Numatytųjų
failų nuostatų keitimas, p. 85.
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Kaip atidaryti naujos plokštelės failą lange „Startup Wizard“ (paleisties vedlys)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atidarykite „Startup Wizard“ (paleisties
vedlys), jeigu jis dar nerodomas:

n Pasirinkite „View > Startup Wizard“ (peržiūrėti > paleisties vedlys).

n Įrankių juostoje spustelėkite „Startup Wizard“ (paleisties vedlys).

2. Jeigu reikia, išplečiamajame sąraše pasirinkite prietaiso tipą.

3. Norėdami sukurti naują plokštelę, spustelėkite „User-defined“ (naudotojo nustatytas) kaip paleidimo
tipą.

Atidaromas dialogo langas „Run Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Protocol“ 
(protokolas).

4. Spustelėkite kortelę „Plate“ (plokštelė) ir „Create New“ (kurti naują).

Atidaromas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodoma numatytoji plokštelės
schema pasirinktam prietaisui.

Kaip atidaryti naujos plokštelės failą dialogo lange „Run Setup“ (paleidimo sąranka)

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų ir atidarykite dialogo langą „Run Setup“ 
(paleidimo sąranka):

n Pasirinkite „Run > User-defined Run“ (paleidimas > naudotojo nustatytas paleidimas).

n Įrankių juostoje spustelėkite „User-defined Run Setup“ (naudotojo nustatyto paleidimo sąranka).

Dialogo langas „Run Setup“ (paleidimo sąranka) atidaro kortelę „Protocol“ (protokolas).

2. Norėdami sukurti naują plokštelę, spustelėkite kortelę „Plate“ (plokštelė) ir „Create New“ (kurti naują).

Atidaromas langas „Plate Editor“ (plokštelės redaktorius), kuriame rodoma numatytoji plokštelės
schema pasirinktam prietaisui.
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Esamo plokštelės failo atidarymas plokštelės redaktoriumi
„CFX Maestro Dx SE“ pateikia mėginių plokštelės failus, kuriuos galite redaguoti ir įrašyti kaip naują
plokštelę. Taip pat galite sukurti naują failą iš anksčiau įrašyto plokštelės failo.

Kaip atidaryti mėginio plokštelės failą

1. Lange „Home“ (pagrindinis) pasirinkite „File > Open > Plate“ (failas > atidaryti > plokštelė).

„Windows Explorer“ atidaromas „CFX Opus Dx“ sistemos aplanko „Sample files“ (mėginių failai)
vietoje.

2. Atidarykite aplanką „Sample files“ (mėginių failai), o tada – aplanką „Plates“ (plokštelės).

3. Pasirinkite plokštelės failą ir spustelėkite „Open“ (atidaryti).

Lange „Plate Editor“ (plokštelės redaktorius) atidaromas mėginių plokštelės failas.

4. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite plokštelės failą nauju pavadinimu ar
naujame aplanke.

Kaip atidaryti anksčiau įrašytą plokštelės failą

1. Lange „Home“ (pagrindinis) atlikite vieną iš šių veiksmų:

n Pasirinkite „File > Open > Plate“ (failas > atidaryti > plokštelė), raskite ir atidarykite taikinio
plokštelę ir spustelėkite „Open“ (atidaryti).

n Atidarykite „Startup Wizard“ (paleisties vedlys) ir atlikite vieną iš šių veiksmų:

o Norėdami redaguoti esamą plokštelės failą, spustelėkite „Select Existing“ (pasirinkti esamą)
ir raskite tikslinį failą.

o Norėdami redaguoti rodomą plokštelę, spustelėkite „Edit Selected“ (redaguoti pasirinktą).

Lange „Plate Editor“ (plokštelės redaktorius) atidaroma taikinio plokštelė.

2. Pasirinkite „File > Save As“ (failas > įrašyti kaip) ir įrašykite plokštelės failą nauju pavadinimu ar
naujame aplanke.
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Naujo plokštelės failo nustatymas
Patarimas. Jei jūsų plokštelės faile yra reikalingų parametrų (pvz., jei redaguojate mėginį ar esamą
plokštelės failą), galite šį skyrių praleisti. Tęskite, kaip nurodyta skirsnyje Pasirenkamųjų parametrų
priskyrimas plokštelės failui , p. 143.

Naujiems plokštelės failams reikalingi šie parametrai:

n „Plate size“ (plokštelės dydis)

n „Plate type“ (plokštelės tipas)

n Nuskaitymo režimas

n Vienas fluoroforas (dažas)

n Vienas mėginio tipas

Plokštelės dydžio ir tipo pasirinkimas

Svarbu. Plokštelės dydį turite pasirinkti per plokštelės sąranką. Negalite keisti plokštelės dydžio
paleidimo metu arba po jo.

Programinėje įrangoje plokštelės dydis ir tipas pritaikomi visiems šulinėliams. Įsitikinkite, kad pasirinktas
plokštelės dydis yra toks pat, kaip plokštelės, kurią naudosite per paleidimą.

„Bio-Rad“ „CFX Opus Dx“, sistemos yra sukalibruotos gamykloje daugeliui fluorescencinių dažų ir
plokštelių derinių. Kalibravimas priklauso nuo prietaiso, dažų ir plokštelės tipo. Įsitikinkite, kad fluoroforas,
kurį ketinate naudoti, sukalibruotas pagal pasirinktą plokštelės tipą.

Patarimas. Norėdami sukalibruoti naują prietaiso dažų ir plokštelės tipo derinį, pasirinkite „Tools >
Dye Calibration Wizard“ (įrankiai > dažų kalibravimo vedlys). Informaciją apie dažų ir plokštelių tipų
kalibravimą žr. dalyje Naujų dažų kalibravimas, p. 77.

Nuskaitymo režimo pasirinkimas

„CFX Opus 96 Dx“ ir „CFX Opus Deepwell Dx“ sistemos sužadina ir aptinka fluoroforus penkiuose
kanaluose (ir FRET). „CFX Opus 384 Dx“ sistema sužadina ir aptinka fluoroforus keturiuose kanaluose (ir
FRET). Visos sistemos taiko kelis duomenų gavimo nuskaitymo režimus fluorescencijos duomenims
paleidimo metu gauti.

„CFX Maestro Dx SE“ teikia tris skenavimo režimus:

n Visi kanalai

o Skenuojami „CFX Opus 96 Dx“ ir „CFX Opus Deepwell Dx“ sistemų 1–5 kanalai

o Skenuojami „CFX Opus 384 Dx“ sistemų 1–4 kanalai
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n SYBR®/FAM

o Skenuojamas tik 1 kanalas

o Galimas greitasis skenavimas

n FRET

o Skenuojamas tik FRET kanalas

o Galimas greitasis skenavimas

Fluoroforų pasirinkimas

Svarbu. Prieš pradedant paleidimą, CFX sistemos patikrina, ar jūsų plokštelėje nurodyti fluoroforai
yra kalibruoti su jūsų prietaisu. Negalite paleisti plokštelės, jeigu joje yra fluoroforų, kurie nebuvo
kalibruoti prietaise.

Prieš paleisdami į plokštelę turite įkelti bent vieną fluoroforą. Šiuo momentu galite pridėti tiek fluoroforų,
kiek reikia, bet plokštelėje turi būti bent vienas fluoroforas. Pasirinkti fluoroforai „Target Names“ (taikinių
pavadinimai) parodomi kaip taikinių parinktys.

Dialogo lange „Select Fluorophores“ (pasirinkti fluoroforus) įkeliate fluoroforus (arba plokštelės dažus)
„Plate Editor“ (plokštelės redaktorius) šulinėlių įkėlimo valdikliuose. Fluoroforai, parodomi dialogo lange
„Select Fluorophores“ (pasirinkti fluoroforus), priklauso nuo jūsų pasirinkto nuskaitymo režimo.

n Visi kanalai

Parodomi visi galimi fluoroforai.

Patarimas. Galite pridėti tiek fluoroforų, kiek reikia, tačiau į kiekvieną šulinėlį vienam kanalui
galite įdėti tik vieną fluoroforą.

n SYBR®/FAM

Parodomi tik 1 kanalo fluoroforai.

n FRET

Parodomas tik 6 kanalo fluoroforas.

Patarimas. 6 kanalo FRET fluoroforas rodomas tik tada, kai FRET yra pasirinktas nuskaitymo
režimas. Jis negalimas „All Channels“ (visi kanalai) nuskaitymo režimu.

Pastaba. Jūs negalite fluoroforų pridėti tiesiogiai į dialogo langą „Select Fluorophore“ (pasirinkti
fluoroforą) arba iš jo pašalinti. Privalote naujus fluoroforus kalibruoti naujame prietaise naudodami
„Dye Calibration Wizard“ (dažų kalibravimo vedlys). Po kalibravimo naujas fluoroforas automatiškai
įtraukiamas į sąrašą. Daugiau informacijos žr. Naujų dažų kalibravimas, p. 77.
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Mėginių tipų pasirinkimas

Svarbu. Prieš paleisdami turite pasirinkti bent vieną mėginio tipą, kurį priskirti plokštelių šulinėliams.

„CFX Maestro Dx SE“ galimi penki mėginių tipai:

n „Unknown“ (nežinomas)

n „Standard“ (standartinis)

n NTC (kontrolė be šablono)

n „Positive Control“ (teigiama kontrolė)

n „Negative Controlׅ“ (neigiama kontrolė)

n NRT (be atvirkštinės transkriptazės)

Priskiriate mėginių tipus plokštelių šulinėliams.

Naujos plokštelės nustatymas

Kaip nustatyti naują plokštelę

1. Lange „Plate Editor“ (plokštelės redaktorius) atidarykite naują plokštelę.

2. Norėdami nustatyti plokštelės dydį, pasirinkite „Settings > Plate Size“ (nuostatos > plokštelės dydis) ir
išplečiamajame meniu pasirinkite tinkamą plokštelės dydį.

3. Norėdami nustatyti plokštelės tipą, pasirinkite „Settings > Plate Type“ (nuostatos > plokštelės tipas),
o tada išplečiamajame meniu pasirinkite „BR White“ (BR baltas) arba „BR Clear“ (BR skaidrus).

4. Arba galite meniu „Settings“ (nuostatos) keisti skaičių rašymo išraišką ir rodomus matavimo vienetus:

n Norėdami pakeisti numeravimo tvarką, pasirinkite „Settings > Number Convention“ (nuostatos >
skaičių rašymo išraiška), o tada pasirinkite „Scientific Notation“ (standartinė skaičiaus išraiška).

Patarimas. Pagal numatytąsias nuostatas pasirinkta „Scientific Notation“ (standartinė
skaičiaus išraiška). Tokiu atveju pasirinkus „Scientific Notation“ (standartinė skaičiaus
išraiška), numatytoji nuostata pašalinama ir nustatoma standartinės formos skaičių rašymo
išraiška.

n Norėdami pakeisti rodomus vienetus, pasirinkite „Settings > Units“ (nuostatos > matavimo
vienetai) ir pasirinkite naują matavimo vieneto reikšmę.

5. Norėdami nustatyti nuskaitymo režimą, pasirinkite tinkamą nuskaitymo režimą išplečiamajame
sąraše „Scan Mode“ (nuskaitymo režimas), esančiame lango „Plate Editor“ (plokštelės redaktorius)
įrankių juostoje.
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6. Pasirinkite reikiamus plokštelės flouroforus:

a. Dešiniojoje srityje spustelėkite „Select Fluorophores“ (pasirinkti flouroforus).

Pasirodo dialogo langas „Select Fluorophores“ (pasirinkti flouroforus). Pamatysite fluoroforus,
skirtus nuskaitymo režimo tipui, kurį pasirinkote atlikdami 5 veiksmas, pavyzdžiui:

b. Norėdami pasirinkti fluoroforą, spustelėkite jo žymės langelį.

Patarimas. Norėdami pašalinti iš sąrašo fluoroforą, pašalinkite jo žymės langelio „Selected“ 
(pasirinkta) žymėjimą.

c. Norėdami pakeisti fluoroforo rodmens spalvą, spustelėkite jo spalvą stulpelyje „Color“ (spalvos).

Pastaba. Jūsų pasirinkta spalva fluoroforas rodomas lange „Plate Editor“ (plokštelės
redaktorius) ir lango „Data Analysis“ (duomenų analizė) diagramose.

d. Dialogo lange „Color“ (spalva) pasirinkite norimą spalvą arba spustelėkite „Define Custom
Colors“ (nustatyti pasirinktines spalvas) ir sukurkite naują spalvą, kuria turi būti rodomas
fluoroforas.

e. Spustelėkite OK (gerai), įrašykite pakeitimus ir išeikite iš dialogo lango „Select Fluorophores“ 
(pasirinkti flouroforus).
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7. Turite pasirinkti bent vieną šulinėlį, į kurį turi būti įkeliamas mėginio tipas. Pagal numatytąsias
nuostatas pasirinktas šulinėlis A1.

Plokštelių srityje atlikite vieną iš toliau nurodytų veiksmų:

n Tam, kad įkeltumėte kelis gretimus šulinėlius, spustelėkite šulinėlį ir vilkite iki taikinio šulinėlio.

n Tam, kad įkeltumėte kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ (valdymas)
ir spustelėkite kiekvieną šulinėlį.

n Tam, kad įkeltumėte visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Tam, kad įkeltumėte visą eilutę, spustelėkite eilutės numerį.

n Tam, kad įkeltumėte visą plokštelę, spustelėkite viršutinį kairįjį plokštelės kampą.

Pavyzdžiui:
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8. Išplečiamajame meniu „Sample Type“ (mėginio tipas) priskirkite mėginio tipą pasirinktam šulinėliui
arba šulinėliams.

9. Visiems šulinėliams, turintiems mėginio tipą, priskirkite bent vieną fluoroforą. Galite šulinėliui ar
šulinėlių grupei priskirti daugiau nei vieną fluoroforą.

Pastaba. Vienam kanalui galite priskirti tik vieną fluoroforą. Jūs negalite priskirti daugiau nei
vieno fluoroforo iš to paties kanalo į tą patį šulinėlį.

Patarimas. Galite susieti taikinį su fluoroforu arba galite dabar tik priskirti fluoroforą, o taikinį su
fluoroforu susieti paskui, kai atliksite eksperimentą.

n Jei norite tik priskirti fluoroforą pasirinktiems šulinėliams, dešinės srities dalyje „Target Names“ 
(taikinių pavadinimai) pažymėkite konkretaus fluoroforo žymės langelį „Load“ (įkėlimas).

n Jei norite susieti taikinį su fluoroforu, dalyje „Target Names“ (taikinių pavadinimai)
išplečiamajame sąraše pasirinkite taikinio pavadinimą konkrečiam fluoroforui. Programinė
įranga automatiškai pažymi žymės langelį „Load“ (įkėlimas).

10. Jei šulinėliams priskirtas mėginio tipas yra „Standard“ (standartinis), turite įkelti koncentracijos
reikšmę. Kiekvieno šulinėlio koncentracijos reikšmė gali būti skirtinga. Pagal numatytąsias nuostatas
„CFX Maestro Dx SE“ įkelia 1.00E+06 koncentracijos reikšmę visiems šulinėliams, kuriems priskirtas
mėginio tipas yra „Standard“ (standartinis). Jei reikia, galite pakeisti reikšmę.

a. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę „Standard“ (standartinis).

b. Dalyje „Concentration“ (koncentracija) spustelėkite „Load“ (įkėlimas), kad įkeltumėte pasirinkto
šulinėlio arba šulinėlių reikšmę.

c. (Neprivaloma) Norėdami įkelti kitą koncentracijos reikšmę, tekstiniame langelyje „Concentration“ 
(koncentracija) įrašykite naują reikšmę ir paspauskite „Enter“ (įvesti).

d. Atlikite šį veiksmą visiems šulinėliams, kurių mėginio tipas yra „Standard“ (standartinis).
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Patarimas. Tam, kad įkeltumėte tą pačią koncentracijos reikšmę visiems šulinėliams, kurie
yra „Standard“ (standartinis), įsitikinkite, kad išplečiamajame sąraše po „Concentration“ 
(koncentracija) reikšme rodoma „<All>“ (visi). Tam, kad įkeltumėte tą pačią koncentracijos
reikšmę visiems šulinėliams, kuriems priskirtas konkretus fluoroforas, spustelėkite
išplečiamąjį sąrašą ir pasirinkite fluoroforą.

11. Spustelėkite mygtuką OK (gerai), kad įrašytumėte naują plokštelę.
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„Plate Editor Tool“ (plokštelės redaktoriaus įrankio) dešiniojo mygtuko meniu
elementai

9 lent. pateikiami meniu elementai, matomi įrankyje „Plate Editor“ (plokštelės redaktorius) dešiniuoju
pelės mygtuku paspaudus bet kurį įrankyje esantį šulinėlį. Šis meniu taip pat rodomas „Spreadsheet
View/Importer“ (skaičiuoklės rodinyje / importavimo įrankyje).

Elementas Funkcija

„Copy“ (kopijuoti) Nukopijuoja visą skaičiuoklę.

„Copy as Image“ 
(kopijuoti kaip
paveikslėlį)

Nukopijuoja skaičiuoklę kaip vaizdo failą.

„Print“ (spausdinti) Atspausdina skaičiuoklę.

„Print Selection“ 
(spausdinti pasirinkimą)

Atspausdinami tik pasirinkti langeliai.

„Export to Excel“ 
(eksportuoti į „Excel“)

Eksportuoja failą į „Excel“ skaičiuoklę.

„Export to Csv“ 
(eksportuoti į Csv)

Eksportuoja failą .csv formatu.

„Export to Xml“ 
(eksportuoti į Xml)

Eksportuoja failą .xml formatu.

„Export to Html“ 
(eksportuoti į Html)

Eksportuoja failą .html formatu.

„Find“ (ieškoti) Ieško konkretaus teksto.

„Sort“ (rūšiuoti) Rūšiuoja skaičiuoklę pasirinkus iki trijų duomenų stulpelių lange
„Sort“ (rūšiuoti).

9 lent. Įrankio „Plate Spreadsheet View/Importer“ (plokštelės skaičiuoklės peržiūra /
importavimo įrankis) pelės dešiniojo mygtuko meniu elementai
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Pasirenkamųjų parametrų priskyrimas plokštelės failui
Plokštelės faile yra informacijos apie kiekvieno šulinėlio, į kurį įdėta mėginio paleisti, turinį. Po paleidimo
programinės įrangos „CFX Maestro Dx SE“ susieja šulinėlio turinį su fluorescencijos duomenimis, gautais
įgyvendinus protokolą, ir lange „Data Analysis“ (duomenų analizė) atliekama atitinkama analizė.

Prieš eksperimento paleidimą, paleidžiant ar net po paleidimo „CFX Maestro Dx SE“ kiekvienam
plokštelės šulinėliui galite priskirti parametrus. Galite priskirti parametrus esančiame plokštelės faile arba
naujame plokštelės faile. Tai šie parametrai:

n „Target names“ (taikinių pavadinimai) – kiekvieno įdėto šulinėlio objekto taikinys ar taikiniai
(genai ar sekos).

n „Sample names“ (mėginių pavadinimai) – identifikatorius ar būsena, kuri atitinka mėginį
kiekviename šulinėlyje, pvz., mouse1, mouse2 arba mouse3.

n „Biological groups“ (biologinės grupės) – identifikatorius arba būsena, kuri atitinka šulinėlių
grupę, pvz., 0Hr, 1Hr arba 2Hr.

Patarimas. Taikinių pavadinimai, mėginių pavadinimai ir biologinės grupės turi būti tokie patys
tarp šulinėlių, kad būtų galima palyginti duomenis kortelėje „Gene Expression“ (geno ekspresija)
lange „Data Analysis“ (duomenų analizė). Kiekvienas pavadinimas turi būti tokiomis pačiomis
didžiosiomis raidėmis, skyryba ir tarpais. Pavyzdžiui, „Actin“ nėra tas pats, kas „actin“, „2Hr“ nėra
tas pats, kas „2 hr“, o „Pelė 1“ nėra tas pats, kas „pelė1“. Norėdami užtikrinti pavadinimų
nuoseklumą, įveskite vardus skyriuje „Libraries“ (bibliotekos) dalies „User > User Preferences >
Plate“ (naudotojas > naudotojo nuostatos > plokštelė) pagrindiniame lange.

n „Technical replicates“ (techninės kopijos) – kiekvienas šulinėlis, kuris naudojamas analizuojant
tokį patį mėginių ir taikinių derinį, tai yra pakartojant qPGR reakcijas.

n Skiedimo serijos – kiekis, skirtas pakeisti „Standard“ (standartinis) mėginio tipo koncentraciją kopijų
grupėje, kad būtų sukurta standartinė duomenų kreivė analizei.

Taikinio priskyrimas šulinėliams
Patarimas. Tokio paties pavadinimo taikinį galite priskirti vienam ar keliems šulinėliams. Taip pat
galite kelis taikinius priskirti tam pačiam šulinėliui.

Svarbu. Spustelėjus OK (gerai), kai priskyrėte taikinius, pakeitimai bus įrašyti ir išjungtas „Undo“ 
(anuliuoti), esantis įrankių juostoje„Plate Editor“ (plokštelės redaktorius). Būkite atsargūs, kai
spustelite OK (gerai).
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Taikinio priskyrimas šulinėliui ar šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad šulinėliui ar šulinėlių grupei buvo
priskirtas mėginio tipas.

Informacijos apie mėginių tipų priskyrimą šulinėliams žr. Mėginių tipų pasirinkimas, p. 137.

2. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę:

n Norėdami pasirinkti atskirą šulinėlį, jį spustelėkite.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ (valdymas)
ir spustelėkite kiekvieną šulinėlį.

n Norėdami pasirinkti visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Norėdami pasirinkti visą eilutę, spustelėkite eilutės numerį.

3. Dešiniajame lange iš išplečiamojo sąrašo „Target Name“ (taikinio pavadinimas) pasirinkite kiekvieno
pasirinkto fluoroforo pavadinimą.

4. Kiekvienam šulinėliui ar šulinėlių grupei, kuriai turite priskirti taikinį, turi būti kartojamas 3 veiksmas.

Patarimas. Kiekvienam pasirinktam fluoroforui galite priskirti tokį patį ar skirtingą taikinio
pavadinimą.

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Pastaba. Jeigu plokštelę pakeitėte per klaidą, prieš spustelėdami OK (gerai) ir patvirtindami
pakeitimus lango „Plate Editor“ (plokštelės redaktorius) įrankių juostoje spustelėkite „Undo“ 
(anuliuoti).

Taikinio pavadinimo šalinimas

u Norėdami pašalinti taikinio pavadinimą iš pasirinkto šulinėlio ar šulinėlių grupės, pašalinkite jo žymės
langelio „Load“ (įkėlimas) žymėjimą.

Svarbu. Pašalinus šulinėlio taikinio pavadinimą, taip pat pašalinamas jo susijęs fluoroforas.
Būkite atsargūs šalindami šulinėlio taikinio pavadinimą.
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Taikinio pavadinimo įtraukimas į sąrašą

u Norėdami taikinio pavadinimą įtraukti į išplečiamąjį sąrašą, atlikite šiuos veiksmus:

n Išplečiamajame sąraše „Target Name“ (taikinio pavadinimas) įrašykite pavadinimą ir
paspauskite „Enter“ (įvesti).

Patarimas. Viename sąraše įrašyti taikinio pavadinimai rodomi visuose kituose taikinių
sąrašuose.

n Išplečiamojo sąrašo dešinėje spustelėkite žalią + simbolį, įrašykite taikinio pavadinimą ir
paspauskite „Enter“ (įvesti).

n Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos) ir bibliotekoje „Target
Names“ (taikinio pavadinimas), esančioje kortelėje „Plate“ (plokštelė), įrašykite pavadinimą.

Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti taikinių pavadinimai taikomi tik naudojamai plokštelei ir
tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą. Jeigu šulinėliui
nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas neįrašomas ir jo negalima
naudoti ateityje. Norėdami taikinio pavadinimą įrašyti visam laikui, jį taip pat įrašykite į biblioteką
„Target Names“ (taikinių pavadinimai) naudodami dialogo langą „User Preferences“ (naudotojo
nuostatos). Jūsų į biblioteką įtrauktus pavadinimus bus galima naudoti jums vėl atidarius langą
„Plate Editor“ (plokštelės redaktorius). Daugiau informacijos žr. Numatytųjų plokštelės
parametrų nustatymas, p. 88.

Taikinio pavadinimo šalinimas iš sąrašo

1. Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (naudotojo nuostatos), kuriame rodoma kortelė
„Plate“ (plokštelė).

2. Bibliotekoje „Target Names“ (taikinių pavadinimai), esančioje kortelėje „Plate“ (plokštelė), pasirinkite
šalinamą pavadinimą ir paspauskite klavišą „Delete“ (šalinti).

3. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei išeikite iš dialogo lango „User Preferences“ 
(naudotojo nuostatos).

Svarbu. Negalite pašalinti taikinių pavadinimų, kuriuos įrašėte su plokštelės failu. Pasirinktiniai
pavadinimai, kuriuos įrašėte į išplečiamąjį sąrašą „Target Names“ (taikinių pavadinimai),
nenaudojote ir įrašėte su plokštele, yra automatiškai pašalinami iš sąrašo. Pavadinimai, kuriuos
pašalinate iš bibliotekos „Target Names“ (taikinių pavadinimai), yra visam laikui pašalinami iš
programinės įrangos ir naudotojas daugiau jų naudoti negali. Būkite atsargūs, kai šalinate
taikinio pavadinimus.
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Mėginio pavadinimo priskyrimas šulinėliams
Pastaba. Tam, kad priskirtumėte mėginio pavadinimą, turite pasirinktiems šulinėliams priskirti bent
vieną fluoroforą. Jei pasirinktiems šulinėliams nepriskirtas fluoroforas, išplečiamasis sąrašas
„Sample Names“ (mėginių pavadinimai) išjungtas. Informacijos apie fluoroforų priskyrimą žr. Taikinio
priskyrimas šulinėliams, p. 143.

Patarimas. Galite priskirti tik vieną mėginio pavadinimą kiekvienam šulinėliui arba šulinėlių grupei.

Mėginio pavadinimo priskyrimas šulinėliui ar šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad šulinėliui arba šulinėlių grupei buvo
priskirtas fluoroforas.

2. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę.

3. Dešiniojoje srityje iš išplečiamojo sąrašo „Sample Names“ (mėginių pavadinimai) pasirinkite
pavadinimą.

Programinė įranga automatiškai pažymi žymės langelį „Load“ (įkėlimas).

4. Kiekvienam šulinėliui ar šulinėlių grupei, kuriai turite priskirti mėginio pavadinimą, turi būti kartojamas
3 veiksmas.

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Pastaba. Jeigu plokštelę pakeitėte per klaidą, prieš spustelėdami OK (gerai) ir patvirtindami
pakeitimus lango „Plate Editor“ (plokštelės redaktorius) įrankių juostoje spustelėkite „Undo“ 
(anuliuoti).

Mėginio pavadinimo šalinimas

u Norėdami pašalinti mėginio pavadinimą iš pasirinkto šulinėlio ar šulinėlių grupės, pašalinkite jo
žymės langelio „Load“ (įkėlimas) žymėjimą.

Mėginio pavadinimo įtraukimas į sąrašą

u Norėdami mėginio pavadinimą įtraukti į išplečiamąjį sąrašą, atlikite vieną iš toliau nurodytų veiksmų:
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n Išplečiamajame sąraše „Sample Names“ (mėginių pavadinimai) įrašykite pavadinimą ir
paspauskite „Enter“ (įvesti).

n Išplečiamojo sąrašo dešinėje spustelėkite žalią + simbolį ir įrašykite mėginio pavadinimą.

n Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos) ir bibliotekoje „Sample
Names“ (mėginių pavadinimai), esančioje kortelėje „Plate“ (plokštelė), įrašykite pavadinimą.

Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti mėginių pavadinimai taikomi tik naudojamai plokštelei
ir tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą. Jeigu šulinėliui
nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas neįrašomas ir jo negalima
naudoti ateityje. Norėdami mėginio pavadinimą įrašyti visam laikui, jį taip pat įrašykite į biblioteką
„Sample Names“ (mėginių pavadinimai), naudodami dialogo langą „User Preferences“ 
(naudotojo nuostatos). Jūsų į biblioteką įtrauktus pavadinimus bus galima naudoti jums vėl
atidarius langą „Plate Editor“ (plokštelės redaktorius). Daugiau informacijos žr. Numatytųjų
plokštelės parametrų nustatymas, p. 88.

Mėginio pavadinimo šalinimas iš sąrašo

1. Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (naudotojo nuostatos), kuriame rodoma kortelė
„Plate“ (plokštelė).

2. Bibliotekoje „Sample Names“ (mėginių pavadinimai), esančioje kortelėje „Plate“ (plokštelė),
pasirinkite šalinamą pavadinimą ir paspauskite klavišą „Delete“ (šalinti).

3. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei išeikite iš dialogo lango „User Preferences“ 
(naudotojo nuostatos).

Svarbu. Negalite pašalinti mėginių pavadinimų, kuriuos įrašėte su plokštelės failu. Pasirinktiniai
pavadinimai, kuriuos įrašėte į sąrašą „Sample Names“ (mėginių pavadinimai), nenaudojote ir
įrašėte su plokštele, yra automatiškai pašalinami iš išplečiamojo sąrašo. Pavadinimai, kuriuos
pašalinate iš bibliotekos „Sample Names“ (mėginių pavadinimai), yra visam laikui pašalinami iš
programinės įrangos ir naudotojas daugiau negali jų naudoti. Šalindami mėginių pavadinimus,
būkite atidūs.

Biologinių grupių priskyrimas šulinėliams
Pastaba. Tam, kad priskirtumėte biologinę grupę, turite pasirinktiems šulinėliams priskirti bent vieną
fluoroforą. Priskyrus fluoroforą, įjungiamas išplečiamasis sąrašas „Biological Groups“ (biologinės
grupės). Informacijos apie fluoroforų priskyrimą žr. Taikinio priskyrimas šulinėliams, p. 143.

Patarimas. Galite priskirti vieną biologinę grupę kiekvienam šulinėliui arba šulinėlių grupei.
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Norėdami priskirti biologinę grupę šulinėliui ar šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad šulinėliui arba šulinėlių grupei buvo
priskirtas fluoroforas.

2. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę.

3. Dešiniojoje srityje pasirinkite elementą iš išplečiamojo sąrašo „Biological Group“ (biologinė grupė).

„CFX Maestro Dx SE“ automatiškai pažymi žymės langelį „Load“ (įkėlimas).

4. Kiekvienam šulinėliui ar šulinėlių grupei, kuriai turite priskirti biologinę grupę, turi būti kartojamas 3
veiksmas.

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Pastaba. Jeigu plokštelę pakeitėte per klaidą, prieš spustelėdami OK (gerai) ir patvirtindami
pakeitimus lango „Plate Editor“ (plokštelės redaktorius) įrankių juostoje spustelėkite „Undo“ 
(anuliuoti).

Norėdami pašalinti biologinę grupę

u Norėdami pašalinti biologinę grupę iš pasirinkto šulinėlio ar šulinėlių grupės, išvalykite žymės
langelio „Load“ (įkėlimas) žymėjimą.

Norėdami įtraukti biologinę grupę į sąrašą

u Norėdami įtraukti biologinę grupę į išskleidžiamąjį sąrašą, atlikite vieną iš šių veiksmų:

n Išplečiamajame laukelyje „Biological Group“ (biologinė grupė) įrašykite pavadinimą ir
paspauskite „Enter“ (įvesti).

n Išplečiamojo sąrašo dešinėje spustelėkite žalią + simbolį ir įrašykite biologinės grupės
pavadinimą.

n Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos) ir bibliotekoje „Biological
Group Names“ (biologinių grupių pavadinimai), esančioje kortelėje „Plate“ (plokštelė), įrašykite
pavadinimą.
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Svarbu. Jūsų į išplečiamąjį sąrašą įrašyti biologinių grupių pavadinimai taikomi tik naudojamai
plokštelei ir tik jeigu pavadinimą priskiriate šulinėliui ir įrašote plokštelės schemą. Jeigu šulinėliui
nepriskiriate pavadinimo ir įrašote plokštelės schemą, pavadinimas neįrašomas ir jo negalima
naudoti ateityje. Norėdami biologinės grupės pavadinimą įrašyti visam laikui, jį taip pat įtraukite į
biblioteką „Biological Group Names“ (biologinių grupių pavadinimai), naudodami dialogo langą
„User Preferences“ (naudotojo nuostatos). Jūsų į biblioteką įtrauktus pavadinimus bus galima
naudoti jums vėl atidarius langą „Plate Editor“ (plokštelės redaktorius). Daugiau informacijos žr.
Numatytųjų plokštelės parametrų nustatymas, p. 88.

Kaip pašalinti biologinės grupės pavadinimą iš sąrašo

1. Įrankių juostoje spustelėkite „User Preferences“ (naudotojo nuostatos).

Parodomas dialogo langas „User Preferences“ (naudotojo nuostatos), kuriame rodoma kortelė
„Plate“ (plokštelė).

2. Bibliotekoje „Biological Group Names“ (biologinių grupių pavadinimai), esančioje kortelėje „Plate“ 
(plokštelė), pasirinkite šalinamą pavadinimą ir paspauskite klavišą „Delete“ (šalinti).

3. Spustelėkite OK (gerai) ir įrašykite pakeitimus bei išeikite iš dialogo lango „User Preferences“ 
(naudotojo nuostatos).

Svarbu. Negalite pašalinti biologinių grupių pavadinimų, kuriuos įrašėte su plokštelės failu.
Pasirinktiniai pavadinimai, kuriuos įrašėte į išplečiamąjį sąrašą „Biological Group Names“ 
(biologinių grupių pavadinimai), nenaudojote ir įrašėte su plokštele, yra automatiškai pašalinami
iš sąrašo. Pavadinimai, kuriuos pašalinate iš bibliotekos „Biological Group Names“ (biologinių
grupių pavadinimai), yra visam laikui pašalinami iš programinės įrangos, ir naudotojas daugiau
negali jų naudoti. Būkite atsargūs, kai šalinate biologinius pavadinimus.

Kaip peržiūrėti visas biologines grupes plokštelėje

u Spustelėkite „Show Biological Groups“ (rodyti biologines grupes) ir peržiūrėkite visas biologines
grupes plokštelėje.

Kiekviena grupė identifikuojama konkrečia spalva, o mygtukas „Show Biological Groups“ (rodyti
biologines grupes) pakeičiamas į „Hide Biological Groups“ (slėpti biologines grupes).
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Spustelėkite „Hide Biological Groups“ (slėpti biologines grupes) ir pašalinkite šulinėlių spalvas. Taip
pat galite spustelėti bet kurį šulinėlį plokštelėje ir paslėpti biologines grupes.

Techninių kopijų skaičiaus priskyrimas šulinėliams
Svarbu. Kad būtų galima priskirti techninių kopijų skaičių, pasirinkti šulinėliai turi būti su identišku
šulinėlių turiniu. Tai yra pasirinkti šulinėliai turi būti tokio paties mėginio tipo ir fluoroforo. Jeigu
taikoma, jiems taip pat turi būti priskirtas toks pats taikinio ir mėginio pavadinimas bei tokia pati
biologinė grupė. Jeigu jie ne tokie patys, „CFX Maestro Dx SE“ šios parinkties neįjungia.

Techninių kopijų skaičiaus priskyrimas šulinėlių grupei

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, ar šulinėlių grupės turinys yra vienodas.

2. Plokštelių lange pasirinkite šulinėlių grupės taikinį.

3. Norėdami tokį patį kopijos numerį priskirti visiems pasirinktiems šulinėliams, dešiniojoje srityje
skyriuje „Replicate #“ (kopijos Nr.) į langelį įrašykite kopijos numerį ir pasirinkite „Load“ (įkėlimas).

4. (Neprivaloma) Norėdami kopijų serijas taikyti pasirinktų šulinėlių rinkiniui, atlikite šiuos veiksmus:

a. Spustelėkite „Technical Replicates“ (techninės kopijos). Pasikeičia skyrius „Replicate #“ (kopijos
Nr.), kad būtų parodytos šios parinktys:

n „Replicate size“ (kopijos dydis) – skaičius, kuris reiškia šulinėlių kiekvienoje kopijų
grupėje, skaičių

n „Starting replicate #“ (pradinės kopijos Nr.) – pasirinktos kopijų grupės pirmasis
numeris kopijų serijoje
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Pastaba. Pagal numatytuosius parametrus „CFX Maestro Dx SE“ rodo pradinės kopijos
numerį kaip didesnį skaičių nei paskutinį techninės kopijos skaičių, priskirtą plokštelei.
Pavyzdžiui, jeigu paskutinis techninės kopijos numeris plokštelėje yra penki, kitas pradinis
skaičius yra šeši. Pradinį numerį galite pakeisti į bet kurį dar nepriskirtą numerį.

n Įkėlimo kryptis (horizontali ar vertikali)

b. Spustelėkite „Apply“ (taikyti) ir pritaikykite parametrus serijai bei grįžkite į rodmenį „Replicate #“ 
(kopijos Nr.).

5. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Pastaba. Jeigu plokštelę pakeitėte per klaidą, prieš spustelėdami OK (gerai) ir patvirtindami
pakeitimus lango „Plate Editor“ (plokštelės redaktorius) įrankių juostoje spustelėkite „Undo“ 
(anuliuoti).

Šulinėlio pašalinimas iš kopijų serijos

u Pasirinkite šalinamą šulinėlį ar šulinėlių grupę ir panaikinkite žymės langelio „Replicate # Load“ 
(kopijos numerio įkėlimas) žymėjimą.

Taip pat galite spustelėti „Clear Replicate #“ (išvalyti kopijos Nr.) ir iš pasirinkto šulinėlio ar šulinėlių
grupės pašalinti kopijos numerį.

Visų techninių kopijų plokštelėje peržiūrėjimas

u Spustelėkite „Show Technical Replicates“ (rodyti technines kopijas) ir peržiūrėkite visas technines
kopijas plokštelėje.

Kiekviena grupė identifikuojama konkrečia spalva, o mygtukas „Show Technical Replicates“ (rodyti
technines kopijas) pakeičiamas „Hide Technical Replicate“ (slėpti technines kopijas).

Spustelėkite „Hide Technical Replicates“ (slėpti technines kopijas), kad pašalintumėte šulinėlių
spalvas. Taip pat galite spustelėti bet kurį šulinėlį plokštelėje ir paslėpti technines kopijas.

Skiedimo serijų priskyrimas standartinių tipų mėginiams
Kaip jau minėta, visiems šulinėliams su standartinio tipo mėginiais turi būti priskirta koncentracijos
reikšmė. Skiedimo serijas galite priskirti keliems šulinėliams su standartinio tipo mėginiais.

Pastaba. Norint skiedimo serijas priskirti šulinėlių grupei, šulinėliai turi būti įtraukti į techninių kopijų
serijas. Informacijos apie šulinėlių įtraukimą į kopijų serijas žr. skirsnyje Techninių kopijų skaičiaus
priskyrimas šulinėliams, p. 150.
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Skiedimo serijų priskyrimas grupei šulinėlių su standartiniais mėginiais

1. Lange „Plate Editor“ (plokštelės redaktorius) įsitikinkite, kad įvykdyti šie reikalavimai:

n Šulinėlių grupės mėginių tipas yra „Standard“ (standartinis).

n Visiems grupės šulinėliams yra priskirtas bent vienas fluoroforas ir jie visi turi tuos pačius
fluoroforus.

n Visi grupės šulinėliai yra įtraukti į tą pačią techninių kopijų seriją.

Pastaba. „CFX Maestro Dx SE“ įjungia parinktį „Dilution Series“ (skiedimo serijos) tik tuo
atveju, jei visi pasirinkti šulinėliai atitinka šiuos kriterijus.

2. Plokštelių lange pasirinkite šulinėlių grupės taikinį.

3. Dešiniojoje srityje esančioje dalyje „Concentration“ (koncentracija) spustelėkite „Dilution series“ 
(skiedimo serijos). Dalis „Concentration“ (koncentracija) pasikeičia, kad būtų parodytos šios
parinktys:

n „Starting concentration“ (pradinė koncentracija) – koncentracijos reikšmė, nuo kurios
prasideda serijos

n „Replicates from and to“ (kopijos nuo ir iki) – kopijos serijoje, kuriai bus taikomas skiedimo
koeficientas

n „Dilution factor“ (skiedimo koeficientas) – kiekis, kuriuo siekiama pakeisti koncentraciją
kiekvienoje kopijų grupėje

4. Nustatykite parinkčių reikšmes arba patvirtinkite numatytąsias.

5. Pagal numatytąsias nuostatas skiedimo serijos sumažinamos skiedimo koeficientu. Norėdami
padidinti skiedimo seriją, pasirinkite „Increasing“ (didinti).

6. (Neprivaloma) Pagal numatytąsias nuostatas skiedimo koeficientas taikomas visiems fluoroforams
kopijų serijose. Jei jūsų serijoje yra daugiau nei vienas fluoroforas ir norite taikyti skiedimą vienam
fluoroforui, pasirinkite jį iš išplečiamojo sąrašo.
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7. Spustelėkite „Apply“ (taikyti), kad skiedimo serijos būtų taikomos šulinėlių grupei, ir grįžkite į rodmenį
„Concentration“ (koncentracija).

8. Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.

Šulinėlio turinio kopijavimas į kitą šulinėlį
Galite nukopijuoti šulinėlio turinį ir įklijuoti jį į vieną ar kelis šulinėlius. Tačiau galite kopijuoti tik vieno
šulinėlio turinį. Negalite pasirinkti kelių šulinėlių ir kopijuoti jų turinio.

Kaip nukopijuoti šulinėlio turinį į kitą šulinėlį

1. Plokštelės srityje pasirinkite šulinėlį, kurio turinį norite kopijuoti.

2. Pelės dešiniuoju mygtuku spustelėkite šulinėlį ir pasirinkite „Copy Well“ (kopijuoti šulinėlį).

3. Pasirinkite šulinėlį ar šulinėlius, į kuriuos norite įklijuoti turinį:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ (valdymas)
ir spustelėkite kiekvieną šulinėlį.

4. Pasirinkę norimus šulinėlius, spustelėkite dešinįjį pelės mygtuką ir pasirinkite „Paste Well“ (įklijuoti
šulinėlį).

„CFX Maestro Dx SE“ įklijuoja pirmojo šulinėlio turinį į pasirinktus šulinėlius.

Pastabos pridėjimas prie šulinėlio
Prie šulinėlio galite pridėti aiškinamąją pastabą. Galite peržiūrėti šulinėliui skirtas pastabas lango „Data
Analysis“ (duomenų analizė) kortelėje „Quantification“ (kiekybinis įvertinimas).

Kaip pridėti pastabą prie šulinėlio

1. Plokštelių srityje pasirinkite šulinėlį ar šulinėlių grupę, prie kurios planuojate pridėti pastabą.

2. Apatinėje srityje esančioje dalyje „View“ (rodymas) pasirinkite „Well Note“ (šulinėliui skirta pastaba).

Dešiniojoje srityje parodomas laukas „Well Note“ (šulinėliui skirta pastaba).

3. Teksto laukelyje įrašykite pastabos turinį ir paspauskite „Enter“ (įvesti).

Tekstas rodomas pasirinktų šulinėlių apačioje.
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Patarimas. Jei sukūrėte ankstesnę šulinėliui skirtą pastabą, galite ją pasirinkti išplečiamajame
sąraše ir taikyti pasirinktiems šulinėliams.

Viso šulinėlių turinio išvalymas
Galite išvalyti visą atskiro šulinėlio, šulinėlių grupės arba visos plokštelės turinį. Išvalius šulinėlius,
fluorescencijos duomenys, surinkti skaitant plokštelę, nėra pašalinami.

Svarbu. Išvalius šulinėlį, jo turinys pašalinamas visam laikui. Paspaudę OK (gerai) ir įrašę plokštelę
po šulinėlio išvalymo, negalite anuliuoti išvalymo veiksmo. Būkite atsargūs valydami šulinėlius.

Kaip išvalyti visas šulinėlių nuostatas

1. Lange „Plate Editor“ (plokštelių redaktorius) pasirinkite šulinėlį ar jų grupę plokštelių srityje:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite šulinėlį ir nutempkite jį į norimą šulinėlį.

n Norėdami pasirinkti kelis negretimus šulinėlius, laikykite nuspaustą klavišą „Control“ (valdymas)
ir spustelėkite kiekvieną šulinėlį.

n Norėdami pasirinkti visą stulpelį su tokio paties tipo mėginiais, spustelėkite stulpelio numerį.

n Norėdami pasirinkti visą eilutę, spustelėkite eilutės numerį.

2. Dešiniojoje srityje spustelėkite „Clear Wells“ (išvalyti šulinėlius).

„CFX Maestro Dx SE“ išvalo visas pasirinktų šulinėlių nuostatas.

3. Atlikite vieną iš toliau nurodytų veiksmų:

n Jeigu šulinėlius išvalėte per klaidą, prieš spustelėdami OK (gerai) ir patvirtindami keitimus,
įrankių juostoje „Plate Editor“ (plokštelės redaktorius) spustelėkite „Undo“ (anuliuoti).

Svarbu. Spustelėjus OK (gerai) prieš „Undo“ (anuliuoti), įrašomi keitimai ir išjungiama
įrankių juostoje „Plate Editor“ (plokštelės redaktorius) esanti funkcija „Undo“ (anuliuoti).

n Spustelėkite OK (gerai) ir patvirtinkite pakeitimus bei įrašykite plokštelę.
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Eksperimento nuostatų keitimas
Dialogo lange „Experiment Settings“ (eksperimento nuostatos) pasižiūrėkite arba pakeiskite taikinių,
mėginių arba biologinių grupių taikinius arba nustatykite geno ekspresijos analizės mėginio grupę ir
išanalizuokite, ar jūs šulinėliams plokštelėje priskyrėte biologinių grupių.

Dialogo lango „Experiment Settings“ (eksperimento nuostatos) kortelėje „Targets“ (taikiniai) rodomas
taikinių pavadinimų kiekvienai PGR reakcijai sąrašas, pvz., taikinio geno ar tikslinių genų sekų.

Kortelėje „Samples“ (mėginiai) ir „Biological Groups“ (biologinė grupės) rodomas mėginių ir biologinės
grupės pavadinimų, kuriuo nurodomas taikinio šaltinis, pvz., mėginių, paimtų „1 hour (1Hr)“ (1 val.) ar
konkretaus asmens („mouse1“ (1 pelė)), sąrašas.

Plokštelės nuostatų keitimas eksperimento nuostatų dialogo lange

1. Norėdami atidaryti dialogo langą „Experiment Settings“ (eksperimento nuostatos) atlikite šiuos
veiksmus:

n „Plate Editor“ (plokštelės redaktorius) dešiniojoje srityje spustelėkite „Experiment Settings“ 
(eksperimento nuostatos).

n Kortelės „Gene Expression“ (geno ekspresija) lange „Data Analysis“ (duomenų analizė)
spustelėkite „Experiment Settings“ (eksperimento nuostatos).

Atidaromas dialogo langas „Experiment Settings“ (eksperimento nuostatos), kuriame rodomas
kortelės „Targets“ (taikiniai) turinys.

2. Norėdami pridėti taikinio, mėginio ar biologinės grupės pavadinimą, atitinkamos kortelės tekstiniame
langelyje „New“ (naujas) įveskite pavadinimą ir spustelėkite „Add“ (pridėti).
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3. Norėdami pašalinti vieną ar kelis taikinio, mėginio ar biologinės grupės pavadinimus iš sąrašo,
atitinkamoje kortelėje pasirinkite elemento žymės langelį stulpelyje „Select to Remove“ (pasirinkti ir
pašalinti) ir spustelėkite „Remove checked
item(s)“ (pašalinti pažymėtą (-us) elementą (-us).

4. „CFX Maestro Dx SE“ neįtraukia mėginio tipo NTC (kontrolės be šablono) iš geno ekspresijos
analizės.

Norėdami įtraukti NTC mėginių tipų, skyriuje „Exclude the following sample types“ (pašalinti šiuos
mėginių tipus) panaikinkite žymės langelio žymėjimą. Galite pašalinti šiuos mėginių tipus pasirinkę
atitinkamą žymės langelį:

n NRT (be atvirkštinės transkriptazės)

n „Negative Controlׅ“ (neigiama kontrolė)

n „Positive Control“ (teigiama kontrolė)

n „Standard“ (standartinis)

5. Kortelėje „Targets“ (taikiniai):

a. Norėdami taikinį pasirinkti kaip etaloną geno ekspresijos duomenų analizei, jį pasirinkite
stulpelyje „Reference“ (etalonas).

b. Norėdami paslėpti analizės nuostatas, kurios bus taikomos lango „Analysis Settings“ (analizės
nuostatos) kortelėje „Gene Expression“ (geno ekspresija), panaikinkite „Show Analysis Settings“ 
(rodyti analizės nuostatas) žymėjimą.

Programinė įranga paslepia šiuos stulpelius:

n „Color“ (spalva)

n „Show Chart“ (rodyti diagramą)

n „Auto Efficiency“ (automatinis veiksmingumas)

n „Efficiency“ (veiksmingumas) (%)

c. Norėdami pakeisti taikinio, pateikto diagramoje „Gene Expression“ (geno ekspresija), spalvą,
stulpelio „Color“ (spalva) iškylančiajame dialogo lange „Color“ (spalva), spustelėkite jos langelį ir
spustelėkite OK (gerai).

d. Norėdami taikinį diagramoje „Gene Expression“ (geno ekspresija) parodyti pasirinkta spalva,
stulpelyje „Show Chart“ (rodyti diagramą) pasirinkite jos žymės langelį.

e. Pagal numatytuosius parametrus „CFX Maestro Dx SE“ automatiškai apskaičiuoja taikinio
santykinį veiksmingumą, jeigu jo duomenys apima standartinę kreivę.
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Norėdami panaudoti anksčiau nustatytą veiksmingumo vertę, stulpelio „Efficiency“ 
(veiksmingumas) (%) langelyje įrašykite vertę ir paspauskite klavišą „Enter“ (įvesti).
„CFX Maestro Dx SE“ panaikina žymės langelio „Auto Efficiency“ (automatinis veiksmingumas)
žymėjimą.

6. Kortelėje „Samples“ (mėginiai) ir Biological Groups (biologinės grupės) atlikite šiuos veiksmus:

a. Norėdami mėginį arba biologinę grupę pasirinkti kaip kontrolinį mėginį geno ekspresijos
duomenų analizei, stulpelyje „Control“ (kontrolė) pasirinkite žymės langelį.

b. Norėdami paleidimo mėginiui ar biologinei grupei priskirti kontrolinę būseną, stulpelyje „Control“ 
(kontrolė) spustelėkite žymės langelį.

c. Jeigu jis dar nepasirinktas, spustelėkite „Show Analysis Settings“ (rodyti analizės nuostatas) ir
peržiūrėkite arba pakeiskite analizės parametrus, kurie bus taikomi kortelėje „Gene Expression“ 
(geno ekspresija). Programinė įranga paslepia stulpelius „Color“ (spalva) ir „Show Chart“ (rodyti
diagramą).

7. Spustelėkite OK (gerai), dialogo laukelyje „Experiment Settings“ (eksperimento nuostatos) įrašykite
parametrus ir grįžkite į langą Plate Editor (plokštelės redaktorius).
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Šulinėlių grupių kūrimas
Šulinėlių grupės dalija atskirą plokštelę į šulinėlių poaibius, kuriuos galima analizuoti nepriklausomai
lange „Data Analysis“ (duomenų analizė). Kai nustatomos šulinėlių grupės, lange „Data Analysis“ 
(duomenų analizė) pasirinkite vieną duomenims, kaip nepriklausomai grupei, analizuoti. Pavyzdžiui,
nustatykite šulinėlių grupes, kad būtų analizuojami keli eksperimentai, paleisti vienoje plokštelėje, arba
kiekviena šulinėlių grupė būtų analizuojama su skirtingomis standartinėmis kreivėmis.

Pastaba. Numatytoji šulinėlių grupė yra „All Wells“ (visi šulinėliai).

Kaip kurti šulinėlių grupes

1. Norėdami atidaryti „Well Groups Manager“ (šulinėlių grupių tvarkyklė), atlikite vieną iš šių veiksmų:

n Įrankių juostoje „Plate Editor“ (plokštelės redaktorius) spustelėkite „Well Groups“ (šulinėlių
grupės).

n Lange „Data Analysis“ (duomenų analizė) spustelėkite „Manage Well Groups“ (tvarkyti šulinėlių
grupes).

Parodomas dialogo langas „Well Groups Manager“ (šulinėlių grupių tvarkytuvė).

2. Spustelėkite „Add“ (pridėti) ir sukurkite naują grupę. Išplečiamajame meniu rodomas pirmosios
grupės pavadinimas „Group 1“ (1 grupė).
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3. Spustelėdami ir vilkdami žymeklį per šulinėlių grupę, pasirinkite šulinėlių iš šulinėlių grupės
plokštelės vaizde. Pasirinkti šulinėliai „Manager“ (tvarkytuvė) rodomi mėlynai.

4. (Neprivaloma) Norėdami pakeisti grupės pavadinimą, išplečiamajame meniu pasirinkite jos
pavadinimą ir įrašykite naują pavadinimą.

5. (Neprivaloma) Norėdami šalinti šulinėlių grupę, išplečiamajame sąraše pasirinkite jos pavadinimą ir
spustelėkite „Delete“ (šalinti).

6. Spustelėkite OK (gerai) norėdami baigti ir uždaryti langą arba spustelėkite „Cancel“ (atšaukti) ir
uždarykite langą neatlikę pakeitimų.

Dialogo lango „Well Groups Manager“ (šulinėlių grupių tvarkytuvė) pelės dešiniojo
mygtuko meniu elementai

10 lent. pateikti meniu elementai, esantys dialogo lange „Well Groups Manager“ (šulinėlių grupių
tvarkytuvė), kai pelės dešiniuoju mygtuku spustelite šulinėlį.

Elementas Funkcija

„Copy“ (kopijuoti) Kopijuojamas šulinėlio turinys, kurį galima įklijuoti į kitą
šulinėlį ar šulinėlius.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Šulinėlio parinkiklio rodinys kopijuojamas kaip paveikslėlis.

„Print“ (spausdinti) Atspausdinamas šulinėlio parinkiklio rodinys.

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinami tik pasirinkti langeliai.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

„Export to Csv“ (eksportuoti į
Csv)

Duomenys eksportuojami kaip kableliais atskirų duomenų
dokumentas.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami kaip .xml dokumentas.

„Export to Html“ (eksportuoti į
Html)

Duomenys eksportuojami kaip .html dokumentas.

10 lent. Pelės dešiniojo mygtuko meniu elementai dialogo lange „Plate Editor Well
Groups Manager“ (plokštelės redaktoriaus šulinėlių grupių tvarkytuvė)
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Pėdsakų stiliaus keitimas
Atlikdami plokštelės sąranką per bandymą, galite keisti amplifikavimo pėdsakų spalvą ir stilių. Tada galite
lengvai peržiūrėti pėdsakus tikralaikės būsenos lange, kai duomenys renkami.

Kaip pakeisti pėdsakų stilių

1. Spustelėkite „Trace Styles“ (pėdsakų stiliai) įrankių juostoje „Plate Editor“ (plokštelės redaktorius).

Pasirodo atidarytos plokštelės dialogo langas „Trace Styles“ (pėdsakų stiliai), pavyzdžiui:

2. Kad pėdsakų stilius būtų rodomas pagal konkretų fluoroforą, pasirinkite jį išplečiamajame meniu
„Fluorophores“ (fluoroforai).

3. Kaip pakeisti pėdsakų rodymą:

a. Pasirinkite pėdsako rūšį išplečiamajame sąraše „Wells“ (šulinėliai).

b. Spustelėkite spalvą stulpelyje „Color“ (spalva).

c. Pasirodžiusiame dialogo lange „Color“ (spalva) pasirinkite kitą pėdsako spalvą ir spustelėkite
OK (gerai).

„CFX Maestro Dx SE“tinklelyje rodomas šulinėlio tipo spalvos pasikeitimas.

d. (Neprivaloma) Pasirinkite pėdsako simbolį išplečiamajame sąraše „Symbols“ (simboliai).

4. Norėdami greitai pakeisti spalvų rinkinį, spustelėkite atitinkamą pasirinktį dalyje „Color Quick Set“ 
(greitas spalvos nustatymas).
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5. Norėdami peržiūrėti šulinėlių etiketes tinklelyje, pasirinkite etiketės rūšį dalyje „Well Labels“ (šulinėlių
etiketės).

6. Spustelėkite OK (gerai), kad įrašytumėte pakeitimus, arba „Cancel“ (atšaukti), norėdami juos
atšaukti.
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Plokštelės peržiūra, eksportavimas ir importavimas
skaičiuoklės formatu

Įrankis „Spreadsheet View/Importer“ (skaičiuoklės rodinys / importavimo įrankis) rodo plokštelės turinį
skaičiuoklės formatu. Peržiūros programa suteikia galimybę peržiūrėti, importuoti ir eksportuoti šulinėlių
duomenis, kaip aprašyta toliau.

Skaičiuoklės peržiūros programos naudojimas plokštelės duomenims eksportuoti
ir importuoti

Iš skaičiuoklės peržiūros programos galite eksportuoti „Target Name“ (objekto pavadinimas), „Sample
Name“ (mėginio pavadinimas), „Biological Group Name“ (biologinės grupės pavadinimas) ir „Well Notes“ 
(šulinėlio pastabos) kaip šabloną kortelės formatu į tokią programą kaip „Microsoft Excel“. Šiuos
duomenis taip pat galite importuoti iš kortelės programos į iš anksto nustatytą plokštelę iš eksperimento
informacijos failo.

Kaip naudoti įrankį „Spreadsheet View/Importer“ (skaičiuoklės rodinys / importavimo
įrankis)

1. Sukurkite ir išsaugokite plokštelės failą (žr. skyrių Plokštelės failo sukūrimas plokštelės redaktoriumi).

2. Įrankių juostoje „Plate Editor“ (plokštelės redaktorius) spustelėkite kortelę „Spreadsheet
View/Importer“ (skaičiuoklės rodinys / importavimo įrankis) ir atidarykite dialogo langą „Plate
Spreadsheet View“ (plokštelės skaičiuoklės rodinys).
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3. (Neprivaloma) Spustelėkite langelius „Show Biological Set Name“ (rodyti biologinio rinkinio
pavadinimą) ir „Show Well Note“ (rodyti šulinėlio pastabą), kad šie stulpeliai būtų rodomi
„Spreadsheet View“ (skaičiuoklės rodinyje) ir eksportuotame faile.

4. Spustelėkite mygtuką „Export Template“ (eksportuoti šabloną), kad sukurtumėte tuščią šabloną
„Excel“ faile (.csv formatu). Eksportuotame faile bus rodomas toks pat išdėstymas kaip ir jūsų
plokštelėje.

Patarimas. Išsaugodami plokštelių failus naudokite plokštelių failo pavadinimą, kad lengvai
atpažintumėte failą.

5. Į „Excel“ failo langelius įrašykite savo šulinėlio turinį.

Pastaba. Galite redaguoti tik to langelio, šalia kurio pavadinimas pažymėtas žvaigždute (*),
turinį (*„Target Name“ (objekto pavadinimas), *„Sample Name“ (mėginio pavadinimas), *
„Biological Group Name“ (biologinės grupės pavadinimas) ir *„Well Note“ (šulinėlio pastaba).

Pastaba. Eksportuotame „Excel“ faile į standartinės kreivės ir kiekio stulpelius negalima pridėti
verčių. Norėdami pakeisti šiuos duomenis, grįžkite į „Plate Editor“ (plokštelės redaktorių) ir
meniu juostoje pasirinkite „Settings“ (nustatymai) > „Units“ (vienetai). Kai baigtas plokštelės
paleidimas, duomenys iš šių standartų parodomi su pasirinktais matavimo vienetais lango „Data
Analysis“ (duomenų analizė) kortelės „Quantification“ (kiekybinis įvertinimas) diagramoje
„Standard Curve“ (standartinė kreivė).

6. Užpildytą „Excel“ failą importuokite atgal į „Plate Editor“ (plokštelių redaktorių) spustelėdami mygtuką
„Import“ (importuoti). Importuoti plokštelių duomenys rodomi lange „Plate Spreadsheet View“ 
(plokštelės skaičiuoklės rodinys).

Svarbu. Jei turite kelis fluoroforus, turėsite atlikti 3–5 veiksmus kiekvienam fluoroforui,
naudodami išskleidžiamąjį meniu „Flours List“ (fluoroforų sąrašas) „Plate Spreadsheet View“ 
(plokštelės skaičiuoklės rodinyje).

7. Spustelėkite mygtuką OK (gerai). Naujos plokštelės duomenys dabar rodomi „Plate Editor“ 
(plokštelės redaktoriaus) lange.

Patarimas. Meniu punktus, kuriuos galima rasti įrankyje „Spreadsheet View/Importer“ (skaičiuoklės
rodinys / importavimo įrankis) galite peržiūrėti dešiniuoju pelės klavišu spustelėję bet kurį įrankyje
esantį šulinėlį arba bet kurią „Plate Spreadsheet“ (plokštelės skaičiuoklės) rodinyje esančią lentelės
antraštę.
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Plokštelės schemos kūrimas plokštelės sąrankos vedliu
Galite pasinaudoti parinktimi „Setup Wizard“ (sąrankos vedlys) ir įvesti normalizuoto geno ekspresijos
analizei reikalingą plokštelės schemos informaciją, į kurią būtų įtraukti šie elementai:

n Taikinių pavadinimai

n Mėginių pavadinimai

n Taikinių ir mėginių vieta ant plokštelės

n Etaloninis (-iai) genas (-ai)

n Kontrolinis mėginys

Parinktį „Setup Wizard“ (sąrankos vedlys) galite naudoti prieš paleidimą, jo metu arba po jo.

Plokštelės sąrankos vedlio naudojimas
Šioje dalyje aiškinama, kaip kurti plokštelės išdėstymą naudojant plokštelės „Setup Wizard“ (sąrankos
vedlys). Norėdami lengviau peržiūrėti kiekvieno plokštelės šulinio turinį, spustelėkite „Zoom plate“ (keisti
plokštelės mastelį) lango „Setup Wizard“ (sąrankos vedlys) viršuje.

Svarbu. Esant bet kurioje lango „Setup Wizard“ (sąrankos vedlys) kortelėje ir grįžus į kortelę „Auto
layout“ (automatinis išdėstymas), atstatomas plokštelės išdėstymas. Būkite atsargūs, kai renkatės
šią kortelę.

Patarimas. Išdėstymą galite atstatyti pasirinkdami „Tools > Clear Plate“ (įrankiai > išvalyti plokštelę)
lange „Setup Wizard“ (sąrankos vedlys).

Kaip naudoti „Setup Wizard“ (sąrankos vedlys)

1. Atidarykite langą „Plate Editor“ (plokštelės redaktorius).

2. Norėdami atidaryti „Startup Wizard“ (paleisties vedlys), atlikite vieną iš šių veiksmų:

n Pasirinkite „Editing Tools > Setup Wizard“ (redagavimo įrankiai > sąrankos vedlys).

n Spustelėkite „Setup Wizard“ (sąrankos vedlys) įrankių juostoje „Plate Editor“ (plokštelių
redaktorius).

Pasirodo „Setup Wizard“ (sąrankos vedlys), kuriame yra kortelė „Auto layout“ (automatinis
išdėstymas).
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3. Kortelėje „Auto layout“ (automatinis išdėstymas) atlikite šiuos veiksmus:

a. Spustelėkite šulinėlį tinklelyje, vilkite skersai ir žemyn, kad nurodytumėte plokštelės sritį, kurioje
planuojate įkelti mėginį.

b. Įveskite taikinių ir mėginių, kuriuos norite įkelti, skaičių.

Patarimas. Taikinių ir mėginių skaičius turi atitikti pasirinktų langelių skaičių. Jei įvesti
skaičiai netelpa į pasirinktą sritį, pakeiskite skaičius arba plokštelių pasirinkimo sritį. Galite
nurodyti plokštelės elementų padėtį ir grupavimą.

c. (Neprivaloma) Pakeiskite plokštelės padėtį. Pavyzdžiui, galite stulpeliuose nustatyti taikinius, o
eilutėse – mėginius, arba grupuoti pagal mėginius.

d. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Target names“ (taikinių pavadinimai).

Pastaba. Jei jūsų plokštelės išdėstymas neturi dėsningo modelio, naudokite kortelę „Target
names“ (taikinių pavadinimai), kad rankiniu būdu nustatytumėte taikinių padėtį, arba kortelę
„Sample Names“ (mėginių pavadinimai), kad rankiniu būdu nustatytumėte mėginių padėtį ant
plokštelės. Spustelėkite ir vilkite, kad pasirinktumėte keletą šulinėlių.

4. Kortelėje „Target Names“ (taikinių pavadinimai) nurodykite taikinių grupių taikinių pavadinimus:

a. Atlikite vieną iš toliau nurodytų veiksmų:

n Norėdami pervadinti taikinius pagal grupę, nustatykite „Select by“ (pasirinkti pagal) į
„Target“ (taikinys).

Naudotojo vadovas | 165



8 skyrius. Plokštelių paruošimas

n Norėdami pervadinti taikinius pagal šulinėlį, nustatykite „Select by“ (pasirinkti pagal) į „Well“ 
(šulinėlis).

b. Pasirinkite taikinių grupę arba šulinėlį tinklelyje ir išplečiamajame sąraše „Target Name“ (taikinio
pavadinimas) įrašykite pavadinimą.

Patarimas. Spustelėkite tabuliavimo klavišą, kad pasirinktumėte kitą grupę arba dešinėje
esantį šulinėlį, arba „Enter“ (įvesti), kad pasirinktumėte kitą grupę arba žemiau esantį
šulinėlį. Taip pat galite kortelėse „Target Name“ (taikinio pavadinimas) ir „Sample Name“ 
(mėginio pavadinimas) laikyti „Control“ (valdymas) mygtuką ir spustelėti šulinėlį, kad
pasirinktumėte kelis ne greta esančius šulinėlius.

c. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Sample Names“ (mėginių pavadinimai).

5. Kortelėje „Sample Names“ (mėginių pavadinimai) nurodykite mėginių grupių mėginių pavadinimus.

6. Spustelėkite „Next“ (toliau), kad pereitumėte į kortelę „Reference Targets“ (etaloniniai taikiniai).

7. Kortelėje „Reference Targets“ (etaloniniai taikiniai) pasirinkite vieną ar kelis taikinius, kuriuos
naudosite kaip etalonus normalizuotoje geno ekspresijoje, ir spustelėkite „Next“ (toliau), kad
pereitumėte į kortelę „Control Sample“ (kontrolinis mėginys).

8. Kortelėje „Control Sample“ (kontrolinis mėginys) pasirinkite vieną mėginį, kurį naudosite kaip
kontrolinį santykinės geno ekspresijos skaičiavimams.

9. Spustelėkite OK (gerai), kad įrašytumėte plokštelės išdėstymą ir grįžtumėte į langą „Plate Editor“ 
(plokštelės redaktorius), kuriame galėsite nustatyti kitus plokštelės parametrus. Daugiau informacijos
rasite dalyje Pasirenkamųjų parametrų priskyrimas plokštelės failui , p. 143.

Arba galite spausti „Previous“ (atgal), kad grįžtumėte į prieš tai buvusią kortelę ir atliktumėte
pakeitimus.

Pastaba. Grįžus į kortelę „Auto layout“ (automatinis išdėstymas), plokštelė automatiškai
atstatoma. Būkite atsargūs, kai spaudžiate „Previous“ (atgal).
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9 skyrius. Eksperimentų paleidimas
Šiame skyriuje paaiškinama, kaip naudojant programinės įrangos „CFX Maestro Dx“, „Security Edition“
vykdyti tinkintus (naudotojo apibrėžtus) arba „PrimePCR“ (PGR pradmenys) analizės eksperimentus.

Paleidimo duomenų faile pateikiama paleisti reikalinga protokolo ir plokštelės informacija. Taip pat faile
pateikiami analizių, kurias „CFX Maestro Dx SE“ atlieka pasibaigus paleidimo veiksmui, duomenys.

„CFX Maestro Dx SE“ suteikia galimybę paprastai pradėti ir vykdyti naudotojo apibrėžtus arba
„PrimePCR“ (PGR pradmenys) eksperimentus. Lange „Run Setup“ (paleidimo sąranka) nuosekliai jums
nurodomi bendrieji eksperimento nustatymo veiksmai, kuriuos atlikę pateksite į dialogo langą „Start Run“ 
(paleidimo pradžia), iš kurio pradėsite paleidimą.
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Paleidimo sąrankos langas
Langas „Run Setup“ (paleidimo sąranka) suteikia sparčią prieigą prie failų ir nuostatų, kurių reikia norint
parengti ir paleisti eksperimentą. Kai pasirenkate paleisti naudotojo apibrėžtą eksperimentą, atidaromas
dialogo langas „Run Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Protocol“ (protokolas). Kai
pasirenkate paleisti „PrimePCR“ (PGR pradmenys) eksperimentą, atidaromas dialogo langas „Run
Setup“ (paleidimo sąranka), kuriame rodoma kortelė „Start run“ (paleidimo pradžia).

Patarimas. Informacijos apie „PrimePCR“ (PGR pradmenys) žr. „PrimePCR“ (PGR pradmenys)
eksperimentų atlikimas, p. 186; informacijos apie kortelę „Start Run“ (paleidimo pradžia) žr.
Paleidimo pradžios kortelė, p. 176.
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1. Kortelėse būsite nukreipti į eksperimento nuostatas ir paleidimą:

n Kortelė „Protocol“ (protokolas) – pasirinkite esamą paleidžiamą ar redaguojamą
protokolą arba „Protocol Editor“ (protokolų redaktorius) ir sukurkite naują
protokolą.

n Kortelė „Plate“ (plokštelė) – pasirinkite esamą paleidžiamą ar redaguojamą
plokštelę arba „Plate Editor“ (plokštelės redaktorius) ir sukurkite naują plokštelę.

n Kortelė „Start Run“ (paleidimo pradžia) – peržiūrėkite eksperimento nuostatas,
pasirinktie vieną ar kelis prietaisų blokus ir pradėkite paleidimą.

2. Pagrindiniame lange rodomos kiekvienos kortelės parinktys, kokias jūs taikote.

3. Naršymo mygtukas nukreips jus į kortelę „Start Run“ (paleidimo pradžia).

LEGENDA

Paleidimo sąrankos lango įjungimas
Kaip įjungti langą „Run Setup“ (paleidimo sąranka)

u Atlikite vieną iš toliau nurodytų veiksmų:

n Kortelėje „Run Setup“ (paleidimo sąranka), kurią rasite lange „Startup Wizard“ (paleisties
vedlys), spustelėkite „User-defined“ (naudotojo apibrėžta) arba „PrimePCR“ (PGR pradmenys).

n Lange „Home“ (pagrindinis) įrankių juostoje spustelėkite „User-defined Run Setup“ (naudotojo
apibrėžta paleidimo sąranka) arba „PrimePCR Run Setup“ (PGR pradmenų paleidimo sąranka).

n Lange „Home“ (pagrindinis) pasirinkite „Run > User-defined Run“ (paleidimas > naudotojo
apibrėžtas paleidimas) arba „Run > PrimePCR Run“ (paleidimas > PGR pradmenų paleidimas).
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Protokolo kortelė
Kortelėje „Protocol“ (protokolas) rodoma jūsų planuojamo paleidimo protokolo failo apžvalga. Protokolo
faile yra instrukcijos dėl prietaiso temperatūros etapų ir prietaiso parinkčių, kuriomis valdomas kitimo
greitis, mėginio tūris ir dangtelio temperatūra.

Pagal numatytąsias nuostatas programinė įranga rodo protokolą, apibūdintą skyriuje „File Selection for
Run Setup“ (failo pasirinkimas paleidimo sąrankai) kortelėje „Files“ (failai), kuri yra dialogo lange „User >
User Preferences“ (naudotojas > naudotojo nuostatos). Numatytąjį protokolą galite pakeisti dialogo lange
„User Preferences“ (naudotojo nuostatos). Daugiau informacijos žr. Numatytųjų failų nuostatų keitimas, p.
85.

Kortelėje „Protocol“ (protokolas) galite atlikti šiuos veiksmus:

n Sukurti naują paleidimo protokolą

n Pasirinkti esamą paleidžiamą ar redaguojamą protokolą

Daugiau informacijos apie protokolų sukūrimą ir keitimą žr. 7 skyrius, Protokolų kūrimas.

Kaip sukurti naują protokolą

1. Kortelėje „Protocol“ (protokolas) spustelėkite „Create New“ (kurti naują).

Parodomas „Protocol Editor“ (protokolų redaktorius).
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2. Naudodami „Protocol Editor“ (protokolų redaktorius) sukurkite naują protokolą.

3. Spustelėkite OK (gerai), įrašykite protokolą ir grįžkite į kortelę „Protocol“ (protokolas), esančią „Run
Setup“ (paleidimo sąranka).

4. Peržiūrėkite protokolo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Plate“ (plokštelė).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir grįžkite į
langą „Protocol Editor“ (protokolų redaktorius). Peržiūrėkite protokolą, įrašykite pakeitimus, tada
kortelėje „Protocol“ (protokolas) spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Plate“ 
(plokštelė).

Kaip pasirinkti esamą protokolą

1. Kortelėje „Protocol“ (protokolas) atlikite vieną iš šių veiksmų:

n Spustelėkite „Select Existing“ (pasirinkti esamą) ir raskite esamą protokolą.

n Spustelėkite „Express Load“ (specialioji apkrova) ir protokolų išplečiamajame sąraše pasirinkite
protokolą.

Patarimas. Į išplečiamąjį sąrašą „Express Load“ (specialioji apkrova) galite įtraukti
protokolus arba iš jo pašalinti. Daugiau informacijos žr. Specialiosios apkrovos protokolų
pridėjimas ir šalinimas.

2. Peržiūrėkite protokolo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Plate“ (plokštelė).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir atidarykite
„Protocol Editor“ (protokolų redaktorius). Peržiūrėkite protokolą, įrašykite pakeitimus, tada
kortelėje „Protocol“ (protokolas) spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Plate“ 
(plokštelė).

Specialiosios apkrovos protokolų pridėjimas ir šalinimas

Galite keisti išplečiamojo sąrašo „Express Load“ (specialioji apkrova), kuris parodomas lange „Protocol
Editor“ (protokolų redaktorius), turinį. Šio sąrašo protokolai įrašomi šiame aplanke:

c:\Users\Public\Public Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\

Kaip keisti protokolų sąrašą „Express Load“ (specialioji apkrova):

1. Suraskite ir atidarykite aplanką „Express Load“ (specialioji apkrova).

2. Aplanke peržiūrėkite protokolo failus (.pcrl).

3. Atlikite bet kurį iš šių veiksmų:
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n Pašalinkite protokolus iš aplanko, kad pašalintumėte juos iš išplečiamojo sąrašo.

n Kopijuokite protokolus į aplanką, kad pridėtumėte juos į išplečiamąjį sąrašą.
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Plokštelės kortelė
Pastaba. Jeigu kortelėje „Protocol“ (protokolas) pasirinktame protokole nėra plokštelės nuskaitymo
veiksmo realiojo laiko PGR analizei, kortelė „Plate“ (plokštelė) paslepiama. Norėdami peržiūrėti
kortelę „Plate“ (plokštelė), į protokolą įtraukite bent vieną plokštelės nuskaitymą.

Kortelėje „Plate“ (plokštelė) rodoma jūsų planuojamo plokštelės failo apžvalga. Realiojo laiko PGR
paleidimo metu plokštelės faile yra kiekvieno šulinėlio turinio aprašymas, įskaitant jo fluoroforus,
nuskaitymo režimą ir plokštelės tipą. „CFX Maestro Dx SE“ šiuos apibūdinimus naudoja duomenims rinkti
ir analizuoti.

Pagal numatytąsias nuostatas programinė įranga rodo plokštelę, apibūdintą failo pasirinkimo veiksme
paleidimo sąrankos skyriuje kortelėje „Files“ (failai), kuri yra dialogo lange „User > User Preferences“ 
(naudotojas > naudotojo nuostatos). Numatytąją plokštelę galite pakeisti dialogo lange „User
Preferences“ (naudotojo nuostatos). Daugiau informacijos žr. Numatytųjų failų nuostatų keitimas, p. 85.

Kortelėje „Plate“ (plokštelė) galite

n Sukurti naują įdedamą plokštelę

n Pasirinkti esamą įdedamą ar redaguojamą plokštelę

Daugiau informacijos apie plokštelių kūrimą ir keitimą žr. 8 skyrius, Plokštelių paruošimas.
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Naujos plokštelės kūrimas

1. Kortelėje „Plate“ (plokštelė) spustelėkite „Create New“ (kurti naują).

Parodomas „Plate Editor“ (plokštelės redaktorius).

2. Naują plokštelę kurkite naudodami „Plate Editor“ (plokštelės redaktorius).

3. Spustelėkite OK (gerai), norėdami įrašyti plokštelę ir grįžti į kortelę „Plate“ (plokštelė), esančią „Run
Setup“ (paleidimo sąranka).

4. Peržiūrėkite plokštelės išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Start Run“ 
(paleidimo pradžia).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir grįžkite į
„Plate Editor“ (plokštelės redaktorius). Peržiūrėkite plokštelės failą, įrašykite pakeitimus, tada
kortelėje „Plate“ (plokštelė) spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Start Run“ 
(paleidimo pradžia).

Kaip pasirinkti esamos plokštelės failą

1. Kortelėje „Plate“ (plokštelė) atlikite vieną iš šių veiksmų:

n Spustelėkite „Select Existing“ (pasirinkti esamą) ir raskite tikslinį plokštelės failą.

n Spustelėkite „Express Load“ (specialioji apkrova) ir išplečiamajame sąraše pasirinkite plokštelės
failą.

Patarimas. Į išplečiamąjį sąrašą „Express Load“ (specialioji apkrova) galite įtraukti
plokšteles arba iš jo pašalinti. Daugiau informacijos žr. Specialiosios apkrovos plokštelių
failų pridėjimas ir šalinimas.

2. Peržiūrėkite plokštelės išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu jūsų informacija teisinga, spustelėkite „Next“ (toliau) ir pereikite į kortelę „Start Run“ 
(paleidimo pradžia).

n Jeigu jūsų informacija neteisinga, spustelėkite „Edit Selected“ (redaguoti pasirinktą) ir atidarykite
langą „Plate Editor“ (plokštelės redaktorius). Peržiūrėkite plokštelės failą, įrašykite pakeitimus, tada
spustelėkite „Next“ (toliau) ir pereikite prie kortelės „Start Run“ (paleidimo pradžia).

Specialiosios apkrovos plokštelių failų pridėjimas ir šalinimas

Galite keisti išplečiamojo sąrašo „Express Load“ (specialioji apkrova), kuris pasirodo lange „Plate Editor“ 
(plokštelės redaktorius), turinį. Šiame sąraše pateiktos plokštelės įrašomos aplanke:

c:\Users\Public\Documents\Bio-Rad\CFX_MDx\Users\<user_name>\ExpressLoad\
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Kaip keisti plokštelių failų „Express Load“ (specialioji apkrova) sąrašą

1. Suraskite ir atidarykite aplanką „Express Load“ (specialioji apkrova).

2. Peržiūrėkite aplanke esančius plokštelių failus (.pltd).

3. Atlikite vieną iš toliau nurodytų veiksmų:

n Pašalinkite plokštelių failus iš aplanko, kad pašalintumėte juos iš išplečiamojo sąrašo.

n Kopijuokite plokštelių failus į aplanką, kad pridėtumėte juos į išplečiamąjį sąrašą.
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Paleidimo pradžios kortelė
Kortelėje „Start Run“ (paleidimo pradžia) rodoma informacija apie norimą vykdyti eksperimentą. Joje taip
pat rodomas prijungtas prietaisų blokas arba blokai, kuriuose galite paleisti eksperimentą.

Kortelėje „Start Run“ (paleidimo pradžia) galite atlikti šiuos veiksmus:

n Peržiūrėti išsamią paleidimo informaciją, įskaitant pasirinktą protokolo failą, plokštelės failą ir
nuskaitymo režimą

n Pridėti pastabų apie paleidimą

n Peržiūrėti išsamią informaciją apie visus prijungtus prietaisus, įskaitant jų paleidimo būseną
(paleistas ar neveikia), mėginio tūrį µl, dangtelio temperatūrą, emuliacijos režimą ir ID ar turimą
brūkšninį kodą

Pastaba. Galite keisti lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą pasirinktuose
blokuose) rodomus stulpelius. Kaip tai daryti, žr. Išsamios informacijos pasirinktų blokų lentelėje
keitimas, p. 177.

n Pasirinkti bloką ar blokus, kuriuose vykdomas paleidimas

n Nuotoliniu būdu atidaryti arba uždaryti kiekvieno pasirinkto prietaiso dangtelį
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n Pradėkite paleidimą.

Išsamios informacijos pasirinktų blokų lentelėje keitimas

Galite keisti lentelėje „Start Run on Selected Block(s)“ (pradėti paleidimą pasirinktame (-uose) bloke (-
uose)) rodomus stulpelius. Lentelėje taip pat galite keisti numatytąjį mėginio tūrį ir dangtelio temperatūros
vertes. Nuostatų pakeitimai taikomi paleidimui, kuris bus atliekamas.

Kaip pridėti stulpelius lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą
pasirinktuose blokuose)

u Pelės dešiniuoju mygtuku spustelėkite lentelėje ir pateiktame meniu pasirinkite parinktį.

Kaip panaikinti stulpelius lentelėje „Start Run on Selected Blocks“ (pradėti paleidimą
pasirinktuose blokuose)

u Pelės dešiniuoju mygtuku spustelėkite lentelėje ir pateiktame meniu panaikinkite parinkties
žymėjimą.

Kaip koreguoti mėginio tūrio ar bloko dangtelio temperatūros vertes

u Pasirinkite tikslinio bloko mėginio tūrį ar dangtelio temperatūros langelį ir į jį įrašykite naują vertę.

Kaip pridėti paleidimo ID ar bloko brūkšninį kodą

u Pasirinkite tikslinio bloko langelį „ID/Bar Code“ (ID / brūkšninis kodas) ir įrašykite ID arba
nuskenuokite bloką brūkšninių kodų skaitytuvu.

Eksperimento paleidimas
Svarbu. Prieš paleisdami eksperimentą, turite užtikrinti, kad paleidžiant jūsų kompiuterio antivirusinė
programa nepradės skenuoti. Jei reikia daugiau informacijos žr. Programinės įrangos „CFX Maestro
Dx SE“ diegimas, p. 34 ir kreipkitės į sistemos administratorių.

Kaip paleisti eksperimentą

1. Kortelėje „Start Run“ (paleidimo pradžia) paleidimo informacijos skyriuje patikrinkite plokštelės ir
protokolo išsamią informaciją.

2. (Neprivaloma) Į pastabų tekstinį laukelį įrašykite pastabas apie paleidimą ar eksperimentą.

3. Pasirinkite vieno ar kelių blokų, kuriuose vykdomas paleidimas, žymės langelį.

Patarimas. Norėdami eksperimentą paleisti visuose blokuose, pasirinkite „Select All Blocks“ 
(pasirinkti visus blokus) parinktį, esančią po pasirinktų blokų lentele.

4. (Neprivaloma) Spustelėkite „Flash Block Indicator“ (mirksintis bloko indikatorius), kad sumirksėtų LED
indikatorius, esantis pasirinkto prietaiso blokuose.
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5. Į bloką įdėkite eksperimento plokšteles:

a. Spustelėkite „Open Lid“ (atidaryti dangtelį). Atsidaro kiekvieno pasirinkto bloko motorizuotas
dangtelis.

b. Į kiekvieną pasirinktą bloką įdėkite eksperimento plokštelę.

c. Spustelėkite „Close Lid“ (uždaryti dangtelį).

Patarimas. „CFX Opus Dx“ sistemos pagrindiniame ekrane palieskite „Open Lid“ (atidaryti
dangtelį) arba „Close Lid“ (uždaryti dangtelį).

6. Spustelėkite „Open Lid“ (atidaryti dangtelį) ir „Close Lid“ (uždaryti dangtelį), kad atidarytumėte arba
uždarytumėte kiekvieno pasirinkto prietaiso bloko motorizuotą dangtelį.

7. Peržiūrėkite paleidimo išsamią informaciją ir atlikite vieną iš šių veiksmų:

n Jeigu išsami informacija teisinga, spustelėkite „Start Run“ (paleidimo pradžia).

n Jeigu išsami informacija neteisinga:

o Lentelėje „Selected Blocks“ (pasirinkti blokai) pakoreguokite informaciją ir spustelėkite
„Start Run“ (paleidimo pradžia).

o Grįžkite į tinkamą kortelę ir atlikite reikiamus pakeitimus, juos įrašykite, tada spustelėkite
„Next“ (toliau) ir grįžkite į kortelę „Start Run“ (paleidimo pradžia) ir pradėkite paleidimą.

Kaip pradėti naują paleidimą iš ankstesnio paleidimo

u Atlikite vieną iš toliau nurodytų veiksmų:

n Pagrindinio programinės įrangos meniu juostoje pasirinkite „File > Repeat a Run“ (failas >
pakartoti paleidimą); raskite ir du kartus spustelėkite paleidimo, kurį norite pakartoti, duomenų
failą.

n Pasirinkite kortelę „Repeat Run“ (pakartoti paleidimą), esančią „Startup Wizard“ (paleisties
vedlys), ir du kartus spustelėkite paleidimo, kurį norite pakartoti, duomenų failą.

Be to, kortelėje „Repeat Run“ (pakartoti paleidimą) galite spustelėti „Browse“ (naršyti) ir rasti bei
du kartus spustelėti paleidimo duomenų failą, kuri norite pakartoti.
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Paleidimo išsamios informacijos dialogo langas
Spustelėjus „Start Run“ (paleidimo pradžia), „CFX Maestro Dx SE“ paragina įrašyti duomenų failą (.pcrd),
pradeda analizę ir atidaro dialogo langą „Run Details“ (paleidimo išsami informacija). Dialogo lange „Run
Details“ (paleidimo išsami informacija) yra trys būsenos kortelės:

n „Run Status“ (paleidimo būsena) – naudokite šią kortelę, jei norite peržiūrėti dabartinę protokolo
būseną, atidaryti arba uždaryti dangtelį, pristabdyti analizę, pridėti pakartojimų, praleisti veiksmus
arba sustabdyti paleidimą.

n „Real-time Status“ (realiojo laiko būsena) – naudokite šią kortelę, jei norite peržiūrėti PGR
fluorescencijos duomenis realiuoju laiku, kai jie renkami.

n „Time Status“ (laiko būsena) – naudokite šią kortelę, jei norite matyti per visą ekraną protokolo
atgalinės atskaitos laikmatį.

Šios kortelės išsamiai paaiškintos tolesniuose skyriuose.

Paleidimo būsenos kortelė
Kortelėje „Run Status“ (paleidimo būsena) rodoma dabartinė vykstančio paleidimo būsena. Šiame
rodinyje taip pat galite valdyti dangtelį ir keisti paleidimą.
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1. Sritis „Run Status“ (paleidimo būsena) – rodoma dabartinė protokolo eiga.

2. „Run Status“ (paleidimo būsena) valdikliai – leidžia valdyti prietaisą arba nutraukti
dabartinį protokolą.

3. Sritis „Run Information“ (paleidimo išsami informacija) – rodoma išsami paleidimo
informacija.

LEGENDA

„Run status“ (paleidimo būsenos) komandos

Naudokite komandas kortelėje „Run Status“ (paleidimo būsena), jei norite valdyti prietaisą iš programinės
įrangos arba keisti vykdomą paleidimą.

Pastaba. Padarius pakeitimų protokole paleidimo metu, pvz., pridėjus pakartojimų, nepakeičiamas
protokolo failas, susijęs su paleidimu. Šie veiksmai registruojami žurnale „Run Log“ (paleidimo
žurnalas).

– atidaromas pasirinktų prietaisų motorizuotas dangtelis.

Svarbu. Atidarius dangtelį paleidimo metu, paleidimas esamo veiksmo metu pristabdomas,
todėl gali būti iškreipti duomenys. „Run status“ (paleidimo būsenos) komandos, p. 180.

– uždaromas pasirinktų prietaisų motorizuotas dangtelis.

– įtraukiama daugiau pakartojimų į GOTO veiksmą protokole. Ši parinktis galima tik tada, kai vyksta
GOTO veiksmas.

Pastaba. GOTO (eiti į) cikle, kai vykdomas protokolas, galite pridėti papildomų pakartojimų.
Tačiau „CFX Maestro Dx SE“ atpažįsta naujausią pakartojimų skaičiaus pakeitimą. Pavyzdžiui,
jei GOTO (eiti į) cikle pridėsite 10 papildomų pakartojimų, programinė įranga pakeis bendrą
skaičių į n + 10. Jei pridėsite dar penkis (5) pakartojimus to paties ciklo metu, „CFX Maestro“ 
pakeis bendrą pakartojimų skaičių į n + 5. Pirmasis pakeitimas (10 pakartojimų) ignoruojamas.
Kad programinė įranga atliktų tikslinį pakartojimų skaičių, įveskite bendrą skaičių (šiuo atveju –
15 pakartojimų).

– praleidžiamas esamas protokolo veiksmas.
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Pastaba. Jei inicijuosite praleidimą GOTO žingsnio metu, sistema pereis į kitą GOTO ciklą. Jei
praleidimo metu buvo vykdomas paskutinis GOTO žingsnio ciklas, sistema pereina prie kito
žingsnio.

– įjungiamas mirksintis pasirinkto prietaiso šviesos diodas, kad būtų galima nustatyti pasirinktus
blokus.

– pristabdomas protokolas.

Pastaba. Šis veiksmas registruojamas žurnale „Run Log“ (paleidimo žurnalas).

– atnaujinamas pristabdytas protokolas.

– paleidimas sustabdomas prieš pasibaigiant protokolams.

Pastaba. Sustabdžius paleidimą prieš pasibaigiant protokolui, gali būti iškreipti duomenys.

Prietaiso dangčio atidarymas PGR vykdymo metu

Jei PGR vykdymo metu atidaromas bet kurio prietaiso dangtis, „CFX Maestro Dx SE“ bus rodomas šis
patvirtinimo dialogo langas:

Kol rodomas dialogo langas, prietaisai toliau vykdo protokolą. Mygtukas OK (gerai) sustabdo vykdymą, o
prietaiso dangtis atsilaisvina ir atsidaro. Mygtuku „Cancel“ (atšaukti) atmetamas dialogo langas ir tęsiamas
vykdymas.
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Būsenos realiuoju laiku kortelė
Kortelėje „Real-time Status“ (realiojo laiko būsena) rodomi PGR realiojo laiko duomenys, surinkti per
kiekvieną paleidimo ciklą po pirmų dviejų plokštelių nuskaitymų.

1. „Amplification trace pane“ (amplifikavimo pėdsako sritis) – per paleidimą rodomi
realiojo laiko amplifikavimo duomenys.

2. „Well group identifier“ (šulinėlių grupės identifikatorius) – jei šulinėlių grupės
identifikuotos plokštelės sąrankoje, naudotojai gali pasirinkti konkrečią šulinėlių
grupę ir peržiūrėti jos pėdsakus, šulinėlius ir informaciją lentelėse.

„Step number identifier“ (veiksmo numerio identifikatorius) – jei protokole renkami
duomenys iš daugiau nei vieno veiksmo (pavyzdžiui, per amplifikavimą ir lydymosi
kreivę), naudotojai gali pasirinkti konkretų veiksmą ir peržiūrėti tame veiksme
surinktus pėdsakus.

3. „Well selector pane“ (šulinėlių parinkiklio sritis) – rodo aktyvius, neaktyvius ir tuščius
plokštelės šulinėlius.

4. „Plate setup table pane“ (plokštelės sąrankos lentelės sritis) – rodo plokštelės
sąranką lentelėje.

LEGENDA
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5. „Run details pane“ (paleidimo išsamios informacijos sritis) – rodo paleidimo realiojo
laiko būseną, įskaitant:

n Dabartinį veiksmą

n Dabartinį kartojimą

n Dabartinę temperatūrą

n Likusį laiką

n Mėginio temperatūrą

n Dangtelio temperatūrą

6. „Plate Setup“ (plokštelės sąranka) – atidaro dialogo langą „Plate Setup“ (plokštelės
sąranka), kuriame naudotojai gali keisti dabartinės plokštelės sąranką vykstant
paleidimo veiksmui.

Kortelėje „Real-time Status“ (realiojo laiko būsena) galite atlikti šiuos veiksmus:

n Rodyti arba slėpti realiojo laiko pėdsakus, pasirinkdami juos šulinėlių parinkiklio srityje arba
plokštelės sąrankos lentelėje

n Peržiūrėti vieną pėdsaką ar jų grupes, pasirinkdami juos šulinėlių grupių išplečiamajame meniu

n Redaguoti plokštelę arba pakeisti plokštelės failą

n Paleisčiai taikyti „PrimePCR“ (PGR pradmenys) failą

Pėdsakų realiuoju laiku parodymas arba paslėpimas

Pagal numatytuosius parametrus visi pripildyti šulinėliai yra aktyvūs ir rodomi plokštelės sąrankos
lentelėje. Aktyvūs šulinėliai šulinėlių parinkiklio srityje rodomi mėlynai. Paslėpti šulinėliai šulinėlių
parinkiklio srityje rodomi šviesiai pilka spalva, o nenaudojami šulinėliai – tamsiai pilka spalva.

Paleidimo metu galite paslėpti pėdsakus iš aktyvių šulinėlių. „CFX Maestro Dx SE“ toliau renka duomenis
apie visus šulinius; kai slepiate šulinius, jų duomenys nerodomi plokštelių sąrankos lentelėje.

Kaip paslėpti realiojo laiko pėdsakus

u Šulinėlių parinkiklio srityje spustelėkite aktyvius (mėlynus) šulinėlius, kuriuos norite paslėpti.

Kaip rodyti realiojo laiko pėdsakus

u Šulinėlių parinkiklio srityje spustelėkite paslėptus (šviesiai pilkus) šulinėlius, kuriuos norite rodyti.

Daugiau informacijos apie šulinėlių parinkiklį žr. Šulinėlių parinkiklis, p. 205.
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Plokštelės sąrankos redagavimas

Kaip redaguoti plokštelės sąranką

u Spustelėkite „Plate Setup“ (plokštelės sąranka), o tada pasirinkite „View/Edit Plate“ (peržiūrėti /
redaguoti plokštelę).

Parodomas langas „Plate Editor“ (plokštelės redaktorius), kuriame galite redaguoti plokštelę, kol
vykdomas paleidimas. Daugiau informacijos apie plokštelių redagavimą žr. 8 skyrius, Plokštelių
paruošimas.

Pastaba. Lange „Plate Editor“ (plokštelės redaktorius) taip pat galite redaguoti pėdsakų stilius.
Kortelėje „Real-time Status“ (būsena realiuoju laiku) parodomi pakeitimai amplifikavimo pėdsakų
diagramoje.

Plokštelės failo pakeitimas

Patarimas. Plokštelės failo pakeitimas yra itin naudingas, jeigu paleidimą pradedate „Quick Plate“ 
(sparčioji plokštelė) failu aplanke „ExpressLoad“ (specialioji apkrova).

Kaip pakeisti plokštelės failą

u Spustelėkite „Plate Setup“ (plokštelės sąranka) ir pasirinkite vieną iš šių parinkčių:

n Pakeiskite plokštelės failą – naršyklės lango sąraše pasirinkite naują plokštelės failą

n Taikyti „PrimePCR“ (PGR pradmenys) failą – ieškokite paleidimo failo, kuriame bus gauta
plokštelės schema naudojant išmanią paiešką, arba spustelėkite „Browse“ (naršyti) ir raskite
failą, kurį įkėlėte iš „Bio-Rad“ svetainės ir kurio nėra aplanke „PrimePCR“ (PGR pradmenys)

Pastaba. „CFX Maestro Dx SE“ patikrina nuskaitymo režimą ir plokštelės failo plokštelės dydį.
Jie turi būti tokie patys, kaip ir paleidimo nuostatos, su kuriomis buvo pradėtas paleidimas.
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Paleidimo išsamios informacijos dialogo langas

Laiko būsenos kortelė
Kortelėje „Time Status“ (laiko būsena) rodomas laikas, likęs iki esamo paleidimo baigimo.
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9 skyrius. Eksperimentų paleidimas

„PrimePCR“ (PGR pradmenys) eksperimentų atlikimas
Atliekant „PrimePCR“ (PGR pradmenys) eksperimentus naudojami trakto arba konkrečios ligos analizių
duomenys, kuriuos „Bio-Rad“ patvirtino ir optimizavo tradicinėje laboratorijoje ir kurie yra prieinami šiais
formatais:

n Iš anksto apdorotos plokštelės – plokštelės, kuriose yra analizių, būdingų biologiniam traktui arba
konkrečiai ligai; jos apima „PrimePCR“ (PGR pradmenys) kontrolines medžiagas ir etaloninius genus

n Pagal užsakymą sukonfigūruotos plokštelės – plokštelės, kurias galima pritaikyti pagal naudotojo
nustatytą konfigūraciją, sudarančią galimybę pasirinkti analizes, susijusias su dominančiais
objektais, kontrolinėmis medžiagomis ir etalonais.

n Individualūs tyrimai – mėgintuvėliai, kuriuose yra atskiri pradmenų rinkiniai, naudojami realiojo laiko
reakcijoms.

Jei norite sumažinti bendrą paleidimo laiką, galite protokole pašalinti lydymo veiksmą. „Bio-Rad“ 
primygtinai rekomenduoja „PrimePCR“ (PGR pradmenys) paleidimo protokole nedaryti jokių kitų
pakeitimų. Numatytasis protokolas yra tas, kuris naudojamas analizei patvirtinti. Bet koks nukrypimas nuo
jo gali turėti įtakos rezultatams. Protokolo pakeitimai pažymimi gauto duomenų failo kortelėje „Run
Information“ (paleidimo išsami informacija) ir visose sukurtose ataskaitose.

„PrimePCR“ (PGR pradmenys) paleidimo pradžia

u Kad paleistumėte „PrimePCR“ (PGR pradmenys) procesą, atlikite toliau nurodytus veiksmus:

n Meniu „Startup Wizard“ (paleisties vedlys) pasirinkite „PrimePCR“ (PGR pradmenys) kortelėje
„Run Setup“ (paleidimo sąranka), o tada pasirinkite tinkamą cheminę sudėtį (SYBER® arba
zondas).

n Pasirinkite „PrimePCR“ (PGR pradmenys) paleidimo parinktį iš sąrašo „Recent Runs“ (naujausi
paleidimai), esančio meniu „Startup Wizard“ (paleisties vedlys) kortelėje „Repeat Run“ 
(pakartotinis paleidimas).

n Lange „Home“ (pagrindinis) pasirinkite „File > New > PrimePCR Run File“ (failas > atidaryti >
PGR pradmenų paleidimo failas).

n Nutempkite „PrimePC“ (PGR pradmenys) paleidimo failą pagrindiniame lange.

Pasirinkus „PrimePCR“ (PGR pradmenys) paleidimą, atsidaro kortelėje „Start Run“ (paleidimo pradžia)
esantis „Run Setup“ (paleidimo sąranka) langas su numatytąja „PrimePCR“ (PGR pradmenys) plokštelės
schema, kuri įkeliama pagal pasirinktą prietaisą.

Kaip pašalinti lydymo veiksmą iš protokolo

u Kortelėje „Protocol“ (protokolas) panaikinkite žymą žymės langelyje „Include Melt Step“ (įtraukti
lydymo veiksmą).
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„PrimePCR“ (PGR pradmenys) eksperimentų atlikimas

Kaip importuoti informaciją apie taikinį, skirtą „PrimePCR“ (PGR pradmenys) plokštelėms, į
plokštelės schemą

1. Atlikite vieną iš toliau nurodytų veiksmų:

n Kortelėje „Real-time Status“ (realiojo laiko būsena), esančioje dialogo lange „Run Details“ 
(paleidimo išsami informacija), pasirinkite „Plate Setup > Apply PrimePCR File“ (plokštelės
sąranka > taikyti PGR pradmenų failą).

n Lange „Data Analysis“ (duomenų analizė) pasirinkite „Plate Setup > Apply PrimePCR File“ 
(plokštelės sąranka > taikyti PGR pradmenų failą).

2. Paleidimo failo dialogo lange „PrimePCR“ (PGR pradmenys) spustelėkite mygtuką „Browse“ 
(naršyti), kad pasiektumėte atitinkamą „PrimePCR“ (PGR pradmenys) failą (.csv).

3. Pasirinkite taikinio „PrimePCR“ (PGR pradmenys) failą ir spustelėkite „Open“ (atidaryti).

„CFX Opus Dx“ sistema importuoja taikinio informaciją į jūsų plokštelės schemą.
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9 skyrius. Eksperimentų paleidimas

Atskirų duomenų perdavimas analizei atlikti
Svarbu. Kai perkeliate duomenų failus iš „CFX Opus Dx“ sistemos į „CFX Maestro Dx SE“,
perkeliami visi sistemoje įrašyti failai. Įsitikinkite, kad turite pakankamai vietos diske, kad duomenys
būtų saugiai perkelti.

Pasibaigus vykdymui, „CFX Maestro Dx SE“ programinė įranga analizuoja fluorescencijos duomenis. Jei
paleidimas atliktas autonominiu režimu ir įrašomas pačioje „CFX Opus Dx“ sistemoje, duomenys turi būti
perduoti į „CFX Maestro Dx SE“ kompiuterį analizei atlikti.

„CFX Opus Dx“ sistemoje galima saugoti iki 100 realiojo laiko PGR paleidimų. Paleidimui pasibaigus,
galite perduoti atskirus duomenų failus į „CFX Maestro Dx SE“ kompiuterį el. paštu, naudodami USB
atmintinę arba pačią programinę įrangą.

Šiame skirsnyje paaiškinama, kaip perduoti atskirus duomenų failus į „CFX Maestro Dx SE“ kompiuterį.

Duomenų perkėlimas el. paštu
Kaip išsiųsti duomenų failą el. paštu pasibaigus paleidimo veiksmui

1. Nustatykite prietaise el. pašto pranešimus.

Žr. El. pašto pranešimų nustatymas, p. 81 arba „CFX Opus Dx“ realiojo laiko PGR sistemos
naudojimo vadovą.

2. Nustatę el. pašto pranešimus, įsitikinkite, kad pasirinkta „Attach Data File“ (pridėti duomenų failą).

Paleidimo duomenys išsiunčiami el. paštu kaip .pcrd failas.

Duomenų perkėlimas iš „CFX Opus Dx“ realiojo laiko PGR sistemų
Naudodami „CFX Opus Dx“ sistemos failų naršyklės funkciją, galite perkelti duomenų failus į prijungtą
USB diską arba bendrąjį tinklo aplanką. Taip pat galite perkelti „CFX Maestro Dx SE“ protokolo failus iš
USB disko arba bendrojo tinklo disko į „CFX Opus Dx“ sistemos aplanką arba viešąjį aplanką ir paleisti
juos „CFX Opus Dx“ sistemoje.

Patarimas. Šiame skyriuje paaiškinta, kaip perkelti duomenis. Norėdami sužinoti daugiau apie
eterneto žr. „CFX Opus Dx“ realiojo laiko PGR sistemos naudojimo instrukciją, pateiktą
„CFX Maestro Dx SE“ pagalbos meniu.

1. Norėdami pamatyti „CFX Opus Dx“ sistemos failų naršyklės ekraną, pagrindiniame ekrane palieskite
„Files“ (failai).

2. Ekrane „File Browser“ (failų naršyklė) eikite į failą, kurį norite nukopijuoti, tada palieskite failą, kad
peržiūrėtumėte išsamią failo sritį.

3. Failo informacijos srityje bakstelėkite „Options“ (parinktys), tada – „Copy“ (kopijuoti).
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Atskirų duomenų perdavimas analizei atlikti

Pasirodys dialogo langas „Select Location“ (pasirinkti vietą).

4. Dialogo lange „Select Location“ (pasirinkti vietą) atlikite vieną iš šių veiksmų:

n Eikite į esamą aplanką.

n Eikite į vietą, kad sukurtumėte aplanką, kuriame įrašysite failą, tada palieskite „Create Folder“ 
(kurti aplanką)

( ), kad toje vietoje sukurtumėte naują aplanką.

5. Palieskite „Select“ (pasirinkti), jei norite nukopijuoti failą į pasirinktą vietą, arba „Cancel“ (atšaukti), jei
norite grįžti į failų naršyklės ekraną.

Pastaba. Jei pasirinktoje vietoje yra failas tuo pačiu pavadinimu, pasirodys pranešimo langas.
Palieskite „Yes“ (taip), jei norite perrašyti esamą failą, arba „No“ (ne), jei norite grįžti į failų
naršyklės ekraną.

„CFX Opus Dx“ sistemoje rodomas patvirtinimo pranešimas, kai failas sėkmingai nukopijuojamas.
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9 skyrius. Eksperimentų paleidimas

Duomenų perkėlimas per programinės įrangos „CFX Maestro Dx“,
„Security Edition“
Norėdami perduoti duomenis per „CFX Maestro Dx SE“

1. Srityje „Detected Instruments“ (aptikti prietaisai), esančioje lange „Home“ (pagrindinis), dešiniuoju
pelės mygtuku spustelėkite norimą prietaisą ir pasirinkite „Retrieve Data Files“ (parsisiųsti duomenų
failus).

„CFX Maestro Dx SE“ pasirodo dialogo langas „Browse For Folder“ (ieškoti aplanko).

2. Dialogo lange „Browse For Folder“ (ieškoti aplanko) suraskite vietą, kurioje planuojate įrašyti
duomenų failus, ir spauskite OK (gerai).

Perdavimo procese pasirinktoje vietoje sukuriamas aplankas „Real-Time Data“ (duomenys realiuoju
laiku). Paleidimo duomenys įrašomi aplanke „Real-Time Data“ (duomenys realiuoju laiku) kaip atskiri
.zpcr failai.

Duomenų perdavimas USB įrenginiu
Jei USB įrenginį įkišite į prietaiso USB prievadą, duomenų failas bus automatiškai įrašytas USB įrenginio
šakniniame kataloge pabaigus paleidimą. Taip pat galite rasti anksčiau įrašytus duomenų failus ir įrašyti
juos prijungtame USB įrenginyje.

Norėdami perkelti duomenų failus į USB diską naudodami „CFX Opus Dx“ sistemas

u Dialogo lange „Select Location“ (pasirinkti vietą) palieskite „USB“ ir eikite į paskirties aplanką,
kuriame nukopijuosite failą, arba „Cancel“ (atšaukti), jei norite grįžti į ekraną „File Browser“ (failų
naršyklė).

Pastaba. Jei pasirinktoje vietoje yra failas tuo pačiu pavadinimu, pasirodys dialogo langas.
Palieskite „Yes“ (taip), jei norite perrašyti esamą failą, arba „No“ (ne), jei norite grįžti į failų
naršyklės ekraną.

„CFX Opus Dx“ sistemoje rodomas patvirtinimo pranešimas, kai failas sėkmingai nukopijuojamas.
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Atskirų duomenų perdavimas analizei atlikti

Duomenų perkėlimas per bendrąjį tinklo diską naudojant „CFX
Opus Dx“ realiojo laiko PGR sistemas
Patarimas. Duomenis į bendrąjį tinklo diską ir iš jo galite perkelti tik per „CFX Opus Dx“ sistemas.

„CFX Opus Dx“ sistema leidžia prisijungti prie bendrojo tinklo disko naudojant „Ethernet“. Sėkmingai
prisijungę, galite perkelti duomenų failus į aplanką ir iš jo bendrajame tinklo diske.

Norėdami perkelti duomenis į bendrąjį tinklo diską ir iš jo

u Dialogo lange „Select Location“ (pasirinkti vietą) palieskite „Network“ (tinklas) ir eikite į paskirties
aplanką, kuriame nukopijuosite failą, arba „Cancel“ (atšaukti), jei norite grįžti į ekraną „File Browser“ 
(failų naršyklė).

Pastaba. Jei pasirinktoje vietoje yra failas tuo pačiu pavadinimu, pasirodys dialogo langas.
Palieskite „Yes“ (taip), jei norite perrašyti esamą failą, arba „No“ (ne), jei norite grįžti į failų
naršyklės ekraną.

„CFX Opus Dx“ sistemoje rodomas patvirtinimo pranešimas, kai failas sėkmingai nukopijuojamas.

Duomenų failo sukūrimas
Norint išanalizuoti duomenis, perduotus iš prietaiso į „CFX Maestro Dx SE“ kompiuterį, suglaudintų
duomenų failą (.zpcr failas) reikia konvertuoti į duomenų failą (.pcrd failas). „CFX Maestro Dx SE“
konvertuoja .zpcr failą į .pcrd failą, tada parenka plokštelės failą, kurio nuskaitymo režimas ir plokštės
dydis yra toks pats, ir taiko jį .pcrd failui.

Duomenų failo sukūrimas iš vieno atskiro duomenų failo

1. „CFX Maestro Dx SE“ atlikite vieną iš šių veiksmų:

n Raskite tikslinį .zpcr failą ir jį nuvilkite į „CFX Maestro Dx SE“ langą „Home“ (pagrindinis).

n Pasirinkite „File“ > „Open“ > „Stand-alone Run“ (failas > atidaryti > atskiras paleidimas) ir
pereikite prie ir pasirinkite tikslinį failą.

„CFX Maestro Dx SE“ rodomas dialogo langas „Save As“ (įrašyti kaip).

2. Pereikite prie aplanko, kuriame planuojate įrašyti .pcrd failą ir spustelėkite „Save“ (įrašyti).

Kai įrašote .pcrd failą, „CFX Maestro Dx SE“ atveriamas langas „Data Analysis“ (duomenų analizė) ir
rodomi gauti duomenys.
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10 skyrius. Duomenų analizės apžvalga
Programinės įrangos „CFX Maestro Dx“, „Security Edition“ apdoroja realiojo laiko PGR duomenis
automatiškai kiekvieno paleidimo pabaigoje ir atidaro langą „Data Analysis“ (duomenų analizė) šiems
duomenims pateikti (.pcrd failas).

n Nuvilkite duomenų failą (.pcrd plėtiniu) į langą „Home“ (pagrindinis) ir jį paleiskite.

n Lange „Home“ (pagrindinis) pasirinkite „File > Open > Data File“ (failas > atidaryti > duomenų failas) ir
pereikite prie taikinio .pcrd failo.

n Lange „Home“ (pagrindinis) pasirinkite „File > Recent Data Files“ (failas > naujausi duomenų failai) ir
sąraše pasirinkite naujausius atidarytus duomenų failus.

n Pasirinkite kortelę „Analyze“ (analizuoti), esančią „Startup Wizard“ (paleisties vedlys) ir arba
pasirinkite iš „Recent Files“ (naujausi failai), arba spustelėkite „Browse“ (naršyti) ir raskite duomenų
failą.

Duomenų analizės langas
Lange „Data Analysis“ (duomenų analizė) yra kelios kortelės; kiekviena kortelė rodo išanalizuotus su
konkrečiu analizės metodu susijusius duomenis arba su tam tikru paleidimu susijusią informaciją.
Kortelės rodomos tik tuo atveju, jei duomenys, surinkti paleidžiant, gali būti naudojami to tipo analizei.

Patarimas. Norėdami išsirinkti rodytinas korteles, pasirinkite jas iš išplečiamojo sąrašo „View“ 
(rodymas) lange „Data Analysis“ (duomenų analizė). Norėdami grįžti prie pirminio kortelių išdėstymo,
pasirinkite „Settings > Restore Default Window Layout“ (nuostatos > atkurti numatytąjį langų
išdėstymą).
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10 skyrius. Duomenų analizės apžvalga

Duomenų analizės įrankių juosta
Įrankių juosta lange „Data Analysis“ (duomenų analizė) leidžia greitai pasiekti svarbias duomenų analizės
funkcijas.

11 lent. išvardytos įrankių juostoje esančių mygtukų funkcijos.

Mygtukas Pavadinimas Funkcija

Plokštelės sąranka „View/Edit“ (žiūrėti / redaguoti) plokštelę –
atidaro „Plate Editor“ (plokštelės redaktorius),
kuriame galima peržiūrėti ir redaguoti šulinėlių
turinį.

Failas „Replace Plate“ (pakeisti plokštelę) –
pasirenka plokštelės failą, kuriuo keičiamas
plokštelės išdėstymas.

Taikyti „PrimePCR“ (PGR pradmenys) failą:
pasirenka paleidimo failą, kuriuo keičiamas
„PrimePCR“ (PGR pradmenys) paleidimo
plokštelės išdėstymas.

Tvarkyti šulinėlių
grupes

Atidaro langą „Well Groups Manager“ (šulinėlių
grupių tvarkyklė), kuriame galima kurti,
redaguoti ir šalinti šulinėlių grupes.

Šulinėlių grupė Pasirenka esamą šulinėlių grupės pavadinimą
iš išplečiamojo meniu. Numatytoji parinktis yra
„All Wells“ (visi šulinėliai). Šis mygtukas
pasirodo tik tada, kai sukuriamos šulinėlių
grupės.

Analizės režimas Analizuoja duomenis režimu „Fluorophore“ 
(fluoroforas) arba „Target“ (taikinys).

Pagalba Atidaro programinės įrangos pagalbos langą,
kuriame rasite internetinį žinyną ir šį vadovą
skaitmeniniu „Acrobat PDF“ formatu.

11 lent. Įrankių juosta lange „Data Analysis“ (duomenų analizė)
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Duomenų analizės langas

Duomenų analizės meniu juosta
12 lent. pateikiami meniu juostos elementai, esantys lange „Data Analysis“ (duomenų analizė).

Meniu
elementas Komanda Funkcija

„File“ (failas) „Save“ (įrašyti) Įrašo failą.

„Save As“ (įrašyti kaip) Įrašo failą nauju pavadinimu.

„File Passwords“ (failų
slaptažodžiai)

Leidžia naudotojams nustatyti failų įrašymo ir
atidarymo slaptažodžius.

„Sign“ (pasirašyti) Leidžia naudotojams pasirašyti duomenų failą.

„Repeat Run“ (kartoti paleidimą) Ištraukia protokolą ir plokštelės failą iš esamos
paleisties ir paleidžia juos iš naujo.

„Close“ (uždaryti) Uždaro langą „Data Analysis“ (duomenų
analizė).

„View“ (rodinys) „Run Log“ (paleidimų žurnalas) Atidaro langą „Run Log“ (paleidimų žurnalas),
kuriame galite peržiūrėti esamo duomenų failo
paleidimų žurnalą.

Audito seka Atidaro failo audito seką.

„Quantification“ (kiekybinis
įvertinimas), „Melt Curve“ 
(lydymosi kreivė), „Gene
Expression“ (geno ekspresija),
„End Point“ (pabaigos taškas),
„Custom Data View“ (pasirinktinių
duomenų rodinys), QC (KK), „Run
Information“ (paleidimo išsami
informacija)

Rodo analizuojamus duomenis pasirinktose
lango „Data Analysis“ (duomenų analizė)
kortelėse. Reikia pasirinkti bent vieną kortelę.

12 lent. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai
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Meniu
elementas Komanda Funkcija

Nuostatos „Cq Determination Mode“ (Cq
nustatymo režimas)

Leidžia pasirinkite režimą „Regression“ 
(regresija) arba „Single Threshold“ (atskira
ribinė reikšmė), norint nustatyti, kaip
skaičiuojamos kiekvieno pėdsako Cq
reikšmės.

12 lent. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai (tęsinys)
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Duomenų analizės langas

Meniu
elementas Komanda Funkcija

„Baseline Setting“ (pradinis
nustatymas)

Leidžia pasirinkti metodą „Baseline
Subtraction“ (pradinė atimtis) pasirinktoms
šulinėlių grupėms.

„Analysis mode“ (analizės
režimas)

Leidžia analizuoti duomenis pagal
„Fluorophore“ (fluoroforas), ar „Target“ 
(taikinys).

„Cycles to Analyze“ (analizuotini
ciklai)

Leidžia pasirinkti analizuojamus ciklus.

„Baseline Threshold“ (pagrindinė
ribinė reikšmė)

Atidaro „Baseline Thresholds“ (pagrindinės
ribinės reikšmės) langą, kuriame galima keisti
pagrindinę arba ribinę reikšmę.

„Trace Styles“ (pėdsakų stiliai) Atidaro langą „Trace Styles“ (pėdsakų stiliai).

„Plate Setup“ (plokštelės sąranka) Atidaro „Plate Editor“ (plokštelės redaktorius),
kuriame galima peržiūrėti ir redaguoti
plokštelę; pakeiskite esamą plokštelę ta, kuri
yra naudotojo apibrėžtos plokštelės faile arba
„PrimePCR“ (PGR pradmenys) paleidimo faile.

„Include All Excluded Wells“ 
(įtraukti visus neįtrauktus
šulinėlius)

Įtraukia visus neįtrauktus šulinėlius į analizę.

„Mouse Highlighting“ (žymėjimas
pele)

Įjungia arba išjungia funkciją, kuri leidžia tuo
pačiu metu paryškinti duomenis pelės rodykle.

Patarimas. Jei funkcija „Mouse
Highlighting“ (žymėjimas pele) išjungta,
spustelėkite mygtuką „Control“ (kontrolė),
kad laikinai ją įjungtumėte.

„Restore Default Window Layout“ 
(atkurti numatytąjį langų
išdėstymą)

Atkuria langų išdėstymą pagal numatytąsias
nuostatas.

12 lent. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai (tęsinys)
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Meniu
elementas Komanda Funkcija

„Export“ 
(eksportuoti)

„Export All Data Sheets“ 
(eksportuoti visus duomenų lapus)

Leidžia pasirinkti, ar eksportuoti visus
skaičiuoklės rodinius iš kiekvienos kortelės į
.csv, .txt. „Excel“ arba .xml failą.

„Export RDML File“ (eksportuoti
RDML failą)

Leidžia pasirinkti RDML 1.1 arba 1.0 versiją,
kuria eksportuoti failą.

„Custom Export“ (pasirinktinis
eksportas)

Atidaro langą „Custom Export“ (pasirinktinis
eksportas), kuriame galima nurodyti
eksportuotinus laukelius ir failo formatą.

„Export to LIMS Folder“ 
(eksportuoti į LIMS aplanką)

Atidaro langą, kuriame galima įrašyti duomenis
iš anksto nustatytu formatu LIMS aplanke.

Rankinis eksportavimas Atidaro langą, kuriame galima pasirinkti vietą,
kurioje „Excel“ formatu, specialiai pritaikytu
„Seegene, Inc“ ir „ Bio-Rad Laboratories“, bus
įrašyti duomenys iš visų skaičiuoklių rodinių.

Patarimas. Taip pat eksportuodami galite
automatiškai paleisti „Seegene Viewer“.
Daugiau informacijos žr. Meniu „Tools“ 
(įrankiai) komandos, p. 67

„Tools“ (įrankiai) „Reports“ (ataskaitos) Atidaro šio duomenų failo ataskaitą.

„Well Group Reports“ (šulinėlių
grupės ataskaitos)

Atidaro langą „Well Group Report“ (šulinėlių
grupės ataskaita), kuriame galima kurti
ataskaitas nurodytoms šulinėlių grupėms.

„Import Fluorophore Calibration“ 
(importuoti fluoroforo kalibravimą)

Pasirinkite kalibravimo failą, kurį norite taikyti
esamam duomenų failui.

„qbase+“ Paleidžia 2.5 versijos „qbase+“ tiesiai iš esamo
.pcrd failo (jei jis įdiegtas).

„Generate LIMS PLRN file“ 
(generuoti LIMS PLRN failą)

Duomenų failas įrašomas kaip LIMS formato
.plrn failas.

12 lent. Lango „Data Analysis“ (duomenų analizė) meniu juostos elementai (tęsinys)
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Kortelės išsami informacija
Kiekvienoje lango „Data Analysis“ (duomenų analizė) kortelėje rodomi diagramų ir skaičiuoklių
duomenys, skirti tam tikram analizės metodui, taip pat yra šulinėlių parinkiklis, kad galėtumėte pasirinkti
norimus rodyti duomenis. Atidarius langą „Data Analysis“ (duomenų analizė) pagal numatytąsias
nuostatas jame rodoma kortelė „Quantification“ (kiekybinis įvertinimas). Jei norite nustatyti tinkamus
analizės parametrus, galite naudoti diagramą „Amplification“ (amplifikavimas), esančią kortelėje
„Quantification“ (kiekybinis įvertinimas).

Pastaba. Programinė įranga susieja kiekvienos kortelės „Data Analysis“ (duomenų analizė) sričių
duomenis. Pavyzdžiui, jei šulinėlis yra paryškinamas, užvedus virš jo pelės rodyklę šulinėlių
parinkiklio rodinyje, taip pat paryškinami su juo susiję duomenys visose kitose srityse.

Veiksmo numerio parinkiklis
„CFX Opus Dx“ sistemos gali gauti fluorescencijos duomenis, surinktus atlikus įvairius protokolo
veiksmus; programinė įranga išsaugo kiekvieno veiksmo metu gautus duomenis atskirai vienus nuo kitų.
„CFX Maestro Dx SE“ įranga rodo parinkiklį „Step Number“ (veiksmo numeris) po diagrama „Standard
Curve“ (standartinė kreivė) kortelėje „Quantification“ (kiekybinis įvertinimas). Jei protokolas apima bent
vieną duomenų rinkimo veiksmą, „CFX Maestro Dx SE“ rodo pirmojo rinkimo veiksmo metu gautus
duomenis.

Jei protokolas apima daugiau nei vieną rinkimo veiksmą, išplečiamajame sąraše galite pasirinkti kitą
veiksmą. Pavyzdžiui:
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Kai pasirenkate veiksmą, programinė įranga taiko šią parinktį visiems duomenims, rodomiems lange
„Data Analysis“ (duomenų analizė).

Šulinėlių grupių lange „Data Analysis“ (duomenų analizė)
peržiūrėjimas
Plokštelės šulinėlius galima sugrupuoti į pogrupius nepriklausomai analizei, naudojant šulinėlių grupes.
Kai sukuriate šulinėlių grupes, jų pavadinimai pasirodo įrankių juostoje esančiame išplečiamajame sąraše
„Well Groups“ (šulinėlių grupės) lange „Data Analysis“ (duomenų analizė).

Jei sukūrėte šulinėlių grupių, programinėje įrangoje atidarius langą „Data Analysis“ (duomenų analizė)
rodoma numatytoji šulinėlių grupė „All Wells“ (visi šulinėliai). Joje diagramų ir skaičiuoklių forma
pateikiami visų šulinėlių duomenys. Šulinėlių parinkiklyje rodomi tik grupės šulinėliai su turiniu ir tik šių
šulinėlių duomenys įtraukiami į duomenų analizės skaičiavimus.

Patarimas. Norėdami kurti, redaguoti ir šalinti šulinėlių grupes, spauskite „Manage Well Groups“ 
(tvarkyti šulinėlių grupes) įrankių juostoje.

Pastaba. Jei nesate sukūrę šulinėlių grupių, išplečiamasis sąrašas „Well Groups“ (šulinėlių grupės)
įrankių juostoje nerodomas.

Šulinėlių turinio keitimas po paleidimo
Kai atliekant duomenų analizę keičiamas duomenų rodymo būdas, keičiant šulinėlių turinį „Plate Editor“ 
(plokštelės redaktorius), niekada nesikeičia fluorescencijos duomenys, kurie buvo surinkti iš kiekvieno
šulinėlio paleidžiant. Kai modulis renka fluorescencinius duomenis, negalite šalinti šių duomenų, tačiau
galite pasirinkti pašalinti duomenis iš peržiūros ir analizės.

Šulinėlių turinio pakeitimas po paleidimo

u Lange „Data Analysis“ (duomenų analizė) spustelėkite „Plate Setup“ (plokštelės sąranka) ir
pasirinkite vieną iš šių parinkčių:

n „Edit/View Plate“ (redaguoti / peržiūrėti plokštelę) – atidaromas „Plate Editor“ (plokštelės
redaktorius), kuriame rankiniu būdu galite atlikti schemos pakeitimus.

n „Replace Plate file“ (pakeisti plokštelės failą) – atidaroma naršyklė „Select Plate“ (pasirinkti
plokštelę), kurioje galite pasirinkti anksčiau įrašytą plokštelės failą dabartiniam plokštelės
išdėstymui pakeisti.

n „Apply PrimePCR file“ (taikyti PGR pradmenų failą) – atidaromas failo dialogo langas
„Select PrimePCR“ (pasirinkti PGR pradmenis), iš kurio galite pasiekti „PrimePCR“ (PGR
pradmenys) analizės failą ir taikyti jį plokštelės schemai.
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Patarimas. Jūs galite pridėti arba redaguoti informaciją apie šulinėlio turinį prieš paleidimą,
paleidžiant arba tada, kai PGR paleidimas baigtas. Nuskaitymo režimą ir plokštelės dydį turite
priskirti prieš pradėdami paleidimą. Šie parametrai pradėjus paleidimą negali būti keičiami.
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Duomenų analizės nuostatos
Diagramos „Amplification“ (amplifikavimas) duomenys kortelėje „Quantification“ (kiekybinis įvertinimas)
rodo kiekvieno šulinėlio santykinį fluorescencijos vienetą (RFU) kiekvieno ciklo metu. Kiekvienas
pėdsakas diagramoje reiškia duomenis iš atskiro fluoroforo viename šulinėlyje. Šie duomenys naudojami
nustatyti Cq vertėms kiekvienam šulinėliui pagal fluoroforą. Programinė įranga taiko vieną iš dviejų režimų
Cq vertėms nustatyti:

n „Regression“ (regresija) – taiko daugialypį, netiesinės regresijos modelį atskirų šulinėlių
pėdsakams ir tada šį modelį naudoja apskaičiuoti optimaliai Cq vertei.

n „Single Threshold“ (atskira ribinė reikšmė) – naudoja atskirą ribinę reikšmę Cq vertei apskaičiuoti
pagal atskirų fluorescencijos pėdsakų ribinę reikšmę kertantį tašką.

Pasirinkite „Settings > Cq Determination Mode“ (nuostatos > Cq nustatymo režimas) ir pasirinkite Cq
nustatymo režimą.

Ribinės reikšmės koregavimas
Režimu „Single Threshold“ (atskira ribinė reikšmė) galite koreguoti fluoroforo ribinę reikšmę spustelėję
ribinės reikšmės liniją amplifikavimo diagramoje ir pelės rodyklę perkėlę vertikaliai. Taip pat galite nurodyti
pasirinkto fluoroforo tikslią perėjimo ribinę reikšmę.

Pradinės nuostatos
Programinė įranga automatiškai nustato pradines nuostatas atskirai kiekvienam šulinėliui. Pradinė
nuostata apibrėžia pradinį atimties metodą, taikomą visiems fluorescencijos pėdsakams. Programinėje
įrangoje numatytos trys pradinės atimties parinktys:

n „No Baseline Subtraction“ (pradinės atimties nėra) – rodo duomenis kaip santykinius
fluorescencijos pėdsakus. Kai kuri analizė šiuo analizės režimu neįmanoma, todėl programinė įranga
nerodo kortelių „Gene Expression“ (geno ekspresija), „End Point“ (pabaigos taškas) ir „Allelic
Discrimination“ (alelių diskriminacija).

n „Baseline Subtracted“ (pradinė atimtis) – rodo duomenis kaip pėdsako pradinę atimtį, susijusią
su kiekvienu šulinėlio fluoroforu. Programinė įranga turi sukurti duomenų pradinę atimtį, kad
nustatytų kiekybinius ciklus, braižytų standartines kreives ir nustatytų nežinomų mėginių
koncentraciją. Kai norima sukurti pėdsako pradinę atmintį, programinė įranga nustato pradinio ciklo
metu kiekvienam šulinėliui įrašytą fluorescencijos geriausią tiesiąją liniją ir tada atrenka
tinkamiausius duomenis iš foninių kiekvieno ciklo metu atrinktų duomenų.

n „Baseline Subtracted Curve Fit“ (pradinės atimties kreivės atitiktis) – rodo duomenis kaip
pėdsako pradinę atimtį, o programinė įranga išlygina pradinės atimties kreivę, naudodama centruotą
vidurkio filtrą. Šis procesas atliekamas taip, kad kiekvienas Cq liktų nepakitęs.
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Be šių parinkčių, taip pat galite pasirinkti „Apply Fluorescent Drift Correction“ (taikyti fluorescencijos dreifo
korekciją). Šulinėlių, kuriuose per pradinius kelis analizės ciklus gaunamos neįprastai išsisklaidžiusios RFU
reikšmės, atveju programinė įranga apskaičiuoja numatytą pradinę liniją iš gretimų šulinėlių, kuriems
sėkmingai sukurta horizontali pradinė linija.

Pradinės atimties nuostatos keitimas

u Pasirinkite „Settings > Baseline Setting“ (nuostatos > pradinis nustatymas).

Analizės režimas
Duomenis galima sugrupuoti ir analizuoti arba pagal fluoroforą, arba taikinio pavadinimą. Sugrupavus pagal
fluoroforą, duomenų pėdsakai rodomi pagal fluoroforą, kaip nurodyta to paleidimo plokštelės nuostatose.
Atskiro fluoroforo duomenys parodomi amplifikavimo ir standartinės kreivės diagramoje (jeigu yra), kai
pažymimi atitinkami fluoroforo pasirinkimo priemonės žymės langeliai, esantys po amplifikavimo diagrama.

Sugrupavus pagal taikinį, duomenų pėdsakai parodomi pagal taikinio pavadinimą, koks jis buvo įvestas į
paleidimo plokštelės sąranką.

Duomenų analizės režimo pasirinkimas

u Atlikite vieną iš toliau nurodytų veiksmų:

n Pasirinkite „Settings > Analysis Mode“ (nuostatos > analizės režimas).

n Įrankių juostos išplečiamajame meniu „Analysis Mode“ (analizės režimas) pasirinkite režimą.
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Analizuotini ciklai
Galite riboti analizuotinų ciklų skaičių. Taip pat galite analizuoti duomenis iš konkretaus ciklų rinkinio.
Didžiausias ciklų, kurį galite analizuoti, skaičius yra 50.

Pastaba. Pašalinus ciklus iš paleidimo pradžios galima padaryti didelę įtaką pradiniam lygiui.

Duomenų analizės apribojimas iki konkretaus ciklų intervalo

1. Pasirinkite „Settings > Cycles to Analyze“ (nuostatos > analizuotini ciklai).

Parodomas dialogo langas „Cycles to Analyze“ (analizuotini ciklai).

2. Įveskite pradžios ir pabaigos ciklo vertes ir spustelėkite OK (gerai).

Dialogo lange „Cycles to Analyze“ (analizuotini ciklai) spustelėkite „Restore Defaults“ (atkurti
numatytuosius parametrus) ir grįžkite į analizei pradžioje naudojamus ciklus.
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Šulinėlių parinkiklis
Pasinaudokite šulinėlių parinkikliu šulinėlio duomenims parodyti arba paslėpti diagramose arba
skaičiuoklėse lange „Data Analysis“ (duomenų analizė). Šulinėlių parinkiklyje galima pasirinkti tik su
mėginiais įdėtus šulinėlius. Programinė įranga šulinėlių parinkiklyje nuspalvina šulinėlius:

n „Blue“ (mėlyna) – reiškia pasirinktus šulinėlius. Duomenys iš pasirinktų šulinėlių rodomi lange „Data
Analysis“ (duomenų analizė).

n „Light gray“ (šviesiai pilka) – reiškia nepasirinktus šulinėlius. Duomenys iš nepasirinktų šulinėlių
nerodomi lange „Data Analysis“ (duomenų analizė).

n „Dark gray“ (tamsiai pilka) – reiškia tuščius šulinėlius.

Šulinėlių duomenų rodymas arba paslėpimas

u Šulinėlių parinkiklyje atlikite toliau nurodytus veiksmus:

n Norėdami paslėpti vieną šulinėlį, spustelėkite atskirą šulinėlį. Norėdami rodyti tą šulinėlį, jį
spustelėkite dar kartą.

n Norėdami paslėpti kelis šulinėlius, vilkite per šulinėlius, kuriuos norite pasirinkti. Norėdami šiuos
šulinėlius rodyti, vėl vilkite per šiuos šulinėlius.

n Spustelėkite plokštelės viršutinį kairįjį kampą ir paslėpkite visus šulinėlius. Spustelėkite viršutinį
kairįjį kampą dar kartą ir rodykite visus šulinėlius.

n Spustelėkite stulpelio ar eilutės pradžią ir šiuos šulinėlius paslėpkite. Stulpelį ar eilutę
spustelėkite dar kartą ir parodykite šulinėlius.
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Šulinėlių parinkiklio pelės dešiniojo mygtuko meniu elementai
13 lent. pateikiamos pelės dešiniojo mygtuko parinktys, prieinamos šulinėlių parinkiklio rodinyje.

Elementas Funkcija

„Well XX“ (šulinėlis XX) Rodomas tik šis šulinėlis, šis šulinėlis pašalinamas iš rodinio,
nustatoma šio šulinėlio spalva arba šis šulinėlis pašalinamas iš
analizės.

„Selected Wells“ (pasirinkti
šulinėliai) (spustelėjus dešinįjį
pelės mygtuką ir tempiant)

Rodomi tik šie šulinėliai, šie šulinėliai pašalinami iš rodinio, nustatoma
šių šulinėlių spalva arba šie šulinėliai pašalinami iš analizės.

„Copy“ (kopijuoti) Šulinėlio turinys, įskaitant mėginio tipą ir pasirinktines kopijas (Nr.),
kopijuojamas į iškarpinę.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Šulinėlio parinkiklio rodinys kopijuojamas kaip paveikslėlis.

„Print“ (spausdinti) Atspausdinamas šulinėlio parinkiklio rodinys.

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinamas esamas pasirinkimas.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

„Export to Csv“ (eksportuoti į
Csv)

Duomenys eksportuojami kaip .csv dokumentas.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami kaip .xml dokumentas.

„Well Labels“ (šulinėlių etiketės) Šulinėlių etiketės pakeičiamos į „Sample Type“ (mėginio tipas), „Target
Name“ (taikinio pavadinimas) arba „Sample Name“ (mėginio
pavadinimas).

13 lent. Pelės dešiniojo mygtuko meniu elementai šulinėlių parinkiklio rodinyje
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Iš analizės laikinai pašalinami šulinėliai
Kaip laikinai pašalinti šulinėlius iš analizės

1. Spustelėkite šulinėlį dešiniuoju pelės mygtuku šulinėlių parinkiklyje ant fluorescencinio pėdsako arba
taško, pateikto standartinėje kreivėje. Jei norite pašalinti kelis šulinėlius, spustelėkite dešinįjį pelės
mygtuką ir vilkite pelės rodyklę, kad pažymėtumėte keletą šulinėlių, pėdsakų ar taškų.

2. Dešiniojo pelės mygtuko meniu pasirinkite norimą parinktį:

n „Well > Exclude Well“ (šulinėlis > pašalinti šulinėlį)

n „Selected Wells > Exclude from Analysis“ (pasirinkti šulinėliai > pašalinti iš analizės)

n „Selected Traces > Exclude these wells from Analysis“ (pasirinkti pėdsakai > pašalinti šiuos
šulinėlius iš analizės)

Norėdami visam laikui pašalinti šulinėlius iš analizės, taip pat galite išvalyti šulinėlių turinį lange „Plate
Editor“ (plokštelės redaktorius) paspausdami mygtuką „Clear Wells“ (valyti šulinėlius).

Svarbu. Turite iš naujo įvesti bet kokį pašalintą turinį.

Kaip grąžinti pašalintą šulinėlį

u Spustelėkite atitinkamą šulinėlį dešiniuoju pelės mygtuku šulinėlių parinkiklyje ir pasirinkite „Well >
Include Well in Analysis“ (šulinėlis > įtraukti šulinėlį į analizę).
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Diagramos
Kiekvienoje lange „Data Analysis“ (duomenų analizė) esančioje diagramoje duomenų rodymas skiriasi
grafiškai ir pateikiamos duomenų arba diagramų grafikos koregavimo ir eksportavimo parinktys.

Diagramos įrankiai
14 lent. pateikiamos pelės dešiniojo mygtuko meniu parinktys, prieinamos daugelyje diagramų.

Elementas Funkcija

„Copy“ (kopijuoti) Diagramą kopijuoja į iškarpinę.

„Save Image As...“ (įrašyti
paveikslėlį kaip)

Diagrama įrašoma kaip vaizdinis failas. Nustatykite vaizdo raišką ir
dydį, o tada pasirinkite failo tipą (PNG, GIF, JPG, TIF arba BMP).

„Page Setup...“ (puslapio
sąranka)

Parenkama puslapio sąranka spausdinti.

„Print...“ (spausdinti) Atspausdina diagramą.

„Set Scale to Default“ (nustatyti
numatytąją skalę)

Parodomi visi duomenys stulpelinėje diagramoje. Jei diagramos rėme
yra per daug rodytinų duomenų taškų / mėginių, rodomos slinkties
juostos.

„Chart Settings“ (diagramos
nuostatos)

Atidaromas dialogo langas „Chart Settings“ (diagramos nuostatos),
kuriame galite keisti diagramos rodymo parinktis, tokias kaip:

n Diagramos ir ašių pavadinimai

n Diagramos ir ašių šriftas bei dydis

n Ašių mastelis

n Legendos padėtis

14 lent. Pelės dešiniojo mygtuko meniu elementai, būdingi daugumai diagramų

Be to, diagramos įrankiai rodomi kiekvienoje diagramoje, pateikiamoje lange „Data Analysis“ (duomenų
analizė). Šie įrankiai rodomi visose diagramose:

„Copy to Clipboard“ (kopijuoti į iškarpinę) – diagramos rodinio turinys kopijuojamas į iškarpinę.

„Chart Settings“ (diagramos nuostatos) – atidaromas dialogo langas „Chart Settings“ (diagramos
nuostatos), kuriame galite keisti diagramos rodymo parinktis.

„Export“ (eksportuoti) – atidaromas dialogo langas „Export Options“ (eksportavimo parinktys), kuriame
galite keisti grafiko raišką bei dydį ir įrašyti jį nurodytoje vietoje kaip vieno iš šių tipų failą:

n .bmp
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Diagramos

n .jpg

n .png

Stulpelinės diagramos įrankiai

Be diagramos įrankių, stulpelinėse diagramose rodomi šie įrankiai:

„Sort“ (rikiuoti) – taikinius ir mėginius išrikiuoja abėcėlės arba atvirkštine tvarka.

„Color Settings“ (spalvų nuostatos) – atidaromas dialogo langas „Color Settings“ (spalvų nuostatos),
kuriame galite pakeisti taikinių ir mėginių spalvą.

Daugiau informacijos apie šiuos įrankius žr. Diagramos vaizdo keitimas ir komentavimas, p. 270.

Diagramos „Amplification“ (amplifikavimas) įrankiai

Be anksčiau išvardytų, amplifikavimo diagramose rodomi šie įrankiai:

„Trace Styles“ (pėdsakų stilius) – atidaromas dialogo langas „Trace Styles“ (pėdsakų stilius), kuriame
galite keisti pėdsakų išvaizdą amplifikavimo diagramoje.

„Baseline Threshold“ (pradinė ribinė reikšmė) – atidaromas dialogo langas „Baseline Threshold“ 
(pradinė ribinė reikšmė), kuriame galite keisti pasirinktų šulinėlių ribinę reikšmę arba pakeisti kiekvienos
fluorescencinės kreivės ribinę reikšmę amplifikavimo diagramoje.

Diagramos duomenų kopijavimas į iškarpinę

Galite nukopijuoti diagramos rodinio turinį ir įklijuoti jį į bet kurią programą, kuri priima taškinės grafikos
vaizdo failus.

Kaip kopijuoti diagramos duomenis į iškarpinę

1. Diagramos įrankiuose pasirinkite piktogramą „Copy to Clipboard“ (kopijuoti į mainų sritį).

2. Atidarykite programą, kuri priima taškinės grafikos vaizdus, pvz., „Microsoft Word“.

3. Dešiniuoju pelės mygtuku spustelėkite ir pasirinkite „Paste“ (įklijuoti), kad įklijuotumėte taškinės
grafikos vaizdą iš iškarpinės į taikomąją programą.

Diagramos rodmenų nuostatų keitimas

Dialogo lange „Chart Settings“ (diagramos nuostatos) pakeiskite rodomos diagramos antraštes, šriftą ir
šrifto dydį, ašies mastelį ir legendos vietą. Jūsų atlikti pakeitimai galios tik rodomai diagramai ir jie yra
įrašomi su diagrama.
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Diagramos rodmens nuostatų keitimas

1. Diagramos įrankiuose spustelėkite „Chart Settings“ (diagramos nuostatos).

Parodomas dialogo langas „Chart Settings“ (diagramos nuostatos).

2. Pasirinkite kortelę „Chart And Axes“ (diagramos ir ašys), norėdami:

n įrašyti diagramos antraštę,

n įrašyti x ašies naują antraštę ir paversti etiketes,

n įrašyti y ašies naują antraštę.

3. Pasirinkite kortelę „Font“ (šriftas) ir pakeiskite diagramos šriftą ir jo dydį.

Patarimas. Pagal numatytuosius parametrus šrifto dydis automatiškai pakeičiamas, kai
pakeičiamas diagramos dydis. Pasirinkite „Change Font Size“ (keisti šrifto dydį) ir kiekvienam
etiketės tipui nustatykite statinį šrifto dydį.

4. Pasirinkite kortelę „Axes Scale“ (ašių mastelis), norėdami:

n pašalinti x ir y ašių automatinį mastelio keitimą ir nurodyti mažiausią ir didžiausią mastelio vertę,

n diagramoje parodyti grotelių linijas ar varneles.

5. Pasirinkite kortelę „Legend“ (legenda), norėdami:

n paslėpti diagramos legendą,

n pakeisti numatytąją diagramos legendos padėtį.
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Pastaba. Kai legenda yra diagramos kairėje ar dešinėje, joje rodomi tik pirmieji dešimt
fluoroforų.

6. Bet kuriuo metu paspauskite „Apply“ (taikyti) ir peržiūrėkite diagramos nuostatų pakeitimus jų
neįrašę.

7. Spustelėkite „OK“ (gerai), įrašykite pakeitimus ir grįžkite į diagramą.

Diagramos eksportavimas

Šiame dialogo lange modifikuokite diagramos plotį, aukštį ir raišką, norėdami ją eksportuoti vienu iš šių
formatu:

n .bmp

n .jpg

n .png

Eksportuotas diagramas galite naudoti savo rezultatams pademonstruoti pristatymuose plakate,
„Microsoft PowerPoint“ ir profesionaliuose žurnaluose.

Pastaba. Apsvarstykite šias modifikavimo nuostatas:

n Didžiausio ir mažiausio pločio ir aukščio ribos

o Esant 72 dpi: 0,1–83 coliai

o Esant 96 dpi: 0,1–62 coliai

o Esant 150 dpi: 0,1–40 colių

o Esant 300 dpi: 0,1–20 colių

o Esant 600 dpi: 0,1–10 colių

o Esant visoms raiškoms: 2–6 000 pikselių

n Vaizdo santykis pagrįstas pločiu.

Kaip eksportuoti diagramą

1. Diagramos įrankiuose spustelėkite „Export“ (eksportuoti).

Parodomas dialogo langas „Export Preview“ (eksporto peržiūra).
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2. Modifikuokite rodmens nuostatas, jeigu reikia.

3. Spustelėkite „Export“ (eksportuoti).

4. Dialogo lange „Export“ (eksportuoti):

a. (Papildoma) Eikite į aplanką, kuriame įrašysite diagramos failą.

b. Įrašykite failo pavadinimą ir išplečiamajame sąraše pasirinkite failo tipą.

5. Spustelėkite „Save“ (įrašyti) ir įrašykite diagramos failą.

Pradinės ribinės reikšmės nuostatų modifikavimas

Režimu „Single Threshold“ (atskira ribinė reikšmė) galite koreguoti fluoroforo ribinę reikšmę spustelėję
ribinės reikšmės liniją amplifikavimo diagramoje ir pelės rodyklę perkėlę vertikaliai. Taip pat galite nurodyti
pasirinkto fluoroforo tikslią perėjimo ribinę reikšmę.

Patarimas. Galite nurodyti ciklo intervalą, kad būtų galima nustatyti pradinį visų duomenų failų lygį,
kortelėje „Data Analysis“ (duomenų analizė), esančioje „User > User Preferences“ (naudotojas >
naudotojo nuostatos).

Kiekvieno šulinėlio pradinio lygio pradžios ir pabaigos ciklo koregavimas

1. Kortelėje „Quantification“ (kiekybinis įvertinimas) pasirinkite atskirą fluoroforą diagramoje
„Amplification“ (amplifikavimas).

2. Diagramos įrankiuose pasirinkite „Baseline Threshold“ (pagrindinė ribinė reikšmė).
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Parodomas dialogo langas „Baseline Threshold“ (pradinė ribinė reikšmė).

3. Skyriuje „Baseline Cycles“ (pradiniai ciklai) atlikite šiuos veiksmus:

n Norėdami pasirinkti vieną šulinėlį, spustelėkite jo eilutės numerį.

n Norėdami pasirinkti kelis gretimus šulinėlius, spustelėkite pirmojo šulinėlio eilės numerį ir vilkite
stulpeliu žemyn iki galutinio šulinėlio.

n Norėdami pasirinkti kelis negretimus šulinėlius, paspauskite klavišą „Control“ (valdyti) ir
spustelėkite kiekvieną taikinio šulinėlį.

n Norėdami pasirinkti visus šulinėlius, spustelėkite lentelės viršutinį kairįjį kampą.

4. Koreguokite visų pasirinktų šulinėlių pradinį pradžios ciklą ir pradinį pabaigos ciklą arba skaičiuoklės
apačioje pakeiskite pradžios ir pabaigos ciklo numerį.

Patarimas. Norėdami sugrąžinti nuostatų paskutines įrašytas vertes, spustelėkite „Reset All
User Defined Values“ (atstatyti visas naudotojo apibrėžtas vertes).

5. Spustelėkite „OK“ (gerai), įrašykite pakeitimus ir grįžkite į diagramą.

Visų duomenų failų ciklo intervalo nurodymas

u Lange „Home“ (pagrindinis) arba „Plate Editor“ (plokštelės redaktorius) pasirinkite „User > User
Preferences“ (naudotojas > naudotojo nuostatos) ir pasirinkite kortelę „Data Analysis“ (duomenų
analizė).

Taikinio, mėginio ir biologinės grupės duomenų rūšiavimas

Pastaba. Ši parinktis galima tik geno ekspresijos diagramose.

Pagal numatytąsias nuostatas taikinio, mėginių ir biologinių grupių sąrašai pateikiami abėcėlės tvarka.
Dialogo lange „Sort“ (rūšiuoti) galite rūšiuoti rodmenis atvirkštine tvarka pagal abėcėlę arba rankiniu būdu
perkelti terminą į kitą padėtį sąraše.

Norėdami rūšiuoti taikinio, mėginio ir biologinės grupės duomenis

1. Diagramos įrankiuose spustelėkite „Sort“ (rūšiuoti).

Parodomas dialogo langas „Gene Expression Chart Sorting“ (geno ekspresijos diagramų
rūšiavimas).
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2. Dialogo lange spustelėkite Z–A ir surūšiuokite sąrašą atvirkštine abėcėline tvarka.

3. Norėdami rankiniu būdu perkelti terminą, jį pasirinkite ir spustelėkite atitinkamą mygtuką tarp
diagramų:

n Spustelėkite rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite per vieną padėtį.

n Spustelėkite juostos rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite į sąrašo viršų ar
apačią.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į kortelę „Gene Expression“ (geno ekspresija).
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Taikinio ir mėginio spalvos nuostatų keitimas

Pastaba. Ši parinktis galima tik geno ekspresijos diagramose.

Dialogo lange „Color Settings“ (spalvų nuostatos) galite pakeisti taikinio ar mėginio spalvą arba iš
diagramos pašalinti elementą.

Spalvų nuostatų keitimas

1. Diagramos įrankiuose pasirinkite „Color Settings“ (spalvų nuostatos).

Parodomas dialogo langas „Color Settings“ (spalvų nuostatos).

2. Norėdami pakeisti taikinio ar mėginio rodmens spalvą, stulpelyje „Color“ (spalva) spustelėkite jo
spalvą.

3. Pasirodžiusiame dialogo lange „Color“ (spalva) pasirinkite naują spalvą ir spustelėkite „OK“ (gerai).

4. Norėdami elementą pašalinti iš geno ekspresijos diagramos, panaikinkite jo žymės langelio stulpelyje
„Show Chart“ (rodyti diagramą) žymėjimą.

Patarimas. Norėdami visus elementus pašalinti iš geno ekspresijos diagramos, panaikinkite
„Show Chart“ (rodyti diagramą) žymės langelio stulpelyje antraštėje žymėjimą.

5. (Papildoma) Pagal numatytąsias nuostatas stulpelinė diagrama parodoma intensyvėjančiomis
spalvomis. Kad būtų rodomos vientisos formos spalvos, pasirinkite „Use Solid Colors“ (naudoti
vientisas spalvas).

6. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į kortelę „Gene Expression“ (geno ekspresija).
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Diagramos srities didinimas
Kaip didinti diagramos sritį

u Spustelėkite ir vilkite pele diagramoje, o tada spustelėkite „Zoom“ (keisti mastelį). Programinė įranga
pakeičia diagramos dydį ir ją centruoja pasirinktoje srityje.

Pastaba. Stulpelinėje diagramoje nereikia spustelėti „Zoom“ (keisti mastelį) išplečiamosios
komandos.

Diagramos nustatymas į visą rodinį

u Diagramoje spustelėkite dešiniuoju klavišu ir pasirinkite „Set Scale to Default“ (nustatyti numatytąją
skalę).

Diagramų kopijavimas į „Microsoft“ failą
Duomenų diagramas galite kopijuoti į „Microsoft Word“, „Excel“ arba „PowerPoint“ dokumentus. Vaizdo
skiriamoji geba atitinka ekrano, iš kurio buvo gautas vaizdas, skiriamąją gebą.

Kaip nukopijuoti diagramas į „Microsoft“ failą

1. Lange „Data Analysis“ (duomenų analizė) spustelėkite „Copy To Clipboard“ (kopijuoti į iškarpinę)
viršutiniame dešiniajame diagramos srities kampe.

2. Atidarykite tuščią „Microsoft“ failą ir įklijuokite turinį iš iškarpinės.

Bendrieji pelės dešiniojo mygtuko meniu elementai, skirti
diagramoms
15 lent. pateikiami pelės dešiniojo mygtuko meniu elementai, kurie gali būti naudojami diagramose. Kai
kurie elementai yra skirti visoms diagramoms; įskaitant elementus, skirtus keisti duomenų rodymo būdą
arba lengvai eksportuoti duomenis iš diagramos.

Elementas Funkcija

„Copy“ (kopijuoti) Diagrama nukopijuojama į iškarpinę.

„Save Image As“ 
(įrašyti paveikslėlį
kaip)

Įrašomas nustatyto dydžio, raiškos ir failo tipo vaizdas, įskaitant PNG (numatytasis),
JPG ir BMP.

15 lent. Pelės dešiniojo mygtuko meniu elementai, skirti diagramoms
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Elementas Funkcija

„Page Setup“ 
(puslapio sąranka)

Rodo spausdinimo sąrankos parinktis.

„Print“ (spausdinti) Atspausdina diagramą.

„Set Scale to
Default“ (nustatyti
numatytąją skalę)

Padidinta diagrama grąžinama į numatytąjį rodinį.

„Chart Options“ 
(diagramos
parinktys)

Atidaromas langas „Chart Options“ (diagramos parinktys), kuriame galima pakeisti
diagramą, įskaitant pavadinimą, x ir y ašių ribų pasirinkimą, tinklelio linijų ir mažųjų
varnelių ašyse rodymą.

Pastaba. Meniu elementai, taikomi konkrečioms diagramoms, aprašyti 11 skyrius, Išsami duomenų
analizės informacija.
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Skaičiuoklės
Lange „Data Analysis“ (duomenų analizė) pateiktos skaičiuoklės apima duomenų rūšiavimo ir perdavimo
galimybes. Rūšiuokite stulpelius vienu iš šių būdų:

n Spustelėkite ir vilkite stulpelį į naują vietą pasirinktoje lentelėje.

n Spustelėkite stulpelio antraštę, jei norite rūšiuoti duomenis didėjimo ar mažėjimo tvarka.

Kaip rūšiuoti iki trijų duomenų stulpelių lange „Sort“ (rūšiuoti)

1. Dešiniuoju pelės mygtuku spustelėkite skaičiuoklę ir pasirinkite „Sort“ (rūšiuoti).

2. Dialogo lange „Sort“ (rūšiuoti) pasirinkite pirmą stulpelio pavadinimą, kurį rūšiuosite. Rūšiuokite
duomenis didėjimo ar mažėjimo tvarka.

3. Pasirinkite antrą arba trečią stulpelį ir rūšiuokite jį „Ascending“ (didėjimo tvarka) arba „Descending“ 
(mažėjimo tvarka).

4. Spustelėkite OK (gerai), kad išrūšiuotumėte duomenis, arba „Cancel“ (atšaukti), kad sustabdytumėte
rūšiavimą.

Patarimas. Paryškinkite duomenis susijusiose diagramose ir šulinėlių parinkiklyje laikydami pelės
rodyklę virš langelio. Spustelėkite langelį, jei norite kopijuoti ir įklijuoti jo turinį į kitą programinę įrangą.

Bendrieji pelės dešiniojo mygtuko meniu elementai, skirti
skaičiuoklėms
16 lent. pateikiami pelės dešiniojo mygtuko meniu elementai, kurie gali būti naudojami skaičiuoklės
rodinyje.

Elementas Funkcija

„Copy“ (kopijuoti) Pasirinkto šulinėlio turinį kopijuoja į iškarpinę, tada jį įkelia į
skaičiuoklę, pvz., „Excel“.

„Copy as Image“ (kopijuoti kaip
paveikslėlį)

Kopijuoja skaičiuoklės vaizdą kaip paveikslėlio failą ir įkelia į failą,
kuris priima vaizdinius failus, pvz., tekstinį, vaizdinį ar skaičiuoklės
failą.

„Print“ (spausdinti) Atspausdinamas esamas vaizdas.

16 lent. Skaičiuoklių pelės dešiniojo mygtuko meniu elementai
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Elementas Funkcija

„Print Selection“ (spausdinti
pasirinkimą)

Atspausdinamas esamas pasirinkimas.

„Export to Excel“ (eksportuoti į
„Excel“)

Duomenys eksportuojami į „Excel“ skaičiuoklę.

„Export to Text“ (eksportuoti į
tekstinį failą)

Eksportuoja duomenis į teksto redaktorių.

„Export to Csv“ (eksportuoti į
Csv)

Duomenys eksportuojami į .csv failą.

„Export to Xml“ (eksportuoti į
Xml)

Duomenys eksportuojami į .xml failą.

„Export to Html“ (eksportuoti į
Html)

Duomenys eksportuojami į .html failą.

„Find“ (ieškoti) Ieškoma teksto.

„Sort“ (rūšiuoti) Rūšiuoja duomenis į iki trijų stulpelių.

„Select Columns“ (pasirinkti
stulpelius)

Pasirenkami stulpeliai, kurie bus rodomi skaičiuoklėje.

16 lent. Skaičiuoklių pelės dešiniojo mygtuko meniu elementai (tęsinys)
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Eksportavimas
„CFX Maestro Dx SE“ eksportavimo išplečiamajame meniu yra kelios eksportavimo parinktys:

n „Export All Data Sheets“ (eksportuoti visus duomenų lapus)

n „Export RDML Files“ (eksportuoti RDML failus)

n „Custom Export“ (pasirinktinis eksportas)

n „Export to LIMS Folder“ (eksportuoti į LIMS aplanką)

n Rankinis eksportavimas

Visų duomenų lapų eksportavimas
Visus skaičiuoklės rodinius iš kiekvienos „CFX Maestro Dx SE“ kortelės galite eksportuoti į atskirus failus.

Kaip eksportuoti visus duomenų lapus

u Pasirinkite „Export > Export All Data Sheets“ (eksportuoti > eksportuoti visus duomenų lapus) ir tada
pasirinkite pageidaujamą failo tipą:

n CSV (*.csv)

n „Text“ (tekstinis) (*.txt)

n „Excel Workbook“ („Excel“ darbaknygė) ( *.xlsx)

Eksportuotos analizės įrašomos keliuose „Excel“ darbaknygės failuose su atskira analizės
duomenų darbalapio kortele kiekvienam failui. Kai analizė apima kelis fluoroforus, kiekvieno
fluoroforo duomenys eksportuojami į atskirą darbalapio kortelę.

n „Excel Workbook - combined“ („Excel“ darbaknygė - kombinuota) ( *.xlsx)

Eksportuotos analizės įrašomos į atskirą „Excel“ darbaknygės failą, kuriame yra kelios
darbalapio kortelės, po vieną kiekvienam analizės duomenų rinkiniui.

n „Excel 97 - 2003“ ( *.xls)

Svarbu. Jūsų kompiuteryje turi būti įdiegta „Microsoft Excel“ programa, kad galėtumėte
eksportuoti duomenis į „Microsoft Excel“ skaičiuoklę.

n XML (*.xml)
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RDML failų eksportavimas
RDML yra struktūrinis ir universalus duomenų standartas kiekybiniams PGR (qPGR) duomenims keistis.
Duomenų standartas yra tekstinis failas išplėstinės dokumentų aprašų kalbos („Extensible Markup
Language“) (.xml) formatu. Pildomos informacijos apie RDML duomenų pasikeitimo formatą žr.
tarptautinio RDML konsorciumo svetainėje (www.rdml.org).

Svarbu. Eksportuojamuose RDML failuose pateikiami analizės duomenys su baziniais nustatymais,
kuriuos taikote duomenų analizės lange. Daugiau informacijos apie bazinius nustatymus rasite
skyriuje Pradinės nuostatos, p. 202.

Pastaba. RDML failą įrašykite 1.1 versija, jeigu naudojate 2.3 ar naujesnę „qbase+“ programinės
įrangos versiją.

Kaip eksportuoti RDML failą

1. Pasirinkite „Export > Export RDML Files“ (eksportuoti > eksportuoti RDML failus) ir rodomame sąraše
pasirinkite RDML v1.1 arba RDML v1.0.

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. Dialogo lange „Save As“ (įrašyti kaip) nurodykite failo pavadinimą ir vietą, kurioje norite įrašyti RDML
failą.

3. Spustelėkite OK (gerai) ir įrašykite eksporto failą.
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Pasirinktinio eksporto failo sukūrimas
Kaip sukurti pasirinktinio eksporto failą

1. Pasirinkite „Export > Custom Export“ (eksportuoti > pasirinktinis eksportas). Pasirodo dialogo langas
„Custom Export“ (pasirinktinis eksportas).

2. Pasirinkite eksporto formatą iš pasirodžiusio išplečiamojo sąrašo.

3. Pažymėkite norimų eksportuoti elementų žymės langelius.

4. (Neprivaloma) Spustelėkite „Customize Column Names“ (tinkinti stulpelių pavadinimus), norėdami
pakeisti stulpelių pavadinimus.

5. Spustelėkite „Export“ (eksportuoti). Parodomas dialogo langas „Save As“ (įrašyti kaip).
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6. Dialogo lange „Save As“ (įrašyti kaip) nurodykite failo pavadinimą ir vietą, kurioje norite įrašyti
eksportuojamą failą.

7. Spustelėkite OK (gerai) ir įrašykite eksporto failą.
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Eksportavimas į LIMS aplanką
Duomenis galite eksportuoti su LIMS suderinamu failo formatu. Daugiau informacijos apie tai, kaip kurti,
tvarkyti ir naudoti LIMS failus, žr. C priedas, LIMS integravimas.

Kaip eksportuoti duomenis LIMS formatu

1. Pasirinkite „Export > Export to LIMS Folder“ (eksportuoti > eksportuoti į LIMS aplanką).

Parodomas dialogo langas „Save As“ (įrašyti kaip).

2. Dialogo lange „Save As“ (įrašyti kaip) nurodykite failo pavadinimą ir vietą, kurioje norite įrašyti
eksportuojamą failą.

3. Spustelėkite OK (gerai) ir įrašykite eksporto failą.

Duomenų „Seegene“ formatu eksportavimas
Duomenis galite eksportuoti iš visų skaičiuoklių rodinių į „Excel“ failus, specialiai pritaikytus „Seegene,
Inc“.

Patarimas. Taip pat, pasibaigus eksportavimui galite automatiškai paleisti „Seegene Viewer“.
Daugiau informacijos žr. Meniu „Tools“ (įrankiai) komandos, p. 67

Kaip eksportuoti duomenis „Seegene“ formatu

1. Pasirinkite „Export > Manual Export“ (eksportuoti > rankinis eksportavimas).

Pasirodo dialogo langas „Browse For Folder“ (ieškoti aplanko).

2. Dialogo lange„Browse For Folder“ (ieškoti aplanko) nurodykite aplanko vietą, kurioje norite įrašyti
eksportuojamą „Excel“ (.xlsx) failą „Seegene“ formatu.

Analizės eksportuotos keliuose „Excel“ darbaknygės failuose su atskira analizės duomenų
darbalapio kortele kiekvienam failui.

3. Kad įrašytumėte eksportuojamus failus, spustelėkite OK (gerai).
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Programinės įrangos „CFX Maestro Dx“, „Security Edition“ langą „Data Analysis“ (duomenų analizė)
sudaro kelios kortelės, kuriose galima peržiūrėti duomenis. Šiame skyriuje išsamiai paaiškinamos šios
kortelės.

Patarimas. Galite pasirinkti, kurias korteles peržiūrėti lange „Data Analysis“ (duomenų analizė)
pasinaudoję meniu „View“ (rodymas) meniu. Pasirinktinis išdėstymas įrašomas su duomenų failu.
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Kiekybinio įvertinimo kortelė
Pasinaudokite duomenimis kortelėje „Quantification“ (kiekybinis įvertinimas) ir nustatykite duomenų
analizės sąlygas, įskaitant atskirų šulinėlių pagrindines nuostatas ir ribinės reikšmės nuostatas. Kortelėje
„Quantification“ (kiekybinis įvertinimas) rodomi duomenys keturiuose šiuose rodiniuose:

n Diagrama „Amplification“ (amplifikavimas) – kiekvienam šulinėliui kiekviename cikle rodomi
santykiniai fluorescencijos vienetai (RFU). Kiekvienas pėdsakas diagramoje reiškia duomenis iš
atskiro fluoroforo viename šulinėlyje.

n „Standard curve“ (standartinė kreivė) – rodoma tik jeigu paleidimas apima šulinėlius, skirtus mėginių
tipo standartui („Std“ (standartinis)). Standartinėje kreivėje rodomas ribinės reikšmės ciklas,
pažymėtas grafike pradinio kiekio logaritmo atžvilgiu. Sutartiniame žymėjime rodomas reakcijos
veiksmingumas (E) kiekvienam fluoroforui šulinėliuose, kuriuose yra standartinio tipo mėginiai.

n Šulinėlių parinkiklis – pasirenkami šulinėliai su fluorescenciniais duomenimis, kuriuos norite parodyti.

n Skaičiuoklė – rodoma pasirinkto šulinėlio surinktų duomenų skaičiuoklė.

Fluoroforų parinktys
Norėdami kortelės „Quantification“ (kiekybinis įvertinimas) diagramose ir skaičiuoklėse pateikti fluoroforo
duomenis, pasirinkite tikslinį (-ius) fluoroforą (-us), esantį (-čius) po diagrama „Amplification“ 
(amplifikavimas). Norėdami paslėpti duomenų analizės lange esančius fluoroforo duomenis, pašalinkite
jo žymės langelio žymėjimą.
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Dialogo langas „Trace Styles“ (pėdsakų stiliai)
Dialogo lange „Trace Styles“ (pėdsakų stiliai) galite koreguoti visų pėdsakų amplifikavimo ir lydymosi
kreivių diagramų išvaizdą kortelėse „Quantification“ (kiekybinis įvertinimas) ir „Melt Curve“ (lydymosi
kreivė). Tada jūs galite peržiūrėti šulinėlių parinkiklio pakeitimus, kurie rodomi dialogo lange „Trace
Styles“ (pėdsakų stiliai).

Kaip koreguoti pėdsakų stilių

1. Diagramoje „Amplification“ (amplifikavimas) pasirinkite tik vieną fluoroforą.

2. Norėdami atidaryti dialogo langą „Trace Styles“ (pėdsakų stiliai) atlikite vieną iš šių veiksmų:

n Diagramoje „Amplification“ (amplifikavimas) spustelėkite „Trace Styles“ (pėdsakų stiliai).

n Meniu juostoje „Data Analysis“ (duomenų analizė) pasirinkite „Settings > Trace Styles“ 
(nuostatos > pėdsakų stiliai).

n Dešiniuoju pelės mygtuku spustelėkite pėdsaką ir pasirinkite „Trace Styles“ (pėdsakų stiliai).

Parodomas dialogo langas „Trace Styles“ (pėdsakų stiliai).

3. Dialogo lango „Trace Styles“ (pėdsakų stiliai) šulinėlių parinkiklyje apatinėje srityje pasirinkite
konkretų šulinėlių rinkinį. Taip pat galite pasirinkti šulinėlius, kurių išplečiamojo meniu stulpelyje
„Wells“ (šulinėliai) mėginiai yra vieno tipo.

4. Atlikite toliau nurodytus veiksmus:
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n Norėdami pasirinkti pasirinktų šulinėlių spalvą, stulpelyje „Color“ (spalva) spustelėkite langelį.

n Norėdami pasirinktiems šulinėliams priskirti simbolį, išplečiamajame sąraše „Symbol“ (simbolis)
pasirinkite simbolį.

n Norėdami gretai nuspalvinti šulinėlius pagal mygtuko ženklinimą, spustelėkite atitinkamą spartųjį
rinkinį:

o „Random by Well“ (atsitiktinai pagal šulinėlį)

o „Random by Replicate“ (atsitiktinai pagal kopiją)

o „Use Fluor Colors“ (naudoti fluoroforo spalvas)

o „Use Target Colors“ (naudoti taikinio spalvas)

o „Use Sample Colors“ (naudoti mėginio spalvas)

n Norėdami priskirti šulinėlių etiketes, pasirinkite arba „Sample Type“ (mėginio tipas), „Target
Name“ (taikinio pavadinimas), „Sample Name“ (mėginio pavadinimas), arba „Symbol“ (simbolis).

Logaritminės skalės parinktis
Pasirinkite „Log Scale“ (logaritminė skalė), esančią po diagrama „Amplification“ (amplifikavimas), kad
pamatytumėte fluorescencijos pėdsakus antrinio žurnalo skalėje:

Patarimas. Jei norite padidinti bet kurią diagramos sritį, vilkite pele per tikslinę sritį. Jei norite grįžti į
rodinį per visą ekraną, diagramoje spustelėkite dešiniuoju klavišu ir pasirinkite „Set Scale to Default“ 
(nustatyti numatytąją skalę).
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Standartinės kreivės diagrama
Programinė įranga kortelėje „Quantification“ (kiekybinis įvertinimas) sukuria diagramą „Standard Curve“ 
(standartinė kreivė), jei duomenys apima mėginių tipus, apibrėžtus kaip „Std“ (standartinis) bent vienam
fluoroforui analizėje.

Diagramoje „Standard Curve“ (standartinė kreivė) rodoma ši informacija:

n Kiekvienos kreivės (fluoroforo arba taikinio) pavadinimas

n Kiekvieno fluoroforo arba taikinio spalva

n Reakcijos veiksmingumas (E). Naudokite šiuos statistinius duomenis, kad optimizuotumėte
daugkartinę reakciją ir išlygintumėte standartinės kreivės duomenis.

Pastaba. Reakcijos veiksmingumas nusako, kokia jūsų taikinio dalis sukuriama kiekvieno
protokolo ciklo metu. 100 % veiksmingumas parodo, kad kiekvieno ciklo metu padvigubinate
savo taikinį.

n Nustatymo koeficientas R2 (rašoma R^2). Naudokite šiuos statistinius duomenis, kad nustatytumėte,
ar teisingai linija apibūdina duomenis (atitikties laipsnis).

n Statumas

n y ašinė atkarpa
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Amplifikavimo diagramos meniu parinktys
Papildomai įprastoms dešiniuoju pelės mygtuku atidaromo meniu parinktims (žr. Bendrieji pelės dešiniojo
mygtuko meniu elementai, skirti diagramoms, p. 216), 17 lent. išvardytos meniu parinktys, galimos tik
diagramoje „Amplification“ (amplifikavimas).

Meniu parinktis Funkcija

„Well XX“ (šulinėlis XX),
„Fluor Target“ (fluoro
taikinys)

Rodomas tik šis šulinėlis, šis šulinėlis pašalinamas iš rodinio, nustatoma
šio pėdsako spalva arba šis šulinėlis pašalinamas iš analizės.

„Selected Traces“ 
(pasirinkti pėdsakai)

Rodomi tik šie šulinėliai, šie šulinėliai pašalinami iš rodinio, nustatoma šių
pėdsakų spalva arba šie šulinėliai pašalinami iš analizės.

„Show Threshold Values“ 
(rodyti ribines reikšmes)

Rodoma kiekvienos diagramos amplifikavimo kreivės ribinė vertė.

„Trace Styles“ (pėdsakų
stiliai)

Atidaromas langas „Trace Styles“ (pėdsakų stiliai), kuriame galima keisti
pėdsakų, rodomų kortelėse „Quantification“ (kiekybinis įvertinimas) ir
„Melt Curve“ (lydymosi kreivė), stilių.

„Baseline Thresholds“ 
(pagrindinės ribinės
reikšmės)

Atidaromas langas „Baseline Thresholds“ (pagrindinės ribinės reikšmės),
kuriame keičiama kiekvieno fluoroforo pagrindinė arba ribinė reikšmės
(pakeitimai rodomi diagramoje „Amplification“ (amplifikavimas), esančioje
kortelėje „Quantification“ (kiekybinis įvertinimas).

17 lent. Amplifikavimo diagramos dešiniojo ir kairiojo pelės mygtukų meniu elementai

Kiekybinio įvertinimo kortelės skaičiuoklė
18 lent. apibūdinami duomenys, kurie rodomi kiekybinio įvertinimo kortelės skaičiuoklėje.

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Target“ (taikinys) Taikinio, įdėto į plokštelės redaktoriaus šulinėlius, pavadinimas

„Content“ (turinys) Mėginio tipo (privalomas) ir kopijų Nr. (pasirinktinai), įdėtų į plokštelės
redaktorių, derinys

18 lent. Kiekybinio įvertinimo kortelės skaičiuoklės turinys
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Informacija Aprašymas

„Sample“ (mėginys) Į plokštelės redaktorių šulinėlius įdėto mėginio pavadinimas

Cq Kiekvieno pėdsako kiekybinio įvertinimo ciklas

Taikinio, turinio ar mėginio duomenų keitimas

Stulpeliuose „Target“ (taikiys), „Content“ (turinys) ir „Sample“ (mėginys) esančius duomenis galite keisti
redaguodami plokštelės failą su „Plate Editor“ (plokštelės redaktorius) net ir po eksperimento.

Kaip pakeisti duomenis stulpeliuose „Content“ (turinys), „Target“ (taikinys) ir „Sample“ 
(mėginys)

u Spustelėkite „Plate Setup“ (plokštelės sąranka) ir pasirinkite „View/Edit Plate“ (rodyti / redaguoti
plokštelę), kad atidarytumėte „Plate Editor“ (plokštelės redaktorius).
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Kiekybinio įvertinimo duomenų kortelė
Kortelėje „Quantification Data“ (kiekybinio įvertinimo duomenys) rodomi iš kiekvieno šulinėlio gauti
kiekybinio įvertinimo duomenys. „CFX Maestro Dx SE“ duomenis pateikia keturiuose skirtinguose
skaičiuoklės rodiniuose:

n „Results“ (rezultatai) – rodoma duomenų skaičiuoklė. Tai numatytasis rodinys.

n „Standard Curve Results“ (standartinės kreivės rezultatai) – rodoma standartinės kreivės duomenų
skaičiuoklė.

n „Plate“ (plokštelė) – rodomi duomenys kiekviename šulinėlyje kaip plokštelės schema.

n RFU – rodomi kiekvieno ciklo kiekvieno šulinėlio RFU kiekiai.

Pasirinkite kiekvieną skaičiuoklę iš išplečiamojo sąrašo, kuris rodomas po kortele „Quantification Data“ 
(kiekybinio įvertinimo duomenys).

Rezultatų skaičiuoklė
Skaičiuoklėje „Results“ (rezultatai) rodomi kiekvieno šulinėlio plokštelėje duomenys.

Pastaba. Visi „Std. Dev“ (standartinis nuokrypis) skaičiavimai galioja kopijų grupėms, priskirtoms
šulinėliams lange „Plate Editor“ (plokštelės redaktorius). Apskaičiuojamas kiekvieno šulinėlio kopijų
grupėje Cq vertės vidurkis.

19 lent. apibūdinami duomenys, pateikiami skaičiuoklėje „Results“ (rezultatai).
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Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Target“ (taikinys) Amplifikacijos taikinio pavadinimas (genas)

„Content“ (turinys) Mėginio tipas ir kopijos Nr.

„Sample“ (mėginys) Mėginio aprašymas

„Biological Set Name“ (biologinio
rinkinio pavadinimas)

Biologinio rinkinio pavadinimas

Cq Kiekybinio įvertinimo ciklas

„Cq Mean“ (Cq vidurkis) Kopijos grupės kiekybinio įvertinimo vidurkis

„Cq Std. Dev“ (Cq standartinis
nuokrypis)

Kopijos grupės kiekybinio įvertinimo standartinis nuokrypis

„Starting Quantity“ (pradinis
kiekis) (SQ)

Taikinio pradinio kiekio įvertis

„Log Starting Quantity“ (pradinio
kiekio registravimas)

Pradinio kiekio registravimas

„SQ Mean“ (pradinio kiekio
vidurkis)

Pradinio kiekio vidurkis

„SQ Std. Dev“ (C{0>q<0}
standartinis nuokrypis)

Kopijų pradinio kiekio standartinis nuokrypis

19 lent. Rezultatų skaičiuoklės turinys
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Standartinės kreivės rezultatų skaičiuoklė
Skaičiuoklėje „Standard Curve Results“ (standartinės kreivės rezultatai) rodomi apskaičiuoti standartinės
kreivės parametrai.

20 lent. apibūdinami duomenys, pateikiami skaičiuoklėje „Standard Curve Results“ (standartinės kreivės
rezultatai).

Informacija Aprašymas

„Fluor“ (fluoroforas) (arba
„Target“ (taikinys))

Aptiktas fluoroforas (arba taikinys)

„Efficiency“ (veiksmingumas)
(%)

Reakcijos veiksmingumas

„Slope“ (statumas) Standartinės kreivės statumas

„Y-intercept“ (y ašinė atkarpa) Taškas, kuriame kreivė kerta y ašį

R^2 Nustatymo koeficientas

20 lent. Skaičiuoklės „Standard Curve Results“ (standartinės kreivės rezultatai) turinys
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Plokštelės skaičiuoklė
Skaičiuoklėje „Plate“ (plokštelė) vienu metu rodoma vieno fluoroforo duomenų plokštelės schema.

Kaip peržiūrėti konkretaus fluoroforo duomenis

u Skaičiuoklės apačioje spustelėkite jo kortelę.
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RFU skaičiuoklė
Skaičiuoklėje RFU rodomos kiekvieno šulinėlio santykinių fluorescencijos vienetų (RFU) reikšmės,
gautos paleidimo kiekvieno ciklo metu. Šulinėlio numeris rodomas kiekvieno stulpelio viršuje, o ciklo
numeris parodomas kiekvienos eilutės kairėje.
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Lydymosi kreivės kortelė
DNR jungiančių dažų ir neskaidrių hibridizacijos zondų atveju fluorescencija yra ryškiausia, kai dvi DNR
grandinės atkaitinamos. Todėl tada, kai temperatūra kyla iki lydymosi temperatūros (Tm), fluorescencija
mažėja pastoviu greičiu (pastovus statumas). Kai pasiekiama Tm, fluorescencija smarkiai sumažėja ir
pastebimai pasikeičia statumas. Šio pokyčio norma nustatoma pagal neigiamos pirmosios fluorescencijos
regresijos priklausomybę nuo temperatūros (-d(RFU)/dT). Dėl didžiausio fluorescencijos pokyčio
susidaro matomos smailės, kurios atitinka dvigubos DNR kompleksų Tm.

„CFX Maestro Dx SE“ parodo RFU duomenų, surinktų lydymosi kreivės analizės metu, priklausomybę
nuo temperatūros. Siekiant išanalizuoti didžiausios lydymosi temperatūros duomenis, programinė įranga,
perkeldama ribinės reikšmės juostą, kiekvienai smailei priskiria pradinę ir galutinę temperatūrą. Smailės
srities pagrindas nustatomas pagal ribinės reikšmės juostos padėtį. Galiojantis smailės aukštis turi bent
jau atitikti atstumą tarp ribinės reikšmės juostos ir aukščiausios smailės viršūnės taško.

Kortelėje „Melt Curve“ (lydymosi kreivė) rodomi keturi amplifikuotų PGR produktų Tm lydymosi
temperatūros rodiniai:

n „Melt Curve“ (lydymosi kreivė) – rodomi realiojo laiko kiekvieno fluoroforo duomenys, pateikti kaip su
temperatūra susietos RFU reikšmės kiekvienam šulinėliui.

n „Melt Peak“ (didžiausia lydymosi temperatūra) – rodomas neigiamas su temperatūra susietų
kiekvieno šulinėlio RFU duomenų sumažėjimas.

n „Well selector“ (šulinėlių parinkiklis) – rodomi šulinėliai, kurių atveju būtų rodomi arba paslėpti
duomenys.

n „Peak spreadsheet“ (smailės skaičiuoklė) – rodomi pasirinkto šulinėlio surinkti duomenys.

Pastaba. Ši skaičiuoklė rodo iki dviejų kiekvieno pėdsako smailių. Jei norite pamatyti daugiau
smailių, spustelėkite kortelę „Melt Curve Data“ (lydymosi kreivės duomenys).
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21 lent. apibūdinami duomenys, pateikiami skaičiuoklėje „Melt Curve“ (lydymosi kreivė).

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ 
(fluoroforas)

Aptiktas fluoroforas

„Content“ 
(turinys)

Mėginio tipo ir kopijų skaičiaus derinys

„Sample“ 
(mėginys)

Mėginio, įkelto į plokštelės redaktorių, pavadinimas

„Melt Temp“ 
(lydymosi
temperatūra)

Didžiausia kiekvieno šulinėlio lydymosi temperatūra

Pastaba. Šioje skaičiuoklėje rodomos tik dvi aukščiausios smailės.

21 lent. Lydymosi kreivės skaičiuoklės turinys
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Lydymosi kreivės duomenų koregavimas
Kaip koreguoti „Melt Curve“ (lydymosi kreivė) duomenis

u Atlikite toliau nurodytus veiksmus:

n Spustelėkite ir vilkite ribinės reikšmės juostas diagramoje „Melt Peak“ (didžiausia lydymosi
temperatūra) ir į duomenų analizę įtraukite didžiausią temperatūrą arba iš jos pašalinkite.

n Išplečiamajame meniu „Peaks“ (didžiausia temperatūra) pasirinkite „Positive“ (teigiama), kad
virš linijos „Melt Threshold“ (lydymosi ribinė reikšmė) būtų rodoma didžiausios temperatūros
skaičiuoklė, arba pasirinkite „Negative“ (neigiama), kad didžiausios temperatūros skaičiuoklės
duomenys būtų rodomi po lydymosi ribinės reikšmės linija.

n Atidarykite langą „Trace Styles“ (pėdsakų stiliai), kuriame galima keisti pėdsakų, rodomų
kortelėse „Melt Curve“ (lydymosi kreivė) ir „Melt Peak“ (didžiausia lydymosi temperatūra),
spalvą.

n Parinkiklyje „Step Number“ (veiksmo numeris) pasirinkite numerį ir peržiūrėkite „Melt Curve“ 
(lydymosi kreivė) duomenis kitame protokolo veiksme. Sąraše rodomi keli veiksmai, jeigu į
protokolą įtraukti plokštelių nuskaitymai keliuose lydymosi kreivės veiksmuose.

n Pasirinkite šulinėlius šulinėlių parinkiklyje, norėdami susikoncentruoti į duomenų pogrupius.

n Pasirinkite šulinėlių grupę, kurios šulinėlių pogrupį norite peržiūrėti ir analizuoti plokštelėje.
Pasirinkite kiekvieną šulinėlių grupę pagal pavadinimą įrankių juostoje esančiame
išskleidžiamajame meniu „Well Group“ (šulinėlių grupė).
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Lydymosi kreivės duomenų kortelė
Kortelėje „Melt Curve Data“ (lydymosi kreivės duomenys) rodomi duomenys iš kortelės „Melt Curve“ 
(lydymosi kreivė), pateikiami keliose skaičiuoklėse, apimančiose visus kiekvienos kreivės didžiausios
lydymosi temperatūros duomenis. „CFX Maestro Dx SE“ yra keturios skaičiuoklių, kuriose galima
peržiūrėti lydymosi kreivės duomenis, parinktys:

n „Melt Peaks“ (didžiausia lydymosi temperatūra) – rodomi visi duomenys, įskaitant visus kiekvienos
kreivės didžiausios lydymosi temperatūros duomenis. Tai numatytasis rodinys.

n „Plate“ (plokštelė) – rodomas kiekvieno šulinėlio plokštelėje duomenų ir turinio rodinys.

n RFU – rodomi kiekvieno šulinėlio RFU kiekiai kiekvienoje temperatūroje.

n -d(RFU)/dT – rodomas neigiamas RFU pokyčio, keičiantis temperatūrai (T), rodiklis. Tai pirmasis
kiekvieno šulinėlio plokštelėje regresijos grafikas.

Pasirinkite kiekvieną skaičiuoklę iš išplečiamojo sąrašo, kuris rodomas po kortele „Melt Curve Data“ 
(lydymosi kreivės duomenys).

Didžiausios lydymosi temperatūros skaičiuoklė
Skaičiuoklėje „Melt Peaks“ (didžiausia lydymosi temperatūra) rodomi visi lydymosi kreivės duomenys.

22 lent., p. 241 apibūdinami duomenys, kurie pateikiami skaičiuoklėje „Melt Peaks“ (didžiausia lydymosi
temperatūra).
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Lydymosi kreivės duomenų kortelė

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Content“ (turinys) Mėginio tipas, nurodytas lange „Plate Editor“ (plokštelės redaktorius)

„Target“ (taikinys) Amplifikavimo taikinys (genas)

„Sample“ (mėginys) Mėginio pavadinimas, nurodytas lange „Plate Editor“ (plokštelės
redaktorius)

„Melt Temperature“ (lydymosi
temperatūra)

Kiekvieno produkto lydymosi temperatūra, nurodyta kaip viena
didžiausia skaičiuoklės eilutėje

„Peak Height“ (didžiausios
temperatūros viršūnės aukštis)

Didžiausios temperatūros viršūnės aukštis

„Begin Temperature“ (pradžios
temperatūra)

Temperatūra viršūnės pradžioje

„End Temperature“ (pabaigos
temperatūra)

Temperatūra viršūnės pabaigoje

22 lent. Skaičiuoklės „Melt Peaks“ (didžiausia lydymosi temperatūra) turinys

Plokštelės skaičiuoklė
Skaičiuoklėje „Plate“ (plokštelė) rodomi lydymosi kreivės duomenys plokštelės formatu.

Pastaba. Jei norite koreguoti programinės įrangos apibrėžiamą smailę, pakoreguokite kortelėje „Melt
Curve“ (lydymosi kreivė) esančios diagramos „Melt Peak“ (didžiausia lydymosi temperatūra) linijos
ribinę reikšmę.

23 lent., p. 242 apibūdinti duomenys, kurie rodomi skaičiuoklėje „Plate“ (plokštelė).
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11 skyrius. Išsami duomenų analizės informacija

Informacija Aprašymas

„Content“ 
(turinys)

Mėginio tipo (privalomas) ir kopijų Nr. (pasirinktinai) derinys

„Sample“ 
(mėginys)

Mėginio aprašymas

„Peak 1“ (1
didžiausia
temperatūra)

Pirmoji pagal didumą lydymosi temperatūra (aukščiausia)

„Peak 2“ (2
didžiausia
temperatūra)

Antroji didžiausia lydymosi temperatūra (žemesnė)

23 lent. Skaičiuoklės „Plate“ (plokštelė) turinys

RFU skaičiuoklė
RFU skaičiuoklėje rodoma kiekvieno šulinėlio fluorescencija kiekvieno ciklo, kuris nustatomas lydymosi
kreivėje, metu.

24 lent. apibūdinami duomenys, kurie rodomi RFU skaičiuoklėje.

Informacija Aprašymas

„Well number (A1, A2, A3, A4, A5)“ 
(šulinėlio numeris (A1, A2, A3, A4, A5))

Šulinėlio padėtis plokštelėje įkeltų šulinėlių
atveju

„Temperature“ (temperatūra) Amplifikuoto taikinio, pateikiamo kaip vienas
šulinėlis kiekvienai eilutei ir keli šulinėliai
keliems produktams tame pačiame šulinėlyje,
lydymosi temperatūra

24 lent. RFU skaičiuoklės turinys
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Lydymosi kreivės duomenų kortelė

-d(RFU)/dT skaičiuoklė
-d(RFU)/dT skaičiuoklėje rodomas neigiamas RFU pokyčio dydis keičiantis temperatūrai (T).

25 lent. apibūdinami duomenys, kurie pateikiami -d(RFU)/dT skaičiuoklėje.

Informacija Aprašymas

„Well number (A1, A2, A3, A4, A5)“ 
(šulinėlio numeris (A1, A2, A3, A4, A5))

Šulinėlio padėtis plokštelėje įkeltų šulinėlių atveju

„Temperature -d(RFU)/dT“ (temperatūros
riba -d(RFU)/dT)

Neigiamas RFU pokyčio dydis keičiantis temperatūrai (T)

25 lent. -d(RFU)/dT skaičiuoklės turinys
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Pabaigos taško kortelė
Atidarykite kortelę „End Point“ (pabaigos taškas) ir analizuokite mėginių šulinėlių galutinius santykinius
fluorescencijos vienetus (RFU). Programinė įranga šulinėlių su nežinomais mėginiais RFU lygius palygina
su neigiamos kontrolės šulinėlių RFU lygiais ir nežinomą „pavadina“ teigiamu arba neigiamu. Teigiamų
mėginių RFU vertė yra didesnė nei neigiamos kontrolės vidutinė RFU vertė plius ribinė vertė.

Norint išanalizuoti galutinio taško duomenis, plokštelėje turi būti neigiamų kontrolių arba programinė
įranga negalės atlikti užklausos.

n Paleiskite protokolą „Quantification“ (kiekybinis įvertinimas) – nustatykite standartinį protokolą. Baigę
paleidimą atidarykite langą „Data Analysis“ (duomenų analizė), kortelėje „Quantification“ (kiekybinis
įvertinimas) koreguokite duomenų analizės nuostatas, tada spustelėkite kortelę „End Point“ 
(pabaigos taškas) ir pasirinkite pabaigos taško ciklą.

n Paleiskite protokolą „End Point Only“ (tik pabaigos taškas); protokolą „End Point Only“ (tik pabaigos
taškas) įkelkite į lango „Run Setup“ (paleidimo sąranka) plokštelės kortelę ir pradėkite paleidimą.

Kortelėje „End Point“ (pabaigos taškas) rodomos vidutinės RFU vertės, skirtos nustatyti, ar taikinys buvo
amplifikuotas paskutiniu (pabaigos) ciklu. Šiuos duomenis naudokite nustatyti, ar mėginyje yra konkreti
taikinių seka (teigiama). Teigiamų taikinių RFU vertės yra didesnės nei jūsų nustatyta ribinė vertė.
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Pabaigos taško kortelė

Patarimas. Norėdami sukurti pabaigos taško protokolą, atidarykite protokolo kortelę (langas „Run
Setup“ (paleidimo sąranka)) ir pasirinkite „Run“ > „End Point Only Run“ (paleidimas > tik galutinio
taško paleidimas).

Kai paleidimas baigiamas, duomenų failas atidaromas kortelėje „End Point“ (pabaigos taškas), kurią
sudaro šie skyriai:

n „Settings“ (nuostatos) – koreguojamos duomenų analizės nuostatos.

n „Results“ (rezultatai) – rezultatai, rodomi iš karto jums pakoregavus nuostatas.

n „Well Selector“ (šulinėlių parinkiklis) – pasirenkami šulinėliai su pabaigos taško duomenimis, kuriuos
norite parodyti.

n „RFU spreadsheet“ (RFU skaičiuoklė) – rodomi pabaigos RFU, gauti pasirinktuose šulinėliuose.

Rezultatų duomenys
Skyriuje „Results“ (rezultatai) pateikiami šie duomenys:

n „Lowest RFU value“ (mažiausia RFU vertė) – mažiausia RFU vertė duomenyse

n „Highest RFU value“ (didžiausia RFU vertė) – didžiausia RFU vertė duomenyse

n „Negative Control Average“ (neigiamos kontrolės vidurkis) – vidutinis šulinėlių, kuriuose yra
neigiamos kontrolės, RFU

n „Cut Off Value“ (ribinė vertė) – apskaičiuojama sudedant leistiną nuokrypį (intervalo, pateikto
nuostatose, RFU arba „Percentage“ (procentas)) ir neigiamos kontrolės vidurkį. Mėginiai, kurių RFU
yra didesni už ribinę vertę, bus vadinami „teigiamais“. Norėdami koreguoti ribinę vertę, pakeiskite
RFU arba diapazono procentą

„Cut Off Value“ (ribinė vertė) apskaičiuojama taikant šią formulę:

Ribinė vertė = neigiamos kontrolės vidurkis + leistinas nuokrypis

Leistiną nuokrypį pasirinkite vienu iš šių būdų:

n RFU (numatytoji nuostata) – pasirinkite šį metodą ir naudokite absoliučią leistinojo nuokrypio RFU
vertę. Mažiausia RFU leistinojo nuokrypio vertė yra 2. Didžiausia yra didžiausia RFU absoliuti vertė
minus mažiausia RFU absoliuti vertė. Numatytoji RFU leistinojo nuokrypio vertė yra 10 % bendrojo
RFU intervalo.

n „Percent of Range“ (intervalo procentas) – pasirinkite šį metodą ir leistinajam nuokrypiui taikykite
RFU intervalo procentą. Minimalus intervalo procentas yra 1 %. Maksimalus intervalo procentas yra
99 %. Numatytasis intervalo procentas yra 10 %.
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11 skyrius. Išsami duomenų analizės informacija

Pabaigos taško duomenų analizės keitimas
Kaip keisti duomenis kortelėje „End Point“ (pabaigos taškas)

u Atlikite toliau nurodytus veiksmus:

n Išplečiamajame sąraše pasirinkite fluoroforą.

n Pasirinkite reikšmę „End Cycle to Average“ (pabaigos taško vidurkio ciklų skaičius), norėdami
nustatyti ciklų skaičių, pagal kurį skaičiuojamas vidutinis pabaigos taško RFU.

n Pasirinkite RFU, norėdami peržiūrėti duomenis santykiniais fluorescencijos vienetais.

n Pasirinkite „Percentage of Range“ (intervalo procentas), norėdami peržiūrėti duomenis kaip RFU
intervalo procentą.

n Pasirinkite šulinėlius šulinėlių parinkiklyje, norėdami susikoncentruoti į duomenų pogrupius.

n Pasirinkite šulinėlių grupę, kurios šulinėlių pogrupį norite peržiūrėti ir analizuoti plokštelėje.
Pasirinkite kiekvieną šulinėlių grupę pagal pavadinimą įrankių juostoje esančiame
išskleidžiamajame meniu „Well Group“ (šulinėlių grupė).

RFU skaičiuoklė, skirta pabaigos taško analizei
26 lent. apibūdinami duomenys, kurie rodomi RFU skaičiuoklės kortelėje „End Point“ (pabaigos taškas).

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Fluor“ (fluoroforas) Aptiktas fluoroforas

„Content“ (turinys) Mėginio tipo ir kopijų Nr. derinys

„End RFU“ (pabaigos
RFU)

RFU galiniame ciklo taške

„Call“ (paskyrimas) Teigiamas arba neigiamas, kai teigiamų mėginių RFU reikšmė yra didesnė
už vidutinės neigiamų kontrolinių elementų RFU reikšmės ir ribinės reikšmės
sumą

„Sample“ (mėginys) Mėginio pavadinimas, įkeltas į langą „Plate Editor“ (plokštelės redaktorius)

26 lent. „RFU End Point“ (RFU pabaigos taškas) skaičiuoklės turinys
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Alelių diskriminacijos kortelė

Alelių diskriminacijos kortelė
Kortelėje „Allelic Discrimination“(alelių diskriminacija) šulinėliams su nežinomais mėginiais priskiriami
genotipai. Remdamiesi šiais duomenimis, galite nustatyti mėginius su įvairiais genotipais, įskaitant „Allele
1“ (1-asis alelis), „Allele 2“ (2-asis alelis), „Heterozygote“ (heterozigota), „No Call“ (jokio paskyrimo) arba
„Undetermined“ (nenustatyta).

Pastaba. Alelių diskriminacijos duomenys turi būti gaunami iš daugkartinių paleidimų su mažiausiai
dviem fluoroforais. Kiekvienas fluoroforas identifikuoja vieną alelį visuose mėginiuose.

Alelių diskriminacijos analizei reikalingas minimalus šulinėlių turinys:

n Du fluoroforai kiekviename šulinėlyje

n NTC (kontrolės be šablono) mėginiai optimizuotai duomenų analizei

„CFX Maestro Dx SE“ siūlo keturis variantus alelių diskriminacijos duomenims peržiūrėti:

n Diagramoje „Allelic Discrimination“ (alelių diskriminacija) RFU grafiko forma rodomi pirmojo ir (arba)
antrojo alelio duomenys. Kiekvienas grafiko taškas rodo abiejų viename šulinėlyje esančių fluoroforų
duomenis. Koordinates galite perjungti iš Dekarto į polines ir atvirkščiai, pasirinkdami ir išvalydami
žymės langelį „Polar Coordinates“ (polinės koordinatės). Dekarto koordinačių sistemoje x ašyje
pateikiamas pirmojo, o y – antrojo alelio RFU. Polinių koordinačių sistemoje x ašyje pateikiamas
kampas, o y – atstumas tarp atskaitos taško ir RFU (visų NTC mediana).
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11 skyrius. Išsami duomenų analizės informacija

n „Well spreadsheet“ (šulinėlių skaičiuoklė) rodomi alelių diskriminacijos duomenys, surinkti
kiekviename plokštelės šulinėlyje.

n „Well selector“ (šulinėlių parinkiklis) leidžia pasirinkti šulinėlius su norimais rodyti alelių duomenimis.

n „Selected Fluorophores panel“ (pasirinktų fluoroforų skydelis) keičiamos alelių diskriminacijos
diagramos x ir y ašių etiketės, analizuojamas ciklas ir nustatoma, ar rodyti paskyrimo schemą.

Alelių diskriminacijos duomenų koregavimas
Programinė įranga automatiškai priskiria genotipą šulinėliams su nežinomais mėginiais atsižvelgdama į
NTC padėtis ir nežinomų duomenų taškų padėtį bei kampą ir atstumą nuo NTC.

Kaip koreguoti alelių diskriminacijos duomenis

u Atlikite toliau nurodytus veiksmus:

n Kad būtų rodomos polinės koordinatės, diagramoje „Allelic Discrimination“ (alelių diskriminacija)
pažymėkite žymės langelį.

n Kad peržiūrėtumėte kitą fluoroforą, jį pasirinkite išplečiamajame sąraše skydelyje „Selected
Fluorophores“ (pasirinkti fluoroforai).

n Norėdami pakeisti paskyrimą, diagramoje „Allelic Discrimination“ (alelių diskriminacija) vilkite
žymeklį per duomenų elementą (-us) ir pasirinktų šulinėlių sąraše pasirinkite parinktį:

o „Allele 1“ (1-asis alelis)

o „Allele 2“ (2-asis alelis)

o „Heterozygote“ (heterozigota)

o „Undetermined“ (nenustatyta)

o „No Call“ (nėra paskyrimo)

o „Auto Call“ (automatinis paskyrimas)

Patarimas. Pasirinkite „Auto Call“ (automatinis paskyrimas) ir pakeiskite į numatytąjį
paskyrimą.
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Alelių diskriminacijos kortelė

Diagramos meniu parinktys
Be įprastai dešiniuoju mygtuku atidaromo diagramos meniu parinkčių (žr. Bendrieji pelės dešiniojo
mygtuko meniu elementai, skirti diagramoms, p. 216), 27 lent. išvardytos galimos diagramos „Allelic
Discrimination“ (alelių diskriminacija) meniu parinktys.

Meniu parinktis Funkcija

„Zoom“ (keisti mastelį) Diagramos vaizdą fokusuoja pasirinktoje srityje (spustelint žymeklį ir
jį patraukiant diagramoje).

Patarimas. Kad atkurtumėte mastelį ir būtų rodomi visi
duomenų taškai, spustelėkite dešinįjį klavišą ir pasirinkite „Set
Scale to Default“ (nustatyti mastelį į numatytąjį).

„Well“ (šulinėlis) Pasirinktų šulinėlių galimos funkcijos: rodyti tik šiuos šulinėlius,
pašalinti šį šulinėlį iš vaizdo, nustatyti šio pėdsako spalvą arba šį
šulinėlį pašalinti iš analizės.

„Selected Wells“ (pasirinkti
šulinėliai)

Pasirinktų šulinėlių (pasirenkami spustelint ir patraukiant žymeklį
diagramoje) parinktys yra: rodyti tik šiuos šulinėlius, šiuos šulinėlius
pašalinti iš vaizdo, nustatyti šių pėdsakų spalvas arba šiuos
šulinėlius pašalinti iš analizės.

27 lent. Diagramos „Allelic Discrimination“ (alelių diskriminacija) dešiniojo ir kairiojo meniu
parinktys

Alelių diskriminacijos skaičiuoklė
28 lent. apibūdinami duomenys, kurie pateikiami „Allelic Discrimination“ (alelių diskriminacija)
skaičiuoklėje.

Informacija Aprašymas

„Well“ (šulinėlis) Šulinėlio padėtis plokštelėje

„Sample“ (mėginys) Mėginio pavadinimo aprašymas

„Call“ (paskyrimas) Identifikuokite alelį, įskaitant automatinį „Allele 1“ (1-asis alelis), „Allele
2“ (2-asis alelis), „Heterozygote“ (heterozigota), „No Call“ (jokio
paskyrimo) arba „Undetermined“ (nenustatyta)

28 lent. „Allelic Discrimination“ (alelių diskriminacija) skaičiuoklės turinys
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Informacija Aprašymas

„Type“ (tipas) Automatinis arba rankinis – taip apibūdinama, kaip buvo atliktas
paskyrimas. Automatinis reiškia, kad programinė įranga pasirinko
paskyrimą. Rankinis reiškia, kad paskyrimą pasirinko naudotojas

RFU1 RFU 1-ajam aleliui

RFU2 RFU 2-ajam aleliui

28 lent. „Allelic Discrimination“ (alelių diskriminacija) skaičiuoklės turinys (tęsinys)
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Pasirinktinių duomenų rodymo kortelė

Pasirinktinių duomenų rodymo kortelė
Kortelėje „Custom Data View“ (pasirinktinių duomenų rodymas) vienu metu rodomos kelios sritys
pritaikomu formatu.

Išplečiamajame sąraše „Load a Preset View“ (įkelti iš anksto nustatytą rodinį) pateikiama įvairių rodinių
formatų šablonų. Numatytasis rodinys parenkamas priklausomai nuo analizuojamo failo rūšies.
Pavyzdžiui, jei pateikiami kortelės „Melt Curve“ (lydymosi kreivė) duomenys, parodomas numatytasis
„Amp+Melt“ rodinys.
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Pasirinktinių duomenų rodinio sukūrimas
Kaip sukurti pasirinktinių duomenų rodinį

u Atlikite toliau nurodytus veiksmus:

n Išplečiamajame sąraše pasirinkite kitą iš anksto nustatytą rodinį.

n Išplečiamajame sąraše, esančiame kiekvienos atskiros srities viršuje, pasirinkite kitą diagramos
rodinį.

n Pakeiskite eilučių ir stulpelių skaičių kortelėje.

n Pakeiskite atskiros srities matmenis. Vilkite juostas kiekvienos srities pakraštyje.

Spustelėkite „Save as Preset“ (įrašyti kaip išankstinę nuostatą), kad įrašytumėte pasirinktą rodinį kaip iš
anksto nustatytą šabloną. Jei norite pašalinti, pervardyti arba atkurti esamus iš anksto nustatytus rodinius,
spustelėkite „Manage Presets“ (valdyti išankstines nuostatas).
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KK kortelė

KK kortelė
Kortelėje QC (KK) galite greitai įvertinti paleidimo duomenų kokybę, remdamiesi taisyklėmis, nustatytomis
kortelėje QC (KK) lange „User Preferences“ (naudotojo nuostatos).

„CFX Maestro Dx SE“ siūlo keturis variantus QC (KK) duomenims peržiūrėti:

n „Amplification chart“ (amplifikavimo diagrama) – kiekvienam šulinėliui kiekviename cikle
rodomas RFU. Kiekvienas pėdsakas diagramoje reiškia duomenis iš atskiro fluoroforo viename
šulinėlyje.

n „QC rules table“ (KK taisyklių lentelė) – rodomos taikomos QC (KK) taisyklės ir nuostatos,
kuriomis apibrėžiama kiekviena taisyklė. Galiojančios QC (KK) taisyklės nurodomos varnele.

n „Well selector“ (šulinėlių parinkiklis) – pasirenkami šulinėliai su fluorescenciniais duomenimis,
kuriuos norite parodyti.

n „QC rule summary pane“ (KK taisyklių santraukos sritis) – rodoma pasirinkta QC (KK) taisyklė
ir paryškinami šulinėliai, kurie neatitinka taisyklės.
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KK kriterijų keitimas
Kaip keisti QC (KK) kriterijus

u Pažymėkite arba išvalykite taisyklės, kurią norite įtraukti į QC (KK) arba pašalinti iš jo, žymės langelį
„Use“ (naudoti).

Šulinėlių, kurie neatitinka KK, pašalinimas
„CFX Maestro Dx SE“ rezultatų stulpelyje QC (KK) taisyklių lentelėje ir santraukos srityje parodo
šulinėlius, kurie neatitinka QC (KK) kriterijų.

Šulinėlių, kurie neatitinka QC (KK) kriterijų, pašalinimas

u Prie kiekvieno šalinamo šulinėlio pasirinkite „Exclude Wells“ (pašalinti šulinėlius).
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Paleidimo išsamios informacijos kortelė

Paleidimo išsamios informacijos kortelė
Kortelėje „Run Information“ (paleidimo išsami informacija) rodomas protokolas ir kita informacija apie
kiekvieną paleidimą. Veiksmai, kuriuos galima atlikti šioje kortelėje:

n Peržiūrėti protokolą

n Įvesti arba redaguoti paleidimo pastabas

n Įvesti arba redaguoti paleidimo ID arba brūkšninį kodą

n Peržiūrėti įvykius, kurie įvyko per paleidimą. Naudokite šiuos pranešimus paleidimo problemoms
spręsti.

Patarimas. Paspauskite protokolą dešiniuoju pelės mygtuku, norėdami jį kopijuoti, eksportuoti arba
spausdinti. Dešiniuoju pelės mygtuku spauskite sritis „Notes“ (pastabos), „ID/Bar Code“ (ID /
brūkšninis kodas) arba „Other“ (kita), kad anuliuotumėte, iškirptumėte, kopijuotumėte, įklijuotumėte,
pašalintumėte arba pasirinktumėte tekstą.
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Duomenų analizės ataskaitos
Dialogo lange „Report“ (ataskaita) rodoma informacija apie esamą duomenų failą lange „Data Analysis“ 
(duomenų analizė). Norėdami atidaryti ataskaitą, pasirinkite „Tools > Reports“ (įrankiai > ataskaitos) arba
įrankių juostoje spustelėkite „Reports“ (ataskaitos).

Dialogą „Report“ (ataskaita) yra šie skyriai:

n Meniu ir įrankių juosta – pateikia ataskaitos ar šablono formato, įrašymo ir spausdinimo parinkčių.

n Parinkčių sąrašas (dialogo lango viršutinė kairė pusė) – pateikia ataskaitos pateikimo parinkčių.

n Parinkčių sritis (dialogo lango apatinė kairė pusė) – rodomi tekstiniai langeliai, kuriuose galite įrašyti
informaciją apie pasirinktą parinktį.

n Peržiūros sritis (dialogo lango dešinė pusė) – rodoma esamos ataskaitos peržiūra.
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Duomenų analizės ataskaitos

Duomenų analizės ataskaitų kategorijos
29 lent. išvardytos visos parinktys, galimos duomenų analizės ataskaitoje, priklausomai nuo lange „Data
Analysis“ (duomenų analizė) esančių duomenų tipo.

Kategorija Parinktis Aprašymas

Antraštė

Ataskaitos antraštė, paantraštė ir
logotipas

„Report Information“ (ataskaitos
informacija)

Paleidimo data, naudotojo vardas,
duomenų failo pavadinimas, duomenų
failo kelias ir pasirinktų šulinėlių grupė

„Audit Information“ (audito
informacija)

Papildoma informacija, kurios reikia
auditui atlikti, įskaitant parašus

„Notes“ (pastabos) Pastabos apie duomenų ataskaitą

„Run Setup“ (paleidimo sąranka)

„Run Information“ (paleidimo
informacija)

Paleidimo data, naudotojo vardas,
duomenų failo pavadinimas, duomenų
failo kelias ir pasirinktų šulinėlių grupė

„Protocol“ (protokolas) Protokolo veiksmų ir parinkčių tekstinis
vaizdas

„Plate Display“ (plokštelės
rodmuo)

Informacijos plokštelės vaizdas
kiekviename plokštelės šulinėlyje

„Quantification“ (kiekybinis įvertinimas)

„Analysis Settings“ (analizės
nuostatos)

Duomenų rinkimo veiksmo numeris,
analizės režimas ir pradinio taško
atėmimo metodas

„Amplification Chart“ 
(amplifikavimo diagrama)

Amplifikavimo diagrama paleidimams,
kurie apima kiekybinio įvertinimo
duomenis

29 lent. Duomenų analizės ataskaitų kategorijos parinkčių sąraše
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Kategorija Parinktis Aprašymas

„Standard Curve Chart“ 
(standartinės kreivės diagrama)

Standartinės kreivės diagrama

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno šulinėlio
duomenys

Stulpelinė diagrama „Gene Expression“ (geno ekspresija)

„Analysis Settings“ (analizės
nuostatos)

Analizės režimas, diagramos duomenys,
mastelio parinktys ir diagramos paklaida

„Chart“ (diagrama) Stulpelinės diagramos kopija

„Target Names“ (taikinių
pavadinimai)

Taikinių pavadinimų diagrama

„Sample Names“ (mėginių
pavadinimai)

Mėginių pavadinimų diagrama

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno šulinėlio
duomenys

„Target Stability“ (taikinio
stabilumas)

Taikinio stabilumo reikšmių diagrama

„Box-and-Whisker Chart“ 
(stačiakampė diagrama)

Stačiakampė diagrama

„Dot Plot Chart“ (taškinė
diagrama)

Taškinė diagrama

„Gene Expression“ (geno ekspresija) – „Clustergram“ (grupinė diagrama) ir „Scatter Plot“ 
(taškinis grafikas)

„Analysis Settings“ (analizės
nuostatos)

Kiekvieno diagramos tipo nuostatos

„Chart“ (diagrama) Diagramos kopija

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno taikinio
duomenys

29 lent. Duomenų analizės ataskaitų kategorijos parinkčių sąraše (tęsinys)

258 | Programinė įranga „CFX Maestro Dx SE“



Duomenų analizės ataskaitos

Kategorija Parinktis Aprašymas

„Gene Expression – ANOVA Data“ (geno ekspresija – ANOVA duomenys)

„ANOVA Settings“ (ANOVA
nuostatos)

P reikšmės ribinė reikšmė naudojama
analizei

„ANOVA Results“ (ANOVA
rezultatai)

Rezultatų iš ANOVA ir Tukey HSD „post-
hoc“ analizės lentelė

„Melt Curve“ (lydymosi kreivė)

„Analysis Settings“ (analizės
nuostatos)

Lydymosi veiksmų skaičius ir ribinės
reikšmės juostos nuostata

Lydymosi kreivės diagrama Lydymosi kreivės diagrama

Didžiausia lydymosi temperatūra Didžiausia lydymosi temperatūra

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno šulinėlio
duomenys

„Allelic Discrimination“ (alelių diskriminacija)

„Analysis Settings“ (analizės
nuostatos)

Fluoroforų, ciklo ir vaizdo paskyrimų
schema

„Allelic Discrimination Chart“ 
(alelių diskriminacijos diagrama)

Alelių diskriminacijos diagramos kopija

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno šulinėlio
duomenys

„End Point“ (pabaigos taškas)

„Analysis Settings“ (analizės
nuostatos)

Fluoroforas, vidurkio, režimo, mažiausios
RFU vertės, didžiausios RFU vertės ir
vertinimo vertės pabaigos ciklai

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno šulinėlio
duomenys

„QC Parameters“ (KK
parametrai)

29 lent. Duomenų analizės ataskaitų kategorijos parinkčių sąraše (tęsinys)
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Kategorija Parinktis Aprašymas

„Data“ (duomenys) Skaičiuoklėje išvardyti parametrai
kiekvienai QC (KK) taisyklei

29 lent. Duomenų analizės ataskaitų kategorijos parinkčių sąraše (tęsinys)
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Duomenų analizės ataskaitos

Duomenų analizės ataskaitos kūrimas
Ataskaitos išdėstymą galite įrašyti kaip šabloną, kurį vėl galite naudoti panašioms ataskaitoms.

Kaip sukurti duomenų analizės ataskaitą

1. Prieš kurdami ataskaitą, atlikite paskutinius šulinėlių turinio, pasirinktų šulinėlių, diagramų ir
skaičiuoklių pakeitimus lange „Data Analysis“ (duomenų analizė).

2. Pasirinkite „Tools > Reports“ (įrankiai > ataskaitos) meniu juostoje „Data Analysis“ (duomenų
analizė), kad atidarytumėte dialogo langą „Report“ (ataskaita).

3. Pasirinkite parinktis, kurias norite įtraukti į ataskaitą. Ataskaita atidaroma pagal pasirinktas
numatytąsias parinktis. Pasirinkite arba išvalykite žymės langelius, kad pakeistumėte visas
kategorijas ar atskiras kategorijos parinktis.

Galimos parinktys pateikiamos 29 lent., p. 257.

Pastaba. Ataskaitoje pateikiami duomenys priklauso nuo esamų pasirinkimų kortelėse,
esančiose lange „Data Analysis“ (duomenų analizė). Pavyzdžiui, kiekybinio įvertinimo paleistyje
gali nebūti standartinės kreivės, todėl šie duomenys nerodomi lange „Data Analysis“ (duomenų
analizė) arba duomenų ataskaitoje.

4. Pakeiskite kategorijų ir elementų tvarką ataskaitoje. Vilkite parinktis į santykinę padėtį. Elementus
pertvarkyti galima tik tose kategorijose, kurioms jie priklauso.

5. (Neprivaloma) Srityje „Report Options“ (ataskaitų parinktys) įveskite pasirinktai parinkčiai reikalingą
informaciją:

n Pasirinkite informacijos, kurią norite rodyti ataskaitoje, pogrupį.

n Pasirinkite konkrečias pasirinktos parinkties nuostatas.

n Pakeiskite tekstą, kuris bus rodomas pasirinktai parinkčiai.

6. Spauskite „Update Report“ (atnaujinti ataskaitą), kad atnaujintumėte „Report Preview“ (ataskaitos
peržiūra) su pakeitimais.

7. Spausdinkite arba įrašykite ataskaitą:

a. Paspauskite įrankių juostos mygtuką „Print Report“ (spausdinti ataskaitą), norėdami atspausdinti
esamą ataskaitą.

b. Pasirinkite „File > Save“ (failas > įrašyti), jei norite įrašyti ataskaitą PDF („Adobe Acrobat
Reader“ failas), MHT („Microsoft“ dokumentas) arba MHTML („Microsoft“ dokumentas) failo
formatu.

c. Pasirinkite vietą, kurioje norite įrašyti failą.

Naudotojo vadovas | 261



11 skyrius. Išsami duomenų analizės informacija

d. Pasirinkite „File > Save As“ (failas > įrašyti kaip), ir įrašykite ataskaitą nauju pavadinimu ar
naujoje vietoje.

8. (Neprivaloma) Sukurkite ataskaitos šabloną su norima informacija. Norėdami įrašyti esamas
ataskaitos nuostatas šablone, pasirinkite „Template > Save“ (šablonas > įrašyti) arba „Save As“ 
(įrašyti kaip). Tada įkelkite ataskaitos šabloną kitą kartą, kai norėsite sukurti naują ataskaitą.
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Šulinėlių grupės ataskaitų kūrimas
Kaip sukurti šulinėlių grupės ataskaitą

1. Lange „Data Analysis“ (duomenų analizė) pasirinkite „Tools > Well Group Reports“ (įrankiai >
šulinėlių grupės ataskaitos).

2. Dialogo lange „Well Groups Reports“ (šulinėlių grupių ataskaitos) pasirinkite šulinėlių grupes,
amplifikavimo veiksmus ir lydymosi veiksmus, kuriuos norite įtraukti į ataskaitą.

3. Įveskite kelią arba eikite į paskirties aplanką, kuriame norite įrašyti ataskaitą.

4. (Neprivaloma) Pasirinkite „Choose a Report Template“ (pasirinkti ataskaitos šabloną) ir eikite į
šablono failo aplanką.

5. (Neprivaloma) Pasirinkite „Open Destination Folder“ (atidaryti paskirties aplanką), norėdami atidaryti
aplanką ir peržiūrėti sugeneruotas ataskaitas.

6. Spauskite „Create Reports“ (sukurti ataskaitas).
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12 skyrius. Geno ekspresijos analizė
Naudodamiesi griežtai atrinktomis kontrolės priemonėmis reakcijose, galite naudoti programinės įrangos
„CFX Maestro Dx“, „Security Edition“, kad paleistumėte geno ekspresiją, siekdami normalizuoti
santykinius skirtumus tarp taikinio koncentracijų mėginiuose. Paprastai norimo geno ekspresijos lygiams
normalizuoti naudojami vieno ar daugiau etaloninių genų ekspresijos lygiai. Etaloniniuose genuose
atsižvelgiama į apkrovos skirtumus arba kitus kiekviename mėginyje esančius skirtumus, o jų ekspresijos
lygiai neturi būti paveikti tiriamoje biologinėje sistemoje.

Pasirinkite kortelę „Gene Expression“ (geno ekspresija) lange „Data Analysis“ (duomenų analizė), kad
įvertintumėte santykinius skirtumus tarp PGR reakcijų dviejuose ar daugiau šulinėlių. Pavyzdžiui, galite
įvertinti santykinį viruso genomų skaičių arba santykinį transfekuotų sekų skaičių PGR reakcijoje. Geno
ekspresijos tyrime tai dažniausiai taikoma lyginant cDNA (cDNR) koncentracijas daugiau nei vienoje
reakcijoje, siekiant įvertinti pastovios būsenos informacinės RNA (RNR) lygį.

Programinė įranga apskaičiuoja santykinį taikinio ekspresijos lygį pagal vieną iš šių scenarijų:

n Taikinio sekos santykinis ekspresijos lygis (1 taikinys), lyginant su kitu taikiniu (2 taikinys);
pavyzdžiui, vieno geno kiekis, lyginant su kitu genu taip pat apdorojamame mėginyje.

n Santykinis vienos taikinio sekos ekspresijos lygis viename mėginyje, lyginant su tuo pačiu taikiniu
kitaip apdorojamame mėginyje; pavyzdžiui, santykinis vieno geno kiekis, lyginant su tuo pačiu genu
skirtingomis laiko, geografinėmis ar vystymosi sąlygomis.

Plokštelės sąranka geno ekspresijos analizei
Elementai, kurie turi būti šulinėliuose norint atlikti geno ekspresijos analizę:

n Du ar daugiau taikinių – du taikiniai, atitinkantys skirtingus amplifikuotus genus ar sekas jūsų
mėginiuose.

n Vienas ar daugiau etaloninių taikinių – bent vienas normalizuotos ekspresijos taikinys turi būti
etaloninis. Visus etaloninius taikinius priskirkite lange „Experiment Settings“ (eksperimento
nuostatos), kad išanalizuotumėte duomenis režimu „Normalized Expression“ (normalizuota
ekspresija) (ΔΔCq). Paleidimai, kuriuose nėra etalono, turi būti analizuojami režimu „Relative
Expression“ (santykinė ekspresija) (ΔCq).

n Bendrieji mėginiai – jūsų reakcijose turi būti bendrų mėginių (mažiausiai du), kad galėtumėte
peržiūrėti duomenis kortelėje „Gene Expression“ (geno ekspresija). Šie mėginiai turi atspindėti
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įvairius kiekvienos taikinių sekos apdorojimo būdus arba sąlygas. Lange „Experiment Settings“ 
(eksperimento nuostatos) priskirkite kontrolinį mėginį (neprivaloma). Nepasirinkus kontrolinės imties,
programinė įranga vietoj jos pasirenka Cq.

„Gene Expression“ (geno ekspresija) sąrankos reikalavimai „Plate Editor“ (plokštelės redaktorius)
priklauso nuo to, ar reakcijos turinį sudaro vienkartinė PGR, kurioje dalyvauja vienas fluoroforas, ar
daugkartinė PGR, kurioje dalyvauja daugiau nei vienas fluoroforas.

Interaktyvioji plokštelės sąranka
Jei duomenų failų plokštelės sąrankoje nėra analizei reikalingos informacijos ir pasirinkta kortelė „Gene
Expression“ (geno ekspresija), toje vietoje, kurioje paprastai pateikiama stulpelinė diagrama, pateikiami
nurodymai, kaip įvesti šią informaciją. Normalizuotai geno ekspresijai atlikite šiuos veiksmus:

1. Nurodykite „Target“ (taikinys) ir „Sample“ (mėginys) pavadinimus naudodami vieną iš šių parinkčių:

n „Plate Setup“ (plokštelės sąranka) – atidaromas langas „Plate Editor“ (plokštelės redaktorius).

n „Replace Plate file“ (pakeisti plokštelės failą) – atidaroma naršyklė „Select Plate“ (pasirinkti
plokštelę), kurioje galite pasirinkti anksčiau įrašytą plokštelės failą dabartiniam plokštelės
išdėstymui pakeisti.

n „Replace PrimePCR file“ (keisti PGR pradmenų failą) – atidaromas dialogo langas „Select
PrimePCR“ (pasirinkti PGR pradmenis), kuriame galite pasirinkti „PrimePCR“ (PGR pradmenys)
paleidimo failą ir taikyti jį plokštelės išdėstymui.

2. Pasirinkite vieną ar daugiau etaloninių taikinių ir kontrolinį mėginį dialogo lange „Experiment Settings“ 
(eksperimento nuostatos).

Jei plokštelės išdėstymo vietoje jau yra taikinio ir mėginio informacija, reikia atlikti tik antrąjį veiksmą,
kuris pažymėtas oranžine spalva. Šį veiksmą reikia atlikti prieš normalizuotą geno ekspresijos
analizę.

Pastaba. Taškinės diagramos ir grupinės diagramos duomenys rodomi tik jei išpildomi visi
normalizuotos geno ekspresijos reikalavimai, nurodyti geno ekspresijos analizės dalyje „Plate
Setup“ (plokštelės sąranka).
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Geno ekspresijos diagramos

Geno ekspresijos diagramos
„CFX Maestro Dx SE“ įvairiais rodiniais rodomi geno ekspresijos duomenys. 30 lent. pateikiamos
programinėje įrangoje siūlomos diagramos parinktys.

Mygtukas Pavadinimas Funkcija

Grafikai Rodo normalizuotos geno ekspresijos
duomenis vienu iš šių rodinių:

n Stulpelinė diagrama (numatytasis rodinys)

n Stačiakampė diagrama

n Taškinė diagrama

Grupinė diagrama Rodo normalizuotos ekspresijos duomenis
hierarchine tvarka, kuri grindžiama skirtingų
taikinių ir mėginių ekspresijos panašumo
laipsniu.

Taškinis grafikas Rodo kontrolinio ir eksperimentinio mėginio
taikinių normalizuotą ekspresiją.

ANOVA Rodo geno ekspresijos duomenų vienfaktorinės
ANOVA analizės rezultatus. ANOVA analizei
atlikti ir Tukey rezultatams nustatyti naudojami
R paketai:

n „Companion to applied regression“ (CAR)

n Mažiausių kvadratų metodas (LSMEANS)

Etaloninių genų atrankos įrankis (Randamas kortelėje „Study Analysis“ (tyrimo
analizė), esančioje lange „Gene Study“ (geno
tyrimas)). Nustato išbandytus etaloninius genus
ir priskiria juos vienai iš šių kategorijų: „Ideal“ 
(idealus), „Acceptable“ (priimtinas) arba
„Unstable“ (nestabilus) pagal jų stabilumą.

„PrimePCR“ (PGR pradmenys)
valdiklių analizė

(Randamas kortelėje „Study Analysis“ (tyrimo
analizė), esančioje lange „Gene Study“ (geno
tyrimas)). Rodo išbandytų mėginių rezultatus.

30 lent. Geno ekspresijos diagramos parinktys

Naudotojo vadovas | 267



12 skyrius. Geno ekspresijos analizė

Grafikai

Santykinė taikinių ekspresija pateikiama šiuose dviejuose rodiniuose:

n Geno ekspresijos diagrama – rodomi realiojo laiko PGR duomenys kaip vienas iš šių variantų:

o ΔΔCq – santykinė normalizuota ekspresija, apskaičiuota naudojant kontrolinius mėginius ir etaloninius
taikinius.

o ΔCq – santykinis taikinio geno kiekis mėginyje, palyginti su kontroliniu mėginiu.

Daugiau informacijos apie duomenų peržiūrą rasite skyriuje Diagramos vaizdo keitimas ir
komentavimas, p. 270.

n Skaičiuoklė – rodoma geno ekspresijos duomenų skaičiuoklė.

Patarimas. Parinktis galite pasiekti spustelėję dešiniuoju klavišu bet kurią diagramą ar
skaičiuoklę. Išplečiamajame meniu „Plate Setup“ (plokštelės sąranka) pasirinkite „View/Edit
Plate“ (peržiūrėti / redaguoti plokštelę) ir atidarykite „Plate Editor“ (plokštelės redaktorius) bei
pakeiskite šulinėlio turinį plokštelėje.

Patarimas. Dešiniuoju pelės mygtuku atidarę meniu pasirinkite „Sort“ (rūšiuoti) ir pertvarkykite
„Target“ (taikinys) bei „Sample“ (mėginys) pavadinimų tvarką diagramoje.
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Grafikai

Normalizuota geno ekspresija

Norėdami normalizuoti duomenis, naudokite vieno ar kelių etaloninių genų, kaip normalizavimo
koeficiento, išmatuotą ekspresijos lygį. Etaloniniai genai yra taikiniai, kurie nereguliuojami tiriamoje
biologinėje sistemoje, pvz., aktinas, GAPDH arba tubulinas.

Normalizuotos geno ekspresijos (ΔΔCq) analizės nustatymas

1. Atidarykite failą (.pcrd plėtiniu).

2. Peržiūrėkite duomenis lango „Data Analysis“ (duomenų analizė) kortelėje „Quantification“ (kiekybinis
įvertinimas). Pakoreguokite duomenis, pvz., pakeisdami ribinę reikšmę ir analizės režimą.

3. Pasirinkite kortelę „Gene Expression“ (geno ekspresija).

4. Kortelėje „Gene Expression“ (geno ekspresija) spustelėkite „Experiment Settings“ (eksperimento
nuostatos).

5. Dialogo lange „Experiment Settings“ (eksperimento nuostatos) atlikite šiuos veiksmus:

a. Pasirinkite kortelę „Samples“ (mėginiai) ir pasirinkite kontrolę. Kai kontrolė priskirta, „CFX Maestro Dx
SE“ normalizuoja visų genų santykinius kiekius į kontrolės kiekį, kuris yra 1.

b. Pasirinkite kortelę „Target“ (taikinys) ir pasirinkite etaloninius genus. Geno ekspresijos analizei
reikia vieno etalono iš taikinių jūsų mėginiuose.

6. Pasirinkite „Normalized Expression“ (normalizuota ekspresija) (ΔΔCq), jeigu dar nepasirinkta, ir tada
kortelėje „Gene Expression“ (geno ekspresija) peržiūrėkite ekspresijos lygius.

Pastaba. Taip pat galite pasinaudoti „Setup Wizard“ (sąrankos vedlys) ir nustatykite plokštelės
schemą normalizuoto geno ekspresijos analizei.

Santykinis kiekis

Iš esmės santykinio kiekio (ΔCq) duomenys nėra normalizuoti. Šis metodas naudojamas mėginiams,
kuriuose nėra jokių etaloninių genų (taikinių), kiekybiškai įvertinti. Paprastai, atlikdami analizę,
mokslininkai žino, kad vienas iš šių aspektų teisingas:

n Kiekviename šulinėlyje esančiame mėginyje yra vienodas RNA (RNR) arba cDNA (cDNR) kiekis.

n Bet kokio įdėto biologinio mėginio kiekio dispersija bus normalizuota po paleidimo, taikant tam tikrą
duomenų analizės metodą už programinės įrangos ribų. Pavyzdžiui, mokslininkas gali pasirinkti, kad
santykinio kiekio reikšmė būtų padalyta iš normalizuojančio faktoriaus, galbūt iš kiekviename mėginyje
esančios nukleino rūgšties svorio arba iš ląstelių, iš kurių buvo išskirta nukleino rūgštis, skaičiaus.

Santykinis kiekio (ΔCq) analizės paleidimas

u Kortelėje „Gene Expression“ (geno ekspresija) iš dešiniojoje srityje esančio išplečiamojo sąrašo
„Mode“ (režimas) pasirinkite „Relative Quantity“ (santykinis kiekis) (ΔCq).
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Patarimas. Norėdami palyginti rezultatus su kitų geno ekspresijos paleidimų duomenimis,
atidarykite naują geno tyrimą arba pridėkite duomenų failą į esamą geno tyrimą.

Diagramos vaizdo keitimas ir komentavimas
Diagramos įrankių juostos meniu komandomis ir duomenų analizės diagramos įrankiais galite pakeisti
diagramos vaizdą, komentuoti kiekvieną diagramą ir pakeisti diagramos rodmenį. Diagramos įrankių
juosta parodoma tarp diagramos ir duomenų analizės skaičiuoklės ekrano apačioje.

Diagramos įrankių juostos įrankiai

Patarimas. Daugiau informacijos apie diagramos įrankius, kurie rodomi duomenų analizės
diagramos dešinėje pusėje, žr. Diagramos, p. 208.

Įrankių juosta po diagrama suteikia sparčią prieigą prie komentavimo įrankių.

31 lent. išvardytos mygtukų diagramos įrankių juostoje funkcijos.

Mygtukas Pavadinimas Funkcija

Stulpelinė diagrama Rodoma taikinių santykinė ekspresija.

Stačiakampė diagrama Duomenys rodomi kaip kvartiliniai intervalai (skaičiavimo
informaciją žr. Stačiakampės ir linijinės diagramos
skaičiavimai, p. 307).

Pastaba. Taikoma tik tada, jeigu „Analyze Using“ 
(analizuota naudojant) nustatyta į „Biological Groups
Only“ (tik biologinės grupės).

Taškinė diagrama Rodomi kiekvieno taikinio atskiro mėginio duomenų
taškai.
Pastaba: Taikoma tik tada, jeigu „Analyze Using“ 
(analizuota naudojant) nustatyta į „Biological Groups
Only“ (tik biologinės grupės).

Pridėti rodyklę Aktyvioje diagramoje nupiešia rodyklę.

31 lent. Diagramos įrankių juosta
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Mygtukas Pavadinimas Funkcija

Pridėti apskritimą Aktyvioje diagramoje nupiešia apskritimą.

Pridėti tekstą Aktyvioje diagramoje prideda teksto lauką, kuriame galite
įrašyti tekstą, kad būtų identifikuotos diagramos
dominančios sritys.

Anuliuoti Pašalina arba sugrąžina paskutinę aktyvioje diagramoje
atliktą pastabą.

Atšaukti Sugrąžina paskutinį atšaukimo veiksmą, atliktą aktyvioje
diagramoje.

Valyti viską Valo visus aktyvioje diagramoje esančius komentarus.

31 lent. Diagramos įrankių juosta (tęsinys)

Taikinio, mėginio ir biologinės grupės duomenų rūšiavimas

Pastaba. Ši parinktis galima tik geno ekspresijos diagramose.

Pagal numatytąsias nuostatas taikinio, mėginių ir biologinių grupių sąrašai pateikiami abėcėlės tvarka.
Dialogo lange „Sort“ (rūšiuoti) galite rūšiuoti rodmenis atvirkštine tvarka pagal abėcėlę arba rankiniu būdu
perkelti terminą į kitą padėtį sąraše.

Norėdami rūšiuoti taikinio, mėginio ir biologinės grupės duomenis

1. Diagramos įrankiuose spustelėkite „Sort“ (rūšiuoti).

Parodomas dialogo langas „Gene Expression Chart Sorting“ (geno ekspresijos diagramų
rūšiavimas).
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2. Dialogo lange spustelėkite Z–A ir surūšiuokite sąrašą atvirkštine abėcėline tvarka.

3. Norėdami rankiniu būdu perkelti terminą, jį pasirinkite ir spustelėkite atitinkamą mygtuką tarp
diagramų:

n Spustelėkite rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite per vieną padėtį.

n Spustelėkite juostos rodyklę aukštyn ar žemyn ir pasirinktą terminą perkelkite į sąrašo viršų ar
apačią.

4. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į kortelę „Gene Expression“ (geno ekspresija).
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Taikinio, mėginio ir biologinės grupės spalvų nuostatų keitimas

Spalvų nuostatų dialogo lange galite pakeisti taikinio, mėginio ir biologinės grupės spalvą arba iš
diagramos pašalinti elementą.

Taikinio spalvos nuostatų keitimas

1. Dialogo lango „Gene Expression“ (geno ekspresija) dešiniojoje srityje patikrinkite, ar X ašies
išplečiamajame sąraše parodomas mėginys.

2. Diagramos įrankiuose pasirinkite „Color Settings“ (spalvų nuostatos).

Parodomas dialogo langas „Color Settings“ (spalvų nuostatos).

3. Norėdami pakeisti taikinio rodmens spalvą, spustelėkite jo spalvą spalvų stulpelyje.

4. Pasirodžiusiame dialogo lange „Color“ (spalva) pasirinkite naują spalvą ir spustelėkite „OK“ (gerai).

5. Norėdami taikinį pašalinti iš geno ekspresijos diagramos, panaikinkite jo žymės langelio diagramos
rodymo stulpelyje žymėjimą.

Patarimas. Norėdami išvalyti visus taikinius, išvalykite diagramos rodymo žymėjimą stulpelio
antraštėje.

6. (Papildoma) Pagal numatytąsias nuostatas juosta parodoma vientisomis spalvomis. Norėdami
juostas parodyti intensyvėjančiomis spalvomis, panaikinkite „Use Solid Colors“ (naudoti vientisas
spalvas) žymėjimą.

7. Spustelėkite OK (gerai), įrašykite pakeitimus ir grįžkite į kortelę „Gene Expression“ (geno ekspresija).

Mėginio ar biologinės grupės spalvų nuostatų keitimas

1. Dialogo lango „Gene Expression“ (geno ekspresija) dešiniojoje srityje patikrinkite, ar X ašies
išplečiamajame sąraše rodomas taikinys.

2. Atlikite veiksmus, nurodytus Taikinio spalvos nuostatų keitimas, p. 273.

Diagramos vaizdo keitimas

Dabartinio diagramos vaizdo keitimas

u Pasirinkite įrankių juostos meniu taikinio vaizdo komandą.

Pastaba. „Gene Expression“ (geno ekspresija) kortelė visuomet atveria rodomus duomenis
numatytoje stulpelinės diagramos vaizde.
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Išskirtinių duomenų taškų pašalinimas

Taškinėje diagramoje galite lengvai peržiūrėti ir pašalinti išskirtinius taškus iš savo analizės.

Kaip pašalinti išskirtinius duomenų taškus

u Taškinėje diagramoje dešiniuoju pelės mygtuku spustelėkite išskirtinį taikinį ir pasirinkite „Exclude
Well from Analysis“ (pašalinti šulinėlį iš analizės).

Duomenų taškas pašalinamas iš taškinės diagramos ir kortelės „Quantification“ (kiekybinis įvertinimas)
šulinėlių parinkiklio rodinyje esanti šulinėlio piktograma tampa pilka.

Pašalinto išskirtinio duomenų taško įtraukimas

u Kortelėje „Quantification“ (kiekybinis įvertinimas) dešiniuoju pelės mygtuku spustelėkite šulinėlių
parinkiklį ir pasirinkite „Well > Include in Analysis“ (šulinėlis > įtraukti į analizę).

Išsamios informacijos apie duomenų taškus peržiūrėjimas

Kaip peržiūrėti išsamią informaciją apie duomenų taškus

u Stačiakampėje ir taškinėje diagramoje palaikykite žymeklį ant atskiro duomenų taško.

Pasirodo patarimas, kuriame nurodytas mėginio pavadinimas ir jo ekspresija (santykinis kiekis arba
normalizuota ekspresija, priklausomai nuo pasirinkto režimo).

Diagramų komentavimas

Kiekvienoje stulpelinėje diagramoje galite pridėti rodyklių, apskritimų ir teksto, kad aiškiai perduotumėte
duomenis. Komentarai įrašomi su stulpeline diagrama ir parodomi eksportuotame ir atspausdintame faile.
Tačiau komentarai pridedami viename diagramos vaizde ir nėra pridedami kituose diagramų vaizduose.

Rodyklės ar apskritimo piešimas diagramoje

1. Stulpelinės diagramos įrankių juostoje spustelėkite konkretų įrankį.

2. Spustelėkite stulpelinę diagramą ir savo žymeklį tempkite per diagramą, jeigu reikia.
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Teksto pridėjimas diagramoje

1. Stulpelinės diagramos įrankių juostoje spustelėkite „Add Text“ (pridėti tekstą).

2. Spustelėkite stulpelinę diagramą. Toje vietoje parodomas tekstinis langelis.

3. Į tekstinį langelį įrašykite tekstą.

4. Spustelėkite bet kurioje diagramos vietoje ir išeikite iš tekstinio langelio.

Patarimas. Paspauskite „Enter“ (įvesti) ir į tekstinį langelį pridėkite kelias linijas.

Komentaro perkėlimas

1. Savo žymeklį perkelkite virš komentaro. Piktograma pakeičiama į rodomąjį pirštą ir komentaro ribos
paryškinamos.

2. Spustelėkite komentarą ir perkelkite jį į kitą padėtį.

3. Atleiskite komentarą ir fiksuokite jį vietoje.

Komentaro anuliavimas

u Spustelėkite „Undo“ (anuliuoti)

Naujausi pridėti komentarai yra pašalinami.

Patarimas. Naujausius dešimt komentarų galite anuliuoti (vieną vienu metu).

Komentaro atšaukimas

u Spustelėkite „Redo“ (atšaukti)

Naujausiai pašalinti komentarai sugrąžinami.

Patarimas. Naujausius dešimt komentarų galite atšaukti (vieną vienu metu).

Komentaro šalinimas

u Dešiniuoju pelės mygtuku spustelėkite komentarą ir pasirinkite „Delete“ (šalinti).
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Geno ekspresijos duomenų koregavimas
Pasirinkę analizės režimą – normalizuotą ekspresiją (∆∆Cq) arba santykinį kiekį (∆Cq) – pakoreguokite
kortelėje „Gene Expression“ (geno ekspresija) rodomus duomenis keisdami nuostatų parinktis diagramos
dešinėje.

Patarimas. Dialogo lange „User Preferences“ (naudotojo nuostatos) nustatykite numatytąsias „Gene
Expression“ (geno ekspresija) duomenų parinktis (žr. Numatytųjų geno ekspresijos duomenų failo
parametrų nustatymas, p. 93).

Diagramos duomenys

Y ašies vertei nustatykite tiesinį mastelį, kad būtų įjungtos diagramos duomenų parinktys. Diagramos
duomenų parinktys jums leidžia pateikti duomenis diagramoje viena iš šių parinkčių:

n „Relative to control“ (lyginant su kontrole) – diagramos duomenys su ašimi vertinami nuo 0 iki 1.
Jeigu paleisdami priskiriate kontrolę, pasirinkite parinktį, kad greitai vizualizuotumėte taikinio
padidinimą ir sumažinimą.

n „Relative to zero“ (lyginant su nuliu) – diagramos duomenys su nuline pradžia.

Analizuoti naudojant

Išplečiamajame meniu pasirinkite, kaip analizuojami ir diagramoje žymimi duomenys. Pasirinkimai:

n „Samples Only“ (tik mėginiai) – analizuojami ir pateikiami tik mėginių duomenys.

n „Biological Groups Only“ (tik biologinės grupės) – analizuojami ir pateikiami biologinių grupių
duomenys. Biologinės grupės ekspresija yra tos grupės mėginių geometrinis vidurkis.

n „Sample Biological Group“ (mėginio biologinė grupė) – analizuojami ir pateikiami mėginio duomenys,
o biologinė grupė pridedama po mėginio pavadinimo. Rodomos P vertės apskaičiuojamos pagal
biologinę grupę.

n „Biological Group Sample“ (biologinės grupės mėginys) – analizuojami ir pateikiami mėginio
duomenys, o biologinė grupė pateikiama prieš mėginio pavadinimą. Rodomos P vertės
apskaičiuojamos pagal biologinę grupę.

Išplečiamajame meniu pasirinkite mėginį, kuris bus naudojamas normalizuojant santykinį kiekį:

Komentuoti P reikšmes ir P reikšmių ribines reikšmes

Kai pasirinkta „Annotate P-Values“ (komentuoti P reikšmes), programinė įranga stulpelinėje diagramoje
virš taikinio rodo žvaigždutę (*), jeigu P reikšmė yra mažesnė, nei pasirinkta ribinė reikšmė. Programinė
įranga automatiškai apskaičiuoja P reikšmę palygindama mėginio ekspresijos lygį su pasirinkto
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kontrolinio mėginio ekspresijos lygiu naudodama standartinį t testą. P ribinės reikšmės intervalas yra
0,000–1,000.

X ašies parinktys

X ašies parinktis leidžia pasirinkti diagramos „Gene Expression“ (geno ekspresija) x ašies duomenis:

n Taikinys – taikinių pavadinimai grafiškai atvaizduojami x ašyje.

n Mėginys – mėginių pavadinimai grafiškai atvaizduojami x ašyje.

Y ašies parinktys

Y ašies parinktys leidžia jums parodyti diagramą „Gene Expression“ (geno ekspresija) viena iš šių trijų
skalių:

n Tiesinė – šią parinktį pasirinkite norėdami, kad būtų rodoma tiesinė skalė.

Patarimas. Nustačius „Linear“ (tiesinė) y ašį, įjungiamas išplečiamasis sąrašas „Graph Data“ 
(diagramos duomenys), kuriame galite pasirinkti diagramos duomenis, palygintus su kontrole ar
nuliu.

n „Log 2“ – pasirinkite šią parinktį, norėdami mėginius įvertinti dideliame dinaminiame intervale.

n „Log 10“ – pasirinkite šią parinktį, norėdami mėginius įvertinti labai dideliame dinaminiame intervale.

Mastelio parinktys

Pasirinkite „Normalized Gene Expression“ (normalizuota geno ekspresija) (ΔΔCq) ir nustatykite į „None“ 
(nėra), kad įjungtumėte mastelio parinktis geno ekspresijos diagramoje. Pasirinkite vieną iš mastelio
parinkčių, apskaičiuokite ir pateikite savo duomenis tokiu būdu, kuris geriausiai tiktų jūsų paleidimui:

n „Unscaled“ (neskaidytas) – pateikia neskaidytą normalizuotą geno ekspresiją.

n „Highest“ (didžiausias) – suskaido normalizuotą geno ekspresiją kiekvienam taikiniui kiekvieno
mėginio ekspresijos lygį padalydamas iš visų mėginių ekspresijos didžiausio lygio.

Ši skaidymo parinktis taiko suskaidytą iki didžiausio lygio formulę.

n „Lowest“ (mažiausias) – suskaido normalizuotą geno ekspresiją kiekvienam taikiniui kiekvieno
mėginio ekspresijos lygį padalydamas iš visų mėginių ekspresijos mažiausio lygio.

Ši skaidymo parinktis taiko suskaidytą iki mažiausio lygio formulę.

n „Average“ (vidutinis) – suskaido normalizuotą geno ekspresiją kiekvienam taikiniui kiekvieno mėginio
ekspresijos lygį padalydamas iš visų mėginių ekspresijos geometrinio vidurkio.

Ši skaidymo parinktis taiko suskaidytą iki vidutinio lygio formulę.

Diagramoje „Gene Expression“ (geno ekspresija) pasirinkite paklaidų skaičiavimų (paklaidų juostų) tipą:
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Diagramos paklaidų juostos daugiklis

Diagramoje „Gene Expression“ (geno ekspresija) pasirinkite paklaidų juostos daugiklį. Pasirinkite vieną iš
šių sveikųjų skaičių:

n +/- 1 (numatytasis)

n 2

n 3

Daugiklio pokyčių tipas, kai pasirenkate paklaidų juostą:

n SEM – vidurkio standartinė paklaida

n Std Devs standartiniam nuokrypiui

Eksperimento nuostatos
Patarimas. Šis dialogo langas taip pat prieinamas lange „Plate Editor“ (plokštelės redaktorius).
Daugiau informacijos žr. Eksperimento nuostatų keitimas, p. 155.

Dialogo lange „Experiment Settings“ (eksperimento nuostatos) galite peržiūrėti arba keisti taikinių,
mėginių ar biologinių grupių sąrašą, pasirinkti etaloninius genus, pasirinkti kontrolines medžiagas arba
nustatyti, kad būtų analizuojama grupė „Gene Expression Analysis“ (geno ekspresijos analizė), jei prie
šulinėlių pridedama biologinių grupių.

Dialogo lango „Experiment Settings“ (eksperimento nuostatos) atidarymas

u Kortelėje „Graphing (grafikai) dešinės srities apačioje spustelėkite „Experiment Settings“ 
(eksperimento nuostatos).

Atidaromas dialogo langas „Experiment Settings“ (eksperimento nuostatos), kuriame rodoma kortelė
„Targets“ (taikiniai).

„Targets“ (taikinių) nuostatų koregavimas

u Kortelėje „Targets“ (taikiniai) atlikite kurį nors iš toliau nurodytų veiksmų:

n Norėdami pasirinkti taikinį kaip etaloną geno ekspresijos duomenų analizei, pasirinkite jo
pavadinimą stulpelyje „Reference“ (etalonas).

n Norėdami pakeisti taikinio spalvą, spustelėkite jo langelį stulpelyje „Color“ (spalva) ir
pasirodžiusiame dialogo lange „Color“ (spalva) pakeiskite spalvą.

Pasikeitusi spalva matoma „Gene Expression“ (geno ekspresija) diagramose.
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n Jei norite naudoti anksčiau nustatytą veiksmingumo reikšmę, stulpelyje „Auto Efficiency“ 
(automatinis veiksmingumas) panaikinkite taikinio žymės langelio žymėjimą ir įveskite skaičių,
rodantį taikinio veiksmingumą procentais.

Programinė įranga, naudodama „Auto Efficiency“ (automatinis veiksmingumas) funkciją,
apskaičiuoja taikinio santykinį veiksmingumą, jei taikinio duomenys apima standartinę duomenų
kreivę.

Nuostatų „Sample“ (mėginys) koregavimas

u Kortelėje „Samples“ (mėginiai) atlikite kurį nors iš toliau nurodytų veiksmų:

n Tam, kad pasirinktumėte mėginį kaip kontrolinę medžiagą geno ekspresijos duomenų analizei,
stulpelyje „Control“ (kontrolė) pažymėkite jo pavadinimą.

n Tam, kad pakeistumėte mėginio grupės spalvą, spustelėkite jo elementą stulpelyje „Color“ 
(spalva) ir pasirodžiusiame dialogo lange „Color“ (spalva) pakeiskite spalvą.

Pasikeitusi spalva matoma „Gene Expression“ (geno ekspresija) diagramose.

n Tam, kad mėginys būtų rodomas „Gene Expression“ (geno ekspresija) diagramose, pažymėkite
mėginį arba grupę stulpelyje „Show Chart“ (rodyti diagramą).

n Tam, kad mėginys būtų pašalintas iš „Gene Expression“ (geno ekspresija) diagramų,
panaikinkite mėginio arba grupės žymėjimą stulpelyje „Show Chart“ (rodyti diagramą).

Patarimas. Mėginio duomenys išlieka lentelėje „Results“ (rezultatai).

Mėginio tipo pašalinimas iš analizės skaičiavimų

u Pažymėkite jo žymės langelį dialogo lango „Experiment Settings“ (eksperimento nuostatos) apačioje.

Pastaba. Tokiu būdu iš geno ekspresijos analizės pašalinamos kontrolinės medžiagos ir (arba)
etaloniniai tirpalai.

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Dešiniuoju mygtuku spustelėkite geno ekspresijos diagramą ir pasirinkite 32 lent. esančius elementus.

Elementas Funkcija

„Copy“ (kopijuoti) Diagramą kopijuoja į iškarpinę.

„Save Image As“ (įrašyti
paveikslėlį kaip)

Diagrama įrašoma kaip vaizdinis failas. Nustatykite vaizdo raišką ir
dydį, o tada pasirinkite failo tipą (PNG, JPG, arba BMP).

32 lent. Geno ekspresijos dešiniojo mygtuko meniu elementai
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Elementas Funkcija

„Page Setup“ (puslapio sąranka) Parenkama puslapio sąranka spausdinti.

„Print“ (spausdinti) Atspausdina diagramą.

„Set Scale to Default“ (nustatyti
numatytąją skalę)

„Show All“ (parodyti viską) parodo visus duomenis stulpelinėje
diagramoje. „Scroll Bar“ (slinkties juosta) rodoma slinkties juosta, jeigu
diagramos rėme yra per daug rodytinų mėginių išlaikant minimalų
juostos plotį.

Diagramos nuostatos Atidaromas langas „Chart Settings“ (diagramos nuostatos), kad būtų
galima pakoreguoti diagramą.

„Sort“ (rūšiuoti) Rikiuoja mėginius ar taikinius pagal rodymo diagramos x ašyje tvarką.

„Use Corrected Std Devs“ 
(naudoti koreguotą standartinį
nuokrypį)

Apskaičiuoja nuokrypio juostas taikant koreguoto standartinio
nuokrypio formulę.

„Use Solid Bar Colors“ (naudoti
vientisos juostos spalvas)

Diagramoje rodo vientisas juostas.

„X–Axis Labels“ (x ašies
etiketės)

Rodo horizontalias arba pakreiptas x ašies etiketes.

32 lent. Geno ekspresijos dešiniojo mygtuko meniu elementai (tęsinys)

Duomenų skaičiuoklė
33 lent. apibūdinti duomenys, rodomi duomenų lentelėje „Gene Expression“ (geno ekspresija).

Pastaba. Reikšmės lentelėje apskaičiuojamos remiantis diagramos tipu ir nuostatomis,
pasirinktomis dešiniojoje srityje.

Informacija Aprašymas

„Target“ (taikinys) Lange „Experiment Settings“ (eksperimento nuostatos) pasirinkto
taikinio pavadinimas (amplifikuotas genas).

Biologinė grupė

Mėginio biologinė grupė

Biologinės grupės mėginys

Lange „Experiment Settings“ (eksperimento nuostatos) pasirinktas
mėginio ir (arba) biologinės grupės pavadinimas.

33 lent. Informacijos, pateiktos kortelėje esančioje skaičiuoklėje, apibūdinimas
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Informacija Aprašymas

Kontrolė Lange „Experiment Settings“ (eksperimento nuostatos) pasirinktas
kontrolės pavadinimas. Kai „Analyze Using“ (analizuoti naudojant)
nustatyta į „Samples Only“ (tik mėginiai), „Control“ (kontrolė) yra
mėginys, pasirinktas lange „Experiment Settings“ (eksperimento
nuostatos). Kai pasirinktas arba „Biological Groups Only“ (tik
biologinės grupės), „Sample Biological Group“ (mėginio biologinė
grupė), arba „Biological Group Sample“ (biologinės grupės mėginys),
kontrolė yra biologinė grupė, pasirinkta lange „Experiment Settings“ 
(eksperimento nuostatos).

„Relative Quantity“ (santykinis
kiekis) arba
„Expression“ (ekspresija)

Santykinis kiekis (ΔCq) arba normalizuota geno ekspresija (ΔΔCq),
priklausomai nuo pasirinkto režimo.

„Relative Quantity“ (santykinis
kiekis) arba „Expression SEM“ 
(ekspresijos SEM (arba SD))

Santykinio kiekio arba normalizuotos ekspresijos vidurkio standartinė
paklaida (SEM) arba standartinis nuokrypis (SD), priklausomai nuo
pasirinktos parinkties. Galima tik jeigu „Analyze Using“ (analizuota
naudojant) yra nustatyta į „Samples Only“ (tik mėginiai), „Sample
Biological Group“ (mėginio biologinė grupė) arba „Biological Group
Sample“ (biologinės grupės mėginys).

„Corrected Relative Quantity“ 
(koreguotas santykinis kiekis)
arba „Expression SEM“ 
(ekspresijos SEM (arba SD))

Santykinio kiekio ar normalizuotos ekspresijos SEM arba SD
koreguotos vertės skaičiavimas, priklausomai nuo pasirinktos
parinkties. Galima tik jeigu „Analyze Using“ (analizuota naudojant) yra
nustatyta į „Samples Only“ (tik mėginiai), „Sample Biological Group“ 
(mėginio biologinė grupė) arba „Biological Group Sample“ (biologinės
grupės mėginys).

„Mean Cq“ (Cq vidurkis) Kiekio nustatymo vidurkis (nerodoma, jeigu „Analyze Using“ 
(analizuota naudojant) nustatyta į „Biological Groups Only“ (tik
biologinės grupės)).

„Cq SEM“ (Cq SEM (arba SD)) Kiekio nustatymo ciklo SEM arba SD, priklausomai nuo pasirinktos
parinkties (nerodoma, jeigu „Analyze Using“ (analizuota naudojant)
nustatyta į „Biological Groups Only“ (tik biologinės grupės)).
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Išsamios informacijos rodymo parinktis
34 lent. apibūdinami duomenys, rodomi stulpelinės diagramos skaičiuoklės dešiniojo pelės mygtuko
meniu pasirinkus „Show Details“ (rodyti išsamią informaciją).

Informacija Aprašymas

„Data Set“ (duomenų rinkinys) Fluorescencijos duomenys iš vieno fluoroforo duomenų faile

„Relative Quantity“ (santykinis
kiekis)

Apskaičiuotas santykinis mėginių kiekis

„Relative Quantity SD“ 
(santykinio kiekio SD)

Santykinio kiekio skaičiavimo standartinis nuokrypis

„Corrected Relative Quantity
SD“ (pakoreguoto santykinio
kiekio SD)

Apskaičiuotas pakoreguoto santykinio kiekio standartinis nuokrypis

„Relative Quantity SEM“ 
(santykinio kiekio SEM)

Santykinio kiekio apskaičiavimo vidurkio standartinė paklaida

„Corrected Relative Quantity
SEM“ (pakoreguoto santykinio
kiekio SEM)

Apskaičiuota pakoreguoto santykinio kiekio vidurkio standartinė
paklaida

„Relative Quantity“ (santykinis
kiekis) (lg)

Santykinio kiekio, naudojamo statistinei analizei, log2

SD RQ (lg) Santykinio kiekio standartinis nuokrypis (log2)

„SEM Expression(lg)“ (SEM
ekspresijos) (lg)

Ekspresijos vidurkio standartinė paklaida (log2)

„Unscaled Expression“ 
(neapdorota ekspresija)

Apskaičiuota neapdorota ekspresija

„Unscaled Expression SD“ 
(neapdorotos ekspresijos SD)

Apskaičiuotas neapdorotos ekspresijos standartinis nuokrypis

„Corrected Unscaled Expression
SD“ (pakoreguotos neapdorotos
ekspresijos SD)

Apskaičiuotas pakoreguotos neapdorotos ekspresijos standartinis
nuokrypis

34 lent. Informacija, esanti stulpelinės diagramos skaičiuoklėje, pasirinkus „Show Details“ 
(rodyti išsamią informaciją)
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Informacija Aprašymas

„Unscaled Expression SEM“ 
(neapdorotos ekspresijos SEM)

Apskaičiuota neapdorotos ekspresijos vidurkio standartinė paklaida

„Corrected Unscaled Expression
SEM“ (pakoreguotos
neapdorotos ekspresijos SEM)

Apskaičiuota pakoreguotos neapdorotos ekspresijos vidurkio
standartinė paklaida

„Unscaled Expression“ 
(neapdorota ekspresija) (lg)

Neapdorotos ekspresijos Log2

„SD Unscaled Expression(lg)“ 
(neapdorotos ekspresijos SD)
(lg)

Neapdorotos ekspresijos standartinis nuokrypis (log2)

„SEM Unscaled Expression“ 
(neapdorotos ekspresijos SEM)
(lg)

Neapdorotos ekspresijos vidurkio standartinė paklaida (log2)

„Expression“ (ekspresija) Normalizuota geno ekspresija

„Corrected Expression SD“ 
(pakoreguotos ekspresijos SD)

Apskaičiuotas pakoreguotos ekspresijos standartinis nuokrypis

„Expression SEM“ (ekspresijos
SEM)

Ekspresijos vidurkio standartinė paklaida

„Corrected Expression SEM“ 
(pakoreguotos ekspresijos SEM)

Apskaičiuota pakoreguotos ekspresijos vidurkio standartinė paklaida

„Expression“ (ekspresija) (lg) Ekspresijos (normalizuotos ekspresijos), naudojamos statistinei
analizei, log2

„SD Expression“ (SD ekspresija)
(lg)

Ekspresijos standartinis nuokrypis (log2)

„SEM Expression(lg)“ (SEM
ekspresijos) (lg)

Ekspresijos vidurkio standartinė paklaida (log2)

„Mean Cq“ (Cq vidurkis) Kiekybinio įvertinimo ciklo vidurkis

Cq SD Kiekybinio įvertinimo ciklo standartinis nuokrypis

Cq SEM Kiekybinio įvertinimo ciklo vidurkio standartinė paklaida

34 lent. Informacija, esanti stulpelinės diagramos skaičiuoklėje, pasirinkus „Show Details“ 
(rodyti išsamią informaciją) (tęsinys)
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Grupinė diagrama
Grupinėje diagramoje duomenys pateikiami hierarchine tvarka, kuri grindžiama skirtingų taikinių ir
mėginių ekspresijos panašumo laipsniu.

Pastaba. Turite pasirinkti etaloninį taikinį tam, kad būtų rodomos bet kokios duomenų diagramos,
išskyrus santykinės ekspresijos stulpelines diagramas.

Grupinės diagramos vaizde parodyta santykinė mėginio ar taikinio ekspresija:

n Didinimas (raudona) – aukštesnė ekspresija

n Sumažinimas (žalia arba mėlyna) – žemesnė ekspresija

n Nereguliuojama (juoda)

n Nėra apskaičiuotų reikšmių (juoda su baltu X)

Kuo šviesesnis atspalvis, tuo didesnė santykinė ekspresija. Jei nepavyks apskaičiuoti normalizuotos Cq
reikšmės, bus rodomas juodas kvadratas su baltu X.

Duomenų diagramos išoriniuose kraštuose yra dendrograma, nurodanti grupavimo hierarchiją. Taikiniai
arba mėginiai, kurie turi panašius ekspresijos modelius, turės gretimų šakų, o tie, kurių modeliai skirtingi,
bus tolesni.

Nuostatos
Galite nustatyti šias parinktis:

n „Cluster By“ (grupė) – pasirinkite iš „Targets“ (taikiniai), „Samples“ (mėginiai), „Both“ (abu) arba
„None“ (joks).

n „Size“ (dydis) – koreguojamas vaizdo dydis ir pakeičiamas.

n „Split Out Replicates“ (padalyti kopijas) – rodomos atskirų kopijų vertės

Patarimas. Galite pakeisti spalvų schemą iš numatytosios raudonos / žalios į raudoną / mėlyną
pasirinkdami diagramos šią dešiniojo pelės mygtuko meniu parinktį.

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Dešiniojo mygtuko paspaudimu atidaromo meniu grupinės diagramos parinktys yra tokios pačios, kaip
juostinės diagramos. Galimas parinktis žr. čia: 32 lent., p. 279. Be to, pasirinkite „Color Scheme“ (spalvų
schema), kad pakeistumėte iš numatytosios raudoną / žalią į raudoną / mėlyną sumažinimo veiksmui
diagramoje vaizduoti.

Duomenų skaičiuoklė
Skaičiuoklėje pateikiamos taikinių, mėginių ir normalizuotos ekspresijos vertės.
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Taškinis grafikas

Taškinis grafikas
Taškiniame grafike rodoma kontrolės ir eksperimentinio mėginio taikinių normalizuota ekspresija. Grafiko linijos
rodo kartotinio keitimo ribinę reikšmę. Duomenų taškai tarp eilučių rodo, kad to taikinio (geno) ekspresijos
skirtumas tarp mėginių yra nereikšmingas. Duomenų taškai, esantys už linijų ribų, viršija kartotinio keitimo ribinę
reikšmę ir gali būti dominantys.

Grafiko vaizdas parodo šiuos taikinio ekspresijos pokyčius, remiantis kartotinio keitimo ribine reikšme.

n Didinimas (raudonas apskritimas) – santykinai didesnė ekspresija

n Sumažinimas (žalias arba mėlynas apskritimas) – santykinai mažesnė ekspresija

n „No change“ (be pakeitimų) (juodas apskritimas)

Spustelėkite ir vilkite bet kurią ribinės reikšmės liniją, norėdami pakeisti kartotinio keitimo ribinę reikšmę.

Nuostatos
Galite nustatyti šias parinktis:

n „Control Sample“ (kontrolinis mėginys)

n „Experimental Sample“ (eksperimentinis mėginys)

n „Fold Change Threshold“ (kartotinio keitimo ribinė reikšmė). Didinant arba mažinant kartotinio
keitimo reikšmę, ribinių reikšmių linijos diagramoje atitinkamai keičiasi.

Dešiniojo mygtuko paspaudimu atveriamo meniu parinktys
Taškinio grafiko dešiniojo mygtuko paspaudimu atidaromo meniu parinktys yra tokios pačios, kaip ir
stulpelinių diagramų. Galimas parinktis žr. čia: 32 lent., p. 279. Be to, pasirinkite „Symbol“ (simbolis), kad
pakeistumėte diagramoje naudojamą numatytąjį apskritimo simbolį į vieną iš šių:

n Trikampis

n Kryžius

n Kvadratas

n Rombas

Duomenų skaičiuoklė
Skaičiuoklėje pateikiamos taikinių, mėginių ir normalizuotos ekspresijos reikšmės kontroliniams ir
eksperimentiniams mėginiams. Ji taip pat parodo, ar taikiniai yra padidinti, ar sumažinti, palyginti su
nustatytu taikiniu.
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Rezultatų skaičiuoklė
Skaičiuoklėje „Results“ (rezultatai) apibendrinami visų diagramų duomenis. 35 lent. apibūdinami
duomenys, kurie rodomi rezultatų skaičiuoklėje.

Informacija Aprašymas

„Target“ (taikinys) Taikinio pavadinimas (amplifikuotas genas)

„Sample“ (mėginys) Mėginio pavadinimas

Cq vidurkis Kiekybinio įvertinimo ciklo vidurkis

„Mean Efficiency Corrected Cq“ 
(vidutinis koreguotas
veiksmingumo Cq)

Kiekybinio įvertinimo ciklo vidurkis pakoregavus reakcijos
veiksmingumą

Normalizuota ekspresija Taikinių ekspresija, normalizuota etaloniniam taikiniui (ΔΔCq)

„Relative Normalized
Expression“ (santykinė
normalizuota ekspresija)

Normalizuota ekspresija, palyginus su kontroliniu mėginiu, dar
vadinama kartotiniu keitimu

„Regulation“ (taisyklė) Ekspresijos pokytis, palyginus su kontroliniu mėginiu

„Compared to Regulation
Threshold“ (palyginus su
taisyklės ribine reikšme)

Eksperimentinio mėginio padidinimas ar sumažinimas, remiantis
ribinės reikšmės nuostatomis

35 lent. Informacija rezultatų kortelėje

Pastaba. Duomenų kopijos aptinkamos tik duomenų analizės kortelių skaičiuoklėse, kuriose buvo
pasirinkta „Split Out Replicates“ (išskirti kopijas) (t. y. „Clustergram“ (grupinė diagrama). Gali būti
neatitikimų tarp ekspresijos duomenų geno ekspresijos analizės skaičiuoklėje, jeigu stulpelinėje
diagramoje kaip kontrolinį mėginį pasirinktumėte „nėra“.
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Geno tyrimas
Sukurkite geno tyrimą, kad būtų galima palyginti geno ekspresijos duomenis iš vieno ar kelių realiojo laiko
PGR eksperimentų taikant kalibratorių tarp paleidimų, kad būtų normalizuota tarp eksperimentų.
Sukurkite geno tyrimą į jį įtraukdami duomenis iš vieno ar kelių duomenų failų (.pcrd plėtiniu). Programinė
įranga juos sugrupuoja į vieną failą (.mgxd plėtiniu).

Pastaba. Didžiausią mėginių, kuriuos galite analizuoti geno tyrime, skaičių riboja kompiuterio RAM ir
virtualios atminties dydis.

Kalibravimas tarp paleidimų
Kiekviename geno tyrime kiekvienam taikiniui automatiškai bandoma atlikti kalibravimą tarp paleidimų,
siekiant normalizuoti tarpines variacijas tarp taikinių, ištirtų atskiruose PGR paleidimuose tikruoju laiku
(t. y. skirtingi .pcrd failai, gauti iš skirtingų plokštelių).

Kad programinė įranga atpažintų mėginį kaip kalibratorių tarp paleidimų, jis turi turėti tą patį taikinio
pavadinimą, mėginio pavadinimą ir, jei naudojama, biologinio rinkinio pavadinimą visose lyginamose
plokštelėse.

Pastaba. Geno tyrime turi būti bent vienas kalibravimo tarp paleidimų mėginys, kad būtų atliktas
kalibravimas tarp paleidimų. Taikiniai be tinkamų kalibratoriaus tarp paleidimų mėginių bus tvarkomi
be korekcijos geno tyrime (nerekomenduojama).

Kalibratoriai tarp paleidimų gali būti taikomi dviem būdais:

n Taikiniui – skirtingų PGR pradmenų veiksmingumas gali skirtis. Pagal numatytąsias nuostatas
kalibratorius tarp paleidimų taikomas visiems tos pačios plokštelės šulinėliams, turintiems tą patį
taikinio pavadinimą, pavyzdžiui, Cq, gautas su tuo pačiu tyrimu.

n Visam tyrimui – naudotojas pasirenka vieną kalibratorių tarp paleidimų, kuris taikomas visam geno
tyrimui.
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Geno tyrimo dialogo langas

Dialogo lange „Gene Study“ (geno tyrimas) yra dvi kortelės:

n Kortelėje „Study Setup“ (tyrimo sąranka) tvarkomi geno tyrimo paleidimai.

Svarbu. Duomenų failų įtraukimas į geno tyrimą ar šalinimas iš jo nekeičia pirminio failo
duomenų.

n Kortelėje „Study Analysis“ (tyrimo analizė) rodomi kombinuotų paleidimų geno ekspresijos
duomenys.

Tyrimo sąrankos kortelė
36 lent. apibūdinti duomenys, rodomi kortelėje „Study Setup“ (tyrimo sąranka).

Stulpelio pavadinimas Aprašymas

„File Name“ (failo
pavadinimas)

Analizės duomenų failo pavadinimas (.pcrd plėtinys)

„File Folder“ (failo aplankas) Katalogas, kuriame saugomas kiekvieno geno tyrimo metu atlikto
paleidimo duomenų failas

„Date Created“ (sukūrimo
data)

Paleidimo duomenų surinkimo data

36 lent. Kortelė „Study Setup“ (tyrimo sąranka) dialogo lange „Gene Study“ (geno tyrimas)
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Geno tyrimas

Stulpelio pavadinimas Aprašymas

„Well Group Name“ 
(šulinėlių grupės
pavadinimas)

Šulinėlių grupės, kuri buvo pasirinkta pridedant failą prie genų tyrimo,
pavadinimas

Patarimas. Jei geno tyrimo metu norite analizuoti vieną šulinėlių
grupę, prieš importuodami duomenų failą į geno tyrimą turite
pasirinkti tą šulinėlių grupę lange „Data Analysis“ (duomenų
analizė).

„Step“ (veiksmas) Protokolo veiksmas, kurio metu nuskaitoma plokštelė, siekiant rinkti
realiojo laiko PGR duomenis

„Run Type“ (paleidimo
tipas)

Nustatytas naudotojo arba „PrimePCR“ (PGR pradmenys) paleidimas

„Protocol Edited“ 
(redaguotas protokolas)

Jei pasirinkta, rodoma, kuris protokolas, naudotas atliekant
„PrimePCR“ (PGR pradmenys) paleidimą, buvo redaguotas

„View Plate“ (peržiūrėti
plokštelę)

Atveriama plokštelės schema su kiekvieno paleidimo, įtraukto į geno
tyrimą, duomenimis

36 lent. Kortelė „Study Setup“ (tyrimo sąranka) dialogo lange „Gene Study“ (geno tyrimas)
(tęsinys)

Geno tyrimo paruošimas
Kaip paruošti geno tyrimą

1. Prieš importuodami duomenis į geno tyrimą, lange „Data Analysis“ (duomenų analizė) atlikite šiuos
veiksmus:

n Patikrinkite, ar mėginiai, kurių turinys toks pats, yra tokio paties pavadinimo. Geno tyrime
programinė įranga daro prielaidą, kad šulinėliai su tokiu pačiu taikinio ar mėginio pavadinimu turi
tokius pačius mėginius.

n Kortelėje „Quantification“ (kiekybinis įvertinimas) koreguokite pradinį lygį ir ribinę vertę (Cq) ir
optimizuokite kiekvieno paleidimo duomenis.

n Pasirinkite šulinėlių grupę, kurią norite įtraukti į genų tyrimą.

Kad galėtumėte parodyti vienos šulinėlių grupės geno tyrime duomenis, ta grupė turi būti
pasirinkta prieš importuojant duomenų failą.

Kortelėje „Study Setup“ (tyrimo sąranka) rodomas visų paleidimų geno tyrime sąrašas.

2. Dialogo lange „Gene Study“ (geno tyrimas) pasirinkite kortelę „Study Setup“ (tyrimo sąranka).

3. Spustelėkite „Add Data Files“ (pridėti duomenų failus) ir naršyklės lange pasirinkite failą.
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Patarimas. Norėdami į geno tyrimą greitai įtraukti paleidimus, duomenų failus (.pcrd plėtiniu)
nuvilkite į dialogo langą „Study Setup“ (tyrimo sąranka).

4. „CFX Maestro Dx SE“ automatiškai atlieka geno tyrimo analizę, kai pridedate duomenų failus.
Pasirinkite kortelę „Study Analysis“ (tyrimo analizė) ir peržiūrėkite rezultatus.

Paleidimų pašalinimas iš geno tyrimo

u Sąraše pasirinkite vieną ar kelis failus ir spustelėkite „Remove“ (pašalinti).

Pastabų apie geno tyrimą pridėjimas

u Į tekstinį laukelį „Notes“ (pastabos) įrašykite pastabų apie failus ir analizę.

Tyrimo analizės kortelė
Kortelėje „Study Analysis“ (tyrimo analizė) rodomi duomenys iš visų geno tyrimo paleidimų. Geno
ekspresijos duomenų analizės parinktis yra tokia pati, kaip ir atskiro duomenų failo, išskyrus šį atvejį:

n Stulpelinių diagramų kalibracijos tarp paleidimų vertės (jeigu apskaičiuotos) parodomos, kai
paspaudžiate „Inter-run Calibration“ (kalibravimas tarp paleidimų).

Pastaba. Kaip kalibratoriai tarp paleidimų gali būti naudojami tik šių tipų mėginiai:

o „Unknown“ (nežinomas)

o „Standard“ (standartinis)

o „Positive Control“ (teigiama kontrolė)

Neigiamos kontrolės, kontrolės be šablono (NTC) ir kontrolės be atvirkštinės transkriptazės (NRT)
mėginių tipų negalima naudoti kaip kalibratoriaus tarp paleidimų.

n Įrankiu „Reference Gene Selection“ (etaloninio geno pasirinkimas) nustatomi ištirti etaloniniai genai ir
priskiriami „Ideal“ (idealus), „Acceptable“ (priimtinas) arba „Unstable“ (nestabilus) kategorijai pagal jų
stabilumą:

o Idealūs etaloniniai genai yra stabilūs ir reiškia minimalius nuokrypius tarp ištirtų mėginių.

o Priimtini etaloniniai genai nėra idealiai stabilūs ir reiškia vidutinius nuokrypius tarp ištirtų mėginių.
Šiuos etaloninius genus naudokite, jeigu nėra idealių etaloninių genų.

o Nestabilūs etaloniniai genai reiškia didelį kintamumą tarp tiriamų mėginių. Rekomenduojama šių
genų į analizę neįtraukti.

n „PrimePCR Analysis Controls“ (PGR pradmenų analizės valdikliai) įrankis lentelėje parodo ištirtų
mėginių rezultatus:

290 | Programinė įranga „CFX Maestro Dx SE“



Geno tyrimas

o Kortelėje „Summary“ (santrauka) pateikiama visų ištirtų mėginių santrauka. Visi kontrolės tyrimą
praėję mėginiai pažymimi žaliai. Vieno ar kelių kontrolės tyrimų nepraėję mėginiai pažymimi
geltonai.

o PGR kortelėje rodomi teigiamos PGR kontrolės tyrimo rezultatai. Šis tyrimas aptinka slopinimo
ar eksperimento problemas, kurios daro įtaką geno ekspresijai.

o RT kortelėje rodomi atvirkštinės transkriptazės kontrolės tyrimo rezultatai. Šiuo tyrimu
kokybiškai įvertinamas RT veikimas ir nustatomi mėginiai, kurių RT veikimas gali sutrikdyti geno
ekspresiją.

o gDNR kortelėje rodomi DNR užteršimo kontrolės tyrimo rezultatai. Šiuo tyrimu nustatoma, ar
genominės DNR (gDNR) yra mėginyje tokiu lygiu, kuris gali turėti įtakos qPGR rezultatams.

o RQ kortelėje rodomi RNR kokybės tyrimo (RQ1 ir RQ2) rezultatai. Šiais tyrimais kokybiškai
vertinama, ar RNR vientisumas gali daryti neigiamą įtaką geno ekspresijai.

Geno tyrimo ataskaitų kategorijos
Dialogo lange „Gene Study Report“ (geno tyrimo ataskaita) organizuokite geno tyrimo duomenis į
ataskaitą. 37 lent. išvardytos visos parinktys, galimos geno tyrimo ataskaitoje

Kategorija Parinktis Aprašymas

Antraštė

Ataskaitos antraštė, paantraštė ir logotipas

„Report Information“ 
(ataskaitos informacija)

Data, naudotojo vardas, duomenų failo
pavadinimas, duomenų failo kelias ir pasirinktų
šulinėlių grupė

„Gene Study File List“ 
(geno tyrimo failų sąrašas)

Visų duomenų failų geno tyrime sąrašas

„Notes“ (pastabos) Pastabos apie duomenų ataskaitą

Tyrimo analizė: Stulpelinė diagrama

„Analysis Settings“ 
(analizės nuostatos)

Pasirinktų analizės parametrų sąrašas

„Chart“ (diagrama) Geno ekspresijos stulpelinė diagrama, kurioje
rodomi duomenys

37 lent. Geno tyrimo ataskaitos kategorijos
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Kategorija Parinktis Aprašymas

„Target Names“ (taikinių
pavadinimai)

Visų taikinių geno tyrime sąrašas

„Sample Names“ (mėginių
pavadinimai)

Visų mėginių geno tyrime sąrašas

„Data“ (duomenys) Skaičiuoklė, kurioje pateikiami duomenys

„Target Stability“ (taikinio
stabilumas)

Taikinio stabilumo duomenys

„Inter-run Calibration“ 
(kalibravimas tarp
paleidimų)

Kalibravimo tarp paleidimų duomenys

„Box-and-Whisker Chart“ 
(stačiakampė diagrama)

Geno ekspresijos stačiakampė diagrama

„Dot-Plot Chart“ (taškinė
diagrama)

Geno ekspresijos taškinė diagrama

Tyrimo analizė: Grupinė diagrama ir taškinė diagrama

„Analysis Settings“ 
(analizės nuostatos)

Kiekvieno diagramos tipo nuostatos

„Chart“ (diagrama) Geno ekspresijos diagrama, kurioje rodomi
duomenys

„Data“ (duomenys) Skaičiuoklėje išvardyti kiekvieno taikinio
duomenys

Tyrimo analizė: „ANOVA Data“ (ANOVA
duomenys)

„ANOVA Settings“ (ANOVA
nuostatos)

P ribinė reikšmė, naudojama analizėje

„ANOVA Results“ (ANOVA
rezultatai)

Rezultatų iš ANOVA ir Tukey HSD „post-hoc“ 
analizės lentelė

37 lent. Geno tyrimo ataskaitos kategorijos (tęsinys)
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Kategorija Parinktis Aprašymas

„Shapiro-Wilk Normality
Test“ (Shapiro ir Wilko
normalumo bandymas)

Biologinė grupė, skaičius, P reikšmė ir paklaidos,
pasitaikančios kiekviename analizės taikinyje

„ANOVA Errors“ (ANOVA
paklaidos)

Apskaičiuojant ANOVA nustatyta paklaidų

37 lent. Geno tyrimo ataskaitos kategorijos (tęsinys)
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Geno tyrimo ataskaitos kūrimas
Kaip sukurti geno tyrimo ataskaitą

1. Prieš sukurdami ataskaitą, pakoreguokite geno tyrimo ataskaitos duomenis ir diagramas, kai reikia.

2. Pasirinkite „Tools > Reports“ (įrankiai > ataskaitos) meniu „Gene Study“ (geno tyrimas), kad
atidarytumėte dialogo langą „Report“ (ataskaita).

3. Pasirinkite parinktis, kurias norite įtraukti į ataskaitą. Ataskaita atidaroma pagal pasirinktas
numatytąsias parinktis. Pasirinkite arba išvalykite žymės langelius, kad pakeistumėte visas
kategorijas ar atskiras kategorijos parinktis.

Galimos parinktys pateikiamos skyriaus Geno tyrimo ataskaitų kategorijos, p. 291, sąrašuose.

4. Pakeiskite kategorijų ir elementų tvarką ataskaitoje. Vilkite parinktis į reikiamą padėtį. Elementus
pertvarkyti galima tik tose kategorijose, kurioms jie priklauso.

5. Spauskite „Update Report“ (atnaujinti ataskaitą), kad atnaujintumėte „Report Preview“ (ataskaitos
peržiūra) su pakeitimais.

6. Spausdinkite arba įrašykite ataskaitą. Paspauskite įrankių juostos mygtuką „Print Report“ (spausdinti
ataskaitą), norėdami atspausdinti esamą ataskaitą. Pasirinkite „File > Save“ (failas > įrašyti), kad
įrašytumėte PDF („Adobe Acrobat Reader“ failas)formatu, ir pasirinkite, kur norite įrašyti failą.
Pasirinkite „File > Save As“ (failas > įrašyti kaip), ir įrašykite ataskaitą nauju pavadinimu ar naujoje
vietoje.

7. (Neprivaloma) Sukurkite ataskaitos šabloną su norima informacija. Norėdami įrašyti esamas
ataskaitos nuostatas šablone, pasirinkite „Template > Save“ (šablonas > įrašyti) arba „Save As“ 
(įrašyti kaip). Tada įkelkite ataskaitos šabloną kitą kartą, kai norėsite sukurti naują ataskaitą.
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A priedas. Duomenų analizės skaičiavimai
Programinės įrangos „CFX Maestro Dx“, „Security Edition“ formules apskaičiuoja automatiškai ir
rezultatus parodo kortelėse „Data Analysis“ (duomenų analizė). Šiame priede išsamiai paaiškinta, kaip
„CFX Maestro Dx SE“ programinė įranga apskaičiuoja formules.

Reakcijos veiksmingumas
Įrodymai rodo, kad taikant kiekvieno pradmens ir zondo rinkinio veiksmingumo tikslias priemones bus
gauti tikslesni rezultatai, kai analizuojami geno ekspresijos duomenys. Veiksmingumo, taikomo geno
ekspresijos skaičiavimuose, numatytoji vertė yra 100 %. Norėdami įvertinti reakcijos veiksmingumą,
sukurkite standartinę kreivę, taikydami reprezentatyvaus mėginio serijinius skiedimus atitinkamame
dinaminiame intervale ir tada registruokite kitos geno ekspresijos analizės veiksmingumą. Jeigu jūsų
paleistyje yra standartinė kreivė, tada programinė įranga automatiškai apskaičiuoja veiksmingumą ir jį
pateikia „Standard Curve“ (standartinė kreivė) kortelėje „Quantification“ (kiekybinis vertinimas), kai lango
„Experiment Settings“ (eksperimento nuostatos) kortelėje „Targets“ (taikiniai) pažymima „Auto Efficiency“ 
(automatinis veiksmingumas).

Veiksmingumas (E) veiksmingumo formulėse reiškia „veiksmingumus“, kaip jie apibūdinti Pfaffl (2001) ir
Vandesompele et al. (2002)“. Šiose publikacijose 2 veiksmingumas (idealus padvigubėjimas su kiekvienu
ciklu) yra lygus 100 % veiksmingumui programinėje įrangoje. Jūs turite galimybę konvertuoti savo
skaičiavimus į naudojamus programinėje įrangoje taikydami šias matematines lygtis:

n E = (% veiksmingumas * 0,01) + 1

n % veiksmingumas = (E – 1) * 100

Santykinis kiekis
Santykinio kiekio (ΔCq) formulė bet kuriam mėginiui (GOI) yra:

Pastaba. Ši formulė naudojama santykiniam kiekiui apskaičiuoti, kai nėra apibrėžtas kontrolinis
mėginys.

Kur:
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n E = pradmens ir zondo rinkinio veiksmingumas. Šis veiksmingumas apskaičiuojamas pagal formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n C q (min) = vidutinis Cq mėginiui su mažiausiu vidutiniu Cq, skirtas GOI

n Cq (mėginys) = vidutinis Cq mėginiui

n GOI = tikslinis genas (vienas taikinys)

Santykinis kiekis pasirinkus kontrolę
Kai priskirtas kontrolinis mėginys arba biologinė grupė, mėginio su tiksliniu genu (GOI) santykinis kiekis
(RQ) apskaičiuojamas pagal šią formulę:

Kur:

n E = pradmens ir zondo rinkinio veiksmingumas. Šis veiksmingumas apskaičiuojamas pagal formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n Cq (kontrolė) = vidutinis Cq kontroliniam mėginiui

n Cq (mėginys) = vidutinis Cq visiems mėginiams su GOI

n GOI = tikslinis genas (vienas taikinys)

Santykinio kiekio standartinis nuokrypis
Svarbu. Šis skaičiavimas galioja tik kai „Analyze Using“ (analizuoti naudojant) nustatyta „Samples
Only“ (tik mėginiai), „Sample Biological Group“ (mėginio biologinė grupė) arba „Biological Group
Samples“ (biologinės grupės mėginiai).

Santykinio kiekio standartinio nuokrypio formulė yra

Kur:

n SD santykinis kiekis = santykinio kiekio standartinis nuokrypis

n SD CqGOI mėginys = mėginio (GOI) Cq standartinis nuokrypis

n Santykinis kiekis = mėginio santykinis kiekis
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Koreguotas veiksmingumas Cq (CqE)

n E = pradmens ir zondo rinkinio veiksmingumas. Šis veiksmingumas apskaičiuojamas pagal formulę
(% veiksmingumas * 0,01) + 1, kur 100 % veiksmingumas = 2

n GOI = tikslinis genas (vienas taikinys)

Koreguotas veiksmingumas Cq (CqE)
Koreguoto veiksmingumo Cq formulė yra

Kur:

n E = veiksmingumas

Vidutinis koreguotas veiksmingumas Cq (MCqE)
Vidutinio koreguoto veiksmingumo Cq formulė yra

Kur:

n CqE = koreguotas veiksmingumas Cq

n n = kopijų skaičius
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Normalizuota ekspresija
Normalizuota ekspresija (ΔΔCq) yra jūsų taikinio (geno), normalizuoto iki etaloninių taikinių (genų ar sekų)
jūsų biologinėje sistemoje, santykinis kiekis. Norėdami pasirinkti etaloninius taikinius, atidarykite langą
„Experiment Settings“ (eksperimento nuostatos) ir spustelėkite kiekvieno taikinio, kuris naudojamas kaip
etaloninis genas, etalono stulpelį.

Normalizuotos ekspresijos formulė, kuri naudojama apskaičiuoti santykiniam kiekiui (RQ), yra

Kur:

n RQ = mėginio santykinis kiekis

n Ref = etaloninis taikinys paleidžiant, kuris apima vieną ar kelis etaloninius taikinius kiekviename
mėginyje

n GOI = tikslinis genas (vienas taikinys)

Jei etaloniniai taikiniai jūsų biologinėje sistemoje nekeičia jų ekspresijos lygio, normalizuotos ekspresijos
apskaičiavimas apims krovimo skirtumus arba ląstelių skaičiaus skirtumus, kurie yra vaizduojami
kiekviename jūsų mėginyje.
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Normalizuota ekspresija pasirinkus kontrolę

Biologinių grupių ekspresija ir santykinis kiekis
Kai „Analyze Using“ (analizuoti naudojant) nustatytas „Biological Groups Only“ (tik biologinės grupės),
programinėje įrangoje rodoma biologinės grupės mėginių vidutinė ekspresija (normalizuota ekspresija
arba santykinis kiekis, priklausomai nuo pasirinkto režimo). Kadangi ekspresija paprastai logaritmiškai
normaliai pasiskirsčiusi, jos vidurkis apskaičiuojamas naudojant geometrinį vidurkį:

Kur:

n Exp1, Exp2, Expn = mėginių biologinėje grupėje santykinis kiekis arba normalizuota ekspresija

n n = mėginių skaičius biologinėje grupėje

Normalizuota ekspresija pasirinkus kontrolę
Pasirinkus kontrolinį mėginį lange „Experiment Settings“ (eksperimento nuostatos), programinė įranga
nustato kontrolinio mėginio ekspresijos lygį į 1. Esant tokiai situacijai, programinė įranga normalizuoja
santykinius visų taikinių (genų) ekspresijų kiekius į kontrolinį kiekį (reikšmė = 1). Ši normalizuota
ekspresija lygi neapdorotos normalizuotos ekspresijos analizei, kai pasirinkta kontrolė.

Pastaba. Ji dar vadinama santykine normalizuota ekspresija (RNE) ir kartotiniu keitimu.
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Normalizuotos ekspresijos standartinis nuokrypis
Pakartotinis normalizuotos ekspresijos reikšmės mastelio keitimas atliekamas padalijus normalizuotos
ekspresijos standartinį nuokrypį iš jos reikšmės, atitinkančios aukščiausią arba žemiausią ekspresijos
lygį, priklausomai nuo pasirinktos mastelio keitimo parinkties. Normalizavimo koeficiento standartinio
nuokrypio (SD) formulė:

Kur:

n RQ = mėginio santykinis kiekis

n SD = standartinis nuokrypis

n NF = normalizavimo koeficientas

n Ref = etaloninis taikinys

n n = etaloninių taikinių skaičius

Priskyrus kontrolinį mėginį, nereikia atlikti standartinio nuokrypio pakartotinio mastelio keitimo, parodyto
šioje formulėje:

Kur:

n NE = normalizuota ekspresija

n RQ = mėginio santykinis kiekis

n SD = standartinis nuokrypis

n GOI = tikslinis genas (vienas taikinys)
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Normalizuota ekspresija, padidinta iki didžiausio ekspresijos lygio

Normalizuota ekspresija, padidinta iki didžiausio ekspresijos
lygio

Kai paleidžiant nėra kontrolių, pakeiskite normalizuotos ekspresijos (NE) mastelį kiekvienam taikiniui
(genui) padalydami kiekvieno mėginio ekspresijos lygį iš aukščiausio ekspresijos lygio visuose
mėginiuose. Programinė įranga nustato 1 vertės ekspresijos aukščiausią lygį ir pakeičia visų mėginių
ekspresijos lygių mastelį. Aukščiausio mastelio formulė yra

Kur:

n GOI = tikslinis genas (taikinys)

Normalizuota ekspresija, pakeista į mažiausią ekspresijos lygį
Kai paleidžiant nėra kontrolių, pakeiskite kiekvieno taikinio (geno) normalizuotos ekspresijos (NE) mastelį
padalydami kiekvieno mėginio ekspresijos lygį iš visų mėginių žemiausio ekspresijos lygio. Programinė
įranga nustato žemiausią ekspresijos lygį į 1 ir pakeičia visų mėginių ekspresijos lygių mastelį. Žemiausio
mastelio formulė

Kur:

n GOI = tikslinis genas (taikinys)

Normalizuota ekspresija, pakeista iki vidutinio ekspresijos
lygio

Kai paleidžiant nėra kontrolių, pakeiskite kiekvieno taikinio (geno) normalizuotos ekspresijos (NE) mastelį
padalydami kiekvieno mėginio ekspresijos lygį iš visų mėginių ekspresijos lygių geometrinio vidurkio.
Programinė įranga nustato vidutinį ekspresijos lygį į 1 ir pakeičia visų mėginių ekspresijos lygių mastelį.
Vidutinio mastelio formulė

Kur:

n GOI = tikslinis genas (taikinys)
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n GM = visų mėginių normalizuotos ekspresijos geometrinis vidurkis
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Patikslintos normalizuotos ekspresijos standartinis nuokrypis

Patikslintos normalizuotos ekspresijos standartinis nuokrypis
Pakartotinis patikslintos normalizuotos ekspresijos (NE) reikšmės tikslinimas atliekamas padalijus
normalizuotos ekspresijos standartinį nuokrypį (SD) iš normalizuotos ekspresijos reikšmės, atitinkančios
didžiausią (MAX) arba mažiausią (MIN) ekspresijos lygį, priklausomai nuo jūsų tikslinimo parinkties.

Pastaba. Kai kontrolinis mėginys priskiriamas, jums nereikia standartiniam nuokrypiui naudoti šios
pakartotinio tikslinimo funkcijos.

Apskaičiuojama pagal formulę

Kur:

n NE = normalizuota ekspresija

n SD = standartinis nuokrypis

n GOI = tikslinis genas (taikinys)

n MAX = aukščiausias ekspresijos lygis

n MIN = žemiausias ekspresijos lygis
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Standartinio nuokrypio (lg) ir vidurkio standartinės paklaidos
(lg) paklaidų juostos

Ne tik naudojami pasikliautinieji intervalai, bet ir biologinių grupių paklaidų juostos gali būti rodomos,
remiantis ekspresijos log2 standartiniu nuokrypiu ar vidurkio standartine paklaida. Paklaidų juostos
apskaičiuojamos taip:

RQ apatinė paklaidos juosta = 2RQ(lg)-SD RQ(lg) arba 2RQ(lg)-SEM RQ(lg)

RQ viršutinė paklaidos juosta = 2RQ(lg)+SD RQ(lg) arba 2RQ(lg)+SEM RQ(lg)

Kur:

n RQ(lg) = biologinės grupės santykinio kiekio log2

n SD RQ(lg) = santykinio kiekio standartinis nuokrypis (log2)

n SEM RQ(lg) = santykinio kiekio vidurkio standartinė paklaida (log2)

Eksp. apatinė paklaidos juosta = 2Exp.(lg)-SD Exp.(lg) arba 2Exp.(lg)-SEM Exp.(lg)

Eksp. viršutinė paklaidos juosta = 2Exp.(lg)+SD Exp.(lg) arba 2Exp.(lg)+SEM Exp.(lg)

Kur:

n Exp.(lg) = biologinės grupės ekspresijos (normalizuotos ekspresijos) log2

n SD RQ(lg) = ekspresijos standartinis nuokrypis (log2)

n SEM RQ(lg) = ekspresijos vidurkio standartinė paklaida (log2)
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Kartotinis keitimas

Kartotinis keitimas
Kartotinis keitimas yra priemonė padidinti ar sumažinti taikinio ekspresiją eksperimentiniame mėginyje,
palyginti su kontrole arba biologine grupe, ir nustatoma taip:

Jeigu ekspresija (eksperimentinė) > ekspresija (kontrolinė):

Jeigu ekspresija (eksperimentinė) < ekspresija (kontrolinė):

Pastaba. Grafikams Expression (ekspresija) pagrįsta arba santykiniu kiekiu, arba normalizuota
ekspresija, priklausomai nuo pasirinkto režimo (žr. Grafikai, p. 268). Tačiau taškinei diagramai ir
grupinei diagramai kartotinis keitimas visada apskaičiuojama iš normalizuotos ekspresijos.
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A priedas. Duomenų analizės skaičiavimai

Koreguotų verčių formulės
Svarbu. Šie skaičiavimai galioja tik kai „Analyze Using“ (analizuoti naudojant) nustatyta į „Samples
Only“ (tik mėginiai), „Sample Biological Group“ (mėginio biologinė grupė) arba „Biological Group
Samples“ (biologinės grupės mėginiai).

Skirtumas tarp koreguotų verčių ir nekoreguotų verčių matomas tik tada, jeigu sukurta standartinė kreivė
kaip realiojo laiko PGR paleidimo dalis. Paklaidos sklaidai nustatyti programinė įranga taiko tris lygtis:

n Standartinė paklaida

n Standartinė paklaida normalizuotai ekspresijai

n Tikslinio normalizuoto geno (taikinio) standartinė paklaida

Standartinės paklaidos formulė yra

Kur:

n n = etaloninių taikinių skaičius (genai)

n SD = standartinis nuokrypis

Normalizavimo koeficiento standartinė paklaida normalizuotos ekspresijos formulėje yra

Kur:

n n = etaloninių taikinių skaičius

n SE = standartinė paklaida

n NF = normalizavimo koeficientas

n RQ = santykinis kiekis

Tikslinio normalizuoto geno (GOI) standartinės paklaidos formulė yra

Kur:

n SE = standartinė paklaida

n GOI = tikslinis genas (vienas taikinys)
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Biologinės grupės analizės pasikliovimo intervalo skaičiavimas

n NF = normalizavimo koeficientas

n n = etaloninių taikinių skaičius

Biologinės grupės analizės pasikliovimo intervalo
skaičiavimas

Kai atliekama biologinės grupės analizė („Analyze Using“ (analizuoti naudojant) nustatytas į „Biological
Groups Only“ (tik biologinės grupės)), pasikliovimo intervalai apskaičiuoti santykiniam kiekiui ir santykinei
normalizuotai ekspresijai.

Pasikliovimo intervalai apskaičiuoti logaritminėje skalėje, remiantis t pasiskirstymu taikant šią formulę:

Kur:

n = mėginių biologinėje grupėje logaritminės skalės lygių vidutinė ekspresija

n SD = mėginių biologinėje grupėje logaritminės skalės lygių standartinis nuokrypis

n n = mėginių biologinėje grupėje skaičius

n t = gaunamas iš t paskirstymo pagal laisvės laipsnius ir alfa lygį

Pastaba. Alfa lygį galima nustatyti grafikų kortelės P vertės ribinės reikšmės laukelyje.

Apskaičiavus pasikliovimo lygius, jie konvertuojami į tiesinę skalę, pateikiami „Gene Expression“ (geno
ekspresija) duomenų lentelėje ir stulpelinėje diagramoje grafikų kortelėje.

Stačiakampės ir linijinės diagramos skaičiavimai
Stačiakampėje ir linijinėje diagramoje parodomas ekspresijos reikšmių pasiskirstymas biologinėje
grupėje, pateikiant duomenis kaip kvartilius. 1-asis ir 3-iasis kvartiliai rodomi atitinkamai kaip žemutinė ir
viršutinė lango ribos. Mediana rodoma kaip ištisinė linija, einanti skersai stačiakampio. Linijos rodo
minimalias ir maksimalias duomenų rinkinio neišskirtines reikšmes. Išskirtinės reikšmės – tai reikšmės,
kurios 1,5 karto viršija 1-ojo ir 3-iojo kvartilių vidinį intervalą.

Pastaba. Jei biologinėje grupėje yra tik vienas mėginys, jis rodomas kaip vienas apskritimas,
nurodantis vieną duomenų tašką.

Toliau parodytoje stačiakampėje ir linijinėje diagramoje matyti, kaip šie duomenys yra pateikiami.
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A priedas. Duomenų analizės skaičiavimai

1. Išskirtis. Šios išskirties reikšmė yra > Q3 + (1,5 x [Q3 – Q1]).

Pastaba. Nustatykite žymeklį virš apskritimo, jei norite peržiūrėti paaiškinimą, kuriame,
priklausomai nuo pasirinkto režimo, rodomas mėginio pavadinimas ir santykinis kiekis
arba normalizuotos ekspresijos informacija.

2. Maksimali neišskirtinės reikšmės riba

3. Viršutinis / 3-iasis kvartilis (Q3). 75 % ekspresijos reikšmės yra mažesnės nei Q3.

4. Apibrėžtos eilės tvarka nustatytų ekspresijos reikšmių mediana arba vidutinė reikšmė

5. Apatinis / 1-asis kvartilis (Q1). 25 % ekspresijos reikšmės yra mažesnės nei Q1.

6. Minimali neišskirtinės reikšmės riba

7. Išskirtis. Šios išskirties reikšmė yra < Q1 – (1,5 x [Q3 – Q1]).

LEGENDA
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B priedas. Audito sekos
Programinės įrangos „CFX Maestro Dx“, „Security Edition“ sukuria duomenų ir genų tyrimų failų
(atitinkamai .prcd ir .mgxd failų) audito sekas. Visi saugių duomenų ir genų tyrimo bylų pakeitimai ar atlikti
veiksmai fiksuojami failo audito sekoje, kai audito failas įrašomas. „CFX Maestro Dx SE“ sukuria atskirą
kiekvieno failo audito seką.

Galite pasirinkti „File > Save As“ (failas > įrašyti kaip) ir saugius pasirašytus ar nepasirašytus duomenis ir
genų tyrimo failus įrašyti kitame aplanke arba kitu vardu. Naujas failas paveldi audito seką iš pradinio
failo. Naujojo failo audito seka taip pat apima veiklą „Įrašyti kaip“. Naujojo failo pakeitimai ar atlikti
veiksmai užfiksuojami jos paties audito sekoje. Originaliame faile išlieka jo audito seka, kurioje fiksuojama
paskesnė veikla.

Audituojami įvykiai, p. 311 išvardyti audituojami įvykiai, kuriuos užfiksuoja programinė įranga.

Audito sekų peržiūra
Kiekvienoje audito sekoje rodoma ši informacija:

n Išsami audito antraštės informacija

o „File version“ (failo versija) – įrašyta failo versija

o „Date“ (data) – dabartinio audituojamo įvykio data

o „User“ (naudotojas) – prisijungusio naudotojo „Windows“ domenas ir naudotojo vardas

o „Comment“ (komentaras) – paskutinis įrašytas komentaras

o „Signature“ (parašas) – paskutinio failą pasirašiusio asmens elektroninis parašas

o „Signature reason“ (parašo priežastis) – parašo priežastis

o „Application“ (programa) – „CFX Maestro Dx SE“

o „Application version“ (programos versija) – dabartinė „CFX Maestro Dx SE“ versija

o „Full user“ (naudotojo vardas ir pavardė) – prisijungusio naudotojo vardas ir pavardė

o „Machine“ (įrenginys) – kompiuteris, kuriame įdiegta „CFX Maestro Dx SE“

n Išsami audito pakeitimo informacija

o „Object“ (objektas) – pakeistas elementas (audituojamas elementas)
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B priedas. Audito sekos

o „Old value“ (senoji vertė) – ankstesnė vertė

o „New value“ (naujoji vertė) – nauja vertė

o „Description“ (aprašas) – pakeitimo aprašas

Norėdami peržiūrėti audito seką

u Atidarytame duomenų ar genų tyrimo faile pasirinkite „View > Audit Trail“ (rodinys > audito seka).
Pasirodo failo audito seka.

Pagal numatytąsias nuostatas duomenys yra rikiuojami pagal datą ir laiką, o visi įvykiai rodomi
išplėstiniame rodinyje. Galite filtruoti rodinį pagal naudotojo vardą ir objektą, sutraukti išplėstinį rodinį,
kad galėtumėte lengvai rikiuoti pagal bet kurį antraštės lauką. Taip pat galite peržiūrėti audito seką
kaip HTML ataskaitą.

Norėdami rikiuoti pagal naudotojo vardą

u Išplečiamajame sąraše „User Name“ (naudotojo vardas) pasirinkite tikslinį naudotoją.

Norėdami rūšiuoti pagal objektą

u Išskleidžiamajame sąraše „Object“ (objektas) pasirinkite tikslą.

Norėdami paslėpti visą įvykių aprašymą

u Spustelėkite „Collapse All“ (sutraukti viską).

Norėdami rūšiuoti duomenis išsamios pakeitimų informacijos lentelėje

u Spustelėkite rombo simbolį duomenų stulpelio antraštėje, kad surūšiuotumėte didėjimo tvarka (nuo A
iki Z, nuo mažiausio iki didžiausio skaičiaus arba nuo seniausio iki naujausio).
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Audituojami įvykiai

Norėdami išspausdinti audito seką

1. Spustelėkite „HTML Report“ (HTML ataskaita), kad audito seka būtų rodoma žiniatinklio naršyklėje.

2. Naršyklės lange atlikite vieną iš šių veiksmų:

n Pasirinkite „File > Print“ (failas > spausdinti).

n Dešiniuoju pelės mygtuku spustelėkite ataskaitą ir pasirinkite „Print“ (spausdinti).

Audituojami įvykiai
„CFX Maestro Dx SE“ užfiksuoja šiuos audituojamus įvykius duomenų ir genų tyrimo failuose.

Audituojami įvykiai paleidžiant

n Paleidimo pradžios laikas

n Paleidimo laiko plokštelės redagavimas

n Paleidimo laiko protokolo redagavimas

n Paleidimo pabaigos laikas

Audituojami įvykiai, kai sukuriamas duomenų failas

n Duomenų failas sukurtas

n Sistemos pridėti interpoliuotos plokštelės nuskaitymai

Audituojami įvykiai, kai įrašomas duomenų failas

n Bendra

o Pavadinimas

o Pasirašymas

o Plokštelės sąranka

o Rodyti šulinėlius

o Analizuoti fluoroforai

o Plokštelės redagavimas

o Analizės režimas

o PGR aktyvių šulinėlių grupė
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B priedas. Audito sekos

n Kiekybinio įvertinimo kortelė

o Aktyvus žingsnis

o Nuostatos – Cq nustatymo režimas

o Nuostatos – pradinis nustatymas

o Taikyta dreifo korekcija

o Nuostatos – analizuotini ciklai

o Nuostatos – analizės režimas

o Nuostatos – pagrindinė ribinė reikšmė

n Lydymosi kreivės kortelė

o Aktyvus žingsnis

o Rodomas smailės tipas

o Smailės analizės ribinė reikšmė

n Pabaigos taško kortelė

o Aktyvus fluoroforas / taikinys

o Vidurkio skaičiavimo pabaigos ciklai

o Leistinojo nuokrypio skaičiavimo metodas

o Diapazono procentas

n Alelių diskriminacijos kortelė

o X ir Y ašių fluoroforas

o Pasirinkti ciklų skaičių

o Peržiūrėti paskyrimų schemą

n Geno ekspresijos kortelė – visos diagramos

o Eksperimento nuostatos – tikslinė nuoroda

o Eksperimento nuostatos – mėginio valdymas

o Eksperimento nuostatos – automatinis efektyvumas

o Eksperimento nuostatos – efektyvumas
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Audituojami įvykiai

n Geno ekspresijos kortelė – diagramų sudarymas

o Analizės režimas

o Diagramos duomenys

o X ašis

o Y ašis

o Mastelio parinktis

o Paklaidų juosta

o Paklaidų juostos daugiklis

o P ribinė reikšmė

n Geno ekspresijos kortelė – grupinė diagrama

o Grupė

o Padalyti kopijas

n Geno ekspresijos kortelė – taškinė diagrama

o Kontrolės biologinė grupė

o Eksperimentinė biologinė grupė

o Kartotinio keitimo ribinė reikšmė

n Geno ekspresijos kortelė – ANOVA

o P ribinė reikšmė

n Plokštelės sąranka – peržiūrėti / redaguoti plokštelę

o Nuostatos – plokštelės tipas

o Nuostatos – vienetai

o Redagavimo įrankiai – plokštelės apvertimas

o Šulinėlių grupės

o Plokštelės fluoroforai

n Plokštelės sąranka – pakeisti plokštelę ir pritaikyti „PrimePCR“ failą

o Plokštelių sąrankos importavimas
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B priedas. Audito sekos

Genų tyrimo failų audito pakeitimai

Bendra

n „Name“ (pavadinimas)

n Tyrimo sąrankos kortelė

o Pridėti / pašalinti duomenų failus

n Tyrimo analizės kortelė
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C priedas. LIMS integravimas
Galite sukonfigūruoti programinės įrangos „CFX Maestro Dx“, „Security Edition“ naudoti su laboratorijos
informacijos valdymo sistema (LIMS). Tam, kad būtų galima integruoti LIMS, „CFX Maestro Dx SE“
reikalauja, kad būtų LIMS platformos generuota plokštelės sąrankos informacija (LIMS failas, *.plrn),
protokolo failas, sukurtas naudojant „CFX Maestro Dx SE“ (*.prcl), apibrėžta duomenų eksportavimo vieta
ir eksportavimo formatas.

Baigus vykdymą, „CFX Maestro Dx SE“ sugeneruoja duomenų (.pcrd) failą ir įrašo jį nurodytoje duomenų
eksportavimo aplanko vietoje. „CFX Maestro Dx SE“ taip pat gali sukurti su LIMS suderinamą duomenų
failą .csv formatu ir įrašyti jį toje pačioje vietoje.

Su LIMS suderinamų duomenų failų kūrimas
Šiame priede paaiškinama, kaip nustatyti „CFX Maestro Dx SE“, kad būtų galima kurti, įrašyti ir
eksportuoti su LIMS suderinamus duomenų failus.

LIMS aplankų ir duomenų eksporto parinkčių nustatymas
Pagal numatytąsias nuostatas „CFX Maestro Dx SE“ įrašo LIMS protokolus, failus ir duomenų
eksportavimo failus į šį aplanką:
C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Galite sukonfigūruoti „CFX Maestro Dx SE“ įrašyti failus kitame aplanke ir galite pakeisti LIMS duomenų
eksportavimo parinktis.

Kaip nustatyti LIMS aplanko ir duomenų eksporto parinktis

1. Lange „Home“ (pagrindinis) pasirinkite „Tools > Options“ (įrankiai > parinktys).

2. Dialogo lange „Options“ (parinktys) pasirinkite „Data Export Settings“ (duomenų eksportavimo
nuostatos).
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C priedas. LIMS integravimas

3. (Neprivaloma) Pasirinkite „Automatically export LIMS data at end of run“ (automatiškai eksportuoti
LIMS duomenis paleidimo pabaigoje).

Programinė įranga automatiškai eksportuos LIMS duomenis po kiekvieno paleidimo ir juos įrašys
nurodytoje vietoje.

4. Norėdami pakeisti numatytąsias LIMS duomenų eksporto parinktis, spustelėkite „LIMS Data Export
Settings“ (LIMS duomenų eksporto nuostatos).

Svarbu. Atgal į „CFX Maestro Dx SE“ galima importuoti tik LIMS duomenis, eksportuotus kaip
.csv failas.

5. Dialogo lange „LIMS Data Export Format Settings“ (LIMS duomenų eksporto formato nuostatos)
pasirinkite reikiamas eksporto parinktis ir spustelėkite OK (gerai).

6. Dialogo lange „Options“ (parinktys) raskite ir pasirinkite numatytąjį aplanką, kuriame norite įrašyti
LIMS duomenų failus. Kiekvienam failų tipui galite pasirinkti skirtingą vietą:

n Protokolas

n LIMS failas

n Duomenų eksportas
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Su LIMS suderinamų duomenų failų kūrimas

7. Spustelėkite OK (gerai), įrašykite pakeitimus ir uždarykite dialogo langą „Options“ (parinktys).

LIMS protokolo kūrimas
Tam, kad galėtumėte paleisti LIMS, sukurkite „CFX Maestro Dx SE“ protokolo failą (*.prcl) ir įrašykite jį
numatytoje vietoje LIMS protokolo aplanke.

Daugiau informacijos žr. 7 skyrius, Protokolų kūrimas.

LIMS failo kūrimas
LIMS faile (*.plrn) yra išsami informacija apie plokštelės sąranką ir protokolo failo pavadinimas. Šį failą
sugeneravo jūsų vidinė LIMS. „CFX Maestro Dx SE“ naudojamas LIMS failas ir jo pagrindu kuriamas
plokštelės failas, skirtas naudoti su protokolo failu.

„CFX Maestro Dx SE“ pateikiami šabloniniai failai plokštelėms importuoti, kuriuos galite redaguoti, kad
būtų sukurti specialūs LIMS plokštės failai.

Patarimas. Šią užduotį atlieka LIMS specialistas.

Kaip sukurti LIMS failą

1. Lange „Home“ (pagrindinis) pasirinkite „View > Show > LIMS File Folder“ (peržiūrėti > rodyti > LIMS
failo aplankas).

2. Atidarykite aplanką „LIMS Templates“ (LIMS šablonai) ir pasirinkite .csv failą, kurį norite importuoti į
vidaus LIMS sistemą.

3. Redaguokite šablono failą įvesdami reikalaujamus laukelius, nurodytus čia: 38 lent.

4. Atlikite vieną iš toliau nurodytų veiksmų:

n Jei norite įrašyti pakeitimus ateityje, įrašykite failą .csv formatu.

n Norėdami įrašyti pakeitimus ir nedelsdami naudoti failą, įrašykite failą su plėtiniu .plrn.

n Įrašykite šabloną su failo pavadinimo plėtiniu .plrn LIMS failo aplanke.

Svarbu. „CFX Maestro Dx SE“ gali atidaryti tik .plrn failą. Norėdami paleisti LIMS, turite įrašyti
.csv failą kaip .plrn.
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C priedas. LIMS integravimas

Stulpelis Eilutė Aprašymas Turinys Taikinys

A 1 Plokštelės
antraštė

Neredaguoti Iš anksto
nustatytas

A, B, C 2 Laukelis /
duomenys /
nurodymas

Neredaguoti Iš anksto
nustatytas

B 3 Versija Neredaguoti Iš anksto
nustatytas

B 4 Plokštelės dydis Neredaguoti Iš anksto
nustatytas

B 5 Plokštelės tipas Įveskite „BR White“, „BR
Clear“ arba kitą
sukalibruotos plokštelės tipą

Privaloma

B 6 Nuskaitymo
režimas

Įveskite „SYBR/FAM Only:“ 
(tik SYBR/FAM:), „All
Channels“ (visi kanalai) arba
FRET

Privaloma

B 7 Matavimo
vienetai

Įveskite: „copy number“ 
(kopijos numeris), „fold
dilution“ (skiedimo
kartotinis), „micromoles“ 
(mikromoliai), „nanomoles“ 
(nanomoliai), „picomoles“ 
(pikomoliai), „femtomoles“ 
(femtomoliai), „attomoles“ 
(atomoliai), „milligrams“ 
(miligramai), „micrograms“ 
(mikrogramai), „nanograms“ 
(nanogramai), „picograms“ 
(pikogramai), „femtograms“ 
(femtogramai), „attograms”
(atogramai) arba „percent“ 
(procentai)

Privaloma

38 lent. LIMS .csv failo turinio apibrėžimas
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Su LIMS suderinamų duomenų failų kūrimas

Stulpelis Eilutė Aprašymas Turinys Taikinys

B 8 Paleidimo ID Įveskite trumpą aprašymą
arba brūkšninį kodą šiam
paleidimui identifikuoti
(daugiausia 30 ženklų;
neleidžiama naudoti
kablelių)

Neprivaloma

B 9 Paleidimo
pastabos

Įveskite paleidimo aprašymą Neprivaloma

B 10 Paleidimo
protokolas

Įveskite protokolo failo
pavadinimą tiksliai taip, kaip
nurodyta sąraše

Privaloma

A 11 Duomenų failas Įveskite duomenų failo
pavadinimą

Neprivaloma

A 12–15 Bus nuspręsta /
tuščia

Neredaguoti Iš anksto
nustatytas

A 16 Plokštelės
duomenys

Neredaguoti Iš anksto
nustatytas

A 17–113 Šulinėlio padėtis Neredaguoti Iš anksto
nustatytas

B–G Ch1 dažai, Ch2
dažai, Ch3 dažai,
Ch4 dažai, Ch5
dažai, FRET

Įveskite kiekvieno
naudojamo kanalo vieną
sukalibruotų dažų
pavadinimą (pavyzdžiui,
FAM)

Privaloma

38 lent. LIMS .csv failo turinio apibrėžimas (tęsinys)
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Stulpelis Eilutė Aprašymas Turinys Taikinys

H Mėginio tipas Įveskite vieną iš šių mėginių
tipų: „Unknown“ 
(nežinomas), „Standard“ 
(standartinis), „Positive
Control“ (teigiama kontrolė),
„Negative Control“ 
(neigiama kontrolė), NTC
(jokios šablono kontrolės)
arba NRT (jokios atvirkštinės
transkripcijos)

Privaloma

I Mėginio
pavadinimas

Įveskite mėginio pavadinimą Neprivaloma

J–O CH1 taikinys,
CH2 taikinys,
CH3 taikinys,
CH4 taikinys,
CH5 taikinys,
FRET taikinys

Įveskite kiekvieno naudoto
kanalo taikinio pavadinimą

Neprivaloma

P Rinkinio
pavadinimas

Įveskite biologinio rinkinio
pavadinimą

Neprivaloma

Q Kartotinis Įveskite kiekvieno kartotinių
rinkinio teigiamą sveikąjį
skaičių. Reikšmė negali būti
nulis.

Neprivaloma

R–W CH1 kiekis, CH2
kiekis, CH3
kiekis, CH4
kiekis, CH5
kiekis, FRET
kiekis

Įveskite bet kurių standartų
kiekių vertes. Įveskite
koncentraciją dešimtaine
forma.

Privaloma
visiems
standartams

38 lent. LIMS .csv failo turinio apibrėžimas (tęsinys)
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Su LIMS suderinamų duomenų failų kūrimas

Stulpelis Eilutė Aprašymas Turinys Taikinys

X Šulinėlio pastaba Įveskite šulinėlio pastabą
(daugiausia 20 ženklų)

Pastaba. Nors
„CFX Maestro Dx SE“
įvedant pastabą „Well
Note“ per programinę
įrangą taikomas 20
simbolių apribojimas,
„Well Note“ laukelyje
gali būti iki 500
simbolių, jei jie yra
importuotame .plrn
faile. Tačiau
„CFX Maestro Dx SE“
bus rodomi tik pirmieji
20 simbolių.
Eksportuotame .pcrd
faile bus visi „Well Note“ 
laukelio simboliai,
duomenys nebus
prarasti.

Neprivaloma

Y–AD Ch1 šulinėlio
spalva, Ch2
šulinėlio spalva,
Ch3 šulinėlio
spalva, Ch4
šulinėlio spalva,
Ch5 šulinėlio
spalva, FRET
šulinėlio spalva

Įveskite naudotojo nustatytą
pėdsako stiliaus spalvą 32
bitų sveikojo skaičiaus
(ARGB) dešimtaine forma

Neprivaloma

38 lent. LIMS .csv failo turinio apibrėžimas (tęsinys)

LIMS paleidimo pradžia
Kaip pradėti LIMS paleidimą

1. Atlikite šiuos veiksmus, kad atidarytumėte LIMS .plrn failą:

n Lange „Home“ (pagrindinis) pasirinkite „View > Show > LIMS File Folder“ (rodinys > rodyti >
LIMS failo aplankas) ir atidarykite tikslinį .plrn failą.
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n Lange „Home“ (pagrindinis) pasirinkite „File > Open > LIMS File“ (failas > atidaryti > LIMS failas)
ir atidarykite tikslinį .plrn failą.

Failas atidaromas kortelėje „Start Run“ (paleidimo pradžia), esančioje „Run Setup“ (paleidimo
sąranka) vedlyje. Kortelėje „Start Run“ (paleidimo pradžia) rodoma informacija apie norimą vykdyti
eksperimentą. Joje taip pat rodomas prijungtas prietaisų blokas arba blokai, kuriuose galite paleisti
eksperimentą.

2. Kortelėje „Start Run“ (paleidimo pradžia) pasirinkite prietaisą ir spustelėkite „Start Run“ (paleidimo
pradžia).

Duomenų eksportavimas į LIMS
Baigus paleidimą „CFX Maestro Dx SE“ generuoja duomenų (.pcrd) failą ir įrašo jį į nurodytą duomenų
eksporto aplanko vietą.

Duomenų failo eksportavimas į LIMS

u Atidarykite .pcrd failą ir pasirinkite „Export > Export to LIMS Folder“ (eksportuoti > eksportuoti į LIMS
aplanką).

Patarimas. Jeigu „LIMS Options“ (LIMS parinktys) pasirenkate „Automatically Export Data after Run“ 
(automatiškai eksportuoti duomenis po paleidimo), „CFX Maestro Dx SE“ sukuria su LIMS
suderinamą duomenų failą .csv formatu ir jį įrašo tame pačiame aplanke.
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D priedas. Trikčių šalinimas programinės įrangos
„CFX Maestro Dx“, „Security Edition“

Šiame priede pateikiami pasiūlymai, kaip šalinti triktis, su kuriomis galite susidurti naujindami versiją arba
naudodami programinės įrangos „CFX Maestro Dx“, „Security Edition“.

Programinės įrangos „CFX Maestro Dx“, „Security Edition“
failų ir aplankų baltasis sąrašas

Siekiant apsisaugoti nuo virusų ir kenkėjiškų programų, jūsų IT skyrius galėjo įdiegti labai griežtas
programinės įrangos saugos priemones. Šios priemonės gali turėti įtakos „CFX Maestro Dx SE“ versijos
naujinimo ar paleidimo laikui.

Siekiant padidinti „CFX Maestro Dx SE“ našumą, „Bio-Rad“ rekomenduoja, kad jūsų IT skyrius įtrauktų
šiuos failus ir aplankus į „CFX Maestro Dx SE“ kompiuteryje įdiegtos antivirusinės programinės įrangos
užkardos parametrų baltąjį sąrašą:

Aplankai

n C:\Program Files (x86)\Bio-Rad\CFX_MDx

n C:\ProgramData\Bio-Rad\CFX_MDx

n C:\Users\Public\Documents\Bio-Rad\CFX_MDx

Failai

n Visi .exe failai, esantys aplanke C:\Program Files (x86)\Bio-Rad\CFX_MDx

n „R.exe“ ir „Rscript.exe“ (aplanke C:\Program Files (x86)\Bio-Rad\CFX_MDx\ R\
R-3.3.1\bin)
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Programos žurnalas
Prieš pradėdama naują paleidimą, „CFX Opus Dx“ sistema pradeda savidiagnostikos testą, kad
patikrintų, ar veikia pagal specifikacijas. Programinė įranga įrašo šių testų rezultatus „Run Log“ (paleidimo
žurnalas) ir „Application Log“ (programos žurnalas) failuose. Jei vieno ar kelių eksperimentų metu
pastebėtumėte problemą, atidarykite paleidimo ir programos žurnalus, kad sužinotumėte, kuriuo
momentu prasidėjo problema.

„CFX Maestro Dx SE“ „Dx“ stebi prietaiso būsenos informaciją žurnale „Application Log“ (programos
žurnalas). Naudokitės šiais žurnalais, kad stebėtumėte įvykius, susijusius su prietaisais ir programine
įranga, ir pašalintumėte triktis.

Kaip atidaryti programos žurnalą

u Lange „Home“ (pagrindinis) pasirinkite „View > Application Log“ (peržiūrėti > programos žurnalas).

Jei norite peržiūrėti programos žurnalą kaip HTML failą, spustelėkite mygtuką „HTML Report“ (HTML
ataskaita).
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Trikčių šalinimas

Programų ir programinės aparatinės įrangos žurnalo failų gavimas
Programų ir programinės aparatinės įrangos žurnaluose pateikiama informacija apie veiksmus, atliktus
naudojant programinę įrangą ir atliekant paleidimus. Šiuose žurnaluose taip pat registruojamos visos
programinės įrangos ar programinės aparatinės įrangos klaidos, atsiradusios programinės įrangos ar
veikiant prietaisui.

Prieiga prie programų ir programinės aparatinės įrangos žurnalo failų:

1. Lange „Detected Instruments“ (aptikti prietaisai) dešiniuoju pelės klavišu spustelėkite prietaisą.

2. Pasirinkite „Retrieve Log Files“ (atsisiųsti žurnalo failus).

3. Dialogo lange „Browse for Folder“ (ieškoti aplanko) pasirinkite paskirties aplanką tinkle arba
vietiniame diske, į kurį norite įrašyti žurnalo failus.

Pastaba. Aplankas pavadintas „Logs“ (žurnalo failai).

4. Spustelėkite mygtuką OK (gerai), kad įrašytumėte failus.

Svarbu. Įrašydami žurnalo failą tokiu pačiu pavadinimu kaip esamas žurnalo failas, perrašysite
esamą žurnalo failą.

Trikčių šalinimas
Paprastai programinės įrangos ir prietaisų ryšio problemas galima išspręsti iš naujo paleidus kompiuterį ir
sistemą. Prieš paleisdami kompiuterį iš naujo, būtinai įrašykite visus vykdomus darbus.

Pastaba. Patikrinkite, ar kompiuteryje yra pakankamai RAM atminties ir laisvos vietos diske. Turi būti
ne mažiau nei 4 GB RAM atminties ir 128 GB vietos standžiajame diske.

Nutrūkęs maitinimas
Nutrūkus maitinimui prietaisas ir kompiuteris išsijungs. Jeigu maitinimas nutrūksta trumpam, prietaisas
atnaujins protokolo paleidimą, tačiau programos žurnale bus pažymėta, kad maitinimas nutrūko.
Priklausomai nuo kompiuterio nuostatų ir maitinimo nutrūkimo trukmės, prietaisas ir programinė įranga
mėgins tęsti paleidimą, priklausomai nuo protokolo veiksmo:

n Jeigu atliekamas protokolo veiksmas be plokštelės nuskaitymo, protokolas tęsiamas, kai tik
atnaujinamas prietaiso maitinimas.

n Jeigu atliekamas protokolo veiksmas su plokštelės nuskaitymu, prietaisas laukia, kol programinė
įranga bus paleista iš naujo ir atnaujins ryšį duomenims gauti. Tokiu atveju protokolas tęsiamas tik
tada, jeigu kompiuteris programinės įrangos neišjungė. Kai kompiuteris ir programinė įranga vėl
paleidžiami, protokolas tęsiamas.
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Failų perkėlimas į „CFX Maestro Dx SE“ kompiuterį
Galite perkelti prietaise esančius duomenis ir žurnalo failus ir į prijungto „CFX Maestro Dx SE“ kompiuterio
standųjį diską.

Patarimas. Visi failai realiojo laiko duomenų aplanke prietaiso pagrindiniame bloke yra perkeliami į
kompiuterį.

Pastaba. Iš „CFX Opus Dx“ prietaisų galite perkelti tik žurnalo failus. Visi prietaiso žurnalo failai
perkeliami į kompiuterį.

Kaip parsisiųsti failus iš prietaiso

1. Skyriuje „Detected Instruments“ (aptikti prietaisai), esančiame lange „Home“ (pagrindinis), dešiniuoju
pelės mygtuku spustelėkite tikslinį prietaisą ir pasirinkite „Retrieve Log Files“ (nuskaityti žurnalo
failus).

2. Pasirinkite aplanko vietą ir įrašykite parsisiųstus failus.

3. Spustelėkite „OK“ (gerai).

Programinės įrangos „CFX Maestro Dx“, „Security Edition“
diegimas rankiniu būdu
„CFX Maestro Dx SE“ įdiegimas rankiniu būdu

1. Jei reikia, atjunkite nuo kompiuterio visus prijungtus prietaisus.

Raskite ir atjunkite nuo „CFX Maestro Dx SE“ kompiuterio prietaiso USB kabelį. Prie prietaiso
prijungtas kabelio galas gali likti neatjungtas.

2. Prisijunkite prie „CFX Maestro Dx SE“ kompiuterio administratoriaus teisėmis.

3. Į kompiuterio USB prievadą įstatykite „CFX Maestro Dx SE“ USB atmintinę.

4. Naudodamiesi naršykle „Windows Explorer“, pasiekite ir atidarykite „CFX Maestro Dx SE“ USB
atmintinę.

5. Atidarykite CFX aplanką ir dukart spustelėkite CFXMaestroDxSetup.exe, kad įdiegtumėte
„CFX Maestro Dx SE“.

6. Vadovaukitės ekrane pateikiamais nurodymais, kad įdiegtumėte programinę įrangą.

Baigus kompiuterio ekrane pasirodys „Bio-Rad“ programinės įrangos „CFX Maestro Dx“, „Security
Edition“ programos krovimosi ekranas, o darbalaukyje atsiras „Bio-Rad“ programinės įrangos „CFX
Maestro Dx“, „Security Edition“ piktograma.

7. Saugiai išimkite programinės įrangos USB atmintinę ir paleiskite „CFX Maestro Dx SE“.
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Tvarkyklių įdiegimas iš naujo
Kaip naujo įdiegti prietaiso tvarkykles

u Lange „Home“ (pagrindinis) pasirinkite „Tools > Reinstall Instrument Drivers“ (įrankiai > iš naujo
įdiegti prietaisų tvarkykles).

Pastaba. Jei iš naujo įdiegus tvarkykles kyla programinės įrangos ryšio su realiojo laiko sistema
problemų, kreipkitės (prieš tai patikrinę USB jungtį) į „Bio-Rad“ techninės pagalbos.
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E priedas. „Bio-Rad“ Free and Open-Source
Notices for PCR Products

This document includes licensing information relating to free, open-source, and public-source software
and data (together, the “MATERIALS”) included with or used to develop Bio-Rad products and services.
The terms of the applicable free, open-source, and public-source licenses (each an “OPEN LICENSE”)
govern Bio-Rad’s distribution and your use of the MATERIALS. Bio-Rad and the third-party authors,
licensors, and distributors of the MATERIALS disclaim all warranties and liability arising from all use and
distribution of the MATERIALS. To the extent the OSS is provided under an agreement with Bio-Rad that
differs from the applicable OSS LICENSE, those terms are offered by Bio-Rad alone.

Bio-Rad has reproduced below copyright and other licensing notices appearing within the MATERIALS.
While Bio- Rad seeks to provide complete and accurate copyright and licensing information for all
MATERIALS, Bio-Rad does not represent or warrant that the following information is complete, correct, or
error-free. MATERIALS recipients are encouraged to (a) investigate the identified MATERIALS to confirm
the accuracy of the licensing information provided and (b) notify Bio-Rad of any inaccuracies or errors
found in this document so that Bio-Rad may update this document accordingly.

Certain OPEN LICENSES (such as the Affero General Public Licenses, Common Development and
Distribution Licenses, Common Public License, Creative Commons Share-Alike License, Eclipse Public
License, Mozilla Public Licenses, GNU General Public Licenses, GNU Library/Lesser General Public
Licenses, and Open Data Commons Open Database License) require that the source materials be made
available to recipients or other requestors under the terms of the same OPEN LICENSE.

The corresponding open source software is available for download from the links in the section that
follows.

Naudotojo vadovas | 329



E priedas. „Bio-Rad“ Free and Open-Source Notices for PCR Products

Software Notices

ZedGraph
Project homepage/download site:

https://sourceforge.net/projects/zedgraph/

„Bio-Rad“ source code site:

https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1

External source code site:

https://github.com/ZedGraph/ZedGraph

Project licensing notices:

/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

/sources/ZedGraph/LICENSE-LGPL.txt:

See LGPL-2.1 in the Standard OSS License Text appendix to this document.

Standard Open License Text

LGPL-2.1
GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc. 59 Temple
Place, Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to
copy and distribute verbatim copies of this license document, but
changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts
as the successor of the GNU Library Public License, version 2, hence
the version number 2.1.]

330 | Programinė įranga „CFX Maestro Dx SE“

https://sourceforge.net/projects/zedgraph/
https://github.com/bio-rad-lsg-open-source/ZedGraph-5.0.1
https://github.com/ZedGraph/ZedGraph


Standard Open License Text

Preamble

The licenses for most software are designed to take away your freedom
to share and change it. By contrast, the GNU General Public Licenses
are intended to guarantee your freedom to share and change free
software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some
specially designated software packages--typically libraries--of the
Free Software Foundation and other authors who decide to use it. You
can use it too, but we suggest you first think carefully about
whether this license or the ordinary General Public License is the
better strategy to use in any particular case, based on the
explanations below.

When we speak of free software, we are referring to freedom of use,
not price. Our General Public Licenses are designed to make sure that
you have the freedom to distribute copies of free software (and
charge for this service if you wish); that you receive source code or
can get it if you want it; that you can change the software and use
pieces of it in new free programs; and that you are informed that you
can do these things.

To protect your rights, we need to make restrictions that forbid
distributors to deny you these rights or to ask you to surrender
these rights. These restrictions translate to certain
responsibilities for you if you distribute copies of the library or
if you modify it.

For example, if you distribute copies of the library, whether gratis
or for a fee, you must give the recipients all the rights that we
gave you. You must make sure that they, too, receive or can get the
source code. If you link other code with the library, you must
provide complete object files to the recipients, so that they can
relink them with the library after making changes to the library and
recompiling it. And you must show them these terms so they know their
rights.

We protect your rights with a two-step method: (1) we copyright the
library, and (2) we offer you this license, which gives you legal
permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that there
is no warranty for the free library. Also, if the library is modified
by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's
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reputation will not be affected by problems that might be introduced
by others.

Finally, software patents pose a constant threat to the existence of
any free program. We wish to make sure that a company cannot
effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that
any patent license obtained for a version of the library must be
consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the
ordinary GNU General Public License. This license, the GNU Lesser
General Public License, applies to certain designated libraries, and
is quite different from the ordinary General Public License. We use
this license for certain libraries in order to permit linking those
libraries into non-free programs.

When a program is linked with a library, whether statically or using
a shared library, the combination of the two is legally speaking a
combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the
entire combination fits its criteria of freedom. The Lesser General
Public License permits more lax criteria for linking other code with
the library.

We call this license the "Lesser" General Public License because it
does Less to protect the user's freedom than the ordinary General
Public License. It also provides other free software developers Less
of an advantage over competing non-free programs. These disadvantages
are the reason we use the ordinary General Public License for many
libraries. However, the Lesser license provides advantages in certain
special circumstances.

For example, on rare occasions, there may be a special need to
encourage the widest possible use of a certain library, so that it
becomes a de-facto standard. To achieve this, non-free programs must
be allowed to use the library. A more frequent case is that a free
library does the same job as widely used non-free libraries. In this
case, there is little to gain by limiting the free library to free
software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free
programs enables a greater number of people to use a large body of
free software. For example, permission to use the GNU C Library in
non-free programs enables many more people to use the whole GNU
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operating system, as well as its variant, the GNU/Linux operating
system.

Although the Lesser General Public License is Less protective of the
users' freedom, it does ensure that the user of a program that is
linked with the Library has the freedom and the wherewithal to run
that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and
modification follow. Pay close attention to the difference between a
"work based on the library" and a "work that uses the library". The
former contains code derived from the library, whereas the latter
must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License Agreement applies to any software library or other
program which contains a notice placed by the copyright holder or
other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License").
Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data
prepared so as to be conveniently linked with application programs
(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work
which has been distributed under these terms. A "work based on the
Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a
portion of it, either verbatim or with modifications and/or
translated straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
"modification".)

"Source code" for a work means the preferred form of the work for
making modifications to it. For a library, complete source code means
all the source code for all modules it contains, plus any associated
interface definition files, plus the scripts used to control
compilation and installation of the library.

Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running a program using the Library is not restricted, and output
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from such a program is covered only if its contents constitute a work
based on the Library (independent of the use of the Library in a tool
for writing it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's
complete source code as you receive it, in any medium, provided that
you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact
all the notices that refer to this License and to the absence of any
warranty; and distribute a copy of this License along with the
Library. You may charge a fee for the physical act of transferring a
copy, and you may at your option offer warranty protection in
exchange for a fee.

2. You may modify your copy or copies of the Library or any portion
of it, thus forming a work based on the Library, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent notices
stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge
to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a
table of data to be supplied by an application program that uses the
facility, other than as an argument passed when the facility is
invoked, then you must make a good faith effort to ensure that, in
the event an application does not supply such function or table, the
facility still operates, and performs whatever part of its purpose
remains meaningful. (For example, a function in a library to compute
square roots has a purpose that is entirely well-defined independent
of the application. Therefore, Subsection 2d requires that any
application-supplied function or table used by this function must be
optional: if the application does not supply it, the squareroot
function must still compute square roots.)

These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Library,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
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distribute the same sections as part of a whole which is a work based
on the Library, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote
it.

Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Library.

In addition, mere aggregation of another work not based on the
Library with the Library (or with a work based on the Library) on a
volume of a storage or distribution medium does not bring the other
work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public
License instead of this License to a given copy of the Library. To do
this, you must alter all the notices that refer to this License, so
that they refer to the ordinary GNU General Public License, version
2, instead of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared, then you can
specify that version instead if you wish.) Do not make any other
change in these notices. Once this change is made in a given copy, it
is irreversible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative works made
from that copy. This option is useful when you wish to copy part of
the code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion or
derivative of it, under Section 2) in object code or executable form
under the terms of Sections 1 and 2 above provided that you accompany
it with the complete corresponding machine- readable source code,
which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange. If
distribution of object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source
code from the same place satisfies the requirement to distribute the
source code, even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion of the
Library, but is designed to work with the Library by being compiled
or linked with it, is called a "work that uses the Library". Such a
work, in isolation, is not a derivative work of the Library, and
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therefore falls outside the scope of this License. However, linking a
"work that uses the Library" with the Library creates an executable
that is a derivative of the Library (because it contains portions of
the Library), rather than a "work that uses the library". The
executable is therefore covered by this License. Section 6 states
terms for distribution of such executables. When a "work that uses
the Library" uses material from a header file that is part of the
Library, the object code for the work may be a derivative work of the
Library even though the source code is not. Whether this is true is
especially significant if the work can be linked without the Library,
or if the work is itself a library. The threshold for this to be true
is not precisely defined by law. If such an object file uses only
numerical parameters, data structure layouts and accessors, and small
macros and small inline functions (ten lines or less in length), then
the use of the object file is unrestricted, regardless of whether it
is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, you may
distribute the object code for the work under the terms of Section 6.
Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or
link a "work that uses the Library" with the Library to produce a
work containing portions of the Library, and distribute that work
under terms of your choice, provided that the terms permit
modification of the work for the customer's own use and reverse
engineering for debugging such modifications. You must give prominent
notice with each copy of the work that the Library is used in it and
that the Library and its use are covered by this License. You must
supply a copy of this License. If the work during execution displays
copyright notices, you must include the copyright notice for the
Library among them, as well as a reference directing the user to the
copy of this License. Also, you must do one of these things:

a) Accompany the work with the complete corresponding machine-
readable source code for the Library including whatever changes were
used in the work (which must be distributed under Sections 1 and 2
above); and, if the work is an executable linked with the Library,
with the complete machine-readable "work that uses the Library", as
object code and/or source code, so that the user can modify the
Library and then relink to produce a modified executable containing
the modified Library. (It is understood that the user who changes the
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contents of definitions files in the Library will not necessarily be
able to recompile the application to use the modified definitions.)

b) Use a suitable shared library mechanism for linking with the
Library. A suitable mechanism is one that (1) uses at run time a copy
of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will
operate properly with a modified version of the library, if the user
installs one, as long as the modified version is interface-compatible
with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three
years, to give the same user the materials specified in Subsection
6a, above, for a charge no more than the cost of performing this
distribution.

d) If distribution of the work is made by offering access to copy
from a designated place, offer equivalent access to copy the above
specified materials from the same place.

e) Verify that the user has already received a copy of these
materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the
Library" must include any data and utility programs needed for
reproducing the executable from it. However, as a special exception,
the materials to be distributed need not include anything that is
normally distributed (in either source or binary form) with the major
components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies
the executable.

It may happen that this requirement contradicts the license
restrictions of other proprietary libraries that do not normally
accompany the operating system. Such a contradiction means you cannot
use both them and the Library together in an executable that you
distribute.

7. You may place library facilities that are a work based on the
Library side-by-side in a single library together with other library
facilities not covered by this License, and distribute such a
combined library, provided that the separate distribution of the work
based on the Library and of the other library facilities is otherwise
permitted, and provided that you do these two things:
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a) Accompany the combined library with a copy of the same work based
on the Library, uncombined with any other library facilities. This
must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that
part of it is a work based on the Library, and explaining where to
find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the
Library except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense, link with, or distribute the
Library is void, and will automatically terminate your rights under
this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated
so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the
Library), the recipient automatically receives a license from the
original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. You may not impose any
further restrictions on the recipients' exercise of the rights
granted herein. You are not responsible for enforcing compliance by
third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do
not excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under
this License and any other pertinent obligations, then as a
consequence you may not distribute the Library at all. For example,
if a patent license would not permit royalty-free redistribution of
the Library by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both it and this
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License would be to refrain entirely from distribution of the
Library.

If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended
to apply, and the section as a whole is intended to apply in other
circumstances.

It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a
licensee cannot impose that choice. This section is intended to make
thoroughly clear what is believed to be a consequence of the rest of
this License.

12. If the distribution and/or use of the Library is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Library under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.

13. The Free Software Foundation may publish revised and/or new
versions of the Lesser General Public License from time to time. Such
new versions will be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library
specifies a version number of this License which applies to it and
"any later version", you have the option of following the terms and
conditions either of that version or of any later version published
by the Free Software Foundation. If the Library does not specify a
license version number, you may choose any version ever published by
the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free
programs whose distribution conditions are incompatible with these,
write to the author to ask for permission. For software which is
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copyrighted by the Free Software Foundation, write to the Free
Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free
status of all derivatives of our free software and of promoting the
sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU
FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE LIBRARY TO OPERATE WITH ANY OTHER MATERIALS), EVEN IF
SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Libraries

If you develop a new library, and you want it to be of the greatest
possible use to the public, we recommend making it free software that
everyone can redistribute and change. You can do so by permitting
redistribution under these terms (or, alternatively, under the terms
of the ordinary General Public License).

To apply these terms, attach the following notices to the library. It
is safest to attach them to the start of each source file to most
effectively convey the exclusion of warranty; and each file should
have at least the "copyright" line and a pointer to where the full
notice is found.

340 | Programinė įranga „CFX Maestro Dx SE“



Standard Open License Text

<one line to give the library's name and a brief idea of what it
does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is
distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or
FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public
License for more details.

You should have received a copy of the GNU Lesser General Public
License along with this library; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307
USA

Also add information on how to contact you by electronic and paper
mail. You should also get your employer (if you work as a programmer)
or your school, if any, to sign a "copyright disclaimer" for the
library, if necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the
library `Frob' (a library for tweaking knobs) written by James Random
Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!

Naudotojo vadovas | 341



E priedas. „Bio-Rad“ Free and Open-Source Notices for PCR Products

342 | Programinė įranga „CFX Maestro Dx SE“



F priedas. Literatūra
1. Sugimoto et al. (1996). Improved thermodynamic parameters and helix initiation factor to predict

stability of DNA duplexes. Nucleic Acids Research 24, 4,501–4,505.

2. Breslauer KJ et al. (1986). Predicting DNA duplex stability from the base sequence. Proc Nat Acad
Sci 83, 3,746–3,750.

3. Hellemans J et al. (2007). qBase relative quantification framework and software for management and
automated analysis of real-time quantitative PCR data. Genome Biol 8, R19.

4. Livak JL et al. (1995). Towards fully automated genome-wide polymorphism screening. Nature
Genetics 9, 341–342.

5. Pfaffl MW (2001). A new mathematical model for relative quantification in real-time RT-PCR. Nucleic
Acids Research 29, 2,002–2,007.

6. Vandesompele J et al. (2002). Accurate normalization of real-time quantitative RT-PCR data by
geometric averaging of multiple internal control genes. Genome Biology 3, 1–12.

7. Fox J (2008). Applied Regression Analysis and Generalized Linear Models. 2nd ed (New York:
SAGE Publications, Inc.).

„Minpack“ autoriaus teisių pranešimas, Čikagos universitetas, 1999. Visos teisės saugomos.

Leidžiama platinti ir naudoti pirminiu ir skaitmeniniu formatu, su pakeitimais arba be jų, jei laikomasi šių
sąlygų:

1. Platinant pirminį šaltinį turi būti pateiktas pirmiau nurodytas autoriaus teisių pranešimas, šis sąlygų
sąrašas ir šis atsakomybės apribojimas.

2. Platinant skaitmeniniu formatu turi būti pateiktas pirmiau nurodytas autoriaus teisių pranešimas, šis
sąlygų sąrašas ir šis atsakomybės apribojimas šiuose dokumentuose ir (arba) kitoje platinamoje
medžiagoje.

3. Galutinio naudotojo platinamuose dokumentuose, jeigu jie yra, turi būti šis pareiškimas:

„Šį produktą sudaro Čikagos universiteto, kaip „Argonne National Laboratory“ operatoriaus, sukurta
programinė įranga.“
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